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Safety precautions 

Read this manual for your safety before using the product. 

 Mishandling due to ignoring this display may cause death or serious injury. 

 Mishandling due to ignoring this display may cause personal injury. 
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General cautions 

 

 

Do not touch the safety switch inside the machine. Doing so may cause electric shock when high voltage 

occurs. In addition, gears can rotate, which may result in personal injury. 

 

Do not use an inflammable spray near the machine. Doing so may cause a fire since there is an area heating up 

within the machine. 

 

Unplug the power cord from the outlet and contact your dealer if the cover becomes abnormally hot, emits 

smoke, smells strange, or makes an abnormal noise. 

Failure to do so may cause fire. 

 

Unplug the power cord from the outlet and contact your dealer if water or other liquid gets into the machine. 

Failure to do so may cause fire. 

 

If paper clips or other foreign objects enter the machine, disconnect the power plug from the outlet and remove 

foreign objects if any. 

Failure to do so may cause electric shock, fire or injury. 

 

Do not disassemble the machine or perform operations other than those specified in the User's Manual. 

Doing so may cause electric shock, fire or injury. 

 

Unplug the power cord from the outlet and contact your dealer if the machine is dropped or the cover is 

damaged. 

Failure to do so may cause electric shock, fire or injury. 

 

Periodically disconnect the power plug from the outlet and clean the base of the prongs and between the 

prongs. 

Leaving the power plug inside the outlet for a long period of time may cause a fire due to short circuit caused by 

collection of dust at the base of the prongs. 

 

Do not clean up spilled toner using an electric vacuum cleaner. When spilled toner is cleaned up using an 

electric vacuum cleaner, a fire may be caused due to sparks from electrical contacts. 

If toner is spilled on the floor, wipe the toner up carefully using a damp cloth to prevent toner scattering. 

 

Do not insert objects into the air vents. 

Doing so may cause electric shock, fire or injury. 

 

Do not place any containers like cups containing water on the machine. Doing so may cause electric shock or 

fire. 

 

Make sure that no urine from pets on top of the printer wet or enter this machine. Failure to do so may cause 

electric shock or fire. 

 
Take care when touching the fuser unit. Failure to do so may cause burns. 

 

Do not throw the image drum, toner cartridge or waste toner box into fire. Doing so may cause burns due to 

dust explosion. 

 

Do not connect the power cord, cables and ground wire other than those specified in the User's Manual. 

Doing so may cause a fire. 

 

Operations using an uninterruptible power supply (UPS) or an inverter are not guaranteed. Do not use an 

uninterruptible power supply or inverter. 

Doing so may cause a fire. 
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Do not approach the paper discharger when the power is on or during printing. Doing so may cause injury. 

 

Do not touch a broken display. Doing so may cause injury. If any liquid (liquid crystal) leaking from the display 

gets into the eyes or mouth, wash it off promptly with a large quantity of water. Consult a physician as 

necessary. 

 

Do not disassemble or forcibly open the image drum, toner cartridge or waste toner box. Doing so may scatter 

the toner, which may be inhaled by people or may stain clothes or hands. 

 

 

NOTE! 

This product is not intended for use in the immediate visual field on the display work place. To avoid disturbing 

reflections on the display work place, this product shall not be placed in the immediate field of vision. 
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Preface 

• EMERGENCY FIRST AID 

Take care with toner powder: 

 

If swallowed, give small amounts of cold water and seek medical attention. DO NOT attempt to induce 

vomiting. 

If inhaled, move the person to an open area for fresh air. Seek medical attention. 

If it gets into the eyes, flush with large amounts of water for at least 15 minutes keeping eyelids open. Seek 

medical attention. 

Spillages should be treated with cold water and soap to help reduce risk of staining skin or clothing. 
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Trademarks 

Printronix is a registered trademark of Printronix, LLC. 

Microsoft, Windows, Windows Server and Internet Explorer are registered trademarks or trademarks of 

Microsoft Corporation in the United States and other countries. 

Apple, Mac, macOS, iPad, iPhone, iPod, iPod Touch and Safari are registered trademarks of Apple Inc. in the 

United States and other countries. 

 

AirPrint and the AirPrint logo are trademarks of Apple Inc. 

Google, Google Chrome, Android and Gmail are trademarks or registered trademarks of Google LLC. 

iOS is a trademark of Cisco. 

Adobe, Illustrator, Photoshop, PostScript and Reader are registered trademarks or trademarks of Adobe 

Systems Incorporated in the United States and other countries. 

Wi-Fi is a registered trademark of Wi-Fi Alliance. 

Other product names and brand names are registered trademarks or trademarks of their proprietors. 

 

 

This product complies with the requirements of the Council Directives 2014/30/EU (EMC), 

2014/35/EU(LVD), 2014/53/EU (RED), 2009/125/EC (ErP) and 2011/65/EU(RoHS), as amended where 

applicable, on the approximation of the laws of the member states relating to Electromagnetic 

Compatibility, Low Voltage, Radio Equipment, Energy related Products and Restriction on the use of 

certain Hazardous Substances in electrical and electronic equipment. 

 

The following cables were used to evaluate this product for EMC directive 2014/30/EU compliance, and 

configurations other than this may affect that compliance. 

 

CABLE TYPE LENGTH (METER) CORE SHIELD 

Power 1.8   

USB 5.0   

LAN 10.0   

 

The simplified EU declaration of conformity 

Hereby, Oki Electric Industry Co., Ltd. declares that the radio equipment type “AW-CM382” is in compliance 

with Directive 2014/53/EU. 

The full text of the EU declaration of conformity is available at the following internet address: 

https://www.oki.com/eu/printing/support/declaration-of-conformity 

https://www.oki.com/eu/printing/support/declaration-of-conformity
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About this manual 

This section lists a variety of information about this manual. Please read this manual before using the 

machine. 

 

 
 Depending on the target region or country, specifications and functions of the product may differ from those 

described in the manual. Please check the menu items and default settings with the device you are using. 

 

Manual structure 

 Basic Operation Guide (PDF)...included on the DVD enclosed with this machine. 

 User's Manual (PDF)...available on the website. 

 Online Manual...available on the website. 

About this manual 

 The reproduction of this manual, in whole or in part, without permission is strictly prohibited. 

 The content of this manual may be changed without a prior notice in the future. 

 Efforts have been exerted to make the content of this manual as complete as possible. However, should 

you notice any errors, omissions or other problems, contact the retail store where you made the 

purchase. 

 Notwithstanding the foregoing, we shall not have any liability in regard to any operational effect related to 

the instructions contained in this manual. 

Copyrights 

All rights belong to Printronix, LLC. This manual may not be reproduced, transcribed or translated without 

permission. Be sure to obtain the written approval from Printronix, LLC. 

© 2022 Printronix, LLC. 

About the description 

This section describes the marks, symbols, abbreviations and illustrations used in this manual. 

 
 This manual uses screens of the following operating systems unless otherwise specified. 

 For Windows: Windows 10 

 For macOS: macOS 10.15 

 Sometimes, the model name is written as [Printronix Printer]. 

 Depending on the used OS, model and version, the description in this manual may differ. 

About marks 

This manual uses the following marks. 

Mark Meaning 

 
Indicates cautions and restrictions for the correct operation of this machine. Be sure to read them to 

avoid misoperation. 

 

Indicates useful tips and references on how to use this machine. We recommend you read them. 
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Mark Meaning 

 

Indicates reference items. Please read them to learn the detailed information. 

 
Indicates the related items. Please read them to learn the relevant information. 

About symbols 

This section describes the symbols used in this manual and their meanings. 

Symbol Meaning 

« » Indicates buttons/keys on the operator panel of this machine. 

Indicates keys on the PC keyboard. 

[ ] Indicates menu names, item names, options, etc. displayed on the display. 

Indicates menus, windows and dialog box names displayed on the PC screen. 

They can be clearly distinguished in the description and procedure illustration. 

" " Indicates messages and input texts displayed on the display. 

Indicates file names on the PC. 

Indicates item titles of link destinations. 

- Indicates the menu path of this machine or the PC. 
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Features of this machine 

 Installable in restrained space 

As the machine is compact, the space between both sides of this machine and the wall can be as small 

as 20 mm. (When the optional caster stand is not installed) 

 

 Easy maintenance with full front access 

You can replace consumables and maintenance parts, and clear a paper jam from the front side. 

 

 An increased service life of the machine and consumables 

The service life of this machine and the image drum has been extended in comparison with existing 

models. 

 

 Immediate start of printing thanks to short warm-up time 

The warm-up time of this machine has been shortened in comparison with conventional models. 

 

 Massive printing possible with the extension tray 

Up to three extension trays can be installed. 

 

 Easy troubleshooting by watching the display 

The troubleshooting hint is displayed together with illustrations on the display. You can solve problems by 

following the on-screen instructions. 

 

 Easy setting change by shortcut menus 

Menu items can be displayed easily by pressing the «Fn» key and then inputting a number. 

 Setting with the short menu (Fn key) 

 

 Easy update by using the Monitoring Tool 

You can update the firmware and the software easily by using the Monitoring Tool. 

 

 Easy mobile printing and initialization with the NFC and app 

You can print and initialize this machine by using the specialized application from your smartphone, tablet 

or other mobile devices. 

 Applications for mobile devices  
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Installation 

Installation environment 

Install this machine in the following environment. 

Ambient temperature: 10°C to 32°C 

Ambient humidity: 20% to 80% RH (relative humidity) 

Maximum wet-bulb temperature: 25°C 

 
 Make sure there is no condensation. Failure to do so may cause a malfunction. 

 To install this machine in a location where the ambient humidity is 30% RH or less, use a humidifier or static 

prevention mat. 

 Depending on the installation environment, the operating noise of this machine may cause concern. If you are 

concerned about the operating noise, we recommend that you install this machine in an isolated location or a 

separate room. 

 Do not install this machine near any devices in which combustion takes place. Doing so may cause lighter printing. 

 

 Do not install this machine close to high-temperature locations or naked flames. 

 Do not install in locations where chemical reactions occur (e.g. laboratories). 

 Do not install this machine close to combustible solutions such as alcohol and thinners. 

 Do not install this machine within the reach of children or infants. 

 Do not install this machine in an unstable location (e.g. unsteady table or sloping surface). 

 Do not install this machine in a humid or dusty location, or in a location exposed to direct sunlight. 

 Do not install this machine in an environment with salt air, corrosive gas, NOx, or SOx. 

 Do not install this machine in locations with major vibration. 

 Do not install this machine in locations where its air vents are blocked. 

 

 

 Do not directly install this machine on shaggy rugs or carpets. 

 Do not install this machine in locations with poor air circulation or ventilation like in a sealed room. 

 Ensure proper ventilation when it is used for a long time in a small room. 

 Keep this machine away from strong magnetic fields and sources of noise. 

 Keep this machine away from monitors and TVs. 

 When moving this machine, stand at the front and back and hold the handle at the bottom of the machine. 

Installation space 

Install this machine on a flat desk which is larger than the bottom of the machine. 

Allow sufficient space around this machine as shown in the following figures. 

 Plan view (When the optional caster stand is not installed) 
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 Side view (When the rear output tray is used) 

 

 

 Depending on the installation environment, the temperature inside this machine may rise and the printing speed 

may slow down. 

 

 Side view (When the rear output tray is closed and a cable with angled connector is used) 

 

 

 Depending on the installation environment, the temperature inside this machine may rise and the printing speed 

may slow down. 

 Do not place curtains, paper or other flammable objects on the back of this machine. 



 

- 19 - 

Unpacking 

 
Doing so may cause injury. 

 

This machine weighs approx. 30 kg, so be sure to have it lifted by at least 2 personals. 

 
 Be sure to use the consumables/maintenance items supplied with this machine first. If you install the 

consumables/maintenance items other than those supplied first, the lifespan may not be displayed correctly or the 

accessories may not be usable later. 

 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light exceeding approx. 1,500 lux. Do not leave it for more 

than 5 minutes even under room lighting. 

 Do not expose the removed fuser unit to direct sunlight or strong light exceeding approx. 1,500 lux. Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 The packing box and buffer material are required when shipping this machine. Do not discard them, but store them 

safely. 

 

1 Open the packing box and take out the accessories and buffer material. 

 

2 Remove the packing case and take out this machine from the plastic bag. 
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3 Lift this machine and place it at the installation site. 

4 Remove the drying agent on the top of this machine. 

 

 
 To use the optional expansion tray, see "Installing options ". 
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Checking accessories 

Make sure that you have all the following accessories. 

 
Doing so may cause injury. 

 

This machine weighs approx. 30 kg, so be sure to have it lifted by at least 2 personals. 

 
 See "Unpacking " for the unpacking method. 

 
 Be sure to use the consumables enclosed with this machine first. If you install consumables other than the 

accessories first, the service life may not be displayed correctly, or the accessories may not be usable later. 

 

 

 Main unit 

 

 By default, an image drum and a waste toner box are installed in the main unit. 

 

 4 starter toner cartridges (black, cyan, magenta, and yellow) 

 

 Setup Guide 

 

 DVD 

 

 Power cord 

 
 The LAN cable and USB cable are not included. Please prepare a cable separately according to the connection 

environment. 

 Connecting via a wired LAN  

 Connecting via USB  
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Installing the starter toner cartridge 

 
 When you use this machine for the first time, install the included starter toner cartridge. If an optional toner cartridge 

is installed and used first, you may not be able to use the starter cartridge later. 

 Do not install a starter toner cartridge that has been used in another machine. The remaining toner may not be 

displayed correctly. 

 

1 Pull the front cover open lever (blue) to open the front cover. 

 

2 Take the black(K) starter toner cartridge out of the bag, and shake it several times vertically or 

horizontally. 

 

3 Install the black(K) starter toner cartridge in the machine. 

 

4 Install the starter toner cartridge (C/M/Y) in the same way as the black(K) starter toner cartridge. 

 

5 Close the front cover firmly with both hands. 
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Installing options 

This section explains the installation of options. If no option is installed, proceed to "Connecting the power cord ". 

The following options are available. 

 
 Be sure to turn off the power and unplug the power cord and cables before installing any options. If an option is 

installed with the power on, the main unit and the option may be damaged. 

 

 

 Wireless LAN module 

 Description 

 

Install it when you want to use this machine via a wireless LAN.  

 Expansion tray unit 

 Description 

 

Install it to increase the quantity of paper that can be loaded in this 

machine. Up to 3 levels can be expanded. 

 Dedicated caster stand 

 Description 

 

With it installed, the machine is easier to move. After moving, fix with 

a stopper. 

 

 
 After mounting the optional expansion tray unit, install the software on your PC, and set the options from the printer 

driver. See "Setting the printer driver ". 

Installing the wireless LAN module 

Install it when you want to use this machine via a wireless LAN. After installation, it is required to follow the 

procedure to enable the wireless LAN module. 

This section describes the procedure of installing the wireless LAN module and enabling it from the operator 

panel. 

Ethernet and wireless LAN can be used simultaneously on different networks. 
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Model: 45830222 

 

 

1 Turn off this machine and unplug the power cord. 

 
 If you install it with the power on, the main unit or wireless LAN module may be damaged. 

 Turning the power off 

2 Open the wireless LAN module cover on the side of this machine. 

 

3 Pull out the connector and insert it into the wireless LAN module. 

 

4 Insert the wireless LAN module into this machine. 

 

5 Close the wireless LAN module cover. 

 

6 Connect the power cord to this machine. 

 Connecting the power cord  

7 Power on this machine. 

8 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 
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9 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

10 Check that [Network Setup] is selected, and press «OK». 

 

11 Check that [General Setup] is selected, and press «OK». 

 

12 Check that [Extended Network] is selected, and press «OK». 

 

13 Press ▼to select [Wireless], and press «OK». 

 

14 When [Are You Sure?] is displayed, check that [Yes] is selected, and press «OK». 

 

15 Wait until the standby screen appears as this machine restarts. 

16 Enable [Wireless(Infrastructure)] or [Wireless(AP Mode)]. 

 Connecting via a wireless LAN  

 
 [Wireless(Infrastructure)] and [Wireless(AP Mode)] cannot be enabled at the same time. 

Installing the expansion tray unit 

 
Doing so may cause injury. 

 

This machine may fall over. Be sure to install the attached fixing parts. 

To use the dedicated caster stand, be sure to mount the anti-tip feet. 
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Install the expansion tray unit to increase the quantity of paper that can be loaded. After installation, set the 

number of trays in the printer driver. 

Up to three extension trays can be installed. Be sure to install the attached fixing parts. 

To install any of the three expansion trays, it is recommended to install the optional dedicated caster stand to 

avoid the risk of tipping. Be sure to mount the anti-tip feet. 

 Installing the dedicated caster stand 

A flat-head screwdriver is required to install the expansion tray unit. 

 
 The packing case and buffer materials are required to ship the expansion tray. Do not discard them, but store them 

safely. 

 When an extension tray is used to print from, if the printing position shifts, correct the printing position for each 

extension tray. For details, see "Correcting the print position of the tray ". 

Model: N36810A 

 

 

 
Doing so may cause injury. 

 

This machine weighs approx. 30 kg, so be sure to have it lifted by at least 2 personals. 

 

This section describes the installation of two expansion tray units as an example. 

 

1 Turn off this machine and remove the power cord and all the cables. 

 
 Be sure to turn off the power and unplug the power cord and all the cables before installing the expansion tray 

unit. If the expansion tray unit is installed with the power on, this machine and the expansion tray unit may be 

damaged. 

 Installation with a cable connected may cause you to get caught in the cable and get injured. 

2 Install one expansion tray. 

3 Gently stack the additional expansion tray on the expansion tray installed in Step 2 so that they 

are aligned on the right side and front and the protrusions fit into the holes on the bottom. 
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4 Fix the stacked expansion trays on both sides with accessories by using a flat-head 

screwdriver. 

 

5 With the main unit and the expansion trays aligned on the right side and front, gently stack them 

so that the protrusions of the expansion tray fit into the holes on the bottom of the main unit. 

 

6 Fix the main unit and the expansion trays by using a flat-head screwdriver. 

 

 
 When transporting this machine, replacing consumables or maintenance parts, or loading paper in the tray, 

check the following points to avoid the risk of tipping.  
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 Do not press on the back of this machine or the image drum basket when the output tray is open and the 

image drum is pulled out. 

 

 Do not press on the cassette from above when the cassette is pulled out. 

 

 Do not press on this machine from the back with the cassette pulled out. 

 

7 Plug in the power cord and the disconnected cable back to the main unit. 

 Connecting the power cord  

8 Power on this machine. 

9 Press the scroll button▼on the operator panel several times to select [Configuration], and press 

«OK». 

10 Check that [Tray Count] is selected, and press «OK». 

11 Make sure the display shows the installed expansion tray. 

12 After confirming the content, press «ONLINE» to return to the standby screen. 

13 After connecting this machine to a PC and completing software installation, set the expansion 

tray unit in the printer driver. 

 Setting the printer driver  

Installing the dedicated caster stand 

 
Doing so may cause injury. 

 

This machine may fall over. Be sure to install the attached fixing parts. 

To install any of the three expansion trays, be sure to mount the anti-tip feet. 

This is a stand with casters for moving this machine. 

It also comes with anti-tip feet to avoid the risk of tipping. It is recommended to use it when the expansion tray 

is installed. 
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A Phillips-head screwdriver and a flat-head screwdriver are required to install the caster stand. 

 
 To install any of the three expansion trays is installed, be sure to install the dedicated caster stand, the anti-tip feet 

and the attached fixing parts to avoid the risk of tipping. 

 The packing box and buffer materials are required to ship the dedicated caster stand. Do not discard them, but store 

them safely. 

Model: BOD-S3 

 

 

 
Doing so may cause injury. 

 

This machine weighs approx. 30 kg, so be sure to have it lifted by at least 2 persons. 

 

1 Check that you have all the parts for the dedicated caster stand. 

(1) Main unit 

(2) Anti-tip foot a 

(3) Anti-tip foot b (x 3) 

(4) Positioning pin (x 2) 

(5) Metal fixtures of the caster stand (x 2) 

(6) Screw (x 4) 

 

2 Mount the anti-tip foot a on the front of the dedicated caster stand. 
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3 Then, mount the anti-tip foot b (x 3) to both sides and the back. 

 

4 Check that the anti-tip foot a and the anti-tip foot b (x 3) are inserted in place by turning the 

dedicated caster stand upside down. 

 

5 Turn the dedicated caster stand back and mount the positioning pin (x 2). Rotate to fix the 

positioning pin (x 2) with a flat-head screwdriver. 

 

6 Turn off this machine and remove the power cord and all cables. 

 
 Installation with a cable connected may cause you to get caught in the cable and get injured. 

7 Lock the caster (2 places) to prevent the dedicated caster from moving during the installation of 

the main unit and the expansion tray. 
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8 With the main unit or the expansion tray aligned with the dedicated caster on the right side and 

the front, gently stack them so that the positioning pins of the dedicated caster stand fit into the 

holes on the bottom. 

 

9 Fix the main unit or the extension tray and the dedicated caster stand with the metal fixtures (x 

2) and the screws (x 4) by using a Phillips-head screwdriver. 

The figure shows an example of fixing the expansion tray and the dedicated caster stand. 

 

10 To add more extension trays, with the expansion tray already attached onto the dedicated 

caster stand aligned with the expansion tray to be installed on the right side and front, gently 

stack them so that the protrusions fit into the holes on the bottom. 
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11 Fix the stacked expansion trays on both sides with accessories by using a flat-head 

screwdriver. 

 

12 When multiple expansion trays are installed, with the main unit and the expansion trays aligned 

on the right side and front, gently stack them so that the protrusions of the expansion tray fit into 

the holes on the bottom of the main unit. 

 

13 When the expansion tray is installed, fix the main unit and the expansion tray on both sides with 

accessories by using a flat-head screwdriver. 
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14 Before moving this machine, unlock the casters (2 places). 

 

15 After moving this machine, lock the casters (2 places) to prevent accidental sliding. 

 

 
 When transporting this machine, replacing consumables or maintenance parts, or loading paper in the tray, 

check the following points to avoid the risk of tipping. 

 Do not press on the back of this machine or the image drum basket when the output tray is open and the 

image drum is pulled out. 

 

 Do not press on the cassette from above when the cassette is pulled out. 

 

 Do not press on this machine from the back with the cassette pulled out. 

 

16 Plug in the power cord and the disconnected cable back to this machine. 

17 Power on this machine. 

When an expansion tray unit is installed, it is required to check the installation and set the printer driver. 

 Setting the printer driver  
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Connecting the power cord 

About the power supply 

The power supply must meet the following requirements. 

Voltage: 110 to 127V AC (Range 99 to 140V AC) / 220 to 240V AC (Range 198 to 264V AC) 

Power supply frequency: 50/60 Hz ± 2% 

 
 If the power supply is unstable, use a voltage regulator. 

 The maximum power consumption of this machine is 1,150W. Check that there is sufficient voltage capacity. 

 This machine may not work properly if an uninterruptable power supply (UPS) or inverter is used. Do not use any 

uninterruptable power supply or inverter. 

 
Doing so may cause fire or electric shock. 

  

 Be sure to turn off the power before connecting or disconnecting the power cord or ground wire. 

 Be sure to insert the ground wire into the dedicated ground connector. 

If you cannot connect to the ground, please consult your dealer. 

 Do not connect the ground wire to any water pipe, gas pipe, telephone ground line, lightning rod, etc. 

 Be sure to connect the ground wire before connecting the power cord to an outlet. Yet, be sure to disconnect the 

ground wire after disconnecting the power cord from the outlet. 

 Be sure to hold the power plug when plugging or unplugging the power cord. 

 Insert the power cord fully into the outlet. 

 Do not plug or unplug the power cord with wet hands. 

 Do not route the power cord wherever it could be stepped on. Also, do not place anything heavy on the power cord. 

 Do not bundle or tie the power cord during use. 

 Do not use the power cord if damaged. 

 Do not use any multi-outlet power strips. 

 Do not plug this machine and other electric devices to the same outlet. Particularly, if connected to the same outlet 

with air-conditionings, copiers, shredders, this machine may malfunction due to electric noise. If they have to share 

a same outlet, use a commercially available noise filter or noise cut transformer. 

 Plug the power cord that comes with this machine directly to the outlet. Do not use the power cord for other devices 

with this machine. 

 Do not use any extension cord. If you have to use an extension cord, use one with a rating of 15A or above. 

 If an extension cord is used, this machine may malfunction due to lower AC voltage. 

 Do not turn off the power or unplug the power cord during printing. 

 Unplug the power cord if you are not going to use the machine for a long time due to a vacation or traveling. 

 Do not use the power cord that comes with this machine with other devices. 

1 Insert the power cable into the power connector of this machine. 

 

2 Insert the power plug into the outlet. 
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Loading paper in the tray 

This section describes the procedure assuming that A4-sized plain paper is loaded in Tray 1. When other 

paper is loaded, see "Loading paper ". 

 

1 Pull out the paper cassette. 

 

2 Slide the paper guide and the blue part of the paper stopper to fit the size of the paper to be 

loaded. 

 

3 Shuffle the paper well. Straighten the edges of the paper horizontally. 

 

4 Load the paper with the printing side down, and press it down from top. 

 
 Do not exceed the ▽ mark on the paper guide when loading paper. 
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5 Return the paper cassette to this machine. 

 

6 Set the size, type and weight of the paper on the operator panel. 

 Loading paper  
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Connecting via a wired LAN 

Connect this machine and a PC with a LAN cable to print. Connect the LAN cable, and set the IP address and 

others on the operator panel. 

Connecting the LAN cable 

1 Prepare a LAN cable (category 5e or better, twisted pair, straight) and a hub. 

 

2 Power off this machine. 

3 Plug one end of the LAN cable into the network interface connector (LAN1) of this machine. 

 

4 Plug the other end of LAN cable into the hub. 

 

Then, set the network information like the IP address on this machine. 

 Setting the IP address, etc.  

Setting the IP address, etc. 

Set values suitable for the current environment on the operator panel. 

The following case is taken for example here. 

 

(Example) 

 IP address of this machine: 192.168.0.2 

 Subnet mask: 255.255.255.0 

 Gateway address: 192.168.0.1 

When using a wireless LAN, see "Connecting via a wireless LAN ". 
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1 Power on this machine. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Check that [Network Setup] is selected, and press «OK». 

 

5 Press ▼ to select [Wired(LAN1) Setup], and press «OK». 

 

6 Press ▼ to select [IP Address Set], and press «OK». 

 

When you set the IP address manually, press ▼ to select [Manual] and press «OK». 

Go to Step 7. 

 

When you set the IP address automatically, check that [Auto] is selected and press «Back». 

Go to Step 14. 

 

7 Press «BACK», then press ▼ to select [IPv4 Address] on the [Wired(LAN1) Setup] screen, and 

finally press «OK». 
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8 Use either the scroll buttons or the numeric keypad to input the first 3 digits of the IP address, 

and press «OK». 

Input the next 3 digits in the same way. To move to the next box, press «OK». 

Press «OK» after inputting all the digits. 

 

9 Check that the cursor has returned to the first 3 digit, and press «BACK». 

 

10 Press ▼ to select [Subnet Mask], and press «OK». 

 

11 Input the subnet mask in the same way as the IP address. Press «OK» after inputting all the 

information, check that the cursor has returned to the first 3 digit, and press «BACK». 

 

12 Press ▼ to select [Gateway Address], and press «OK». 

 

13 Input the gateway address in the same way as the IP address. Press «OK» after inputting all 

the information, check that the cursor has returned to the first 3 digit, and press «BACK». 

 



 

- 40 - 

14 Press «ON LINE» to return to the standby screen. 

 

Checking the connection from a PC 

Check the IP address of this machine, and access it from a PC by using the Web browser. 

1 Press the scroll button ▼ on the operator panel several times to select [Configuration], and 

press «OK». 

2 Press «5» on the [Configuration] screen. 

 

3 Check that [Network Setup] is selected, and press «OK». 

 

4 Press ▼ to select [Wired(LAN1) Information], and press «OK». 

 

5 Press ▼ several times to select [IPv4 Address], and press «OK». 

 

6 Take a note of the displayed IP address. 

7 Start the Web browser in a PC. 

8 Input "http:// (The IP address recorded in Step 6)", and press the «Enter» key. 

Connection is successful when the web page of this machine is displayed. 
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 If the web page of this machine is not displayed, the network connection between the PC or other terminals and 

this machine has failed. 

Check if [IP Address Set], [IPv4 Address], [Subnet Mask] and [Gateway Address] of this machine are set 

correctly. 

 

Then, go to "Installing software on a PC ". 



 

- 42 - 

Connecting via a wireless LAN 

Connect this machine and a PC via a wireless LAN to print. 

 
 Wired LAN1 and wireless LAN can be used at the same time. If wired LAN1 and wireless LAN are connected to the 

same subnet, the communication may be unstable. 

 Do not place an electric appliance (especially microwave oven or digital cordless telephone) that emits weak 

electronic waves near this machine. 

 Wireless LAN connection may be inferior in communication speed compared to wired LAN connection or USB 

connection depending on the environment. When printing large data such as photos, we recommend you to print via 

a wired LAN or USB connection. 

If detailed settings such as security and server are required, set them from the web page of this machine. 

 Web page (Managing this machine from a PC)  

Connection form 

There are two types of connection forms between this machine and the PC via a wireless LAN. Select the 

connection form according to your environment, and prepare what is necessary as per the following table for 

the connection. 

 
 Wireless LAN (Infrastructure) and wireless LAN (AP mode) cannot be used at the same time. 

 Wired LAN1 and wireless LAN can be used at the same time. 

 Since the communication may be unstable if wired LAN1 and wireless LAN are connected to the same subnet, 

please connect to a different subnet. 

Type Infrastructure AP mode 

Connectio
n image 

 

  

Descriptio
n 

Connect this machine and the wireless terminal (PC, 
tablet, smartphone, etc.) via an access point. 

Set this machine as a wireless access point, and 
connect it directly with the wireless terminal (PC, 
tablet, smartphone, etc.). 

Required 
preparatio
ns 

 Check the following information and take a note. 
 Wireless settings of the printer 
Auto/Manual setting of the IP address 
For manual setting: 
IPv4 Address 
Subnet Mask 
Gateway Address 
Wireless LAN Access Point 
SSID 
Encryption Key 

 Check that your wireless LAN access point 
supports the following environment. 
Standard: IEEE 802.11 a/b/g/n 
Access mode: Infrastructure mode 

 Check that the wireless LAN access point 
supports WPS. 

 If WPS is not supported, check the SSID and 
encryption key with the User's Manual enclosed 
with your wireless access point. 

 Check that your wireless terminal supports the 
following environment. 
Standard: IEEE 802.11 b/g/n 
Security: WPA2-PSK(AES) 

 Check that your wireless terminal supports 
WPS-PBC (push button). 

 If you are not sure whether WPS-PBC is 
supported, connect manually after turning on 
the power of this machine. 

Connectio
n method 

Connecting via an access point (Infrastructure)  Connecting directly with this machine (AP mode)  
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 SSID is also called the network name, ESSID or ESS-ID. 

 Encryption key is also called the network key, security key, password, or pre-shared key (PSK). 

Connecting via an access point (Infrastructure) 

 
 Put this machine in an unobstructed view position near the wireless LAN access point. (The recommended distance 

is 30 m or less.) 

 It may be difficult to connect if there is a metal, aluminum sash or reinforced concrete wall between this machine and 

the wireless LAN access point. 

 When using 2.4GHz for a connection, use it within the range of 1 to 11ch. 12ch and 13ch may be available 

depending on the country or region. 

 

1. Enabling the wireless LAN function 

1 Power on this machine. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Check that [Network Setup] is selected, and press «OK». 

 

5 Check that [General Setup] is selected, and press «OK». 

 

6 Check that [Extended Network] is selected, and press «OK». 

 

7 Press ▼ to select [Wireless], and press «OK». 
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8 When [Are You Sure?] is displayed, check that [Yes] is selected, and press «OK». 

 

9 Wait until the standby screen appears as this machine restarts. 

If [Not connected to wireless access point] is displayed, press «OK». 

If "Set-up wireless?" is displayed, select [No], and press «OK». 

 

2. Enabling infrastructure 

1 Press the scroll button ▼ on the operator panel several times to select [Wireless(Infrastructure) 

Setting], and press «OK». 

2 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

 
 "It is not possible to use the Wireless(AP Mode) at the same time." will be displayed for about 5 seconds. 

3 Press ▲ to select [Enable], and press «OK». 

 

 
 After setting wireless(AP Mode) to [Disable], if a screen appears to ask you to check whether to enable 

wireless(Infrastructure), press «OK» to enable wireless (Infrastructure). 

 

To set the IP address of this machine manually, go to "3. Setting the IP address". 

To obtain an IP address automatically, go to "4. Connecting with the wireless access point". 

 
 The factory default setting is [Auto]. 

 

3. Setting the IP address 

If you want to set the machine's IP address to a fixed value, follow the procedure below. 

 
 For [Auto], the machine's IP address may change dynamically. 

 
 For [IPv4 Address], set a value which is not overlapped to any other networked machines. 

 If you do not use the IPv6 address, set [DHCPv6] to [Disable].  



 

- 45 - 

(Example) 

 IP address of this machine: 192.168.101.2 

 Subnet mask: 255.255.255.0 

 Gateway address: 192.168.101.1 

When using a wired LAN, see "Setting the IP address, etc. ". 

1 Press the scroll button ▼ on the operator panel several times to select [Wireless(Infrastructure) 

Setting], and press «OK». 

2 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

 
 "It is not possible to use the wireless(AP Mode) at the same time." will be displayed for about 5 seconds. 

3 Press ▲ to select [Enable], and press «OK». 

 

4 Press ▼ to select [Network Setting], and press «OK». 

 

5 Check that [IP Address Set] is selected, and press «OK». 

 

6 Press ▼ to select [Manual], and press «OK». 

 

7 Press «BACK», then press ▼ to select [IPv4 Address] on the [Network Setting] screen, and 

finally press «OK». 

 



 

- 46 - 

8 Use either the scroll buttons or the numeric keypad to input the first 3 digits of the IP address, 

and press «OK». 

Likewise, input the next 3 digits, and press «OK». Press «OK» after inputting all the digits. 

 

9 Press ▼ to select [Subnet Mask], and press «OK». 

 

10 Input the subnet mask in the same way as the IP address. Press «OK» after inputting all the 

digits. 

 

11 Press ▼ to select [Gateway Address], and press «OK». 

 

12 Input the gateway address in the same way as the IP address. Press «OK» after inputting all 

the digits. 

 

13 Press «ON LINE» to return to the standby screen. 

 

 

4. Connecting with the wireless access point 

There are three ways as follows. Usually, it is connected with the simplest WPS. 
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 Connecting with WPS 

 Connecting by selecting a wireless LAN access point from the operator panel 

 Connecting by setting manually from the operator panel 

 

 
 When you connect with wireless LAN by WPA/WPA2-EAP, see "Setting IEEE802.1X (Wireless LAN) ". 

 

Connecting with WPS 

If the wireless LAN access point supports WPS, you can easily connect to the wireless LAN using the push 

button for easy setup (WPS button). 

1 Check the position of push button for easy setup (WPS button) and the time for which the 

button is pressed in the User's Manual enclosed with the wireless LAN access point. 

2 Check that the wireless LAN access point is activated and operating properly. 

3 Press the scroll button ▲ on the operator panel several times to select [Wireless(Infrastructure) 

Setting], and press «OK». 

4 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

 
 "It is not possible to use the wireless(AP Mode) at the same time." will be displayed for about 5 seconds. 

5 Press ▲ to select [Enable], and press «OK». 

 

6 Press ▼ several times to select [Automatic setup (WPS)], and press «OK». 

 

7 Check that [WPS-PBC] is selected, and press «OK». 

 

8 When "Implementing this method? Pushbutton method" is displayed, check that [Yes] is 

selected, and press «OK». 
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"Running pushbutton method" is displayed, and this machine will start to search for a wireless LAN 

access point. 

 

9 Press and hold the push button of wireless LAN access point for the period of time confirmed in 

Step 1 or for a few seconds. 

 
 "Running pushbutton method" is displayed for about 2 minutes. Press the push button of wireless LAN access 

point while it is displayed. 

 While "Running pushbutton method" is displayed, the operator panel of this machine is disabled. 

10 When "WPS connection successful" is displayed, the connection to the wireless LAN access 

point is completed. 

 

Go to "6. Checking the connection from a PC". 

 
 When "Not connected to wireless access point" or "Connection failed." is displayed, repeat the procedure from 

Step 1, or try "Connecting by selecting a wireless LAN access point from the operator panel". 

 

Connecting by selecting a wireless LAN access point from the operator panel  

When the wireless LAN access point does not support WPS or when WPS connection does not function well, 

connect by specifying the wireless access point to be used from the list of wireless access points detected by 

this machine. In this case, it is required to input the SSID and encryption key. 

1 Check and take a note of the SSID and encryption key on the side of the wireless LAN access 

point or in the User's Manual enclosed with the access point. 

 
 WPA-EAP and WPA2-EAP cannot be set from the operator panel. Set them from the web page of this machine. 

 Opening the web page  

2 Check that the wireless LAN access point is activated and operating properly. 

3 Press the scroll button ▼ on the operator panel several times to select [Wireless(Infrastructure) 

Setting], and press «OK». 

4 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

 
 "It is not possible to use the wireless(AP Mode) at the same time." will be displayed for about 5 seconds. 
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5 Press ▲ to select [Enable], and press «OK». 

 

6 Press ▼ several times to select [Wireless Network Selection], and press «OK». 

 

This machine starts searching for wireless LAN access points. 

7 A list of SSID of connectible wireless LAN access points is displayed. Press ▲ or ▼ to select 

the SSID of the wireless LAN access point recorded in Step 1, and press «OK». 

 

If no wireless LAN access point is found, only [Manual Setup] is displayed. In that case, make settings by 

following "Connecting by setting manually from the operator panel". 

8 When the encryption key entry screen suitable for the encryption method of the selected 

wireless LAN access point is displayed, input the encryption key recorded in Step 1, and press 

«OK». 

 
 The encryption key varies with the wireless LAN access point and security method. 

 When "WPA Pre-shared key" is displayed 

  Encryption method: WPA/WPA2-PSK or WPA2-PSK 

  Encryption key: Please input the WPA pre-shared key. 

 When "Please set in Web" is displayed 

  Encryption method: WPA/WPA2-EAP or WPA2-EAP 

  * Make settings from the web page of this machine. 

 When "WEP key" is displayed 

  Encryption method: WEP 

  Encryption key: Please input the WEP key. 

 In other cases 

  Encryption method: Disable 

  No need to input the encryption key. 
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9 "Implementing this method?" is displayed, and the SSID selected in Step 7 from the 

confirmation screen and the encryption method input in Step 8 are displayed as the security 

method. If the SSID is the same as the one recorded in Step 1, press «OK». 

 

10 When "Connection successful." is displayed, the connection to the wireless LAN access point is 

completed. 

 

Go to "6. Checking the connection from a PC". 

 
 When "Not connected to wireless access point" is displayed, repeat the procedure from Step 4, or try 

"Connecting by setting manually from the operator panel". 

 

Connecting by setting manually from the operator panel 

Set the wireless LAN access point information (SSID, encryption method, encrypted key) manually, and 

connect to the wireless LAN. 

1 Check and take a note of the SSID and encryption key on the wireless LAN access point or in 

the enclosed User's Manual. 

 
 WPA-EAP and WPA2-EAP cannot be set from the operator panel. Set them from the web page of this machine. 

 Opening the web page  

 
 SSID is also called the network name, ESSID or ESS-ID. 

 Encryption key is also called the network key, security key, password, or pre-shared key (PSK). 

2 Check that the wireless LAN access point is activated and operating properly. 

3 Press the scroll button ▼ on the operator panel several times to select [Wireless(Infrastructure) 

Setting], and press «OK». 

4 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

 
 "It is not possible to use the wireless(AP Mode) at the same time." will be displayed for about 5 seconds. 

5 Press ▼ several times to select [Wireless Network Selection], and press «OK». 
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Start searching for wireless LAN access points. Please wait. 

6 A list of SSID of connectible wireless LAN access points is displayed. Press ▼ several times to 

select [Manual Setup] at the end of the list, and press «OK». 

 

7 Check that [SSID] is selected, and press «OK». 

 

8 Input the SSID recorded in Step 1, and press «OK». 

 

9 Press ▼ to select [Security], and press «OK». 

 

10 Select the encryption method recorded in Step 1, and press «OK». 

 

11 Press ▼ to select [WPA Pre-shared Key], and press «OK». 

 

12 Input the encryption key recorded in Step 1, and press «OK». 
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 The encryption key varies with the wireless LAN access point and security method. 

13 Press ▼ to select [Execute], and press «OK». 

 

14 "Implementing this method?" is displayed, and the SSID selected in Step 8 from the 

confirmation screen and the encryption method input in Step 10 are displayed as the security 

method. If the SSID is the same as the one recorded in Step 1, press «OK». 

 

15 When "Connection successful." is displayed, the connection to the wireless LAN access point is 

completed. 

 

Go to "6. Checking the connection from a PC". 

 
 When "Not connected to wireless access point" is displayed, repeat the procedure from Step 4. 

 If you cannot connect, see "Troubleshooting for wireless LAN connection ". 

 

5. Choosing a valid default gateway 

By default, [Enabling Default Gateway] is set to [Wired(LAN1)]. This machine can use a wired LAN and 

wireless LAN at the same time, but only either of them can be used to connect a terminal outside the segment 

(a different subnet). 

When a wireless LAN (infrastructure) is used to communicate across segments, follow the following procedure 

to change into [Wireless(Infrastructure)]. 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 
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2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Check that [Network Setup] is selected, and press «OK». 

 

5 Check that [General Setup] is selected, and press «OK». 

 

6 Press ▼ to select [Enabling Default Gateway], and press «OK». 

 

7 Press ▼ to select [Wireless(Infrastructure)], and press «OK». 

 

8 Press «ON LINE» to return to the standby screen. 

 

 

6. Checking the connection from a PC 

Check the IP address of the device, and access it from a PC by using the Web browser. 
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1 Press the scroll button ▼ on the operator panel several times to select [Configuration], and 

press «OK». 

2 Press «5» on the [Configuration] screen. 

 

3 Press ▼ to select [Wireless(Infrastructure) Information], and press «OK». 

 

4 Press ▼ several times to select [IPv4 Address], and press «OK». 

 

5 Take a note of the displayed IP address. 

6 Start the web browser in a PC. 

7 Input "http:// (The IP address recorded in Step 5)", and press the «Enter» key. 

Connection is successful when the web page of this machine is displayed. 

 

 
 If the web page of this machine is not displayed, the network connection between the PC or other terminals and 

this machine has failed. 

Check that [IP Address Set], [IPv4 Address], [Subnet Mask], [Gateway Address] and [Enabling Default 

Gateway] have been set correctly for this machine. 

 

Then, go to "Installing software on a PC ". 

When using a mobile device, go to "Printing from a mobile device ". 

Connecting directly with this machine (AP mode) 

 
 It may be difficult to connect if there is a metal, aluminum sash or reinforced concrete wall between this machine and 

the wireless terminal. 

 Up to 4 terminals can be connected to this machine wirelessly (AP mode). You cannot connect 5 or more terminals. 
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1. Enabling the wireless LAN function 

1 Power on this machine. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Check that [Network Setup] is selected, and press «OK». 

 

5 Check that [General Setup] is selected, and press «OK». 

 

6 Check that [Extended Network] is selected, and press «OK». 

 

7 Press ▼ to select [Wireless], and press «OK». 

 

8 When [Are You Sure?] is displayed, check that [Yes] is selected, and press «OK». 

 

9 Wait until the standby screen appears as this machine restarts. 

 

2. Enabling the AP mode 
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1 Press the scroll button ▼ on the operator panel several times to select [Wireless(AP Mode) 

Setting], and press «OK». 

2 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

3 Check that [Wireless(AP Mode)] is selected, and press «OK». 

 

 
 "Cannot be used simultaneously with wireless(infrastructure)." will be displayed for about 5 seconds. 

4 Press ▲ to select [Enable], and press «OK». 

 

 
 After setting Wireless(Infrastructure) to [Disable], if a screen appears to ask you to check whether to enable 

wireless (AP mode), press «OK» to enable wireless (AP mode). 

5 Press «ON LINE» to return to the standby screen. 

 

 

3. Connecting with a device 

There are two ways as follows. 

 

 Connecting automatically(Push button) 

 Connecting manually 

 

Connecting automatically (Push button) 

If the wireless terminal supports WPS-PBC (push button), you can connect it to this machine using the WPS 

button. 

1 Check the position of the WPS button in the User's Manual enclosed with the wireless terminal. 

2 Press the scroll button ▼ on the operator panel several times to select [Wireless(AP Mode) 

Setting], and press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

 
 "Cannot be used simultaneously with wireless(infrastructure)." will be displayed for about 5 seconds. 
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4 Press ▲ to select [Enable], and press «OK». 

 

5 Press ▼ to select [Automatic Setup (PushButton)] , and press «OK». 

 

6 When "Implementing this method? Pushbutton method" is displayed, check that [Yes] is 

selected, and press «OK». 

 

"Running pushbutton method" is displayed, and this machine will start to search for a wireless LAN 

access point. 

 

7 Start WPS-PBC (push button) on the wireless terminal. 

 
 "Running pushbutton method" is displayed for about 2 minutes. Start the push button on the wireless terminal 

while it is displayed. 

 While "Running pushbutton method" is displayed, the operator panel of this machine is disabled. 

8 When "Connection successful." is displayed, the connection is completed. 

 

 
 If the connection fails, follow the procedure in "Connecting manually" to connect again. 

Then, go to "Installing software on a PC ". 

When using a mobile device, go to "Printing from a mobile device ". 

 

Connecting manually 

If the wireless terminal does not support WPS-PBC (push button), input the SSID and password of this 

machine in the wireless terminal to connect. 
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1 Press the scroll button ▼ on the operator panel several times to select [Wireless(AP Mode) 

Setting], and press «OK». 

2 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

 
 "Cannot be used simultaneously with wireless(infrastructure)." will be displayed for about 5 seconds. 

3 Press ▲ to select [Enable], and press «OK». 

 

4 Press ▼ several times to select [Manual Setup], and press «OK». 

 

5 Check that [SSID] and [Password] of this machine are displayed. 

 
 The screens shown here are examples, and they may differ from the actual display. 

 

6 Input [SSID] and [Password] of this machine confirmed in Step 5 in the wireless terminal to 

connect. 

 
 If the wireless terminal is set to obtain the IP address automatically, you can communicate by connecting to this 

machine in the AP mode and allocating the IPv4 address automatically to the mobile terminal. 

 The factory default IP address is [192.168.110.100]. 

 If you cannot connect, see "Troubleshooting for wireless LAN connection ". 

 

Then, go to "Installing software on a PC ". 

When using a mobile device, go to "Printing from a mobile device ". 
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Connecting via USB 

Connect this machine and a PC with a USB cable to print. 

1 Prepare a USB 2.0 cable. 

 
 Not compatible with USB 3.0. 

 The connector shape on the machine side is of type B. 

 

 
 To connect in the USB 2.0 hi-speed mode, use a USB cable compliant with USB 2.0 hi-speed specifications. 

2 Power off this machine. 

3 Plug one end of the USB cable into the USB interface connector of this machine. 

 
 Do not insert the USB cable into the network interface connector. Doing so may cause a malfunction. 

 

4 Plug the other end of the USB cable into the USB interface connector of the PC. 

 

Proceed to "Installing software on a PC ". 
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Installing software on a PC 

If your PC comes with a DVD drive, install the printer driver and other software on the PC from the provided 

DVD. 

If your PC does not come with a DVD drive, or if you want to update the printer driver or any other software, 

download and install it from the website. 

Operating environment 

 Windows 10 

 Windows 8.1 

 Windows 8 

 Windows 7 

 Windows Server 2019 

 Windows Server 2016 

 Windows Server 2012 R2 

 Windows Server 2012 

 Windows Server 2008 R2 

 Windows Server 2008 

 macOS 10.15 - 10.12, OS X 10.11 

 
 The screen display may differ from the description depending on the version of Windows and macOS or the specific 

printer driver. 

Types of printer driver 

There are two types of printer driver, the PCL printer driver and the PS printer driver. For normal printing, use 

the PCL printer driver. The PS printer driver is suitable for printing documents containing the ESP data or the 

PostScript font. 

 Screens and functions of the printer driver  

 
 Only the PS printer driver is applicable to macOS. 

For Windows 

1 Check that this machine and the PC are connected, and that the power supply is on. 

2 Insert the provided DVD to the PC. 

 
 To install the driver from the provided DVD, it is necessary to install and enable .NET Framework 3.5 or above. 
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3 When the [DVD drive] screen is displayed, click [Launch Setup.exe]. 

 

 
 If the [User Account Control] screen is displayed, click [Yes]. 

 If the [DVD drive] screen is not displayed, open DVD from the Explorer. 

4 Choose a language from the pull-down menu of language selection in the [Welcome] screen. 

5 Read the software license agreement, and click [Accept]. 

6 Read the environmental advice, and click [Go]. 

7 Click either [Network Connection] or [USB Connection] depending on the connection method 

between the PC and this machine. 

 

If [Windows Security Alert] screen is displayed, click [Allow Access]. 

8 Select the model name of this machine, and click [Go]. 

 
 If the printer is not displayed with a network connection, input the IP address assigned to the printer by selecting 

[Search Range], and click [Search Again]. 

 



 

- 62 - 

9 Click [Recommended Install]. 

 

Check the software, and click [Start]. 

 

Installation will begin. 

 
 The following software will be installed. 

 PCL6 printer driver (including Network Extension, Color Swatch Utility) 

 FAQs 

 Monitoring Tool 

 Other software is installed from either [Batch Install] or [Individual Install]. 

10 Check that the software installation is complete. 

11 Click [Exit]. 

 

The [Firmware Update] screen is displayed.  
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12 If you do not need to update, click [Go]. 

Click [Confirm] if you do not know or an update is required. 

 

If the following screen appears, click [Yes]. 

 

After the update is completed, click [Go]. 

13 Click [Go]. 

 

If the following screen appears, click [Yes]. 

 

14 Click [Exit]. 

 

 

Now installation is completed. 

If you install options like the expansion tray unit, change the settings of printer driver. 

 Setting the printer driver  

When the Monitoring Tool is displayed, register the installed printer. 

 Monitoring Tool (Windows)  
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For macOS 

1 Check that this machine and the PC are connected, and that the power supply is on. 

2 Insert the included DVD to the PC. 

3 Double-click on the [PRINTRONIX] icon on the desktop. 

4 Double-click on [Drivers] - [PS] - [Installer for OSX]. 

5 Finish the installation by following the on-screen instructions. 

6 Select [System Preferences] from the Apple menu. 

7 Click [Printers and Scanners]. 

8 Click [+], and select [Add Printer or Scanner] when the menu appears. 

 

 
 If you cannot click [+], click the key mark. 

9 Click [Default]. 

10 Select this machine, and select [PRINTRONIX LP654C PS] from [Drivers]. 

Connection Method Listed name Type 

Network PRINTRONIX-LP654C (Last 6 digits of the MAC address) Bonjour 

USB PRINTRONIX LP654C USB 

 
 The MAC address can be checked by pressing the scroll buttons on the operator panel to print the network 

information from [Print Information] - [Network]. 

 To change the name, input a new name to be used in [Name]. 

 

11 Click [Add]. 

 
 If the option confirmation screen appears, click [OK]. 
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12 Make sure that this machine is added to the list of [Printers] and that "PRINTRONIX LP654C   

PS" is displayed in [Type]. 

 

 
 If "PRINTRONIX LP654C PS" is not displayed in [Type] properly, click [-] to delete this machine from [Print], and 

then repeat Steps 8 - 12. 

13 Click [Open the Print Queue]. 

14 Select [Print Test Page] from the [Print] menu. 

Installation is completed when the test page is printed. 

If you install options like the expansion tray unit, change the settings of printer driver. 

 Setting the printer driver  

Setting the printer driver 

If an expansion tray unit has been installed, change the printer driver settings with the following procedure 

after installing the printer driver. 

 Installing software on a PC 

 
 To follow this procedure, it is necessary to log into the computer with administrator privileges. 

 

For Windows PCL printer driver 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the icon of [PRINTRONIX LP654C PCL], and select [Printer Properties]. 

3 Select the [Device Options] tab.  
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4 For a network connection, click [Get Printer Settings]. 

For a USB connection, input the number of trays minus the MP tray in [Installed Paper Trays]. 

For example, if three expansion tray units are mounted, the usable trays are trays 1/2/3/4, so input "4". 

 

5 Click [OK]. 

 

For Windows PS printer driver 

1 Open the "Devices and Printers". 

 How to open the printer folder 

2 Right-click on the icon of [PRINTRONIX LP654C PS], and select [Printer Properties]. 

3 Select the [Device Settings] tab. 

4 For a network connection, select [Get installed options automatically] in [Installable Options], 

and click [Setup]. 

For a USB connection, select the corresponding value in [Available Trays] of [Installable Options]. 

 

5 Click [OK]. 
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For macOS 

 
 Depending on the timing when the printer is added, the information for the expansion tray unit may have been set. 

1 Select [System Preferences] from the Apple menu. 

2 Click [Print & Scan]. 

3 Select this machine, and click [Options and Supplies]. 

4 Select the [Options] tab. 

5 Select the total number of trays from [Available Trays], and click [OK]. 
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Parts identification 

This section explains the name and functions of each part of the main unit. 

Front 

 

 

No. Name Function 

1 Front cover This is the cover on the front side of the main unit. You can 

open the front cover by pulling its lever towards yourself. 

2 Operator panel This is the panel used to operate the main unit. 

It comes with a display, functional buttons, a numeric 

keypad, a Fn key, an attention lamp, etc. 

 Parts identification of the operator panel  
 

3 Output tray (Top cover) This is the output tray on the top of the main unit. You can 

open it by pulling up the open lever inside after opening the 

front cover. 

4 Fuser unit This unit fixes the toner to the paper. 

5 Power switch Turns on/off the power of the main unit. Lights blue when 

the power is turned on, and lights off when the power is 

turned off. 

6 Wireless LAN module cover A cover for the housing of the wireless LAN module. 

7 Air vents Allows air to enter and exit from the inside of the main unit. 

Be careful not to block the air vents. 

8 Front cover lever This is a blue lever to unlock to open the front cover. 

9 Multi Purpose Tray (MP tray) In addition to paper of various sizes, you can also print on 

envelopes. 

10 Tray 1 Load the paper to print on. 

11 Waste toner box cover This is the storage port of the box that holds the waste 

toner. 

12 Paper supporter Load the paper in the MP tray. 

13 Paper placement cover Holds the paper loaded in the MP tray. 
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Inside the main unit 

 

 

No. Name Function 

14 Toner cartridge black (K: Black) The toner cartridge contains toner (powder ink) for printing. 

The toner cartridge is a consumable. 15 Toner cartridge (C: Cyan) 

16 Toner cartridge (M: Magenta) 

17 Toner cartridge (Y: Yellow) 

18 Serial number The machine-specific number. 

19 Lever L2 The lever used to lift up the cover of the output tray. 

20 Lever L1 The lever uses to replace the image drum. 

21 Belt unit The unit to convey the paper. 

22 Handle L3 The handle used to pull out the image drum basket. 

23 Image drum (K: Black) The image drum is a unit to create an image on the paper 

by using toner. 

The image drum is a consumable. 

24 Image drum (C: Cyan) 

25 Image drum (M: Magenta) 

26 Image drum (Y: Yellow) 

27 Image drum basket Holds the image drum. 

28 LED head (x 4) Writes an image onto the image drum using light. 
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Back 

 

 

No. Name Function 

29 Rear output tray This is the paper exit when the paper is output with the print 

side facing up. 

30 Power connector This is where the included power cord is plugged in. 

31 Interface unit There is a connector to connect to a PC. 

32 USB interface connector This is where the USB cable is plugged in when the 

computer and the main unit is connected with a USB cable. 

33 Accessory connector This is a port to which the USB memory is connected. 

34 Network interface connector (LAN1) This is where the LAN cable is plugged in when the 

computer and the main unit is connected via a network. 
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Turning the power on/off 

Turning the power on 

1 Press and hold the power switch for approx. one second. 

 

When the power is on, the LED lamp of the power switch will light on. 

When this machine gets ready, "Ready To Print" will appear on the display. 

Turning the power off 

1 Press and hold the power switch for approx. 1 second. 

"Shutting down. Please wait. The power will turn off automatically" will appear on the display, and the 

LED lamp of the power switch will flash at intervals of approx. 1 second. 

Wait a moment, and this machine will be powered off automatically, and the LED lamp of the power 

switch will turn off. 

 
 If you press and hold the power switch for approx. 1 second while this machine is in the power save mode, the 

power will turn off without displaying anything. 

 Please wait. This may take about 5 minutes to turn off the power. 

 Press and hold the power switch for more than 5 seconds to turn off the power by force. Use only if a problem 

has occurred. For troubles with this machine, refer to “Troubleshooting for the machine ". 
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Loading paper 

This section explains the types of paper applicable to this machine, paper precautions and paper storage 

methods. 

Procedure for loading paper 

1. Check the applicable paper. 

 Applicable paper  

 Inapplicable paper  

 

2. Load the paper in the tray. 

 Paper applicable to each tray  

 Loading paper in Tray 1  

 Loading paper in Tray 2/3/4 (Optional)  

 Loading paper in the MP tray  

 

3. Set the paper information (media size, media type, media weight) on the operator 

panel. 

 Setting paper information on the operator panel  

Applicable paper 

In order to maintain high-quality printing, it is necessary to use paper that fulfills the quality, weight and 

surface finish conditions. Please use electrophotographic paper. 

If you are printing on non-recommended paper, thoroughly test the print quality and paper traction beforehand 

and check that there are no problems before use. 

For precautions for printing on various types of paper, refer to "Paper precautions by type ". 

Media Type Paper size Paper weight Other conditions 

Plain A4 For simplex printing: 

60 - 256 g/m2 

For duplex printing: 

64 - 176 g/m2 

 

The custom-sized paper must meet the 

requirements for plain paper. 

B6 half, B7, B8 and 4 x 6 inches paper 

are not applicable to duplex printing. 

A5 

A6 

B5 

B6 

B6 Half 

B7 

B8 

Letter 

Legal (13 inches) 

Legal (13.5 inches) 

Legal (14 inches) 

Executive 

Statement 

8.5-inch SQ 

Folio (210 x 330 mm) 

16K (184 x 260 mm) 

16K (195 x 270 mm) 

16K (197 x 273 mm) 

4 x 6 inches 

5 x 7 inches 
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Media Type Paper size Paper weight Other conditions 

Long paper 

Custom 

Width: 55 - 216 

Length: 91 - 1321 

Envelope Com-9 Media using 24 lb paper Media made of craft paper, 

electrophotographic paper or dry PPC 

paper. 

Media with the flap folded tightly. 

Duplex printing is not available. 

Com-10 

Monarch 

DL 

C5 

Index Card 3 x 5 inches  Duplex printing is not available. 

Label A4 Total weight: 0.1 - 0.2 

mm 

Labels for electrophotographic printers or 

dry PPCs where the surface paper, 

adhesive, and backing are not degraded 

by heat. 

Media with a structure that prevents the 

front paper from peeling off from the 

backing in the heat fixing process of the 

printer. 

Media with a structure that prevents the 

front paper from peeling off the backing 

when the paper is traveling. 

Media with a combined weight of 0.1 to 

0.2 mm of front paper and backing. 

Media whose surface paper covers the 

entire backing sheet with no adhesive 

sticking out. 

Media with no breaks or creases. 

Duplex printing is not available. 

Letter 

Partially printed 

paper 

Equivalent to plain paper 64 - 256 g/m2 Media that meets the requirements for 

plain paper. 

Media whose ink used for partial printing 

is heat resistant and can withstand 

230°C. 

Colored paper Equivalent to plain paper 64 - 256 g/m2 Media whose pigment or ink used to 

color the paper is heat resistant and can 

withstand 230°C. 

Media made of electrophotographic 

paper with the same features as plain 

paper. 

Long paper Width: 210 mm 

Length: 356 to 1320 mm 

128 g/m2 If the length of the paper exceeds 356 

mm, the width must range from 210 mm 

to 216 mm. 

 
 If the paper grain direction does not match the paper feeding direction, paper jams may occur. 

 Printing from the MP tray may cause wrinkles. In this case, feed paper from the paper cassette. 

 The paper wrapper shows the orientation of the surface. Load paper properly so that the face side is the printing 

side. 

 The paper is wrapped in moisture-proof paper to prevent moisture. Please use the paper as early as possible after 

opening its package. 

 Wrap unused paper in the wrapping paper, and keep it away from moisture absorption as much as possible. 

 If it is used beyond the normal room temperature (temperature: 17°C to 25°C; humidity: 40% to 60%), the printing 

quality may be degraded or problems may occur such as paper jams, wrinkles, curls, and warpage. 
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 Depending on the installation environment of the machine, printing on paper that contains moisture may cause white 

steam or water droplets to appear around the paper exit area of the machine. This is not abnormal because the heat 

generated when the toner is fixed to the paper evaporates the moisture contained in the paper. 

Inapplicable paper 

Do not use the following types of paper. Doing so may cause paper jams or malfunction. 

 Paper with smooth surface, rough paper, and paper with different front and back roughness 

 Paper that is too thin or too thick 

 Paper with much paper dust 

 Short grain paper (Do not use for vertical feeding.) 

 Wet (damp) paper 

 Paper with curl, curve or wave due to humidity 

 Paper stuck by static electricity 

 Paper and envelopes that have been textured, embossed or coated 

 Paper specially processed with glue, chemicals, etc. 

 Paper specially processed without heat resistance (230°C) 

 Paper with holes, perforations, notches, holes for binder 

 Paper that has irregularities, crushing, burrs, etc. on the paper cut surface 

 Non-square shaped paper, or paper whose cutting angle is not right 

 Paper or envelopes with wrinkles, warping, corner bending, waving, creases, tears, etc. 

 Paper with staples, clips, ribbons, tapes, clasps, etc. 

 Special paper such as carbon paper, non-carbon paper, thermal paper, and pressure-sensitive paper 

 Thermal transfer printer paper, ink jet paper, wet PPC paper, copying paper, Japanese paper, etc. 

 Envelopes sticked with stamps 

 Envelopes that are too thick 

 Envelope made of plastic 

 Double envelopes with inner bags 

 Envelopes with clasps, buttons or windows 

 Envelopes sticked with double-sided tape or with adhesive on the flap 

 Envelopes with water repellency 

Paper precautions by type 

Plain 

 The printing speed will be slowed when the paper size is set to [A6] or [A5] (lengthwise direction) or when 

the paper width is set to 182 mm or less. 

 For thick paper, the toner may stick thinly to the whole paper or the printing may be light. 

Partially printed paper 

 When a printing frame is set, design it with careful considerations of the following variations in the printing 

position. 

Output position accuracy: ±2 mm; paper slant: ±1 mm/100 mm; image expansion and contraction: ±1 

mm/100 mm (When GSM paper weight is 80 g/m 2) 

 This machine cannot print over a printed area. 
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Envelope 

 The paper may warp or wrinkle after printing. 

 The toner may stick thinly to the whole paper or the printing may be light. 

 The toner may be easily removed. 

 The printing quality may decline in an area of about 5 mm around the sealing part (of different weights) of 

the envelope. 

 The warps on an envelope may cause poor paper feeding. Use the envelope after correcting warps or 

bulges. 

 If the glued part at the rear edge of the envelope is bent, it may cause poor paper feeding. Correct the 

bending before use. 

 Duplex printing is not available. 

 Always perform trial printing and check that there are no problems. 

Label 

 The toner may stick thinly to the whole paper or the printing may be light. 

 The toner may be easily removed. 

 The warps on the front edge of a label may cause poor paper feeding. Use labels after correcting warps 

or bulges. 

 Duplex printing is not available. 

 Always perform trial printing and check that there are no problems. 

Long paper 

 For thick paper, the toner may stick thinly to the whole paper or the printing may be light. 

 If the paper grain direction does not match the paper feeding direction, paper jams may occur. 

 Do not use paper that has been printed once with a thermal transfer printer, inkjet printer, etc. 

 The paper wrapper shows the orientation of the surface. Load paper properly so that the face side is the 

printing side. 

 The paper is wrapped in moisture-proof paper to prevent moisture. Please use the paper as early as 

possible after opening its package. 

 If the paper has a GSM weight other than 128 g/m2, the print quality may deteriorate. Always perform trial 

printing and check that there are no problems. 

 Be sure to set the paper size to portrait length. The portrait length cannot be set to a value shorter than 

the landscape length. 

 Some applications may not be available. 

 Even when using under the recommended conditions, the long paper with a length exceeding 356 mm 

may not be able to guarantee the print quality. 

Irregular-sized paper (custom size) 

 Skewing, curling, warping, folded corners (the edge is folded) and paper jams caused by these factors 

may occur. Check the print result of the paper to be used in advance. 

 Register the paper in portrait orientation and load it in portrait orientation in the tray. 

 If the length exceeds 356 mm, use the rear output tray. 

 Some applications may not be available. 

 The quality of printing on the paper with a length exceeding 356 mm will be not guaranteed. 

 If the paper is too long and protrudes from the paper supporter of the MP tray, support the paper with 

your hand. 
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 For the paper size that can be fed from each tray and the paper size that can be printed on both sides, 

please refer to "Applicable paper ". 

 If you cannot print correctly on a large-sized paper, it is suggested to set [Quality] to [Normal] in the PS 

printer driver. 

 Always perform trial printing and check that there are no problems. 

Recycled 

 The toner may stick thinly to the whole paper or the printing may be light. 

 Some recycled paper contains additives that may reduce the printing quality. Be sure to check that it is 

the recycled paper for the electrophotographic printer before using it. 

Paper applicable to each tray 

Tray 1 

Media type Media size Media weight 
Applicable 
number of 

sheets 

Plain 

Partially printed 

paper 

Colored paper 

A4, A5, A6, B5, B6, Letter, Legal (13 inches), Legal (13.5 inches), 

Legal (14 inches), Executive, Statement, 8.5-inch SQ (8.5 x 8.5 

inches), Folio (210 x 330 mm), 16K (184 x 260 mm), 16K (195 

mm x 270 mm), 16K (197 x 273 mm), 5 x 7 inches, custom size 

(width: 100 - 216 mm; length: 148 - 356 mm) 

60～256 g/m2 250 (When the 

paper weight is 

80 g/m2) 

Tray 2/3/4 (Optional) 

Media type Media size Media weight 
Applicable 
number of 

sheets 

Plain 

Partially printed 

paper 

Colored paper 

A4, A5, A6, B5, B6, Letter, Legal (13 inches), Legal (13.5 inches), 

Legal (14 inches), Executive, Statement, 8.5-inch SQ (8.5 x 8.5 

inches), Folio (210 x 330 mm), 16K (184 x 260 mm), 16K (195 

mm x 270 mm), 16K (197 x 273 mm), 5 x 7 inches, custom size 

(width: 105 - 216 mm; length: 148 - 356 mm) 

64～176 g/m2 530 (When the 

paper weight is 

80 g/m2) 

MP tray 

Media type Media size Media weight 
Applicable 
number of 

sheets 

Plain 

Envelope 

Label 

Index Card 

Partially printed 

paper 

Color paper 

A4, A5, A6, B5, B6, B6 Half, B7, B8, Letter, Legal (13 inches), 

Legal (13.5 inches), Legal (14 inches), Executive, Statement, 8.5-

inch SQ (8.5 x 8.5 inches), Folio (210 x 330 mm), 16K (184 x 260 

mm), 16K (195 mm x 270 mm), 16K (197 x 273 mm), 4 x 6 

inches, 5 x 7 inches, Com-9, Com-10, Monarch, DL, C5, custom 

size (width: 55 - 216 mm; length: 91 - 1,321 mm) 

60～256 g/m2 100 (When the 

paper weight is 

80 g/m2) 

10 (When the 

envelope weight 

is 80g/m2) 

Loading paper in Tray 1 

For the paper that can be used, please see "Applicable paper ","Paper applicable to each tray ". 

 
 You can load the A5-sized paper in either portrait or landscape. 
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1 Pull out the paper cassette. 

 

 
 If you pull out the paper cassette with the power on, "Change tray settings?" may appear on the display. This 

message will disappear automatically in 10 seconds after the paper cassette is returned to the main unit. 

If you have changed the paper, press the «OK» button and change the settings of paper size, media type and 

media weight accordingly. 

 Be cautious for the orientation of paper that can be loaded in either portrait or landscape, like A5 size. 

2 Slide the paper guide and the blue part of the paper stopper to fit the size of the paper to be 

loaded. 

 

3 Shuffle the paper well. Align edges of the paper horizontally. 

 

4 Load the paper with the printing side down, and press it down from top. 

 
 Do not exceed the ▽ mark on the paper guide when loading paper. 

  



 

- 79 - 

5 Return the paper cassette to this machine. 

 
 If the paper cassette is returned to the main unit forcefully, the paper stopper may slide. 

 

6 Proceed to "Setting paper information on the operator panel ". 

Loading paper in Tray 2/3/4 (Optional) 

For the paper that can be used, please see "Applicable paper " ,"Paper applicable to each tray ". 

 
 You can load the A5-sized paper in either portrait or landscape. 

 

1 Pull out the paper cassette. 

 

2 Set the paper size dial to fit the paper size. 

 

 
 Set it to [OTHER] when you have loaded the paper of a standard size not available on the paper size dial. 

 
 If you pull out the paper cassette with the power on, "Change tray setting?" may appear on the display. This 

message will disappear automatically in 10 seconds after the paper cassette is returned to the main unit. 

If you have changed the paper, press [Yes] and change the settings of paper size, media type and media 

weight accordingly. Also, change the setting of the paper size dial of the tray. 

 Make sure that the setting of the paper size dial matches the size of paper to be loaded. If they do not match, a 

paper size error will occur, and you will be unable to print. 
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 Be cautious for the orientation of paper that can be loaded in either portrait or landscape, like A5 size. 

3 Slide the paper guide and the blue part of the paper stopper to fit the size of the paper to be 

loaded. 

 

4 Shuffle the paper well. Align edges of the paper horizontally. 

 

5 Load the paper with the printing side down, and press it down from top. 

 
 Do not exceed the ▽ mark on the paper guide when loading paper. 

 

6 Check that the size and orientation of the loaded paper well match the settings of the paper size 

dial. 

 
 If the size and the orientation of the loaded paper do not match the settings of the paper size dial, a paper size 

error may occur during printing and you may not be able to print. 

7 Return the paper cassette to this machine. 

 
 If the paper cassette is returned to the main unit forcefully, the paper stopper may slide. 

 

8 Proceed to "Setting paper information on the operator panel ". 
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Loading paper in the MP tray 

For the paper that can be used, please see "Applicable paper " and "Paper applicable to each tray ". 

 
 Do not load paper of different sizes, types, and weight at the same time. 

 When adding paper, remove the paper in the MP tray, align edges of the paper and the paper to be added, and then 

load them together. 

 Do not insert anything other than print paper into the MP tray. 

 Do not leave paper in the MP tray for an extended period of time. Dust and dirt will adhere to the paper, and the print 

quality will degrade. 

 
 You can load the A5-sized paper in either portrait or landscape. 

 

1 Place your fingers in the front recess and pull to open the MP tray towards you. 

 

2 Hold the center of the paper supporter and pull it out towards you. 

 

3 Open the auxiliary supporter. 

 

4 Move the paper placement cover upward. 
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5 Adjust the manual feeder guide to the width of the paper to be loaded. 

 

6 Shuffle the paper well. Align edges of the paper horizontally. 

 

7 Load the paper with the print side facing up. 

 
 Do not exceed the ▽ mark on the paper guide when loading paper. 

 

 "Would you like to change the tray settings?” may appear on the display. This message will disappear 

automatically after 10 seconds. If you have changed the paper, press «OK» and change the settings of paper 

size, media type and media weight accordingly. 

8 Move the paper placement cover downward. 

 
 The paper cannot be fed without lowering the paper placement cover. 

 

If you always print on paper of the same size and type from the MP tray, register the loaded paper in this 

machine. 

Proceed to "Setting paper information on the operator panel ". 

Setting paper information on the operator panel 

Set the size, type and weight of the paper loaded in each tray in order. 

When envelopes are loaded, see "Printing on envelopes ". 

When labels are loaded, see "Printing on labels ". 

When long paper is loaded, see "Printing on long paper ". 

When irregular-sized paper is loaded, see "Printing on irregular-sized paper (custom size) ". 
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 If the machine is in the power save mode, press «POWER SAVE» to restore. 

 For details about the short cut menu, see "Setting with the short menu (Fn key) ". 

 

For Tray 1/the MP tray 

1 Check that "Ready To Print" appears on the display. 

2 To set the paper size of Tray 1, press the keys in the following order: «Fn» → «1» → «0» → 

«OK». 

To set the paper size of the MP tray, press the keys in the following order: «Fn» → «9» → «0» → «OK». 

3 Press the scroll button ▲ or ▼ to select the paper size to set, and press «OK» and then 

«BACK». 

4 Press «2» to display [Media Type], press ▲ or ▼ to select the paper type to set, and press 

«OK» and then «BACK». 

5 Press «3» to display [Media Weight], press ▲ or ▼ to select the paper type to set, and press 

«OK» and then «BACK». 

6 Press «ON LINE» to return to the standby screen. 

 

For Tray 2/3/4 

1 Check that "Ready To Print" appears on the display. 

2 To set the paper size of Tray 2, press the keys in the following order: «Fn» → «2» → «0» → 

«OK». 

To set the paper size of Tray 3, press the keys in the following order: «Fn» → «3» → «0» → «OK». 

To set the paper size of Tray 4, press the keys in the following order: «Fn» → «4» → «0» → «OK». 

3 Press ▲ or ▼ to select [Cassette Size], and press «OK» and then «BACK». 

4 If the paper size dial of the tray is set to any other option than [OTHER], proceed to Step 5. 

If [OTHER] is set, press «4» to display [Other Size]. Press ▲ or ▼ to select the paper size to set, and 

press «OK» and then «BACK». 

5 Press «2» to display [Media Type]. Press ▲ or ▼ to select the paper type to set, and press 

«OK» and then «BACK». 

6 Press «3» to display [Media Weight]. Press ▲ or ▼ to select the paper type to set, and press 

«OK» and then «BACK». 

7 Press «ON LINE» to return to the standby screen. 
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About values to be set 

Refer to the following table for settings in the case of plain, partially printed paper and colored paper. 

Values to be set on the operator panel 

Media type Media weight 

Plain 60 - 63 g/m2 paper: Ultra Light 

64 - 74 g/m2 paper:Light 

75 - 82 g/m2 paper: Medium Light 

83 - 90 g/m2 paper: Medium 

91 - 104 g/m2 paper: Medium Heavy 

105 - 120 g/m2 paper: Heavy 

121 - 176 g/m2 paper: Ultra Heavy 1 

177 - 220 g/m2 paper: Ultra Heavy 2 

221 - 256 g/m2 paper: Ultra Heavy 3 

 

Refer to the following table for settings in the case of index cards. 

Values to be set on the operator panel 

Paper size Media weight 

Index Card 60 - 63 g/m2 : Ultra Light 

64 - 74 g/m2 : Light 

75 - 82 g/m2 : Medium Light 

83 - 90 g/m2 : Medium 

91 - 104 g/m2 : Medium Heavy 

105 - 120 g/m2 : Heavy 

121 - 176 g/m2 : Ultra Heavy 1 

177 - 220 g/m2 : Ultra Heavy 2 

221 - 256 g/m2 : Ultra Heavy 3 

Storing paper 

Please keep the paper under the following conditions to maintain the quality. 

 A dark and flat place with low humidity 

 Temperature: 20°C 

 Humidity: 50% RH (relative humidity) 

Do not store in any of the following places. 

 Places exposed to direct sunlight 

 Places with extreme rises and sudden fluctuations in temperature 

 Places near copiers, air conditioners, heaters, ducts, etc. 

 Places near the inside of an outer wall 

 Uneven or curved surfaces 

 Directly on the floor 

 Places where static electricity is generated 

 
 Do not open the paper until you use it. 

 Do not leave the paper exposed to the air for a long period of time. You may not be able to print correctly. 

 Depending on the paper in use, operating conditions and storage conditions, the print quality may deteriorate, or the 

paper may be curled or wrinkled. 
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Setting the output bin 

This machine outputs paper to the output tray or rear output tray. The following types of paper can be output 

to each output tray. 

Output bin Types of paper to output Number of sheets to output 

Output tray Plain, recycled paper 150 (80 g/m2) 

Rear output tray Plain, recycled paper, envelope, Index Card, 

labels, long paper 

100 (80g/m2) 

10 (envelopes/card stocks) 

 
 Do not open or close the output tray during printing. Doing so may cause a paper jam. 

Output tray 

The paper is output with the printing side down in the order in which they are printed. 

 

 
 Check that the rear output tray at the back of this machine is closed. When the rear output tray is open, paper will 

always be output to the rear output tray. 

 

When the printed paper does not stack well, lift the paper supporter. There are two paper supporters, but only 

either of them is used according to your environment. 

 When lifting the paper supporter on the front side 

 

 When lifting the paper supporter on the back side 
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Rear output tray 

Use the rear output tray to print on envelopes, labels or custom-sized paper. 

The paper is output with the printing side up in the reverse order to which they are printed. 

 

1 Open the rear output tray at the back of this machine. 

 

2 Open the paper supporter. 

 

3 Pull out the auxiliary supporter. 
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Checking the configuration 

You can print out and check the configuration of this machine. You can also check the configuration from the 

operator panel. 

Printing the menu map (configuration) 

You can print the list of configurations (menu map) of this machine or the Printer Usage Report. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

 

3 On the function number screen, press «1», «0», «0» and finally «OK». 

 

4 Make sure that [Configuration] is displayed and [Execute] is selected, and press «OK». 

 

5 The configuration is printed . 

 

How to read the configuration 

 

A Displays the options that have been installed. 

B Displays the function number. 

 Setting with the short menu (Fn key)  
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 For the information not listed in [Configuration], see "Menu list " - [Print Information]. 

Confirming on the operator panel 

You can check the supplies status and counter information on the operator panel. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Configuration], and 

press «OK». 

3 Select the item that you want to check, and press «OK». 

4 Select the information that you want to check, and press «OK». 

5 After confirming the content, press «ON LINE» to return to the standby screen. 
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How to use levers L1 and L2 

When the front cover is open, you will find the L1 lever and the L2 lever. This section describe how to use 

these levers. 

 

 

Lever L1 

Used to replace the image drum and to clean the LED head. 

 Replacing the image drum  

 Cleaning the LED head  

After opening the front cover, operate the L1 lever first and then the L2 lever. 

After the operation, only the output tray is raised. 

 

No. Name 

1 Output tray 

2 Image drum basket 

When closing, close the output tray first. Then, press the L1 lever, and close the front cover with your both 

hands firmly.  
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Lever L2 

Used to replace the belt unit and to remove the jammed paper. 

 Replacing the belt unit  

 When paper is jammed  

After opening the front cover, pull the L2 lever. 

After the operation, both the output tray and the image drum basket are integrated and raised. 

 

No. Name 

1 Output tray 

2 Image drum basket 

When closing, close the output tray first, and then close the front cover with your both hands firmly. 
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Parts identification of the operator panel 

 

No. Name Function 

1 Display Displays the state of this machine and operation instructions. 

There are two types of standby screens: "Show Remaining Toner" and 

"Show Tray Information". 

The factory default setting is "Show Remaining Toner". 

2 «ON LINE» button Switches between online and offline. 

Lights green when online, and goes off when offline. 

3 «CANCEL» button Cancels the current printing. Goes back to the standby screen when the 

menu is displayed. 

4 «OK» button Confirms the highlighted item. 

5 Scrolls buttons ▲▼  Used to select a menu or scroll the screen display.It can be used to 

input numbers in the numerical input screen. 

6 «BACK» button Goes back to the previous screen. 

7 «HELP» button Displays the help screen. To close the screen, press the «HELP» 

button again, or press the «BACK» or «CANCEL» button. 

8 «POWER SAVE» button Turns on or off the power save mode. 

Cancels the sleep mode. 

Lights green in the power save mode, and flashes green in the sleep 

mode. 

9 Numeric keypad Inputs alphanumeric characters or symbols. 

10 «Fn» key Used to display the short cut menu. 

Fn: The abbreviation for "Function". 

11 «CLEAR» key Long or short press the key to perform the following actions according 

to the item to input. 

 Minimizes the settings. 

 Inputs 0 for the settings. 

 Deletes one character of the input text. 

 Deletes the selected item. 

* Disabled when the IP address is input. 

12 ATTENTION lamp Indicates the state of this machine. 

Lights off in the normal state. 

On:Indicates that a minor error has occurred. 

Blinking:Indicates that a major error has occurred. 

13 NFC mark When using the NFC function, bring your mobile device close here. For 

details about the NFC function, see "Printing from a mobile device ". 

14 Power switch Turns on/off the power of this machine. Lights blue when the power is 

turned on, and lights off when the power is turned off. 
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Adjusting the display orientation 

You can adjust the angle so that it is easier to watch the display. 

 

1 Put your finger in the recess on the left side of the display, and raise the display towards you. 

 

To return to the original angle, press it gently. 
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Inputting text 

You can input alphabetic or numeric characters using the numeric keypad. If a same key is pressed in 

succession, the alphanumeric character will switch. To continue tying with the same key, press «OK» after 

inputting each alphanumeric character. 

The following characters can be input when the corresponding key is pressed. 

For a menu that can only input numbers, it will not switch to alphabetic characters. 

Key Text to input 

«1» 1 → 1 

«2» 2 → a → b → c → A → B → C → 2 

«3» 3 → d → e → f → D → E → F → 3 

«4» 4 → g → h → i → G → H → I → 4 

«5» 5 → j → k → l → J → K → L → 5 

«6» 6 → m → n → o → M → N → O → 6 

«7» 7 → p → q → r → s → P → Q → R → S → 7 

«8» 8 → t → u → v → T → U → V → 8 

«9» 9 → w → x → y → z → W → X → Y → Z → 9 

«0» 0 → ( space ) → 0 

« » 

«Fn» 

 

* → @ → . → _ → - → (space) → + → ! → ” → $ → % → & → ’ → (→ ) → , → / → : → ; → < → = → > → ? 

→ [ → → ] → ^ → # → ` → { → │→ } → ~ → *  

 
 If the setting value contains [+] and [-], you can switch between [+] and [-] by pressing it while you are 

inputting. 

Example 

To input "abc", 

press «2» «2» «OK», «2» «2» «2» «OK», and «2» «2» «2»«2» «OK». 

 

The functions of the following keys are described below. 

«Fn» 

Used to quickly display items of the Setting menu. When "Ready To Print" is displayed, press «Fn» and then 

the numeric key to display the menu item corresponding to the number. 

 Setting with the short menu (Fn key)  

«CLEAR» 

Deletes each character individually when a password is input. 



 

- 95 - 

Changing settings 

Setting menu display 

This section describes how to change menu settings from the operator panel. 

 
 See "Menu list " for a list of menu items. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▲ or ▼ on the operator panel several times to select the category of the 

item to be set, and press «OK». Repeat until you see the category of the item to be set. 

The display color of the selected item is highlighted. 

 

3 Press ▲ or ▼ several times to select the item to be set, and then press «OK». 

 

4 Use ▲/▼ or the numeric keypad to display the value to be set, and press «OK». A check mark 

appears to the left of the set value. 

 

5 Press «ON LINE» to return to the standby screen. 

 

Setting with the short menu (Fn key) 

When "Ready To Print" is displayed, press the «Fn» key on the operator panel, and then press any number to 

display the relevant menu item. 

 
 For the number corresponding to the menu item, refer to "Function Number List". 
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 You can print to check the configuration. 

 Printing the menu map (configuration)  

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

 

3 Since it will be a function number screen, input the number of the menu you want to display 

using the numeric keypad, and press «OK». 

 

4 When the menu is displayed, check or change the settings. 

 

 

Function Number List 

Function No. Corresponding menu item 

1 Shared Print (Stored Job) 

2 Private Print (Encrypted Job) 

10 Media Size (Tray 1) 

11 X Dimension (Tray 1) 

12 Y Dimension (Tray 1) 

13 Media Type (Tray 1) 

14 Media Weight (Tray 1) 

20 Media Size (Tray 2) 

21 X Dimension (Tray 2) 

22 Y Dimension (Tray 2) 

23 Media Type (Tray 2) 

24 Media Weight (Tray 2) 

30 Media Size (Tray 3) 

31 X Dimension (Tray 3) 

32 Y Dimension (Tray 3) 

33 Media Type (Tray 3) 

34 Media Weight (Tray 3) 

40 Media Size (Tray 4) 

41 X Dimension (Tray 4) 

42 Y Dimension (Tray 4) 
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Function No. Corresponding menu item 

43 Media Type (Tray 4) 

44 Media Weight (Tray 4) 

80 Paper Tray 

90 Media Size (MP tray) 

91 X Dimension (MP tray) 

92 Y Dimension (MP tray) 

93 Media Type (MP tray) 

94 Media Weight (MP tray) 

95 Tray Usage (MP tray) 

100 Print Information (Menu Map (Configurations)) 

101 Print Information (Network) 

102 Print Information (Printer Usage Report) 

103 Print Information (Error Log) 

200 Power Save Time 

201 Sleep Time 

202 Auto Power Off Time 

210 Error Report 

220 Print Position Adjust (MP tray) 

221 Print Position Adjust (Tray 1) 

222 Print Position Adjust (Tray 2) 

223 Print Position Adjust (Tray 3) 

224 Print Position Adjust (Tray 4) 

230 Paper Black Setting 

231 Paper Color Setting 

232 Trans. Black Setting 

233 Trans. Color Setting 

234 SMR Setting 

235 BG Setting 

236 Drum Cleaning 

237 Hex Dump 

300 Adjust Density 

301 Adjust Registration 

302 Print Color Tuning Pattern 

310 Cyan Density 

311 Magenta Density 

312 Yellow Density 

313 Black Density 

 
 If the function number of an optional part that is not installed is specified, [Invalid Number] is displayed. 

 
 For a list of menu items, see "Menu list ". 
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Adjusting the buzzer volume 

The volume of the following buzzers is adjustable in three steps. 

 Paper jam buzzer 

 Printing completion buzzer 

 Buzzer for AirPrint printing 

 IC Card hold buzzer 

 

1 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

2 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

3 Press ▼ or ▲ several times to select [Buzzer Setup], and press «OK». 

4 Press▼ or ▲ several times to select the item to change, and press «OK». 

5 Adjust the volume of the selected item, and press «OK». 

6 Press «ON LINE» to return to the standby screen. 
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Setting the power save function 

Setting the time that elapses before entering the power save mode 

This machine automatically enters the power save mode (an energy saving mode) if no operation is done for a 

certain period of time. 

The following time can be set. The factory default setting is 1 minutes. 

1 min, 2 mins, 3 mins, 4 mins, 5 mins, 10 mins, 15 mins, 30 mins, and 60 mins 

 
 This machine may not enter the power save mode after the set period of time since the fan is working until this 

machine has cooled down depending on the printing environment or the usage conditions. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

 

3 Input «2», «0» and «0» using the numeric keypad, and press «OK». 

 

4 Press the scroll button ▲ or ▼ to select the time to set, and press «OK». 

 

5 Press «ON LINE» to return to the standby screen. 

 

Setting the time that elapses before entering the sleep mode 

This machine automatically enters the sleep mode (a more energy saving mode) if no operation is done for a 

certain period of time in the power save mode. 

The following time can be set. The factory default setting is 15 minutes. 

1 min, 2 mins, 3 mins, 4 mins, 5 mins, 10 mins, 15 mins, 30 mins, and 60 mins 
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 This machine may not enter the sleep mode after the set period of time since the fan is working until this machine 

has cooled down depending on the printing environment or the usage conditions. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

 

3 Input «2», «0» and «1» using the numeric keypad, and press «OK». 

 

4 Press the scroll button ▲ or ▼ to select the time to set, and press «OK». 

 

5 Press «ON LINE» to return to the standby screen. 

 

Restrictions of the power save function 

The sleep mode will not be entered in the following cases. 

 When an error has occurred to this machine 

 When access control is enabled for the access control settings, and local IC card authentication or LDAP 

IC card authentication is enabled for the authentication method 

Turning off the power automatically (Auto Power Off) 

This machine comes with a function (Auto Power Off) to turn off the power automatically if it has not been 

used for a certain period of time. 

There are 3 types of settings for Auto Power Off, and the default factory setting is [Auto Config].  
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 [Auto Config]: The power is turned off automatically if the machine has not been used for a certain period 

of time, except in the following situations. 

 When the LAN cable is connected to the network interface connector 

 When the wireless LAN is enabled 

 [Enable]: The power is automatically turned off if this machine has not been used for a certain period of 

time. 

 [Disable]: Disables the Auto Power Off function. The power does not turn off automatically. 

 
 Auto Power Off does not work in the following cases. 

 With the factory default settings, Auto Power Off does not work when a network (wired/wireless) is connected. 

 When an error has occurred 

 

Follow the procedure below to change the Auto Power Off setting. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Press ▼ several times to select [Power Setup], and press «OK». 

 

5 When [Auto Power Off] is displayed, press «OK». 

 

6 Press ▲ or ▼ to select [Auto Config], [Enable] or [Disable], and press «OK». 

 

7 Press «ON LINE» to return to the standby screen. 
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Setting the time that elapses before entering the auto power off mode 

The following time can be set. The factory default setting is 4 hours. 

1 hour, 2 hours, 3 hours, 4 hours, 8 hours, 12 hours, 18 hours, and 24 hours 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

 

3 Input «2», «0» and «2» using the numeric keypad, and press «OK». 

 

4 Press the scroll button ▲ or ▼ to select the time to set, and press «OK». 

 

5 Press «ON LINE» to return to the standby screen. 
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Menu list 

You can print to check the menu list. 

 Printing the menu map (configuration)  

 
 The following items are displayed when the wireless LAN module (optional) is installed. 

 AirPrint 

 Wireless(Infrastructure) Setting 

 Wireless(AP Mode) Setting 

Print From USB Memory 

Item 
Factory 
default 

settings 
Description 

Select Print 

File 

  Select the file to be printed. 

Print Setup Paper Feed Tray 1 (xx) Specifies the paper feeding tray. 

(xx) is the size of the paper loaded in this tray. 

Copies 1 Sets the number of copies to be printed. 

Duplex On or Off *1 Sets whether or not to implement duplex printing. 

Binding Long Edge  Sets the binding method for duplex printing. 

Fit On Specifies whether to fit to the paper. 

Color Mode Color Selects whether to print in color or mono. 

Barcode Print 

Setup 

Repeat 1 Sets the number of copies to be printed. 

Layout Rows 1 Sets the number of rows on each page. 

Layout Columns 1 Sets the number of columns on each page. 

Start Position X Coordinate 5 millimeter Sets the X coordinate of the start position (i.e. the direction 

perpendicular to the paper travel direction). 

Y Coordinate 30 millimeter Sets the Y coordinate of the start position (i.e. the direction 

parallel to the paper travel direction). 

Spacing X Spacing 5 millimeter Sets the X spacing of the scheduled printing range of 

barcodes. 

Y Spacing 5 millimeter Sets the Y spacing of the scheduled printing range of 

barcodes. 

Barcode Type QRCode Sets the type of barcodes. 

Barcode 

Attribute 

Error 

Correction 

Level 

Low Sets the error correction level of QRCode. 

Module Size 10 x 1.7 mils Sets the module size of QRCode. 

Human 

Readable 

Character  

None Sets the attributes of 1D barcodes. 

Bar Height  29 pixels Sets the bar height. 

Bar Width 8 x 1.7 mils Sets the bar width. 

*1 Factory default setting values are different according to the country or region. 
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Configuration 

Item Description 

Tray Count MPTray Displays the total number of print pages for 

each tray. 

Trays 2 to 4 are displayed when optional 

expansion trays are mounted. 

Tray1 

Tray2 

Tray3 

Tray4 

Paper Feed Roller Counter MPTray Displays the number of sheets fed from each 

tray. 

Trays 2 to 4 are displayed when optional 

expansion trays are mounted. 

Tray1 

Tray2 

Tray3 

Tray4 

A4/Letter Impressions Count Color Displays the number of color printing sheets 

converted to A4/Letter paper. 

Mono Displays the number of mono printing sheets 

converted to A4/Letter paper. 

Supplies Life Cyan Toner 

(n.nK)* 

Displays the remaining toner amount (%) of 

each color. 

*: The display may vary with the type of toner 

cartridge installed. 

Magenta Toner 

(n.nK)* 

Yellow Toner 

(n.nK)* 

Black Toner 

(n.nK)* 

Cyan Drum Displays the remaining service life (%) of 

image drum of each color. Magenta Drum 

Yellow Drum 

Black Drum 

Belt Displays the remaining service life (%) of the 

belt unit. 

Fuser Displays the remaining service life (%) of the 

fuser unit. 

Network Network 

Information 

General 

Information 

Extended 

Network 

Displays the enabled expanded network other 

than the standard wired LAN1. 

Enabling Default 

Gateway 

Displays the enabled default gateway. 

Printer Name Displays the printer name. 

Short Printer 

Name 

Displays the short printer name. 

NIC Program 

Version 

Displays the network firmware version. 

Web Remote 

Version 

Displays the web page version. 

Wired(LAN1) 

Information 

Wired(LAN1) Displays the state (enabled/disabled) of the 

standard wired LAN1. 

IPv4 Address Displays the IP address of the wired network. 

Subnet Mask Displays the subnet mask. 

Gateway 

Address 

When [Enabling Default Gateway] is set to 

[Wired(LAN1)], the gateway address is 

displayed. 

MAC Address Displays the MAC address of the wired 

network. 

IPv6 Address 

(Local) 

Displays the IPv6 address (local). 
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Item Description 

IPv6 Address 

(Stateless 

Address) 

Displays the IPv6 address (stateless). 

IPv6 Address 

(Stateful 

Address) 

Displays the IPv6 address (stateful). 

Wireless(Infrastructure) 

Information 

* Displayed when the wireless LAN 

module (optional) is installed. 

 

Firmware 

Version 

Displays the wireless network firmware version. 

Wireless(Infrastr

ucture) 

Displays the state (enabled or disabled) of the 

wireless network (infrastructure). 

SSID Displays the SSID of the connected wireless 

network access point. 

Security Displays the security type of the wireless 

network connection. 

State Displays the connection status of the wireless 

network. 

Band Displays the frequency bands of the current 

wireless network. 

Channel Displays the channel number used by the 

wireless network. 

RSSI Displays the signal strength of the wireless 

network. 

IPv4 Address Displays the IP address of the wireless 

network. 

Subnet Mask Displays the subnet mask. 

Gateway 

Address 

When the [Enabling Default Gateway] is set to 

[Wireless(Infrastructure)], the gateway address 

is displayed. 

MAC Address Displays the MAC address of the wireless 

network. 

IPv6 Address 

(Local) 

Displays the IPv6 address (local). 

IPv6 Address 

(Stateless 

Address) 

Displays the IPv6 address (stateless). 

IPv6 Address 

(Stateful 

Address) 

Displays the IPv6 address (stateful). 

Wireless(AP Mode) Information 

* Displayed when the wireless LAN 

module (optional) is installed. 

 

Wireless (AP 

mode) 

Displays the state (enabled or disabled) of the 

wireless network (AP mode). 

SSID Displays the SSID of this machine. 

Password Displays the password. 

Number of 

connected   

Displays the number of wireless terminals 

which are currently connected. 

IPv4 Address Displays the IP address. 

System Serial Number Indicates the serial number of the printer. 

Asset Number Indicates the asset number of the printer. 

Lot Number Indicates the lot number of the printer. 

Firmware 

Version 

Indicates the version of firmware. 

CU Version Indicates the firmware version of the Control 

Unit (CU). 

PU Version Indicates the firmware version of the Print Unit 

(PU). 
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Item Description 

Panel Version Indicates the firmware version of the operator 

panel. 

RAM Indicates the total capacity of all RAM installed 

in this machine. 

Flash Memory Indicates the total value capacity of all flash 

memories installed in this machine. 

Date and Time Displays the current date and time. 

Print Information 

Item Description 

Configuration (Fn100) Prints the configurations of the printer. 

Network (Fn101) Prints the setup situation of the network. 

File List Prints a list of files stored in the printer. 

PS Font List Prints the PS font sample. 

PCL Font List Prints the PCL font sample. 

IBM PPR Font List Prints the IBM PPR font sample. 

EPSON FX Font List Prints the EPSON FX font sample. 

Usage Report (Fn102) Prints the collective usage report of the printer. 

Supplies Report Prints the information such as the remaining service life of 

consumables. 

Error Log (Fn103) Prints the error log. 

Color Profile List Prints the list of color profiles registered in the printer. 

Job Log Prints the history of print data. 

Displayed when [Admin Setup] - [Others Setup] - [Job Log Setup] - 

[Save Job Log] is set to [Enable]. 

CMYK TEST1 Performs test print of each color with paper fed from the MP tray. 

Print 

Item Description 

Shared Print (Fn1) ---Print All--- Displayed when the shared print data is available. 

Prints all shared print data. 

---Delete All--- Displayed when the shared print data is available. 

Deletes all shared print data. 

(Displays a list of 

target files) 

Displayed when the shared print data is available. Select a file, input the 

password, and start printing. 

Private Print (Fn2) Please select a User Selects a user. 

Enter Password Input the password for the selected user. 

Search all the Private 

Jobs? 

Selects whether to search for print data of all users or personal print 

data (of the logged-in user). 

---Print All--- Prints all confidential print data. 

---Delete All--- Deletes all confidential print data. 

(Displays a list of 

target files) 

Displayed when the confidential print data is available. Select a file, 

input the password, and start printing. 

Menus 

Item 
Factory 
default 

settings 
Description 

Tray 

Configuration 

MPTray 

Config 

Paper Size (Fn90) A4 or Letter *1 Sets the size of the paper you want to print 

on from the MP tray. 
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Item 
Factory 
default 

settings 
Description 

X Dimension (Fn91) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from the MP tray. 

 Y Dimension (Fn92) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from the MP tray. 

Media Type (Fn93) Plain Sets the type of paper that you want to print 

on from the MP tray. 

Media Weight (Fn94) Light  Sets the weight of the paper that you want 

to print on from the MP tray. 

Tray Usage (Fn95) When 

Mismatching 

Sets how to use the MP tray. The available 

values are as follows. 

[Normal Tray]: Treats the MP tray as a 

normal tray like Tray 1 or Trays 2-4 

(optional). 

[When Mismatching]: Prints from the MP 

tray with the correct paper loaded when the 

paper loaded in the specified tray for 

printing is different from the paper size of 

the print data. 

[Do Not Use]: Ignores the MP tray in 

selecting or switching the tray automatically. 

Tray1 Config Paper Size (Fn10) A4 or Letter *1 Sets the size of the paper you want to print 

on from Tray 1. 

X Dimension (Fn11) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from Tray 1. 

Y Dimension (Fn12) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from Tray 1. 

Media Type (Fn13) Plain Sets the type of the paper you want to print 

on from Tray 1. 

Media Weight (Fn14) Light Sets the weight of the paper you want to 

print on from Tray 1. 

Tray2 Config Paper Size (Fn20) Cassette 

Size 

Sets the size of the paper you want to print 

on from Tray 2. 

For [Cassette Size], follows the settings of 

the paper size dial of the paper tray. 

X Dimension (Fn21) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from Tray 2. 

Y Dimension (Fn22) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from Tray 2. 

Media Type (Fn23) Plain  Sets the type of the paper you want to print 

on from Tray 2. 

Media Weight (Fn24) Light Sets the weight of the paper you want to 

print on from Tray 2. 

Other Size A5[LEF] Specifies the paper size when the paper 

size dial of Tray 2 is set to [OTHER]. 

Tray3 Config Paper Size (Fn30) Cassette 

Size 

Sets the size of the paper you want to print 

on from Tray 3. 
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Item 
Factory 
default 

settings 
Description 

For [Cassette Size], follows the settings of 

the paper size dial of the paper tray. 

     

  X Dimension (Fn31) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from Tray 3. 

Y Dimension (Fn32) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from Tray 3. 

Media Type (Fn33) Plain Sets the type of the paper you want to print 

on from Tray 3. 

Media Weight (Fn34) Light Sets the weight of the paper you want to 

print on from Tray 3. 

Other Size A5[LEF] Specifies the paper size when the paper 

size dial of Tray 3 is set to [OTHER]. 

 Tray4 Config Paper Size (Fn40) Cassette 

Size 

Sets the size of the paper you want to print 

on from Tray 4. 

For [Cassette Size], follows the settings of 

the paper size dial of the paper tray. 

 X Dimension (Fn41) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from Tray 4. 

 Y Dimension (Fn42) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from Tray 4. 

 Media Type (Fn43) Plain Sets the type of the paper you want to print 

on from Tray 4. 

 Media Weight (Fn44) Light Sets the weight of the paper you want to 

print on from Tray 4. 

 Other Size A5 [LEF] Specifies the paper size when the paper 

size dial of Tray 4 is set to [OTHER]. 

 Paper Feed (Fn80) Tray1 Specifies the paper feeding tray. 

The settings of the printer driver take 

priority. 

 Auto Tray Switch On Sets whether or not to use the auto tray 

switch function. 

The settings of the printer driver take 

priority. 

 Tray Sequence Down Specifies the selection order of the tray 

when the auto tray selection or auto tray 

switching function is used. 

 Duplex Last Page Skip Blank 

Page 

Sets whether or not to print the last 1-sided 

page when the duplex printing is done on 

odd-numbered pages. 

System 

Adjust 

Power Save Time (Fn200) 1minute Sets the time that will elapse before the 

power save mode is entered. 

Value range: 1 minute, 2 minutes, 3 

minutes, 4 minutes, 5 minutes, 10 minutes, 

15 minutes, 30 minutes, 60 minutes 

Sleep Time (Fn200) 15minutes Sets the time that will elapse before the 

sleep mode is switched from the power save 

mode. 
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Item 
Factory 
default 

settings 
Description 

Value range: 1 minute, 2 minutes, 3 

minutes, 4 minutes, 5 minutes, 10 minutes, 

15 minutes, 30 minutes, 60 minutes 

    

 Auto Power Off Time (Fn202) 4hours Sets the time that will elapse before the 

power is turned off automatically after the 

standby mode is entered. 

Value range: 1 hour, 2 hours, 3 hours, 4 

hours, 8 hours, 12 hours, 18 hours, 24 

hours 

Silent Mode On Specifies the printing preparations when the 

standby mode is switched from the sleep 

mode. 

[On]: Silent due to no preparation for 

printing. 

[Off]: The image drum makes a noise as it 

prepares for printing, facilitating a faster 

speed for the first printing start time. 

Clearable Warning ONLINE Sets the timing to clear the recoverable 

error display. 

Auto Continue Off Sets whether or not to automatically restore 

this machine when a memory overflow or 

tray request occurs. 

Manual Timeout 60 seconds Sets the waiting time for loading the paper 

when you print with [Feed paper individually] 

checked in the printer driver.  

Value range: Off, 30 seconds, 60 seconds 

Timeout Injob 40 seconds Sets the time from loss of the data receipt 

(canceled by PostScript) until force-printing. 

Value range: Off, 5 seconds, 10 seconds, 

20 seconds, 30 seconds, 40 seconds, 50 

seconds, 60 seconds, 90 seconds, 120 

seconds, 150 seconds, 180 seconds, 210 

seconds, 240 seconds, 270 seconds, 300 

Seconds 

Timeout Local 40 seconds Sets the time to keep each port open after 

printing. (Except for network) 

The value range is from 0 to 300 seconds in 

increments of 5 seconds. 

Timeout Network 90 seconds Sets the time to keep the network port open 

after printing. 

The value range is from 0 to 300 seconds in 

increments of 5 seconds. 

Low Toner Continue Sets the action of this machine when [Toner 

Low] is displayed. 

This machine goes offline when [Stop] is 

selected. 

Print Mode w/o Color Toner Alarm Specifies the action when there is an empty 

color toner cartridge. 

[Alarm]: This machine stops without printing 

the color print data. 
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Item 
Factory 
default 

settings 
Description 

Replace the empty toner cartridge with a 

new one. 

[Cancel]: Cancels color print data 

automatically. 

Replace the empty toner cartridge with a 

new one. 

    

 Jam Recovery On Sets whether to reprint pages not printed 

due to a paper jam after the paper jam is 

cleared. 

When [Off] is selected, the printing process 

including pages missed due to the paper 

jam will be canceled. 

Error Report (Fn210) Off Sets whether to print an error report when 

an internal error occurs. 

Hex Dump (Fn237) Execute Prints the data received from the PC in 

hexadecimal dump. To exit this mode, turn 

off the power. 

Print Adjust Print Position 

Adjust 

MPTray 

(Fn220) 

X Adjust 0.00millimete

r 

Adjusts the printing position of each tray. 

 • X Adjust: Corrects the position of the 

entire print image perpendicularly to the 

paper travel direction. 

Value range: ±2.00 mm (in increments of 

0.25 mm) 

• Y Adjust: Corrects the position of the entire 

print image along the paper travel direction. 

Value range: ±2.00 mm (in increments of 

0.25 mm) 

• Duplex X Adjust: Corrects the position of 

the entire print image at the right angle to 

the paper travel direction for printing the 

face side during duplex printing (when 

printing the print side of paper fed from the 

duplex unit). 

Value range: ±2.00 mm (in increments of 

0.25 mm) 

• Duplex Y Adjust: Corrects the position of 

the entire print image along the paper travel 

direction for printing the face side during 

duplex printing (when printing the print side 

of paper fed from the duplex unit). 

Value range: ±2.00 mm (in increments of 

0.25 mm) 

Tray 2/3/4 is displayed when the expansion 

tray is mounted. 

Y Adjust 0.00millimete

r 

Duplex X 

Adjust 

0.00millimete

r 

Duplex Y 

Adjust 

0.00millimete

r 

Tray1 

(Fn221) 

X Adjust 0.00millimete

r 

Y Adjust 0.00millimete

r 

Duplex X 

Adjust 

0.00millimete

r 

Duplex Y 

Adjust 

0.00millimete

r 

Tray2 

(Fn222) 

X Adjust 0.00millimete

r 

Y Adjust 0.00millimete

r 

Duplex X 

Adjust 

0.00millimete

r 

Duplex Y 

Adjust 

0.00millimete

r 

Tray3 

(Fn223) 

X Adjust 0.00millimete

r 

Y Adjust 0.00millimete

r 

Duplex X 

Adjust 

0.00millimete

r 

Duplex Y 

Adjust 

0.00millimete

r 

Tray4 

(Fn224) 

X Adjust 0.00millimete

r 
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Item 
Factory 
default 

settings 
Description 

Y Adjust 0.00millimete

r 

Duplex X 

Adjust 

0.00millimete

r 

Duplex Y 

Adjust 

0.00millimete

r 

    

 Paper Black Setting (Fn230) 0 Used for fine adjustment in case of 

noticeable blur etc. in the print results during 

mono printing when [Plain] is selected as 

[Media Type]. Decreases the value if 

printing such as scattered or snow-covered 

printing occurs in high-density printing. 

Increases the value if printing is blurred. 

Adjusts within the range of ±2. 

Paper Color Setting (Fn231) 0 Used for fine adjustment in case of 

noticeable blur etc. in the print results during 

color printing when [Plain] is selected as 

[Media Type]. Decreases the value if 

printing such as scattered or snow-covered 

printing occurs in high-density printing. 

Increases the value if printing is blurred. 

Adjusts within the range of ±2. 

Trans. Black Setting (Fn232) 0 Used for fine adjustment in case of 

noticeable blur etc. in the print results during 

mono printing when [Transparency] is 

selected as [Media Type]. Decreases the 

value if printing such as scattered or snow-

covered printing occurs in high-density 

printing. Increases the value if printing is 

blurred. Adjusts within the range of ±2. 

Trans. Color Setting (Fn233) 0 Used for fine adjustment in case of 

noticeable blur etc. in the print results during 

color printing when [Transparency] is 

selected as [Media Type]. Decreases the 

value if printing such as scattered or snow-

covered printing occurs in high-density 

printing. Increases the value if printing is 

blurred. Adjusts within the range of ±2. 

SMR Setting 

(Fn234) 

Cyan 0 Corrects printing variations for each color 

due to differences in temperature and 

humidity environments, printing 

density/printing frequency. Changes the 

value if there is burr in the image. Adjusts 

within the range of ±3. 

Magenta 0 

Yellow 0 

Black 0 

BG Setting 

(Fn235) 

Cyan 0 Corrects printing variations for each color 

due to differences in temperature and 

humidity environments, printing 

density/printing frequency. Change the 

value if the underlay is dark. Adjusts within 

the range of ±3. 

Magenta 0 

Yellow 0 

Black 0 
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Item 
Factory 
default 

settings 
Description 

HU Setting Off Sets the mode to remove the dirt due to 

leaving this machine idle for a long period of 

time. 

VL Cleaning Execute Improves the printing result when there are 

white streaks in the vertical direction. 

Gloss Mode Off A mode used to print with an increased 

fixing temperature and improved gloss. 

Please select [On] when you want to print 

more glossy. 

 Drum Cleaning (Fn236) Off Sets to empty the drum before printing when 

white streaks appear in the horizontal 

direction. When it is turned on, the 

remaining service life of the image drum will 

be shortened. 

High Humid Mode Off The paper may curl when the paper is 

ejected at a high humidity. Set this setting to 

[Mode1] or [Mode2] to reduce the curling 

effect. 

Try [Mode2] if [Mode1] does not reduce the 

paper curling effect. 

The printing time is longer than the case of 

[Off]. 

When [Mode1] or [Mode2] is set, the service 

life of the image drum will be shortened. 

Office Document Mode Mode1  In the case of Mode 1, toner is saved 

according to the setting of [Admin Setup] - 

[Print Setup] - [Toner Save] - [Toner Save 

Level]. 

In the case of Mode 2, if [Toner Save Level] 

is set to [Off], toner is saved by 5%. When 

[Toner Save Level] is set to [Low], [Middle] 

or [High], toner is saved according to the 

settings. 

Moisture Control Off Enables/Disables the moisture control. 

When [Mode1] or [Mode2] is set, it is 

possible to prevent the paper from 

absorbing moisture at high humidity and 

prevent the paper from getting wet. It may 

take much time to print the first page. 
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Item 
Factory 
default 

settings 
Description 

    

 Narrow Paper Speed Mode1 Sets the printing speed when narrow paper 

is used. 

The target paper weight ranges from Ultra 

Light to Medium. 

Mode1: 

The recommend mode for massive printing 

on narrow paper (with a width of 182 mm or 

less). 

Switches the speed to a low speed when 

printing on narrow paper. 

Mode2: 

The recommend mode for printing on a 

small amount of narrow paper. Prints on 

narrow paper without reducing the speed. 

When printing on a large amount of narrow 

paper, it is easier to begin the waiting time 

for fixing temperature adjustment. 

Mode3: 

To print on wide paper after printing a large 

amount of narrow paper, poor printing may 

occur at the edge of paper. In this case, this 

mode is recommended to reduce the poor 

printing. 

To start printing on wide paper after printing 

on narrow paper, the waiting time for fixing 

temperature adjustment may be available. 

Switches the speed to a low speed when 

printing on narrow paper. 
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Item 
Factory 
default 

settings 
Description 

Quiet Mode Off Sets the quiet print mode to reduce the 

noise during printing. The print speed 

becomes lower when [On] is set. 

Ultra Light Paper Care Mode Off If the following phenomena occur when you 

are printing with [Media Weight] set to [Ultra 

Light] or [Light], setting it to [On] may 

improve the situation. But, the printing 

speed becomes lower. 

 Thin stripes appear along the paper 

travel direction. 

 An after-image is printed on either the 

top, bottom, left or right side of light-

colored texts or images, about 94 mm 

apart. 

Low Coverage Mode Off When used in a hot and humid environment, 

setting this when vertical band or vertical 

streaks-like blur appear on the edges of the 

paper may improve the print result. 

Low Temp. Mode Off Set to idle the drum and belt so that they 

operate stably when color registration is 

noticeable in a low temperature 

environment. 

When it is turned [On], the remaining 

service life of the image drum will be 

shortened. 
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*1 Factory default setting values are different according to the country or region. 

*2 The values are displayed with the unit set in [Admin Setup] - [Tray Setup] - [Unit of Measurement]. 

 

Easy Setup 

Item 
Factory 
default 

settings 
Description 

Enter Password ********** Input the password required to enter the 

Admin Setup menu. 

Language 

Setup 

Select Language English Selects the display language of the display. 

Time Setup Date Format yyyy/mm/dd Sets the date in the format of yyyy/mm/dd. 

Time Zone +9:00 Sets the GMT time zone.  

Value range: -12:00 to +13:00 (in 

increments of 15 minutes) 

Daylight Saving Off Sets the daylight saving (daylight saving 

time). 

Setting method Manual 

Setup 

Selects how to set the time. 

SNTP Server (Primary) (Blank) Sets the SNTP server used to set the 

current date and time. Up to 64 characters 

can be used. 

Displayed when [Auto Config] is selected as 

the setting method.  

SNTP Server (Secondary) (Blank) 

Time Setting 2001/01/01 

00:00:00 

The time is set at factory delivery. Change 

the date and time if necessary. 

Displayed when [Manual Setup] is selected 

as the setting method. 

Admin 

Password 

New Password  Input a new admin password. 

Verify Password  Input the new admin password again to 

verify. 

Network 

Setup 

General 

Setup 

Extended Network Disable Selected when you want to enable any other 

network than the standard wired LAN. 

Enabling Default Gateway Wired(LAN1)  Specifies the network connection method for 

segment-based communication. 

TCP/IP Enable Enables/Disables the wired LAN. 

NetBIOS over TCP Enable Enables/Disables the NetBIOS over TCP 

protocol. 

Web Enable Enables the access from the web browser. 

Displayed when the TCP/IP protocol is 

enabled. 

Telnet Disable Enables the access using Telnet. 

Displayed when the TCP/IP protocol is 

enabled. 

FTP Disable Enables the access via FTP. 

Displayed when the TCP/IP protocol is 

enabled. 

IPSec Disable Displayed only when IPSec is enabled. It 

can be changed to Disable only. 

Displayed when the TCP/IP protocol is 

enabled. 

SNMP Enable Enables the access from SNMP. 

Displayed when the TCP/IP protocol is 

enabled. 
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Network Scale Small Normally, [Small] is selected. 

Network Factory Defaults Execute Restores network menu settings to factory 

default settings. 

Wired(LAN1) 

Setup 

Wired(LAN1)  Enable Enables/Disables the wired LAN1. 

IP Address Set Auto Set to obtain the IPv4 address automatically 

or input it manually. 

IPv4 Address xxx.xxx.xxx.x

xx 

Input the IPv4 address manually. Displayed 

when [IP Address Set] is set to [Manual]. 

Subnet Mask xxx.xxx.xxx.x

xx 

Input the subnet mask. Displayed when [IP 

Address Set] is set to [Manual]. 

Gateway Address xxx.xxx.xxx.x

xx 

Input the gateway address. Displayed when 

[IP Address Set] is set to [Manual]. 

DHCPv6 Disable Set to obtain the IPv6 address 

automatically. Set to [Disable] when you do 

not use the IPv6 address. 

HUB Link Setting Auto 

Negotiate 

Sets the connection method to the hub. 

System 

Adjust 

Power Save Time (Fn200) 1minute Sets the time that will elapse before the 

power save mode is entered. 

Value range: 1 minute, 2 minutes, 3 

minutes, 4 minutes, 5 minutes, 10 minutes, 

15 minutes, 30 minutes, 60 minutes 

Sleep Time (Fn200) 15minute Sets the time that will elapse before the 

sleep mode is switched from the power save 

mode. 

Value range: 1 minute, 2 minutes, 3 

minutes, 4 minutes, 5 minutes, 10 minutes, 

15 minutes, 30 minutes, 60 minutes 

Auto Power Off Time (Fn202) 4hours Sets the time that will elapse before the 

power is turned off automatically after the 

standby mode is entered. 

Value range: 1 hour, 2 hours, 3 hours, 4 

hours, 8 hours, 12 hours, 18 hours, 24 

hours 

Silent Mode On Specifies the printing preparations when the 

standby mode is switched from the sleep 

mode. 

[On]: Silent due to no preparation for 

printing. 

[Off]: The image drum makes a noise as it 

prepares for printing, facilitating a faster 

speed for the first printing start time. 

Clearable Warning ONLINE Sets the timing to clear the recoverable 

error display. 

Auto Continue Off Sets whether or not to automatically restore 

this machine when a memory overflow or 

tray request occurs. 

Manual Timeout 60seconds Sets the waiting time for loading the paper 

when you print with [Feed paper individually] 

checked in the printer driver.  

Value range: Off, 30 seconds, 60 seconds 
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 Timeout Injob 40seconds Sets the time from loss of the data receipt 

(canceled by PostScript) until force-printing. 

Value range: Off, 5 seconds, 10 seconds, 

20 seconds, 30 seconds, 40 seconds, 50 

seconds, 60 seconds, 90 seconds, 120 

seconds, 150 seconds, 180 seconds, 210 

seconds, 240 seconds, 270 seconds, 300 

Seconds 

Timeout Local 40seconds Sets the time to keep each port open after 

printing. (Except for network) 

The value range is from 0 to 300 seconds in 

increments of 5 seconds. 

Timeout Network 90seconds Sets the time to keep the network port open 

after printing. 

The value range is from 0 to 300 seconds in 

increments of 5 seconds. 

Low Toner Continue Sets the action of this machine when "Toner 

Low" is displayed. 

This machine goes offline when [Stop] is 

selected. 

Print Mode w/o Color Toner Alarm Specifies the action when there is an empty 

color toner cartridge. 

[Alarm]: This machine stops without printing 

the color print data. 

Replace the empty toner cartridge with a 

new one. 

[Cancel]: Cancels color print data 

automatically. 

Replace the empty toner cartridge with a 

new one. 

Jam Recovery On Sets whether to reprint pages not printed 

due to a paper jam after the paper jam is 

cleared. 

When [Off] is selected, the printing process 

including pages missed due to the paper 

jam will be canceled. 

Error Report (Fn210) Off Sets whether to print an error report when 

an internal error occurs. 

Hex Dump (Fn237) Execute Prints the data received from the PC in 

hexadecimal dump. To exit this mode, turn 

off the power. 

Tray 

Configuration 

MPTray 

Config 

Paper Size (Fn90) A4 or Letter *1 Sets the size of the paper you want to print 

on from the MP tray. 

X Dimension (Fn91) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from the MP tray. 

Y Dimension (Fn92) 297 

millimeter or 

11.0 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from the MP tray. 
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Media Type (Fn93) Plain Sets the type of paper that you want to print 

on from the MP tray. 

Media Weight (Fn94) Light  Sets the weight of the paper that you want 

to print on from the MP tray. 

Tray Usage (Fn95) When 

Mismatching 

Sets how to use the MP tray. The available 

values are as follows. 

[Normal Tray]: Treats the MP tray as a 

normal tray like Tray 1 or Trays 2 - 4 

(optional). 

[When Mismatching]: Prints from the MP 

tray with the correct paper loaded when the 

paper loaded in the specified tray for 

printing is different from the paper size of 

the print data. 

[Do Not Use]: Ignores the MP tray in 

selecting or switching the tray automatically. 

Tray1 Config Paper Size (Fn10) A4 or Letter *1 Sets the size of the paper you want to print 

on from Tray 1. 

X Dimension (Fn11) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from Tray 1. 

Y Dimension (Fn12) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from Tray 1. 

Media Type (Fn13) Plain Sets the type of the paper you want to print 

on from Tray 1. 

Media Weight (Fn14) Light Sets the weight of the paper you want to 

print on from Tray 1. 

Tray2 Config Paper Size (Fn20) Cassette 

Size 

Sets the size of the paper you want to print 

on from Tray 2. 

For [Cassette Size], follows the settings of 

the paper size dial of the paper tray. 

X Dimension (Fn21) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from Tray 2. 

Y Dimension (Fn22) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from Tray 2. 

Media Type (Fn23) Plain  Sets the type of the paper you want to print 

on from Tray 2. 

Media Weight (Fn24) Light Sets the weight of the paper you want to 

print on from Tray 2. 

Other Size A5 [LEF] Specifies the paper size when the paper 

size dial of Tray 2 is set to [OTHER]. 

Tray3 Config Paper Size (Fn30) Cassette 

Size 

Sets the size of the paper you want to print 

on from Tray 3. 

For [Cassette Size], follows the settings of 

the paper size dial of the paper tray. 

X Dimension (Fn31) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from Tray 3. 
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Y Dimension (Fn32) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from Tray 3. 

Media Type (Fn33) Plain Sets the type of the paper you want to print 

on from Tray 3. 

     

  Media Weight (Fn34) Light Sets the weight of the paper you want to 

print on from Tray 3. 

Other Size A5 [LEF] Specifies the paper size when the paper 

size dial of Tray 3 is set to [OTHER]. 

Tray4 Config Paper Size (Fn40) Cassette 

Size 

Sets the size of the paper you want to print 

on from Tray 4. 

For [Cassette Size], follows the settings of 

the paper size dial of the paper tray. 

X Dimension (Fn41) 210 

millimeter or 

8.5 inch *2 

Sets the paper width when you have 

selected a custom size for the paper that 

you want to print on from Tray 4. 

Y Dimension (Fn42) 297 

millimeter or 

11.0 inch *2 

Sets the paper length when you have 

selected a custom size for the paper that 

you want to print on from Tray 4. 

Media Type (Fn43) Plain Sets the type of the paper you want to print 

on from Tray 4. 

Media Weight (Fn44) Light Sets the weight of the paper you want to 

print on from Tray 4. 

Other Size A5 [LEF] Specifies the paper size when the paper 

size dial of Tray 4 is set to [OTHER]. 

Paper Feed (Fn80) Tray1 Specifies the paper feeding tray. 

The settings of the printer driver take 

priority. 

Auto Tray Switch On Sets whether or not to use the auto tray 

switch function. 

The settings of the printer driver take 

priority. 

Tray Sequence Down Specifies the selection order of the tray 

when the auto tray selection or auto tray 

switching function is used. 

Duplex Last Page Skip Blank 

Page 

Sets whether or not to print the last 1-sided 

page when the duplex printing is done on 

odd-numbered pages. 

Wireless(Infr

astructure) 

Setting 

Wireless(Infrastructure) Disable  Switches the state (enabled or disabled) of 

the wireless(Infrastructure). 

Network 

Setting 

IP Address Set Auto  Set to obtain the IPv4 address automatically 

or set it manually. 

IPv4 Address 192.168.101.

100 

Input the IPv4 address manually. 

Displayed when [IP Address Set] is set to 

[Manual]. 

Subnet Mask 255.255.255.

0 

Input the subnet mask. 

Displayed when [IP Address Set] is set to 

[Manual]. 

Gateway Address 0.0.0.0 Input the gateway address. 

Displayed when [IP Address Set] is set to 

[Manual]. 
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DHCPv6 Disable Set to obtain the IPv6 address 

automatically. Set to Disable when you do 

not use the IPv6 address. 

Automatic 

setup (WPS) 

WPS-PBC  Executed when setting is done by pressing 

the WPS button of the wireless LAN access 

point. 

WPS-PIN  Executed when the PIN code displayed on 

this machine is registered with the wireless 

LAN access point. 

Wireless 

Network 

Selection 

xxxxxx 

    ...... 

 Displays a list of wireless LAN access point 

names found by the search. 

Manual 

Setup 

SSID  Input the SSID. 

Security Disable Sets the security of the wireless LAN 

function. 

WEP Key  Input the WEP key. 

WPA 

Encryption 

Type 

 Displays the WPA-PSK encryption type. The 

setting is carried out automatically according 

to the security settings. (Impossible to 

switch in this menu) 

WPA Pre-

shared Key 

 Input the pre-shared key. Displayed when 

[Security] is set to any other value than 

[Disable] or [WEP]. 

Execute  Executes the changes to security settings. 

Wireless Reconnection  Reconnects to the wireless LAN 

(infrastructure). 

*1 Factory default setting values are different according to the country or region. 

*2 The values are displayed with the unit set in [Admin Setup] - [Tray Setup] - [Unit of Measurement]. 

 

Admin Setup 

Item 
Factory 
default 

settings 
Description 

Enter Password ********** Input the password required to enter the 

Admin Setup menu. 

Network 

Setup 

General 

Setup 

Extended Network Disable Selected when you want to enable any other 

network than the standard wired LAN. 

Enabling Default Gateway Wired(LAN1) Specify the network connection method for 

segment-based communication. 

TCP/IP Enable Enables/Disables the wired LAN. 

NetBIOS over TCP Enable Enables/Disables the NetBIOS over TCP 

protocol. 

Web Enable Enables the access from the web browser. 

Displayed when the TCP/IP protocol is 

enabled. 

Telnet Disable Enables the access using Telnet. 

Displayed when the TCP/IP protocol is 

enabled. 

FTP Disable Enables the access via FTP. 

Displayed when the TCP/IP protocol is 

enabled. 
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IPSec Disable Displayed only when IPSec is enabled. It 

can be changed to Disable only. 

Displayed when the TCP/IP protocol is 

enabled. 

SNMP Enable Enables the access from SNMP. 

Displayed when the TCP/IP protocol is 

enabled. 

Network Scale Small Normally, [Small] is selected. 

Network Factory Defaults Execute Restores network menu settings to factory 

default settings. 

Wired(LAN1) 

Setup 

Wired(LAN1) Enable Enables/Disables the wired LAN1. 

IP Address Set Auto Set to obtain the IPv4 address automatically 

or input it manually. 

IPv4 Address xxx.xxx.xxx.x

xx 

Input the IPv4 address manually. Displayed 

when [IP Address Set] is set to [Manual]. 

Subnet Mask xxx.xxx.xxx.x

xx 

Input the subnet mask. Displayed when [IP 

Address Set] is set to [Manual]. 

Gateway Address xxx.xxx.xxx.x

xx 

Input the gateway address. Displayed when 

[IP Address Set] is set to [Manual]. 

DHCPv6 Disable Set to obtain the IPv6 address 

automatically. Set to [Disable] when you do 

not use the IPv6 address. 

HUB Link Setting Auto 

Negotiate 

Sets the connection method to the hub. 

USB Setup USB Enable Enables/Disables the USB interface. 

Speed 480 Mbps Sets the maximum baud rate using a USB 

interface. 

Soft Reset Disable Enables/Disables the soft reset command. 

Serial Number Enable Enables/Disables the USB serial number. 

The USB serial number is used to identify 

the USB device connected to the PC. 

Offline Receive Disable When [Enable] is selected, data can be 

received even if the printer is offline. 

USB Memory Interface Enable Enables/Disables the USB memory 

interface. 

Connected Host Normal Set to [Specific] in case of timeout when 

printing is done on this machine which is in 

the sleep mode. 

Power consumption in the sleep mode is 

higher than the state where it is set to 

[Normal]. 

Print Setup Personality Auto Selects the operating language of the 

printer. 

 Copies 1 Sets the number of copies. 

The value set in the printer driver takes 

priority. 

 Duplex On or Off *1 Sets whether or not to implement duplex 

printing. 

The value set in the printer driver takes 

priority. 

 Binding Long Edge Specifies the binding method for duplex 

printing. 
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The value set in the printer driver takes 

priority. 

 Media Check Enable Sets whether to check the mismatch 

between the paper size of the print data and 

that of the tray. 

 A4/Letter Override Yes Sets the functions of auto switching the 

printing paper from A4 to Letter when A4 

paper runs out and Letter paper is loaded, 

or from Letter to A4 when Letter paper runs 

out. 

    

 Resolution 600 dpi Sets the resolution. 

The value set in the printer driver takes 

priority. 

 Toner Save Toner Save Level Off Sets the toner save level. 

 Color All Specifies whether to apply toner save to 

100% black. 

 Mono-Print Mode Auto Sets the print mode of mono pages. 

[Auto] controls the print mode with a good 

balance. 

[Color Mode] is suitable for printing a large 

amount of color pages. 

[Normal Mode] is suitable for printing a large 

amount of mono pages. 

 Changing mono print mode 
 

 Color Ready Mode Off Sets whether or not to prepare for the next 

color printing after the printing has 

completed. 

 Default Orientation Portrait Specifies the print orientation. For 

PostScript, this setting is disabled. 

 Edit Size Cassette 

Size 

Sets the size of the drawing area when the 

size is not specified by the paper size edit 

command from a PC. 

 Trapping Off Set when white streaks appear between 

adjacent colors. 

 X Dimension 210 

millimeter 

Sets the default value of paper width for 

custom paper sizes. 

 Y Dimension 297 

millimeter 

Sets the default value of paper length for 

custom paper sizes. 

PS Setup L1 Tray Type1 Sets the tray selection number of PostScript 

level-1 operator commands. 

Network Protocol RAW Specifies the PS communication protocol for 

network connection. 

USB Protocol RAW Specifies the PS communication protocol for 

USB connection. 

PDF Paper Size Current Tray 

Size 

Specifies the paper size for direct printing of 

PDF files. 

PDF Scaling Size 99% Set the reduction ratio when [Scaling Size] 

is selected in [PDF Paper Size]. 

PDF Print Mode Quality 

priority 

Sets whether to prioritize print quality or 

print speed when a PDF is printed. 

PCL Setup Font Source Resident2 Selects the location of the font to be used. 

Font Number C1 Selects the number of the font to be used. 
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Value range: I0 to I90 when [Resident] is 

set; or C1 to C4 when [Resident2] is set 

Font Pitch 10.00 CPI Sets the PCL font width. 

Value range: 0.44 to 99.99 CPI (in 

increments of 0.01 CPI) 

Font Height 12.00 points Sets the PCL font height. 

Value range: 4.00 to 999.75 points (in 

increments of 0.25 points) 

Symbol Set WIN3.1J Selects the symbol set of PCL. 

A4 Print Width 78 column Sets the number of columns until an auto 

carriage return on A4 paper. 

White Page Skip Off Selects whether or not to print blank pages. 

CR Function CR Sets the operation of this machine when 

receiving a CR code. 

LF Function LF Sets the operation of this machine when 

receiving an LF code. 

Print Margin Normal Sets the unprintable area of the paper. 

True Black Off  Sets whether to use composite black 

(CMYK mixed color) or pure black (K only) 

for the black color (100%) of image data. 

Pen Width Adjust On Sets whether to emphasize fine lines and 

make them thicker. 

Tray ID# MPTray 4 Sets the value to specify the tray with the 

output specification command of PCL. 

Value range: 1 - 59 

Tray1 1 

Tray2 5 

Tray3 20 

Tray4 21 

SIDM Setup SIDM Manual ID# 2 Sets up Pn specified in MANUAL by 

MANUAL-1 ID No.FX/PPR Emu in CSF 

control command (ESC EM Pn). 

SIDM Manual2 ID# 3 Sets up Pn specified in MANUAL by 

MANUAL-2 ID No.FX/PPR Emu in CSF 

control command (ESC EM Pn). 

SIDM MP Tray ID# 4 Sets up Pn specified TRAYO (MP Tray) by 

MP Tray ID No.FX/PPR Emu in CSF control 

command (ESC EM Pn). 

SIDM Tray1 ID# 1 Sets up Pn specified TRAY 1 by Tray 1 ID 

No.FX/ PPR Emu in CSF control command 

(ESC EM Pn). 

SIDM Tray2 ID# 5 Sets up Pn specified TRAY 2 by Tray 2 ID 

No.FX/ PPR Emu in CSF control command 

(ESC EM Pn). 

SIDM Tray3 ID# 6 Sets up Pn specified TRAY 3 by Tray 3 ID 

No.FX/ PPR Emu in CSF control command 

(ESC EM Pn). 

SIDM Tray4 ID# 7 Sets up Pn specified TRAY 4 by Tray 4 ID 

No.FX/ PPR Emu in CSF control command 

(ESC EM Pn). 

IBM PPR 

Setup 

Character Pitch 10 CPI Specifies character pitches in IBM PPR 

emulation. 

Font Condense 12 CPI to 20 

CPI 

Specifies 12CPI pitches for Condense 

Mode. 
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Character Set SET-2 Specifies a character set. 

Symbol Set IBM-437 Specifies a symbol set. 

Letter O Style Disable Specifies the style that replaces 9BH with 

letter o and 9DH with a zero. 

Zero Character Normal Sets the zero to be slashed or unslashed. 

Line Pitch 6 LPI Specifies the line spacing. 

White Page Skip Off Selects whether to print blank pages. 

CR Function CR Selects a carriage return from [CR] or 

[CR+LF]. 

LF Function LF Selects a line feed from [LF] or [LF+CR]. 

Line Length 80 Column Specifies the number of characters per line. 

Form Length 11.7 inch or 

11 inch *1 

Specifies the length of paper. 

TOF Position 0.0 inch Specifies the distance from the top edge of 

paper. 

Left Margin 0.0 inch Specifies the distance from the left edge of 

paper so that the print starting point shifts to 

the right horizontally. 

Fit to Letter Disable or 

Enable *1 

Sets the printing mode that can fit paper to 

the printable area equivalent to 11 inches 

(66 lines). 

Text Height Same Sets the height of a character. 

Same: The height stays the same 

regardless of CPI. 

Diff: The height varies according to CPI. 

EPSON FX 

Setup 

Character Pitch 10 CPI Specifies character pitch. 

Character Set SET-2 Specifies a character set. 

Symbol Set IBM-437 Specifies a symbol set. 

Letter O Style Disable Specifies the style that replaces 9BH with 

letter o and 9DH with a zero. 

Zero Character Normal Sets the zero to be slashed or unslashed. 

Line Pitch 6 LPI Specifies the line spacing. 

White Page Skip OFF Selects whether to print blank pages. 

CR Function CR Select a carriage return from [CR] or 

[CR+LF]. 

Line Length 80 Column Specifies the number of characters per line. 

Form Length 11.7 inch or 

11 inch *1 

Specifies the length of paper. 

TOF Position 0.0 inch Specifies the distance from the top edge of 

paper. 

Left Margin 0.0 inch Specifies the distance from the left edge of 

paper so that the print starting point shifts to 

the right horizontally. 

Fit To Letter Disable or 

Enable *1 

Sets the printing mode that can fit paper to 

the printable area equivalent to 11 inches 

(66 lines). 

Text Height Same Sets the height of a character. 

Same: The height stays the same 

regardless of CPI. 

Diff: The height varies according to CPI. 

Private Print 

Setup 

Verify job option Disable Specifies whether to verify the print data 

before printing. 
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If enabled, printing is performed after 

verifying that the print data has not been 

changed. The integrity of print data is 

guaranteed, but the time to start printing will 

be longer. 

 Erase job option No overwrite Sets the method for erasing the print data. 

Specifies that the data cannot be 

overwritten after it has been erased and 

cannot be restored. 

If you overwrite, it will take longer to erase. 

Value range: No overwrite/Zero out once 

Keep job for 2hours Sets the retention period of the print data. 

After the print data is saved, if the print data 

is not printed after the set period, the print 

data is automatically deleted. 

Value range: 15 min/30 min/1 hour/2 

hours/4 hours/8 hours/12 hours/1 day/2 

days/3 days/4 days/5 days/6 days/7 days 

Job Limitation Enable all 

print formats 

Sets whether to save restricted print data. 

When [Private Print only] is selected, print 

data other than private print will not be 

accepted. 

Verify job password Off Selects whether to verify the job password 

when the access control is enabled. 

Job Auto Search On Selects whether to perform job search at the 

same time as unlocking the panel when the 

access control is enabled. 

Color Setup Ink Simulation Off The printer comes with a built-in process 

simulation tool that simulates standard 

printing colors on the printer. 

UCR Low Adjusts the degree of under color removal. 

CMY100% Density Disable  Selects whether to use halftone for C, M, Y 

100% output. 

CMYK Conversion On Selects whether to perform CMYK 

conversion in the simple (high speed) mode. 

Panel Setup Near Life Status Enable Sets whether to display a message when 

the supplies or maintenance parts are 

approaching the end of service life. 

Near Life LED Enable Sets whether to light the «ATTENTION» 

lamp when the supplies or maintenance 

parts are approaching the end of service 

life. 

Idle display Toner Gauge Selects the information to be displayed on 

the standby screen. 

Panel Contrast 0 Adjusts the contrast of the display. 

Value range: -10 to +10 

Buzzer Setup Error Volume Off Sets the buzzer volume when an error 

occurs. 

Print Completion Buzzer Volume Off Sets the buzzer volume when the printing 

has completed. 

AirPrint Buzzer Volume Low Sets the volume of the AirPrint buzzer. 
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Card Hold Buzzer Volume Low Sets the buzzer volume when the IC card is 

held. 

Displayed when access control is enabled. 

Time Setup Date Format yyyy/mm/dd Sets the date in the format of yyyy/mm/dd. 

Time Zone +9:00 Sets the GMT time zone.  

Value range: -12:00 to +13:00 (in 

increments of 15 minutes) 

Daylight Saving Off Sets the daylight saving (daylight saving 

time). 

Setting method Manual 

Setup 

Selects how to set the time. 

SNTP Server(Primary) (Blank) Sets the SNTP server used to set the 

current date and time. Up to 64 characters 

can be used. 

Displayed when [Auto Setup] is selected as 

the setting method. 

SNTP Server(Secondary) (Blank) 

Time Setting 2001/01/01 

00:00:00 

The time is set at factory delivery. Change 

the date and time if necessary. 

Displayed when [Manual Setup] is selected 

as the setting method. 

Power Setup Auto Power Off Auto Config Sets the operation of Auto Power Off. 

Auto Config: Auto Power Off does not work 

for network (wired/wireless) connection. 

Enable: Auto Power Off works regardless of 

the connection method. 

Disable: Auto Power Off does not work. 

Tray Setup Unit of Measurement millimeter Sets the unit of measurement for the custom 

size (mm/inch). 

Default Paper Size A4 Sets the default paper size of a custom size. 

Others Setup Paper Feed 

Roller 

Counter 

Clear 

MP Tray Clear Execute Clears the counter after the paper feed roller 

of the MP tray is replaced. 

Tray1 Clear Execute Clears the counter after the paper feed roller 

Tray 1 is replaced. 

Tray2 Clear Execute Clears the counter after the paper feed roller 

Tray 2 is replaced. 

Tray3 Clear Execute Clears the counter after the paper feed roller 

Tray 3 is replaced. 

Tray4 Clear Execute Clears the counter after the paper feed roller 

Tray 4 is replaced. 

Flash 

Memory 

Setup 

Initialize Execute Initializes the flash memory. 

Format Partition PCL Formats the specified partition of a flash 

memory. 

Job Log 

Setup 

Save Job Log Disable Sets whether to save a log of print data. 

Clear Job Log Execute Clears the log of saved print data. 

Displayed when [Save Job Log] is enabled. 

Security 

Setup 

Access Control Disable Sets whether to enable access control. 

User Counter Report Execute Prints a user counter report. Displayed 

when access control is set to [Enable] and 

[Save Job Log] is enabled. 

Language 

Setup 

Select Language English Selects the display language of the display. 
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 Job Cancel 

Setup 

Cancel Key Behavior Short Sets the actions when the cancel button is 

pressed. 

Short: A short press (for 2 seconds or less) 

cancels the printing. 

Long: A long press for 2 to 5 seconds 

cancels the printing. 

Off: Pressing the cancel button does not 

cancel the printing. 

Inquiry Display On Sets whether to display a screen to confirm 

whether to cancel the printing. 

Focus Position Yes Sets whether to select [Yes] or [No] as the 

default on the job cancel inquiry screen. 

Display Timeout 180 Sets the waiting time in seconds before a 

button is pressed on the job cancel inquiry 

screen. When the waiting time has passed, 

the printing will be continued instead of 

being canceled. 

Near Life 

Setup 

Drum Near Life Timing 1500 Sets whether to display the number of 

copies before the image drum is 

approaching the end of its service life. 

Value range: 500 to 5,000 (in increments of 

500) 

Fuser Near Life Timing 1500 Sets whether to display the number of 

copies before the fuser unit is approaching 

the end of its service life. 

Value range: 500 to 5,000 (in increments of 

500) 

Belt Near Life Timing 1500 Sets whether to display the number of 

copies before the belt unit is approaching 

the end of its service life. 

Value range: 500 to 5,000 (in increments of 

500) 

Erase Privacy Data Execute Erases the following data set in this 

machine. 

• Admin password, values set in various 

menus 

• Various records 

• Access control registered to this machine, 

user information 

NFC Setup Enable Enables/Disables the NFC function. 

Settings Reset Settings Execute Resets the menu settings changed by the 

user to the factory default settings. 
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Item 
Factory 
default 

settings 
Description 

Save Settings Execute Saves the current menu settings. Menu 

settings that have been saved previously 

will be overwritten. 

Restore Settings Execute Restores settings to the saved menu 

settings. 

Change 

Password 

New Password - Input a new admin password. 

Verify Password - Input the new admin password again to 

verify. 

*1 Factory default setting values are different according to the country or region. 

 

Print Statistics 

Item 
Factory 
default 

settings 
Description 

Enter Password **** Input the password required to enter the Print Statistics 

menu. 

The input range is a 4-digit number. 

The factory default setting is "0000". 

Usage Report Enable Enables/Disables the usage report. 

Maintenance Counter Disable Sets whether or not to add a maintenance report (non-

resettable counter and non-resettable consumables 

replacement times) to [Usage Report]. 

[Disable]: Prints the resettable counter and resettable 

consumable replacement counter in [Usage Report]. 

[Enable]: In addition to resettable counter and resettable 

consumable replacement counter, the maintenance report 

(non-resettable counter and non-resettable consumable 

replacement counter) is also printed together in [Usage 

Report]. 

Displayed when [Print Statistics] - [Usage Report] is set to 

[Enable]. 

Reset Main Counter Execute Resets the main counter. 

Displayed when [Print Statistics] - [Usage Report] is set to 

[Enable]. 

Reset Supplies Counter Execute Resets the replacement counter of consumables. 

Maintenance counter is not reset. 

Displayed when [Print Statistics] - [Usage Report] is set to 

[Enable] and [Maintenance Counter] is set to [Enable]. 

Change Password New Password **** Sets a new password required to enter the Print Statistics 

menu. 

The input range is a 4-digit number. 

Displayed when [Print Statistics] - [Usage Report] is set to 

[Enable]. 

Verify Password **** Input the new password required to enter the Print 

Statistics menu set in [New Password] again. 

Calibration 
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Item 
Factory 
default 

settings 
Description 

Auto Density Mode Standard Sets whether to automatically adjust the density/tone for 

color printing. Or, changes the frequency to adjust the 

density/tone for color printing. 

Adjust Density (Fn300) Execute Executed when you want to adjust the density immediately. 

Adjust Registration (Fn301) Execute Executed when you want to adjust the registration 

immediately. 

Long Paper Adjust 0 Adjusts the fixing speed for printing on long paper. 

Set to a plus value if color shift occurs, or to a minus value 

if color misregistration occurs. 

    

Color Density Cyan Density 

(Fn310) 

0 Sets the print density for each color. Adjusts within the 

range of ±3. Darkens the print result by adjusting in + 

direction, or lightens the print result by adjusting in - 

direction. 

Magenta Density 

(Fn311) 

0 

Yellow Density 

(Fn312) 

0 

Black Density 

(Fn313) 

0 

Print Color Tuning Pattern (Fn302) Execute Prints a pattern for density adjustment. 

Cyan Tuning Highlight 0 Adjusts the density of highlights (light areas), mid-tone and 

dark tone (dark areas) for each color. Darkens the density 

by adjusting in the plus direction, and lightens the density 

by adjusting in the minus direction. 

Used for fine adjustment that is not possible with the 

density setting. Adjusts within the range of ±3. 

Mid-Tone 0 

Dark 0 

Magenta Tuning Highlight 0 

Mid-Tone 0 

Dark 0 

Yellow Tuning Highlight 0 

Mid-Tone 0 

Dark 0 

Black Tuning Highlight 0 

Mid-Tone 0 

Dark 0 

AirPrint 

Item Factory default settings Description 

AirPrint Enable Sets AirPrint to [Enable]. 

Wireless(Infrastructure) Setting 

Item 
Factory 
default 

settings 
Description 

Enter Password ********** Input the password required to enter the Admin Setup 

menu. 

Wireless(Infrastructure) Disable  Enables/Disables the wireless LAN (infrastructure). 

Network 

Setting 

IP Address Set Auto Set to obtain the IPv4 address automatically or input it 

manually. 
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Item 
Factory 
default 

settings 
Description 

IPv4 Address 192.168.101.

100 

Input the IPv4 address manually. 

Displayed when [IP Address Set] is set to [Manual]. 

Subnet Mask 255.255.255.

0 

Input the subnet mask. 

Displayed when [IP Address Set] is set to [Manual]. 

Gateway Address 0.0.0.0 Input the gateway address. 

Displayed when [IP Address Set] is set to [Manual]. 

DHCPv6 Disable Set to obtain the IPv6 address automatically. Set to disable 

when you do not use the IPv6 address. 

Automatic 

setup (WPS) 

WPS-PBC  Executed when setting is done by pressing the WPS button 

of the wireless LAN access point. 

WPS-PIN  Executed when the PIN code displayed on this machine is 

registered with the wireless LAN access point. 

Wireless 

Network 

Selection 

xxxxxx 

...... 

 Displays the list of wireless LAN access points detected by 

this machine. 

Manual 

Setup 

SSID  Input the SSID. 

Security Disable  Sets the security of the wireless LAN function. 

WEP Key  Input the WEP key. 

WPA 

Encryption 

Type 

 Displays the WPA-PSK encryption type. 

The setting is carried out automatically according to the 

security settings. (Impossible to switch in this menu) 

WPA Pre-

shared Key 

 Input the pre-shared key. 

Displayed when [Security] is set to any other value than 

[Disable] or [WEP]. 

Execute  Executes the changes to security settings. 

Wireless reconnection  Reconnects to the wireless LAN (infrastructure). 

Wireless(AP Mode) Setting 

Item 
Factory 
default 

settings 
Description 

Enter Password ********** Input the password required to enter the Admin Setup 

menu. 

Wireless(AP mode) Disable Enables/Disables wired (AP mode). 

Automatic Setup (PushButton)  If YES is selected, automatic connection can be started 

with a push button. 

If the connection has failed, the system goes back to the 

home screen. If the connection is successful, [Wireless(AP 

Mode) connection setting is completed/Close by the setting 

button] is displayed. 

Manual Setup  Displays the SSID and password of this machine for 

manual setup. 

Connection Setting SSID Printronix-

Printer name-

Last 6 digits 

of the MAC 

address 

Inputs a new one to change the SSID. 

Password  Inputs a new one to change the password. 

IPv4 Address 192.168.110.

100 

Input the IPv4 address. 

Execute  Executes connection setup. 

AP Mode User Setting Don't 

disclose user 

Sets whether or not to disclose the AP mode information to 

users other than the administrator. 
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Boot Menu 

To display the Boot Menu, do the following. 

 Power on this machine while pressing «OK» on the operator panel. When [Boot Menu] appears on the 

display, release your finger and press «OK» again. 

 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

 

Item 
Factory 
default 

settings 
Description 

Enter Password ********** Input the password required to enter the Boot Menu. 

Menu Lockout Off When [On] is set, the administrator setup menu and user 

menu list are hidden and thus unavailable. However, only 

printing settings are displayed. 

Panel Lockout Off Disables buttons/keys on the operator panel. 

[Mode1]: Disables all keys except «ON LINE», «OK», 

«CANCEL», «POWER SAVE» and «HELP». 

[Mode2]: Disables keys except «ON LINE», «OK» and 

«POWER SAVE». 

[Off]: Do not restrict operations with buttons/keys on the 

operator panel. 

After AC power supply fails Always Off Sets whether to restore the Ready To Print status 

automatically in case of a power failure. 

[Always On]: 

 This machine is started by force when the power failure is 

recovered without pressing the power switch. This machine 

starts simply by connecting the power plug to the outlet. 

[Always Off]: 

 This machine does not start when the power failure is 

recovered without pressing the power switch. 

[Last State]: 

 This machine remembers the state when the power supply 

is interrupted and restarts with that state after the power 

failure is recovered. This machine automatically restores 

the Ready-to-Print state when the power failure is 

recovered even if the power supply is interrupted due to a 

power failure while the machine is working. If a power 

failure occurs when the power is off, this machine does not 

start even after the power failure is recovered. 
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Printing from a PC 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [PRINTRONIX LP654C PCL6] from [Select Printer]. 

4 Click [Preferences] (or [Properties]). 

 

5 Select the loaded paper size from [Size] in the [Setup] tab. 

 

6 Select the tray to be printed from in [Source]. 

 
 If you cannot select Tray 2/3/4, see "Setting the printer driver ". 

7 Set [Type] and [Weight]. 

8 Set other necessary items. 

9 Click [OK]. 

10 Printing starts. 
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For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [PRINTRONIX LP654C PS] from [Select Printer]. 

4 Click [Preferences] (or [Properties]). 

 

5 Select the [Paper/Quality] tab. 

6 Select the tray to be printed from in [Paper Source]. 

 
 If you cannot select Tray 2/3/4, see “Setting the printer driver ". 

7 Click [Advanced]. 

8 Click [Paper Size], and select the loaded paper size from the drop-down list. 

9 Set other necessary items. 

10 Click [OK]. 

11 Printing starts. 

For macOS 

1 Open the file to be printed. 

2 Select [Page Setup] from the [File] menu. 

3 Select the loaded paper size from [Media Size], and click [OK]. 

4 Select [Print] from the [File] menu. 

5 Select [Paper Feed] from the panel menu. 

6 Select [All Pages From], and select the tray to be printed from. 

 
 If you cannot select Tray 2/3/4, see "Setting the printer driver ". 

7 Set other necessary items. 

8 Printing starts. 
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Screens and functions of the printer driver 

Windows PCL printer driver 

[Setup] tab 

 

No. Item Description 

1 Driver settings Save the settings. 

2 Layout image Displays a sample image of the print layout. 

3 Size Sets the media size. 

4 Source Sets the paper source. 

5 Type Sets the media type. 

6 Weight Sets the media weight. 

7 Finishing Mode Sets multicast printing, booklet printing, poster printing, etc. 

8 2-Sided Printing Sets the duplex printing. 

9 Orientation Sets the printing orientation. 

10 Color Setting Switches between color printing and mono printing. 

11 Toner saving Decreases the print density to reduce the amount of toner to be used. 

12 About Displays the version of the printer driver. 

13 Default Restores the settings of each item in the tab to the initial values. 
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[Job Options] tab 

 

No. Item Description 

1 Quality Specifies the print resolution. 

2 Scale Sets the enlargement/reduction of printing. 

3 Copies Specifies the number of copies. 

4 Job type Sets the type of printing. 

5 Print mode Sets whether the print data sent to the printer is in PCL format or as an image. 

6 Advanced Make other printing settings. 

7 Default Restores the settings of each item in the tab to the initial values. 

[Extend] tab 

 

No. Item Description 

1 Watermarks Set for printing with a text or stamp watermark. 

2 Overlays Set for printing with an overlapping print format registered in the printer 

beforehand. 

3 Fonts Sets the TrueType font and printer font. 

4 User authentication Sets the user authentication. 
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Windows PS printer driver 

[Layout] tab 

 

No. Item Description 

1 Orientation Sets the printing orientation. 

2 Print on Both Sides Set for duplex printing. 

3 Page order Sets the order of pages to be printed. 

4 Page format Specifies the number of pages to be printed on one sheet of paper and booklet 

printing. 

5 Layout image Displays a sample image of the print layout. 

6 Advanced You can make detail settings such as the print quality and media size. 

[Paper/Quality] tab 

 

No. Item Description 

1 Tray selection Changes the paper tray. 

2 Color Selects to print in color/mono mode. 

3 Advanced You can make detail settings such as the print quality and media size. 
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[Job Options] tab 

 

No. Item Description 

1 Quality Specifies the print resolution. 

2 Job Type Sets the type of print data and the number of copies. When [Shared Print] or 

[Private Print] is set, [Job Type Options] is available. If [Collate] is checked, 

multiple documents will be printed as a batch. 

3 Fit to page Check [Resize document to fit printer page] to print on a different size of paper. 

4 Watermarks Set for printing with a text or stamp watermark. 

5 Overlays Set for printing with an overlapping format registered in the printer beforehand. 

6 Advanced Other settings can be made. 

7 User authentication Sets the user authentication. 

8 About Displays the version of the printer driver. 

9 Default Restores the settings of each item in the tab to the initial values. 

[Color] tab 

 

No. Item Description 

1 Color Mode Specifies the color adjustment for colored printing. 

2 Toner Saving Print in the toner save mode. 

3 Advanced Other printing settings can be made. 

4 Color Swatch Utility Starts the Color Swatch Utility. 

5 Default Restores the settings of each item in the tab to the initial values. 
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macOS printer driver 

[Layout] panel 

 

No. Item Description 

1 Pages per Sheet Selects the number of pages to be printed on one sheet of paper. 

2 Layout direction Specifies the layout for printing multiple pages on one sheet of paper. 

3 Border Specifies the type of borders. 

4 Two-Sided Specifies settings for printing on both sides. 

5 Reverse page orientation Checked to print with the page direction reversed. 

6 Flip horizontally Checked to print with the left and right reversed. 

[Color Matching] panel 

 

No. Item Description 

1 ColorSync Specifies the ColorSync function. 

2 In printer Uses color matching in this machine. 

3 Profile Specifies a profile. 
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[Paper Handling] panel 

 

No. Item Description 

1 Collate pages Checked to print a multi-page document in collation. 

2 Pages to print Specifies the pages to be printed. 

3 Page Order Specifies the order of pages to be printed. 

4 Scale to fit paper size Prints by fitting to the media size. Depending on the settings, printing may not 

work correctly. Checked to print by zooming-in/-out according to the media size. 

5 Destination Paper Size Specifies the size of the paper to be printed when [Scale to ft paper size] is 

checked. 

6 Scale down only Specifies settings for printing in reduction only to fit the size of the paper. 

[Paper Feed] panel 

 

No. Item Description 

1 All Pages From Specifies the tray to feed paper. When [Auto Select] is specified, a tray is 

selected automatically. 

2 First Page From Selected to print only the first page from the specified tray. 

3 Remaining From Selected to print the remaining pages from the specified tray. 
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[Cover Page] panel 

 

No. Item Description 

1 Print Cover Page Specifies the cover printing. 

2 Cover Page Type Specifies the text string for cover printing. 

[Color] panel 

 

No. Item Description 

1 Grayscale Print in monochrome. 

2 Color Specifies the color adjustment for colored printing. 
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[Print Options] panel 

 

No. Item Description 

1 Quality1, Quality2, Feed, 

Paper 

Specifies the print quality, toner save, media type, etc. 

[User Authentication] panel 

 

No. Item Description 

1 Use user authentication Checked to set user authentication for printing. 

2 User name The user name for user authentication. 

3 Password The password for user authentication. 

4 Authentication type Specifies the authentication type to be used. 

 
 [Authentication Type] can be enabled in the [Options] tab of [Options and Supplies] displayed by selecting [System 

Preferences] - [Printers and Scanners] from the Apple menu.  
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[Secure Print] panel 

 

No. Item Description 

1 Job Type Specifies the type of print data. When [Private Print] or [Shared Print] is set, [Job 

Type Options] is available. 

2 Job Type Options Specifies the password for printing the job name displayed on the panel. 

[Supply Level] panel 

 

No. Item Description 

1 Consumables Displays the usage status of consumables. 

 
 The [Supply Level] panel may not be displayed depending on the usage environment such as the connection method 

of this machine.  
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How to open the printer folder 

This section explains how to open the printer driver icon folder for each version of Windows. 

 

For Windows 10 (Version 1703 or later)/Windows Server 2019 

1 Click [Start] to display the application list. 

2 Select [Windows System Tool] - [Control Panel] - [Devices and Printers]. 

 

For Windows Server 2012 R2/Windows Server 2016 

1 Select [Control Panel] - [View devices and printers]. 

 

For Windows 10/Windows 8/Windows 8.1/Windows Server 2012 

1 Open the control panel and select [View devices and printers]. 

 

For Windows 7/Windows Server 2008 R2 

1 Select [Start] - [Devices and Printers]. 
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Printing on various types of paper 

This section describes how to print on various types of paper. 

Printing on envelopes 

To print on envelopes, change the setting of the media size, and use the MP tray and the rear output tray. 

First, set the media size for the MP tray on the operator panel. Then, set the media size, paper tray, media 

weight, etc. in the printer driver. 

 

Loading envelopes 

1 Check the paper precautions. 

 Applicable paper  

 Inapplicable paper  

 Paper precautions by type  

2 Load the envelope in the MP tray. 

With the address side facing up, place each envelope in the following orientation. 

 Load the envelopes (Com-9, Com-10, DL, C5, Monarch) with the flaps (opening margin) open as 

shown in the figure. 

 The arrow indicates the direction to feed the paper. 

Com-9, Com-10, DL, C5, Monarch 

 

 

3 Open the rear output tray on the back. 

 
 If you always print on envelopes from the MP tray, register the loaded media in this machine. If you print on 

envelopes only once, go to the printing procedure from the printer driver. 

4 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

5 Press «Fn» on the operator panel. 

6 On the functional number screen, press «9», «0» and «OK». 

7 Press the scroll button ▼ to select [Envelope*], and press «OK». 

* Select the type of the envelope loaded. 

8 Press «ON LINE» to return to the standby screen. 

 

Printing from a PC 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 
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3 Click [Preferences]. 

4 Select [Envelope*] from [Size] in the [Setup] tab. 

* Select the type of the envelope loaded. 

5 Select [Multi Purpose Tray] in [Source]. 

6 Select [Portrait] or [Landscape] in [Orientation]. 

7 Specify the media weight and other settings as necessary, and click [OK]. 

 
 If you want to print while checking each sheet, click [Paper Feed Options] in [Setup] of the printer driver and 

check [Feed paper individually] (or select [Yes]). To print continuously, uncheck [Feed paper individually] (or 

select [No]). For details, see "Printing one sheet at a time manually ". 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] in the [Layout] tab, and select [Envelope*] from [Paper Size]. 

* Select the type of the envelope loaded. 

5 Click [OK]. 

6 Select [Portrait] or [Landscape] from [Orientation] in the [Layout] tab. 

7 Select [Multi Purpose Tray] from [Paper Source] in the [Paper/Quality] tab. 

8 Specify the media weight and other settings as necessary, and click [OK]. 

 
 If you want to print while checking each sheet, check [Feeds paper one by one from the MP tray] in [Advanced] 

on the [Layout] tab of the printer driver (or select [Yes]). To print continuously, uncheck [Feeds paper one by 

one from the MP tray] (or select [No]). For details, see "Printing one sheet at a time manually ". 

9 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the envelope size in [Paper Size] and the orientation in [Orientation] 

4 Select [MP Tray] from [All Pages From] in the [Paper Feed] panel. 

5 Specify the media weight and other settings as necessary, and click [Print]. 

 
 If you want to print while checking each sheet, check [Feeds paper one by one from the MP tray] (or select 

[Yes]) in the printer driver . To print continuously, uncheck [Feeds paper one by one from the MP tray] (or select 

[No]). For details, see "Printing one sheet at a time manually ". 

 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 
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Printing on labels 

To print on labels, change the setting of media type, and use the multi-purpose tray (MP tray) and the rear 

output tray. 

First, set the media size and media type for the MP tray on the operator panel. Next, set the media size, paper 

tray, media weight, etc. in the printer driver. 

 

Loading labels 

1 Check the paper precautions. 

 Applicable paper  

 Inapplicable paper  

 Paper precautions by type  

2 With the print side facing up, load labels in the MP tray. 

Label  

 

The arrow indicates the direction to feed the media. 

3 Open the rear output tray on the back. 

 
 If you always print on labels from the MP tray, register the loaded media in this machine. If you print on labels 

only once, go to the printing procedure from the printer driver. 

4 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

5 Press «Fn» on the operator panel. 

6 When the numerical input screen is displayed, press «9», «0» and «OK». 

7 Press the scroll button ▼ to select [A4] or [Letter], and press «OK». 

8 Press «BACK» and confirm that the [MPTray Config] screen is displayed. 

9 Press ▼ to select [Media Type], and press «OK». 

10 Press ▼ to select [Labels], and press «OK». 

11 Press «ON LINE» to return to the standby screen. 

 

Printing from a PC 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [A4] or [Letter] from [Size] in the [Setup] tab. 

5 Select [Multi Purpose Tray] in [Source]. 

6 Specify [Portrait] in [Orientation]. 
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7 Specify the media weight and other settings as necessary, and click [OK]. 

 
 If you want to print while checking each sheet, check [Feed paper individually] in the printer driver (or select 

[Yes]). To print continuously, uncheck [Feed paper individually] (or select [No]). For details, see "Printing one 

sheet at a time manually ". 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] in the [Layout] tab, and select [A4] or [Letter] from [Paper Size]. 

5 Click [OK]. 

6 Select [Multi Purpose Tray] from [Paper Source] in the [Paper/Quality] tab. 

7 Specify [Portrait] from [Orientation] in the [Layout] tab. 

8 Specify the media weight and other settings as necessary, and click [OK]. 

 
 If you want to print while checking each sheet, check [Feeds paper one by one from the MP tray] in the printer 

driver (or select [Yes]). To print continuously, uncheck [Feeds paper one by one from the MP tray] (or select 

[No]). For details, see "Printing one sheet at a time manually ". 

9 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [A4] or [Letter] in [Paper Size] and the orientation in [Orientation]. 

4 Select [Multi-Purpose Tray] from [All Pages From] in the [Paper Feed] panel. 

5 Specify [Portrait] in [Orientation]. 

6 Specify the media weight and other settings as necessary, and click [Print]. 

 
 If you want to print while checking each sheet, check [Feeds paper one by one from the MP tray] in the printer 

driver (or select [Yes]). To print continuously, uncheck [Feeds paper one by one from the MP tray] (or select 

[No]). For details, see "Printing one sheet at a time manually ". 

 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing on long paper 

To print on long paper, change the setting of media type, and use the multi-purpose tray (MP tray) and the 

rear output tray. 

First, set the media size for the MP tray on the operator panel. Next, register the media size and media weight 

in the printer driver. 

The media size that can be registered ranges from 55 mm to 216 mm in width and from 91 mm to 1,321 mm 

in length. 
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Loading paper 

1 Check the paper precautions. 

 Applicable paper  

 Inapplicable paper  

 Paper precautions by type  

2 Load paper in the MP tray. 

3 Open the rear output tray on the back. 

4 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

5 Press «Fn» on the operator panel. 

6 When the numerical input screen is displayed, press «9», «0» and «OK». 

7 Press the scroll button ▼ several times to select [Cassette Size], and press «OK». 

8 Press «BACK». 

9 Press ▼ to select [X Dimension], and press «OK». 

10 Input the X dimension using the numeric keypad, and press «OK». 

11 Press «BACK». 

12 Press ▼ to select [Y Dimension], and press «OK». 

13 Input the Y dimension using the numeric keypad, and press «OK». 

14 Press «ON LINE» to return to the standby screen. 

  

 Applicable paper  

 

Printing from a PC 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Set User Defined Size] from [Size] in the [Setup] tab. 

 
 If the set media size is 210.0 x 900.0 mm, 215.0 x 900.0 mm, or 215.0 x 1200.0 mm, you can select the media 

size from [Banner *** x *** mm]. 

For how to set the irregular size, see "Printing on irregular-sized paper (custom size) ". 

5 Select [Multi Purpose Tray] in [Source]. 

6 Specify the media weight and other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the "Devices and Printers". 

 How to open the printer folder  
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2 Right-click on the icon [PRINTRONIX LP654C PS], and select [Printing preferences]. 

3 Click [Advanced] in the [Layout] tab. 

4 Click [Paper Size], select [PostScript Custom Page Size] from the pull-down menu, and input 

values in [Width] and [Height]. 

5 Click [OK] until the [Print settings] screen is closed. 

6 Open the file to be printed. 

7 Select [Print] from the [File] menu. 

8 Click [Preferences]. 

9 Click [Advanced] in the [Layout] tab, and select [PostScript Custom Page Size] from [Paper 

Size], and then click [OK]. 

10 Click [OK]. 

11 Select [Paper/Quality] from [Paper Source] in the [Multi Purpose Tray] tab. 

12 Specify the media weight and other settings as necessary, and click [OK]. 

13 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Manage Custom Size] in [Paper Size]. 

4 Click [+] to add an item to the list of media size. 

5 Double-click on [Untitled], and input a name for the long media size. 

6 Input values in [Width] and [Height]. 

7 Click [OK]. 

8 Select the media size registered in [Paper Size]. 

9 Select [Multi-Purpose Tray] from [All Page From] in the [Paper Size] panel. 

10 Specify the media weight and other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing on irregular-sized paper (custom size) 

When printing on irregular-sized paper (custom size), set the media size, media type and media weight of the 

irregular size (custom size) on the operator panel. Next, register the media size in the printer driver. 

Setting the media size after loading the paper 

1 Check the paper precautions. 

 Applicable paper  

 Inapplicable paper  

 Paper precautions by type 
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2 Load the paper with a size that can be set to a custom size into the tray to be used. 

3 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

4 Press the scroll button ▼ on the operator panel several times to select [Menus], and press 

«OK». 

5 Check that [Tray Configuration] is selected, and press «OK». 

6 Press ▼ several times to select [Tray Setup] of the tray where the paper is loaded, and press 

«OK». 

7 Check that [Media Size] is selected, and press «OK». 

8 Press ▼ several times to select [Custom], and press «OK». 

9 Press «BACK». 

10 Press ▼ to select [X Dimension], and press «OK». 

11 Input the X dimension using the numeric keypad, and press «OK». 

12 Press «BACK». 

13 Press ▼ to select [Y Dimension], and press «OK». 

14 Input the Y dimension using the numeric keypad, and press «OK». 

15 Press «ON LINE» to return to the standby screen. 

 

Printing from a PC 

For Windows PCL printer driver 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the icon [PRINTRONIX LP654C PCL6], and select [Printing preferences]. 

3 Click [Paper Feed Options] in the [Setup] tab. 

4 Click [Custom Size]. 

5 Input a name for the new size in [Name]. 

6 Input values in [Width] and [Length]. 

7 Click [Add] to save any media size in the list, and click [OK]. 

Up to 32 settings can be saved. 

8 Click [OK] until the [Printing preferences] screen is closed. 

9 Open the file to be printed. 

10 Select [Print] from the [File] menu. 

11 Click [Preferences]. 

12 Select the media size registered in [Size] on the [Setup] tab. 

13 Specify the media weight and other settings as necessary, and click [OK]. 

14 Click [Print] in the [Print] screen. 
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For Windows PS printer driver 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the icon [PRINTRONIX LP654C PS], and select [Printing preferences]. 

3 Click [Advanced] in the [Layout] tab. 

4 Click [Paper Size], and select [PostScript Custom Page Size] from the pull-down menu. 

5 Click [PostScript Custom Page Size Definition]. 

6 Input values in [Width] and [Height], and click [OK]. 

 
 [Offset Relative to Paper Feed Direction] cannot be set. 

7 Click [OK] until the [Printing preferences] screen is closed. 

8 Open the file to be printed. 

9 Select [Print] from the [File] menu. 

10 Click [Preferences]. 

11 Click [Advanced] in the [Layout] tab. 

12 Select [PostScript Custom Page Size] from [Paper Size]. 

13 Click [OK]. 

14 Specify the media weight and other settings as necessary, and click [OK]. 

15 Click [Print] in the [Print] screen. 

 

For macOS 

 
 When using macOS, you cannot print properly, although you can set the media size beyond the usable range. Set 

the media size within the range. 

 macOS may regard the custom-sized paper which is close to a fixed size as the fixed-sized paper. 

 

1 Open the file to be printed. 

2 Select [Page Setup] from the [File] menu. 

3 Select [Manage Custom Size] from [Paper Size]. 

4 Click [+] to add an item to the list of media size. 

5 Double-click on [Untitled], and input a name for the media size. 

6 Input values in [Width] and [Height]. 

7 Click [OK] until the [Page Setup] is closed. 

8 Select [Print] from the [File] menu. 

9 Select the media size registered in [Paper Size]. 

10 Specify the media weight and other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 
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Printing methods 

This section describes various printing methods such as zooming-in/-out and booklet printing. 

Printing one sheet at a time manually 

You can print one sheet at a time by loading paper to the MP tray. 

Each time after a single page is printed, the display shows the message "Manual Printing. Set [Media Size] In 

MP Tray. Press OK To Start Printing".To continue printing, press «OK». 

To cancel the printing, press «CANCEL». 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Multi Purpose Tray] from [Source] in the [Setup] tab. 

5 Click [Paper Feed Options]. 

6 Check [Feed paper individually] in [Multi Purpose Tray], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

9 If a message appears on the display, load paper into the MP tray and press «ON LINE». 

If you are printing a multi-page document, the same massage appears each time after one page is printed. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Multi Purpose Tray] from [Paper Source] in the [Paper/Quality] tab. 

5 Click [Advanced]. 

6 Select [Yes] from [Feeds paper one by one from the MP tray] in [Printer Features]. 

7 Click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 

10 If a message appears on the display, load paper into the MP tray and press «ON LINE». 

If you are printing a multi-page document, the same massage appears each time after one page is printed. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Multi-Purpose Tray] from [All Pages From] in the [Paper Feed] panel. 
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4 Select the [Print Options] panel. 

5 Check [Feed paper individually] in the [Paper Feed] tab. 

6 Specify other settings as necessary, and click [Print]. 

7 If a message appears on the display, load paper into the MP tray and press «ON LINE». 

If you are printing a multi-page document, the same massage appears each time after one page is printed. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

Enlarging/Reducing to fit the specified media size 

You can print on a different media size without changing the print data. 

 
 This function is not applicable to some applications. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the media size of the print data in [Size] in the [Setup] tab. 

5 Check [Resize document to fit printer page] in [Size]. 

6 Select the size of the media to be printed on. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Check [Resize document to fit printer page] in the [Job Options] tab. 

5 Select the size of the media to be printed on. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Check [Scale to fit paper size] in the [Paper Handling] panel. 

4 Select the size of the media to be printed on in [Destination Paper Size]. 
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5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing by enlargement/reduction 

You can print at the magnification rate you want without changing the print data. 

 
 This function is not available to macOS. 

 This function is not applicable to some applications. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Input the scaling rate for [Scale] on the [Job Options] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Input the scaling rate for [Scale] of [Job Type] inn the [Print Options] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

Printing only the cover from another tray 

You can choose to feed the first page and the remaining pages from different trays. 

 
 This function is not available to the Windows PS printer driver. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Paper Feed Options] in the [Setup] tab. 

5 Check [Use different source for first page]. 
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6 Select the paper tray from [Source], and click [OK]. 

Select the paper type from [Type], and the paper weight from [Weight] as necessary. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Paper Feed] panel. 

4 Select [First Page From], and select the tray to feed the first page. 

5 Select the tray to feed the remaining pages in [Remaining From]. 

6 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Booklet printing 

 
 Some applications may not be available. 

 This function is not available to macOS. 

 Watermarks cannot be printed correctly when [Booklet] is used. 

 This function is disabled when private jobs are printed from a client PC that shares the network of the device with the 

print server. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Booklet] in [Finishing Mode] on the [Setup] tab. 

5 Click [Options], and set booklet printing as necessary. 

 [Signature]: Specifies the unit of the page to close. 

 [2 pages]: Prints 2 pages on 1 sheet of paper. 

 [Right to Left]: Prints to create a right-to-left booklet. 

 [Bind Margin]: Sets the margin. 

6 Click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 
 To create an A5 booklet using A4-sized paper, select [A4] from [Size] in the [Setup] tab.  
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 If [Booklet] is not available to the Windows PCL printer driver, open the "Devices and Printers", right-click on the icon 

[PRINTRONIX LP654C PCL6], and select [Printer Properties] - [Preferences] tab - [Print Processor] - [OKX05PPP] - 

[RAW], and click [OK]. 

To open the "Devices and Printers", see "How to open the printer folder ". 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Booklet] in [Page Format] in the [Layout] tab. 

5 Check [Draw Borders] as necessary. 

6 Click [Advanced]. 

7 Click [Booklet Binding Edge] under [Document Options] to set the binding position. 

 
 To make a right-edge binding booklet (i.e. a booklet with the binding on the right edge when the first page is 

facing up), select [On Right Edge]. 

 To create an A5-sized booklet using A4 paper, select [A4] from [Paper Size]. 

8 Click [OK] until the [Printing preferences] screen is closed. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 

 
 If [Page Format] is not displayed in the [Layout] tab, open the "Devices and Printers", right-click on the [PRINTRONIX 

LP654C PS] icon, and select [Printer properties] - [Advances] tab. Check [Enable advanced printing features]. 

To open the "Devices and Printers", see "How to open the printer folder ". 

Printing a poster by dividing a document 

A single document can be divided or enlarged for printing on multiple pages. Finally, you will create a poster 

by combining all pages together. 

 
 This function is not available to an IPP network. 

 This function is not available to the Windows PS printer driver or macOS. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Poster Print] from [Finishing Mode] of the [Setup] tab. 

5 Click [Options]. 

6 Set the values of [Hor./Vert. Enlargement], [Add Registration Marks] and [Add Overlap] as 

necessary, and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 
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8 Click [Print] in the [Print] screen. 

 
 To create an A2-sized poster using 4 sheets of A4 paper, select [A4] in the paper size, and select [4] in [Enlarge]. 

 If this feature is not available to the Windows PCL printer driver, open the "Devices and Printers", right-click on the 

icon [PRINTRONIX LP654C PCL6], and select [Printer properties] - [Advanced] tab - [Print Processor] - [OKX05NPP] 

- [RAW], and click [OK]. 

Inserting and printing a watermark text (watermark) 

 
 This function is not available to macOS. 

 Watermarks cannot be printed correctly in booklet printing. 

 If you check [Print in background] on the [Watermarks] screen of the Windows PS printer driver, the watermark may 

not be printed depending on the application. In this case, uncheck [Print in background]. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Watermarks] on the [Extend] tab. 

 
 To print the job information such as a user name for printing or a document name as a watermark, check [Print 

job information] and set the job information to be printed. 

5 Click [New]. 

6 Input the text string to be printed as a stamp in [Text] of the [Watermarks] screen. 

7 Set [Font], [Size], etc. as necessary, and click [OK]. 

8 Make sure that the watermark to be printed is selected, and click [OK]. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Watermark] of the [Job Options] tab. 

5 Click [New]. 

6 Input the text string to be printed as a stamp in [Text] of the [Watermark] screen. 

7 Set [Font], [Size], etc. as necessary, and click [OK]. 

8 Make sure that the watermark to be printed is selected, and click [OK]. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 



 

- 160 - 

Printing overlaid text or logos (overlay printing) 

You can print a document with an overlapping form file (like a logo or format) registered in this machine 

beforehand. It is called overlay printing. 

 
 This function is not available to macOS. 

 It is not available to the Windows PCL printer driver when [Print Mode] is set to [Image]. 

 

Registering a form file 

For Windows PCL printer driver 

1 From the application, create a form which you want to register with this machine. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Overlays] in the [Extend] tab. 

5 Select [Register print document as a new form]. 

6 Click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

9 From [New Form], input [Form name] and [ID] to register with this machine. 

 
 You can also specify the print position of an overlay. 

10 Select the page onto which you want to apply that overlay in [Print on Pages] as the registration 

information to the printer driver. 

To specify a page to apply to, select "Custom", and input the target page in [Custom Pages]. 

11 Click [OK]. 

 

For Windows PS printer driver 

Refer to "Registering forms (form overlay) " for the detailed procedure. 

 

Printing a form file 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Extend] tab. 

5 Click [Overlays].  
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6 Select [Overlay Print], and then select the form file to overlay from the drop-down list. 

 
 Click [Edit list] and add it to the list if you want to add a form file registered with the Configuration Tool or if you 

want to overlay multiple forms as a group. 

If you want to add a form file registered with the Configuration Tool, click [Add a registered form], input the form 

name in [Form name] and the ID of the form registered with the Storage Manager plugin of the Configuration 

Tool in [ID], select the page onto which you want to apply that overlay in [Print on Pages], and click [OK]. 

7 Click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

 
 You will have to log into the PC as a user with administrator privileges. 

1 Open the "Devices and Printers". 

2 Right-click on the PS printer icon, and select [Printing Preferences]. 

3 Click [Overlays] of the [Job Options] tab. 

4 Select [Use Overlays] from the pull-down menu, and click [New]. 

5 Input the form name registered with the Storage Manager plug-in of the Configuration Tool in 

[Form Name], and click [Add]. 

6 In [Overlay Name], input an overlay name. 

7 Select the page onto which you want to apply that overlay in [Print on Pages]. 

8 Click [OK]. 

9 Select the overlay to be used for printing from [Defined Overlays], and click [Add]. 

10 Click [OK]. 

11 Specify other settings as necessary, and click [OK]. 

12 Open the file to be printed. 

13 Select [Print] from the [File] menu. 

14 Click [Print] in the [Print] screen. 

Outputting to a file without printing on paper 

You can export print data to a file and save it without printing on paper. 

 
 To perform this procedure, you will have to login to the PC as a user with administrator privileges. 

 

For Windows 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the icon [PRINTRONIX LP654C *], and select [Printer properties]. 

* Please select the type of printer driver that you want to use. 
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3 Select the [Ports] tab. 

4 Select [FILE:] from the port list, and click [OK]. 

5 Open the file to be printed. 

6 Select [Print] from the [File] menu. 

7 Click [Print]. 

8 Input the file name, and click [OK]. 

Example: C:¥temp¥printdata.prn 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [PDF] on the print screen, and select the file format to be saved as. 

4 Input a name for the file, select a destination for the file, and then click [Save]. 

Printing frequently used documents without using a PC 

By storing frequently used documents in the machine, you can print them directly from the operator panel 

without using a PC. 

 
 If the print data cannot be stored due to insufficient capacity of the memory, a message is displayed indicating that 

the file system is full and the printing will not be performed. 

 

Storing documents 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Select [Shared Print] from [Job Type]. 

6 Click [Job Type Option]. 

7 Input the print data name in [Job Name]. 

If you check [Input job type option when printing], a prompt asking for the print data name is displayed 

when the print data is sent to this machine. 

8 Click [OK]. 

9 Make other settings as necessary to print. 

The print data is sent to this machine, but not printed yet. 

 

For Windows PS printer driver 

1 Open the file to be printed. 
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2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Select [Shared Print] from [Job Type]. 

6 Click [Job Type Option]. 

7 Input the print data name in [Job Name]. 

If you check [Input job type option when printing], a prompt asking for the print data name is displayed 

when the print data is sent to this machine. 

8 Click [OK]. 

9 Make other settings as necessary to print. 

The print data is sent to this machine, but not printed yet. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Secure Print] panel. 

4 Select [Shared Print] from [Job Type]. 

5 Specify other settings as necessary, and click [Print]. 

The print data is sent to this machine, but not printed yet. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

 

Printing the saved document 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

3 On the functional number screen, press «1» and «OK». 

4 If a list of shared print data appears, press the scroll button ▲ or ▼ to select the shared print 

data which you want to print, and press «OK». 

 To print all shared print data, select [Print All] and press «OK». 

 Select [Delete All] and press «OK» to delete all the shared print data displayed. 

5 Check that [Print] has been selected, and press «OK». 

Select [Delete] and press «OK» to delete the print data. 

6 Input the number of copies, and press «OK».  
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Printing an email attachment 

This machine can print the file attached to the email you have received. Printable file formats are PDF (v1.7), 

JPEG and TIFF (V6 baseline). 

To use this function, you will have to configure email reception settings on the POP server or SMTP server. 

 Setting E-mail receiving (Web page)  

 
 The email body will not be printed. 

 For the number of copies, duplex printing or other settings, the current settings of [Admin Setup] will be applied. 

 Up to 10 files with a maximum size of 8 MB per file can be printed. 



 

- 165 - 

Printing in economy mode 

This section describes how to save paper and toner on printing. 

Printing on both sides of paper 

You can print on both sides of paper. 

For paper applicable to duplex printing, see “Applicable paper ". 

 
 Some applications may not be available. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Long Edge] or [Short Edge] from [2-Sided Printing] on the [Setup] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Flip on Long Edge] or [Flip on Short Edge] from [Print on Both Sides] in the [Layout] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Long-Edge blinding] or [Short-Edge blinding] from [Two-Sided] in the [Layout] panel. 

4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing in the toner save mode 

Print in the toner save mode. 

The amount of toner to be saved can be set in 3 levels. 

 [Printer Setting]: Follows the device settings. 

 [OFF]: Prints at normal density without saving toner. 
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 [Save Level Low]: Prints at a slightly lighter density. 

 [Save Level Middle]: Prints at a light density. 

 [Save Level High]: Prints at a considerably light density. 

 
 The density of the image printed using this function varies with the print data. 

 If you do not want to reduce the printing density for 100% black, check [Do not save 100% black toner]. 

 The amount of toner to be saved can also be set from the operator panel of this machine. Set the amount of toner to 

be saved in [Admin Setup] - [Print Setup] - [Toner Save] - [Toner Save Level]. However, the setting of the printer 

driver takes priority. 

 The default setting of the printer driver is [Printer Setting]. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Setup] tab. 

5 Select the amount of toner to be saved from [Toner saving]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Color] tab. 

5 Select the amount of toner to be saved from [Toner saving]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel. 

4 Select the amount of toner to be saved in [Toner Saving] of the [Quality2] tab. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen.  
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N-in-1 printing 

You can print by zooming in on the data of multiple pages to one side of a single sheet of paper. 

 
 This function prints data at a reduced size, so the center of the paper may not be aligned accurately. 

 Some applications may not be available. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the number of pages to be printed on 1 sheet in [Finishing Mode] of the [Setup] tab. 

5 Click [Options]. 

6 Set [Page Borders], [Page Layout] and [Bind Margin], and then click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Pages per sheet] in the [Page Format] of the [Layout] tab. 

5 Select the number of pages to be printed on 1 sheet from the pull-down menu. 

6 If you want to draw a borderline, check [Draw Borders]. 

7 Click [Advanced], select the order of page layout from the [Pages per sheet layout] in the 

[Document Options]. 

8 Click [OK]. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the number of pages to be printed on 1 sheet in [Pages per Sheet] of the [Layout] panel. 

4 Set the [Border] and [Layout Direction]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 
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Printing as an image (image) 

If it takes a long time to print, you can select [Image] in [Print Mode] to shorten the printing time. 

This function is available to the Windows PCL printer driver only. 

 
 This function has the following limitations. 

 When this machine is set as a shared printer, or when connected via a WSD / IPP port and in environments 

such as a remote desktop client, it will not print with the optimal color. 

 Overlay printing, printing with printer fonts, or trapping function cannot be used. 

 If you select a setting that cannot be used when [Print Mode] is set to [Image] for functions other than the 

above, a warning for resolving the conflict will be displayed. 

 A warning will be displayed if this machine is not connected or if it is offline due to an error. 

 The results of color tone or representation will be different when printing with [PCL] of [Print Mode]. 

 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Select [Image] in [Print Mode]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
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Color setup 

Printing color data in monochrome 

You can print color data in monochrome. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Monochrome] in [Color Setting] of the [Setup] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 
 You can print color data in monochrome by selecting [Monochrome] even when cyan, magenta and yellow 

toners are empty. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Greyscale] in [Color Mode] of [Color] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 
 You can print color data in monochrome by selecting [Greyscale] even when cyan, magenta and yellow toners 

are empty. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Color] panel. 

4 Select [Grayscale]. 

5 Specify other settings as necessary, and click [Print]. 

 
 You can print color data in monochrome by selecting [Grayscale] even when cyan, magenta and yellow toners 

are empty. 

 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 
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Color matching in the printer driver 

Color matching is to manage and adjust colors of print data to maintain the consistency between input and 

output devices. 

This section explains color matching in the printer driver. 

Settings Description 

Automatic Color matching shall be done depending on the specific document. In general, use this setting. 

Office Color Select it if you print a business document by using the word processing software, spreadsheet 

software, and presentation software. The print data of RGB color space is color matched for 

CMYK color space of this machine. 

Graphic Pro Select it if you use the software for DTP. You can specify a simulation when printing by a CMYK 

output device. 

No Color Matching Select it if you match the color from an application. 

For macOS, you can also use the [ColorSync] function for color matching. 

 
 To manage CMYK color data, use the Graphics Pro function. 

 The CMYK Link Profile cannot be specified with the Windows PCL printer driver. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Color] in [Color Setting] of the [Setup] tab. 

5 Click [Detail]. 

6 Select the item you want to set, and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Color] tab. 

5 Select the item you want to set, and click [OK]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Color] panel. 

4 Select the item you want to set in [Color]. 



 

- 171 - 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Simulating print results 

By adjusting CMYK color data, this machine will simulate the characteristics of the ink used for offset printing. 

 
 Some applications may not be available for macOS. 

 This function can be used when [Graphic Pro] is selected in [Color Mode]. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Color] in [Color Setting] of the [Setup] tab. 

5 Click [Options] in [Setup], and select [Graphic Pro]. 

6 Select [Printer Simulation]. 

7 Select the characteristics of the ink that you want to simulate from [Simulation Target Profile] of 

[Input Profile], and click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Color] tab, select [Graphic Pro], and then click [Options]. 

You can also simulate business documents by using [Office Color]. Click [Options], and select the 

attribute of the ink that you want to simulate from [CMYK Ink Simulation]. 

5 Select [Printer Simulation]. 

6 Select the characteristics of the ink that you want to simulate from [Simulation Target Profile] of 

[Input], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Color] panel. 
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4 Select [Graphic Pro] in [Color]. 

5 Select [Printing Simulation] in [Mode Selection]. 

6 Select the characteristics of the ink that you want to simulate in [Simulation Target Profile] of 

[Input] tab. 

7 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed on the [Print] screen, click [Show Details] at the bottom of the screen. 

Printing with color separation 

The color separation printing function can be used without any application. 

 
 This function is not available to the Windows PCL printer driver. 

 If you are using the Adobe Illustrator, use the color separation function of this application. In this case, disable the 

color matching function in the printer driver. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Color] tab, and click [Advanced]. 

5 Select the color that you want to print in separation from [Print color separations], and click 

[OK]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel 

4 Select the color that you want to print in separation from [Separations] of the [Quality2] tab. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show Details] at the bottom of the screen. 

Adjusting registration manually 

Although this machine adjusts registration automatically when the power is turned on or when the output tray 

is opened and closed, it is possible to adjust it manually in case the registration is concerned. 

 



 

- 173 - 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

3 On the function number screen, press «3», «0», «1» and finally «OK». 

4 Check that [Execute] is selected, and press «OK». 

 
 During registration adjustment, "Color Adjusting" is displayed on the second line (under "Ready To Print") of the 

display. 

Adjusting the density manually 

The machine automatically adjusts the density every time when about 500 sheets have been printed after a 

new image drum is installed or when continuous printing is done. If you are concerned about the print density, 

you can adjust it manually from the operator panel. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

 
 If this machine is in the power save mode, press the «POWER SAVE» to wake it up from the power save mode. 

3 On the function number screen, press «3», «0», «0» and finally «OK». 

4 Check that [Execute] is selected, and press «OK». 

 
 During density adjustment, "Density Adjusting" is displayed on the second line (under "Ready To Print") of the 

display. 

Adjusting the color balance (density) 

Print the color tuning pattern to check the color, and adjust the color as you like from the operator panel. 

Specify the adjustment by darkening or lightening the three areas of highlight, mid-tone and dark of each 

color. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

3 On the function number screen, press «3», «0», «2» and finally «OK». 

4 Check that [Execute] is selected, and press «OK». 

A color sample is printed. 

 
 The color tuning pattern is printed as 44 quadrilaterals. The current settings of highlight, dark, and mid-tone of 

colors are displayed as dotted lines. Check the colors for adjustment. 
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5 Press the scroll button ▼ several times to select [Calibration], and press «OK». 

6 Press ▼ several times to select [Cyan Tuning], [Magenta Tuning], [Yellow Tuning] or [Black 

Tuning], and press «OK». 

7 Press ▼ to select [Highlight], [Dark] or [Mid-Tone], and press «OK». 

8 Press ▲ or ▼ to select the value (-3 to +3), and press «OK». 

9 Press «ON LINE» to return to the standby screen. 

10 Printing starts. 

Repeat until you get the desired color. 

Changing mono print mode 

You can adjust the print mode of mono pages. The available values are as follows. 

Settings Description 

[Auto] Controls the print mode with a good balance. Please select "Auto" generally. 

[Color Mode] Suitable for printing a large amount of color pages. 

Always print by using 4 color image drums without switching between color pages and 

monochrome pages. 

[Normal Mode] Suitable for printing a large amount of mono pages. 

Color pages are printed by using 4 color image drums, and mono pages are printed by using the 

black image drum only. If color pages and mono pages are mixed, the printing time will be 

longer. 

 
 The admin password is required to enter the [Admin Setup] menu. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Press ▼ several times to select [Print Setup], and press «OK». 

5 Press ▼ to select [Mono-Print Mode], and press «OK». 

6 Select the print mode, and press «OK». 

7 Press «ON LINE» to return to the standby screen. 

Adjustment with utilities 

You can tune the color using utility software. Please refer to the instructions on the specific utility for details. 

 Color Correct Utility  

 Color Swatch Utility  
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Refining your finishing 

This section describes how to make the print result better when you are printing from your PC. 

Printing sharper photos 

You can print more naturally vividly images like photos. 

 
 This function is not available to the Windows PS printer driver or macOS. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab 

5 Check [Photo Enhance]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

Printing with the specified print resolution 

You can change the print quality as needed. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Select the value you want to set from [Quality]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Select the value you want to set from [Quality]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 
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For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel. 

4 Select the value you want to set from [Quality] of the [Quality1] tab. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

Printing by correcting fine lines 

The fine line correcting function is enabled by default to prevent fine lines from becoming faint or inconsistent 

in thickness. 

Depending on the specific application, the spacing of bar codes may become narrower. In that case, disable 

the function. 

 

For Windows PCL printer driver 

When this function is enabled, ultra fine lines are slightly thicker. 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Select [Adjust ultra fine lines] in [Item], set it to [ON] in [Settings], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

When this function is enabled, the thickness of ultra fine lines is consistent in the specified direction. 

When this function is disabled, ultra fine lines may be slightly thicker. 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Check [Adjust ultra fine lines], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
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For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel. 

4 Check [Adjust ultra fine lines] in the [Quality1] tab. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

Printing by specifying the font to use 

Using printer-specific fonts 

 
 The printer fonts may not be reproduced as the TrueType font design displayed on screen. 

 This function is not available to the Windows PCL printer driver when [Print Mode] is set as [Image], nor to a macOS. 

 This function is not applicable to some applications. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Extend] tab. 

5 Click [Font]. 

6 Check [Font Substitution] in [TrueType Font Output Type]. 

7 Specify the printer font to be used instead of the TrueType font in [Font Substitution Table]. 

8 Click [OK]. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the "Devices and Printer". 

 How to open the printer folder  

2 Right-click on the icon of [PRINTRONIX LP654C PS], and select [Printer Properties]. 

3 Double-click on [Font Substitution Table] in the [Device settings] tab. 

4 Click the TrueType font, and select the substitution printer font from the list. 

5 Click [OK]. 

6 Open the file to be printed. 

7 Select [Print] from the [File] menu. 

8 Click [Preferences]. 
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9 Click [Advanced] in the [Layout] tab. 

10 Select [Substitute with Device Font] from [TrueType Font] in [Graphic]. 

11 Click [OK]. 

12 Specify other settings as necessary, and click [OK]. 

13 Click [Print] in the [Print] screen. 

 

Using PC fonts 

With the TrueType font of the PC, you can print with the same text as the screen display. 

 
 This function is not applicable to macOS. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Extend] tab. 

5 Click [Font]. 

6 Uncheck [Font Substitution] in [TrueType Font Output Type], select the export format, and click 

[OK]. 

 [Download as Outline Font] 

Creates font images using the printer. 

 [Download as Bitmap Font] 

Creates font images using the printer driver. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] in the [Layout] tab. 

5 Select [Download as Softfont] from [TrueType Font] in [Graphic]. 

6 Click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 
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Changing black finishing 

The finishing for the black parts can be changed in color printing. The black finishing settings can be used 

when [Office Color] or [Graphic Pro] is selected in the printer driver. 

Two types of black finishing can be created: from the toner cartridges of Cyan (C), Magenta (M), Yellow (Y) 

and Black (K), and from only Black (K). The black finishing with CMYK toner is ideal for printing photos. The 

black finishing with black toner is ideal for printing black characters and graphics. 

This setting can be automatically selected when [Office Color] is selected. When Auto is selected, this 

machine prints by selecting the ideal method automatically. 

 

For Windows PCL printer driver 

1 Open the file to be printed 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Color] in [Color Setting] of the [Setup] tab. 

5 Click [Detail] in [Setup], and select [Office Color] or [Graphic Pro]. 

6 Select the black finishing method from [Black Finish], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Color] tab, then select [Office Color] or [Graphic Pro], and then click [Detail]. 

5 Select the black finishing method from [Black Finish], and click [OK]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed 

2 Select [Print] from the [File] menu. 

3 Select the [Color] panel. 

4 Select [Office Color] or [Graphic Pro]. 

5 Select the black finishing method from [Black Finish]. 

6 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed on the [Print] screen, click [Show details] at the bottom of the screen. 
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Blurring white streaks between text and background (black overprint) 

If there are white streaks and other gaps between black text and colored backgrounds, you can eliminate 

them by printing black text over colored backgrounds. 

 
 This function is not applicable to some applications. 

 This function is applicable when black text is printed over colored backgrounds. 

 If the toner layer is too thick, the toner may not be fixed securely. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab and click [Advanced]. 

5 Change the setting of [Overprint Black] to [ON], and click [OK]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Color] tab, and click [Advanced]. 

5 Check [Black overprint], and click [OK]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel. 

4 Check [Black Overprint] in the [Quality1] tab. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

Inconspicuous white streaks in color superposition (trapping function) 

If white or colored streaks appear between overlapping objects, you can use the trapping function to make 

them less noticeable. 
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 This function is not available to the Windows PCL printer driver when [Print Mode] is set to [Image]. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab and click [Advanced]. 

5 Change the setting of [Trapping] to [Narrow] or [Wide] according to the corrected amount, and 

click [OK]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Change the setting of [Trapping] to [Narrow] or [Wide] according to the corrected amount. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel. 

4 Select [Narrow] or [Wide] according to the corrected amount from [Trapping] in the [Quality1] 

tab. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 
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Useful functions 

This section describes useful functions for printing from a PC. 

Printing with multiple pages sorted into one complete set (Collate) 

You can print the print data of multiple pages and put them into one complete set. 

 
 Some applications may not be available. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Click [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Input the number of copies in [Copies], and check [Collate]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Click [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Input the number of copies in [Copies] of the [Job Options] tab, and check [Collate]. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 
 Turn off the Collate function in the application. 

If the Collate function is on in the application, you can print without using the memory of this machine. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Input the number of copies in [Copies]. 

4 Select the [Paper Handing] panel, and uncheck [Collate pages]. 

5 Select the [Print Setup] panel, and check [Collate] in the [Paper Setup] tab. 

6 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

 If [Collate] is checked in the [Paper Handing] panel, you can print without using the memory of this machine. 
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Printing from the last page of your document 

You can print the pages either in order or in reverse order. 

When the output tray is used, printouts will be stacked in page order if it is set to print in order. 

When the rear output tray is used, printouts will be stacked in page order if it is set to print in reverse order. 

 
 If the rear output tray is not opened, printouts will be discharged from the output tray. 

 This function is not available to the Windows PCL printer driver. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Back to Front] from [Page Order] in the [Layout] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 
 If [Page Order] is not displayed, open the "Devices and Printers", right-click on the [PRINTRONIX LP654C PS] icon, 

and select [Printer properties] - [Advanced] tab. Check [Enable advanced printing features]. 

To open the "Devices and Printers", see "How to open the printer folder ". 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Reverse] in [Page Order] on the [Paper Handling] panel. 

4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

Printing by automatically selecting a tray for the specified paper 

The tray (paper trays (Tray1-4), or the MP tray) matching the paper size and type that are set in the printer 

driver will be selected automatically for printing. Trays are selected according to the setting of [Tray 

Sequence]. 

 
 Be sure to set the paper size and paper weight for the paper pay and MP tray on the operator panel. 

 Loading paper  

 

When using the MP tray 

By default, [When Mismatching] is set for the MP tray. In this case, the MP tray is not subject to auto tray 

switch. 

To set the MP tray as a target for auto tray switch, use the following settings. 
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1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

3 On the functional number screen, press «9», «5» and «OK». 

4 Press the scroll button ▲ to select [Normal Tray], and press «OK». 

5 Press «ON LINE» to return to the standby screen. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Auto] in [Source] of the [Setup] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select [Automatically Select] in [Paper Source] of the [Paper/Quality] tab. 

5 Specify other settings as necessary, and click [OK]. 

6 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Auto Select] in [All Pages From] on the [Paper Feed] panel. 

4 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

Switching tray automatically at running out of paper 

When the paper loaded in the trays (paper trays (Tray1-4) or the MP tray) is of the same media size, media 

weight and media type, you can set that the machine will continue the printing from another tray when the 

feeding tray is empty. 

First, select Auto Tray Switch from the operator panel. Then, select Auto Tray Switch in the printer driver.  
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 Configure the same paper settings of the tray to be used for both the machine and the printer driver. 

 Loading paper  

 

When using the MP tray 

By default, [When Mismatching] is set for the MP tray. In this case, the MP tray is not subject to auto tray 

switch. 

To set the MP tray as a target for auto tray switch, use the following settings. 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

3 On the functional number screen, press «9», «5» and «OK». 

4 Press the scroll button ▲ to select [Normal Tray], and press «OK». 

 
 Trays are switched according to the setting of [Tray Sequence]. 

5 Press «ON LINE» to return to the standby screen. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Paper Feed Options] in the [Setup] tab. 

5 Check [Auto Tray Change] in [Paper feed options], and click [OK]. 

6 Specify other settings as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] in the [Layout] tab. 

5 From [Tray Switch] in [Printer Features], select [On]. 

6 Click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 
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2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel. 

4 Check [Tray Switch] in the [Feed] tab. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

Changing default settings of the printer driver 

You can set those frequently used functions as the default settings of the printer driver. 

 

For Windows 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the icon [PRINTRONIX LP654C *], and select [Printing preferences]. 

* represents the type of printer driver you want to use. 

3 Configure the print settings to be used as the default settings of the printer driver. 

4 Click [OK]. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Configure the print settings to be used as the default settings of the printer driver. 

4 Select [Save Current Settings as Preset] from [Presets]. 

5 Input a name for the setting, and click [OK]. 

6 Click [Cancel]. 

 
 To use the saved setting, select the set name from the [Presets] in the print screen. 

Printing with frequently used settings registered in the printer driver 

Registering frequently used settings 

You can save the settings in the printer driver. 

 
 This function is not available to the Windows PS printer driver. 

 

For Windows PCL printer driver 

 
 Up to 14 settings can be saved. 

1 Open the "Devices and Printers". 

 How to open the printer folder  
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2 Right-click on the icon [PRINTRONIX LP654C PCL6], and select [Printing preferences]. 

3 Set the print setup you want to save. 

4 In the [Setup] tab, click [Save] in the [Driver Settings]. 

5 Specify a name for the setting to save, and click [OK]. 

6 Click [OK] to close the [Printing preferences] screen. 

 

For macOS 

 
 You can change the default settings on the [Page Setup] screen. 

 Settings saved with other printer drivers cannot not be guaranteed. Save the setting with a name that identifies the 

model name. 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Set the print setup you want to save. 

4 Select [Save Current Settings as Preset...] from [Presets]. 

5 Input a preset name, and click [OK]. 

 

Printing with registered settings 

 
 This function is not available to the Windows PS printer driver. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the setting name to be used from [Driver Setting] in the [Setup] tab. 

5 Click [OK]. 

6 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the setting to be used from [Presets]. 

4 Click [Print]. 

 
 When you select [Show Presets] from [Presets] and uncheck [Reset Preset Menu to "Default Settings" after Printing], 

the preset you set will always be applied. 
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Printing data stored in this machine 

The print data can be stored in the built-in memory of this machine. Because the work on the PC completes 

more quickly, the PC can do other work while the machine is operating in the background. 

 
 If the spooled data cannot be stored due to insufficient capacity of the memory, a message is displayed indicating 

that the file system is full and the printing will not be performed. 

 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Select [Job Spool], select [ON] for [Settings], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Check [Job Spool], and click [OK]. 

7 Specify other settings as necessary, and click [OK]. 

8 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel. 

4 In the [Quality2] tab, check [Job Spool]. 

5 Specify other settings as necessary, and click [Print]. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

Printing data from a USB memory 

You can connect a USB memory to this machine, and print the data saved on it. 
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 We do not guarantee the use of all USB memory products (The USB memory with security function is not supported). 

 Not compatible with USB 3.0. 

 Not compatible with the USB Hub or external USB-HDD. 

 Not compatible with encrypted PDF. 

 
 Compatible with FAT12, FAT16 and FAT32. 

 Compatible with PDF (v1.7), JPEG, TIFF (v6 baseline), PRN (PS, PCL), and OBC. 

 Refer to "Printing QR codes or barcodes " for printing files in the OBC format. 

 Create data in ASCII form. 

 Compatible with a maximum of 32GB USB memory. 

 Among all the files saved in the USB memory with the compatible file format, a maximum of 100 files are displayed in 

the file list. 

 The file list will not be displayed correctly if more than 100 files are stored on the USB memory. 

 Files may not be read correctly from the USB memory with a directory structure of 20 or more layers. 

 Files with a path length of over 240 characters may not be read correctly. 

 Only one file in the USB memory can be printed at a time. 

 

1 Insert the USB memory to the accessory connector (ACC) of this machine. 

 

2 Check that [Select File] is displayed, and press the scroll button ▲ or ▼ to select the file to 

print, and press «OK». 

3 To set the number of printing sheets and other items, press ▼ to select [Print Setup] and press 

«OK». 

After completing the settings, press «BACK» to return to the screen of the file you want to print. 

4 Press ▼ or ▼ to select [Execute], and press «OK». 

The screen returns to the file list screen once the printing is completed. To continue printing, select the 

file from [Select File] and repeat Steps 4 and 5. 

If you do not want to continue printing, press «ON LINE». 

5 You can remove the USB memory when a message appears indicating that you can safely 

remove it. 

 

Canceling the printing 

To cancel the printing from the USB memory, press «CANCEL» on the operator panel. 

Please see "Canceling the printing " for details. 

 
 The pages ready for printing in this machine will be printed as they are. 
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Printing QR codes or barcodes 

You can print a QR code or barcode if you save the file containing the URL or the like in the OBC format to a 

USB memory, then connect the USB memory to this machine and finally print the file. 

Before printing, specify the number of rows and columns in which one QR code or barcode is to be placed on 

one sheet of paper. 

The printable formats are as follows. The factory default setting is [QRCode]. 

QRCode, UPC-A, UPC-A +2, UPC-A +5, UPC-E, UPC-E +2, UPC-E +5, EAN/JAN-8, EAN/JAN-8 +2, 

EAN/JAN-8 +5, EAN/JAN-13, EAN/JAN-13 +2, EAN/JAN-13 +5, 

Interleaved2of5, Interleaved2of5 + CHK, Code39, Code39 + CHK, Code128 autoswitch, Code128 A, Code128 

B, Code128 C, EAN/UCC-128, CODABAR, 

CODABAR + CHKmod16, ZIP +4 POSTNET 5, ZIP +4 POSTNET 9, ZIP +4 POSTNET 11, and custom 

barcodes 

This section uses Notepad (a Windows accessory application) as an example. 

 

1  Attach a USB memory to your computer. 

2 Open Notepad, and input the text string you want to display when scanning the QR code or 

barcode. 

 
 Only one type of QR codes or barcodes can be printed in one file. 

3 After you have finished the input, select [File] - [Save as], and click on the USB memory. 

4 Select [All Files] from [File Type]. 

5 Input any text string with an extension of [.obc] in [File Name], and click [Save]. 

Example of the file name: aaaaa.obc 

6 Close Notepad. 

7 Remove the USB memory from the computer. 

8 Insert the USB memory to the accessory connector (ACC) of this machine. 

9 Check that [Select Print File] appears on the display, press the scroll button ▲ or ▼ to select 

the file to be printed, and press «OK». 

10 Press ▼ to select [Barcode Print Setup], and press «OK». 

11 Input the number of QR codes or barcodes to be printed using the numeric keypad since 

[Repeat] is selected, and press «OK». 

12 Press ▼ to select [Layout Rows], and press «OK». 

13 Input the number of rows to be printed on one page using the numeric keypad, and press 

«OK». 

14 Press ▼ to select [Layout Columns], and press «OK». 

15 Input the number of rows to be printed on one page using the numeric keypad, and press 

«OK». 

16 Press ▼ to select [Barcode Type], and press «OK». 

17 Press ▲ or ▼ to select the type of the barcode to be printed, and press «OK». 

18 Press «BACK» to return to the screen of the file you want to print. 



 

- 191 - 

19 Press ▲ or ▼ to select [Print], and press «OK». 

 
 If the text string in the file (.obc) does not meet the standard of the QR code or barcode to be printed, X is printed on 

the QR code or barcode. 

 If there is no text string in the file (.obc), a blank page is printed. 

Printing PS errors 

You can print the error content when a PostScript error occurs. 

 
 This function is not applicable to the PCL printer driver or macOS. 

 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Advanced] in the [Layout] tab. 

5 Click [Send PostScript Error Handler] under [PostScript Options], and select [Yes] from the 

drop-down list. 

6 Click [OK] until the [Printing preferences] is closed. 

7 Click [Print] in the [Print] screen. 

Editing margins 

You can extend the margins to the top, bottom, left, and right to 30.0 mm/1.18 inches, change the printable 

area, and print on the paper to be printed. 

 
 This function is available to the Windows PCL printer driver only. 

 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Click [Advanced]. 

6 Select [Edit Margins] in [Item], set it to [On] in [Settings], and click [Options]. 

7 Input margin values for [Top], [Bottom], [Left] and [Right], and click [OK]. 

8 Click [OK]. 

9 Specify other settings as necessary, and click [OK]. 

10 Click [Print] in the [Print] screen. 
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Correcting the print position of the tray 

You can correct the print start position vertically and horizontally on paper for each tray. Set the correction 

volume in increments of 0.25 mm on the operator panel. 

[X Adjust] and [Y Adjust] correct the simplex printing and the back side (the printing side fed from the tray) of 

duplex printing. 

[Duplex X Adjust] and [Duplex Y Adjust] correct the face side (the printing side fed from the duplex unit) of 

duplex printing. 

 
 The thick arrows in the figure indicate the paper feed direction. 

 X indicates the vertical direction of paper travel, and Y the horizontal direction of paper travel. 

 Correct with [+] to widen the blank space in the X direction, and [+] to widen the blank space in the Y direction. 

 Readjustment might be necessary depending on the usage conditions (temperature and humidity/media type). 

 This function corrects the position and does not improve the writing start position (±2mm). 

 

 
 The corresponding function numbers for each tray are listed below. 

Target tray Function number 

Multi-purpose tray (MP tray) 220 

Tray 1 221 

Tray 2 222 

Tray 3 223 

Tray 4 224 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

3 When the function number screen is displayed, press the function number of the tray you want 

to correct, and then press «OK». 

4 Press the scroll button ▲ or ▼ to select the time to correct. 

5 Press «OK». 

6 Press ▲ or ▼ to select the correction volume, and press «OK». Make sure that a check is 

displayed to the left of the selected value. 

7 Press «ON LINE» to return to the standby screen. 
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Printing with print data encrypted and password set (Private Print) 

When printing private jobs, to prevent others from seeing the printing results of personal and confidential 

documents, the print data is encrypted and saved with a password in the machine's memory, and it is 

authenticated and printed from the operator panel. 

Because the print data is sent encryptedly, unauthorized access to confidential information can be prevented. 

 
 If the spooled data cannot be stored due to insufficient capacity of this machine's internal memory, a message is 

displayed indicating that the file system is full and the printing will not be performed. 

 When using a print server for network sharing on this machine, the Windows PCL printer driver cannot use this 

function in conjunction with the poster printing or booklet printing. 

 To use this function, uncheck [Job Spool]. 

 Printing data stored in this machine  

 

Setting encryption/password on the PC 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Select [Job Type] of [Private Print]. 

6 Input any password in [Password] of [Job Type Option]. 

7 Click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 

Only the print data with a password set for encryption is sent to this machine, but without printing. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Job Options] tab. 

5 Select [Job Type] from [Private Print]. 

6 Input the password in [Password] of [Job Type Option]. 

7 Click [OK]. 

8 Specify other settings as necessary, and click [OK]. 

9 Click [Print] in the [Print] screen. 

Only the print data with a password set for encryption is sent to this machine, but without printing. 
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For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Secure Print] panel. 

4 Select [Job Type] of [Secure Print]. 

5 Input the password in [Job Password]. 

6 Specify other settings as necessary, and click [Print]. 

Only the print data with a password set for encryption is sent to this machine, but without printing. 

 
 If there is no detail settings displayed in the [Print] screen, click [Show details] at the bottom of the screen. 

 

Printing a document with encryption/password set from this machine 

You can print the encrypted print data with a password saved in the machine's internal memory. 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press «Fn» on the operator panel. 

3 On the functional number screen, press «2» and «OK». 

4 When the User List appears, select the user name of your PC and press «OK». 

5 Input the password set on the PC, and press «OK». 

6 When a list of private jobs appears, press the scroll button ▲ or ▼ to select the print data to 

print and press «OK». 

7 Check that [Execute] is selected, and press «OK». 

Select [Delete] and press «OK» to delete the specified print data. 

 
 The print data saved in the memory is automatically deleted when the print data has been printed or has not 

been printed after a certain period of time. If an error occurs sending data or it is detected that the print data has 

changed since it was sent from the PC, the print data will be deleted automatically. 
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Canceling the printing 

To cancel the data being printed or ready to print, press «CANCEL» for a short time (2 seconds or less) on the 

operator panel. 

 
 You can change how long the button is pressed from [Cancel Key Behavior] of the menu items. 

 

If you press «CANCEL», the following screen will be displayed. 

 

To cancel the printing, select [Yes] and press «OK». 

To continue the printing, select [No] and press «OK». 

If no operation is done within 3 minutes while this screen is displayed, the screen display will disappear and 

printing will continue. 

 

Canceling the printing from the PC 

Cancel the printing from your PC if you accidentally send a large amount of data from your PC to the printer. 

 

For Windows 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the printer’s icon, and select [See what's printing]. 

3 Select the name of the file that you want to cancel printing. 

4 Press the <Delete> key on the keyboard. 

5 Check the operator panel of this machine. 

If "Processing" or "Data Present" is displayed, cancel the printing from this machine’s operator panel. 

 

For macOS 

1 Select [System Preferences] from the Apple menu. 

2 Click [Printers & Scanners]. 

3 Click the icon of the printer. 

4 Click [Open the Print Queue...]. 

5 Select the name of the file that you want to cancel printing. 

6 Click [x]. 
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7 Check the operator panel of this machine. 

If "Processing" or "Data Present" is displayed, cancel the printing from this machine’s operator panel. 
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Management of this machine 
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Admin password 

The admin password is used to change the settings of the machine. 

We recommend you to change the admin password to protect your personal information. 

Checking the factory default admin passwords 

The factory default admin password is set to a 10-digit value of this machine's serial number with upper-case 

letters converted to lower-case ones. 

Examples of serial number and admin password 

Item Example Value checked by customer 

Serial number AB01234567  

Admin password ab01234567  

 
 The serial number may be displayed as [Serial Number] or [Serial No.]. 

 

Check the machine's serial number with one of the following methods. 

 Check by the display on the operator panel. 

 Check by printing the menu map. 

 Check against the sticker inside the machine. 

 

This section explains the procedure assuming that the machine's serial number is "AB01234567". 

 

 

Checking by the display on the operator panel 

 
 On the operator panel, the serial number is displayed as [Serial Number]. 

1 Press the scroll button ▼ on the operator panel several times to select [Configuration], and 

press «OK». 

 

2 Press ▼ or ▲ several times to select [System], and press «OK». 

 



 

- 199 - 

3 Check that [Serial Number] is selected, and press «OK». 

 

4 Check the 10-digit alphanumeric characters displayed in [Serial Number]. 

 

5 Convert the upper-case letters of [Serial Number] into lower-case ones and use the converted 

string as the admin password. 

 

Checking by printing the menu map 

 
 On the menu map, the serial number is displayed as [Serial Number]. 

1 Print the menu map. 

 Printing the menu map (configuration)  

2 Check [Serial Number]. 

 

3 Convert the upper-case letters of [Serial Number] into lower-case ones and use the converted 

string as the admin password. 

 

Checking against the sticker inside the machine 

1 Pull the front cover open lever (blue) to open the front cover. 
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2 Check the leftmost 10 digits of the alphanumeric characters written on the sticker on the left to 

the L2 lever. 

 

3 You may convert the upper-case letters into lower-case ones and use the converted string as 

the admin password. 

Inputting the factory default admin passwords 

This section explains the procedure assuming that the factory default admin password is "ab01234567". 

 Checking the factory default admin passwords  

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Press «2» twice using the numeric keypad to confirm that "a" is displayed, and press «OK». 

The entered character is displayed in "*" and the cursor moves to the next position. 

 

4 Press «2» for three times to confirm that "b" is displayed, and press «OK». 

 

5 Press «0» and then «OK». 

6 Press «1». 

 
 It is not necessary to press «OK» since «1» is confirmed by one press. 

7 Press «2» and then «OK». 

8 Input the remaining characters by the same procedure. 
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9 Press «OK» again to complete inputting the admin password and display [Admin Setup]. 

 

Changing the admin password 

The admin password can consist of 1 to 32 digits. 

The following characters can be used for the admin password. 

 Upper-case letters 

 Lower-case letters 

 Figures 

 Symbols: [Space] ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ ] ^ _ ` { | } ~ 

 

 
 Be sure to write down the password you set just in case you forget. 

 If you forget the changed password, you cannot change [Admin Setup] or [Boot Menu]. 

 If you wish to reset the password, the charged service by maintenance staff will be necessary. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

 

This section describes how to change the factory default admin password as an example. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the factory default admin password. 

 Inputting the factory default admin passwords  

4 Press the scroll button ▲ or ▼ on the operator panel several times to select [Change 

Password], and press «OK». 

 

5 Enter a new password and press «OK». 

 Inputting text  

 



 

- 202 - 

6 Press «OK» again to display the [Verify Password] screen. 

 

7 Input the password again, and press «OK». 

 

8 When «OK» is pressed again, the password has been changed and the screen returns to 

[Admin Setup]. 

 

 

Admin password memo field  
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Changing settings of Admin Setup 

This section explains the procedure of changing settings of this machine as an administrator. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Press ▲ or ▼ to select the menu for which you want to change the settings, and press «OK». 

5 Press ▲ or ▼ to change the settings. 

6 Press «OK». 

7 Press «ON LINE» to return to the standby screen. 
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Web page (Managing this machine from a PC) 

You can manage this machine by accessing the web page of this machine from a PC. What you can do with 

the web page is as follows. The web page can be used on both Windows and macOS. 

 Displaying the state of this machine 

 Setting up the tray, network, default settings of each function, and this machine 

 Displaying the print data list 

 Printing PDF files without printer driver 

 Links to frequently used web pages 

 
 To change settings of this machine from the web page, it is necessary to log in as an administrator. 

Opening the web page 

 
 Set the security level of your browser to medium or enable Cookies. 

This section takes the following environment for example. 

 Device name: LP654C 

 IP address of this machine: 192.168.0.2 

 

1 Start the web browser. 

2 Input the URL "http:// (this machine's IP address)" in the address bar, and press the «Enter» 

key. 

The IP address of this machine is available on the printed menu map. 

 Printing the menu map (configuration)  

 

 
 If the IP address includes values of 1 or 2 digits, do not add "0" before such values. Otherwise, communication 

may fail. 

 Correct: http://192.168.0.2/ 

 Wrong: http://192.168.000.002/ 

Logging in as an administrator 

To change the settings of this machine using the web browser, it is necessary to log in as an administrator. 
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1 Click [Administrator Login]. 

 

2 Input "admin" in [User Name] and the current password in [Password], and click [OK]. 

 

 
 The password is the same as "Admin Password" on the operator panel. 

 Admin password  

 When access control is enabled, you can log in as a local user with administrator privileges (with .AdminRole 

assigned). 

3 The following screen is displayed. 

 

Changing admin password (Web page) 

You can change the admin password of this machine from the web page. The admin password specified on 

the web page is used to log into this machine or to change settings from the operator panel or web page. 

The admin password can consist of 1 to 32 digits. 

The following characters can be used for the admin password. 

 Upper-case letters 

 Lower-case letters 

 Number 

 Symbols: ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ ] ^ _ ` { | } ~ 

 
 Be sure to write down the password you set just in case you forget. 
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 If you forget the admin password, you cannot change [Admin Setup] or [Boot Menu]. Or, if you wish to reset the 

password, the charged service by maintenance staff will be necessary. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Management] - [Admin Password]. 

5 Input the new password in [New Admin Password]. 

6 Input the new password again in [New Admin Password(Verify)]. 

The password you input is not displayed. Write down your password and keep it in a safe place. 

7 Click [Submit]. 

 
  It is not necessary to restart the machine. The next time you log in as an administrator, use the new password. 

Checking/Changing the state of this machine 

 
 Set the security level of your browser to medium or enable Cookies. 

 The admin password is required to enter [Admin Setup]. 

 Changing admin password (Web page)  

 To change settings of this machine from the web page, it is necessary to log in as an administrator. 

 Logging in as an administrator  

 About network setup 

 Connecting via a wireless LAN  

 Connecting via a wired LAN  

 

This section takes the following environment for example. 

 Device name: LP654C 

 IP address of this machine: 192.168.0.2 

 

Checking the state of this machine 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  
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3 The following screen is displayed. 

You can check the supplies life, print statistics, and network and system information of this machine. 

 

 

Changing settings of this machine 

You can change settings of this machine from the web page. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Change the settings, and click [Submit]. 

You can change settings of this machine from the following tabs. 

 Paper Setup 

You can set the paper size or media type for each tray. 

 Admin Setup 

 Job Lists 

 Direct Print 

 Links 

 User Management 

Saving configurations 

The settings of this machine and the usage of consumables and maintenance parts can be saved as a CSV 

file. 

 

1 Open the web page of this machine. 

 Opening the web page  
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2 Click [Export MenuMap]. 

 

3 Save it with a name. 

Communication encryption (SSL/TLS) 

You can encrypt the communication between your PC and this machine. The communication is encrypted with 

SSL/TLS in the following cases. 

A certificate is pre-installed on this machine to enable the communication using HTTPS. 

 

Creating a certificate 

You can use a certificate when sending data to this machine connected to a network. This section describes 

how to create a certificate from the web page. 

The following two types of certificates can be created. 

 Self-signed certificate 

This certificate is issued by this machine. 

 Certificate issued by certificate authority 

This certificate is signed and issued by an external certificate authority for CSR (Certificate Signing 

Request) created by this machine. 

 
 Before creating a certificate, make sure that the certificate already installed has been deleted. 

 If an IP address is set in [Common Name] of the certificate, the certificate will be invalidated when the printer IP 

Address is changed after the certificate is created. Please create a certificate again. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Security] - [SSL/TLS]. 

5 Click [Delete Certificate] to delete the certificate already installed. 

 
 If the certificate has been removed, proceed to Step 6. 

6 Configure the settings following the on-screen instructions. 
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7  Confirm the settings, and click [OK]. 

 For a self-signed certificate, follow on-screen instructions to close the web page, and proceed to 

"Enabling encryption settings". 

 To obtain a certificate issued by a certificate authority, go to Step 7. 

8 Send the CSR to the certificate authority by following on-screen instructions. 

9 Click [OK]. 

10 Install the certificate from the certificate authority by following on-screen instructions. 

11 Click [Submit]. 

See "Enabling encryption settings". 

 

Importing a certificate and private key 

This section describes how to import the certificate and private key from the web page. 

You can also import the certificate and private key to use the certificate issued by an external certificate 

authority. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Security] - [SSL/TLS]. 

5 Select [Using Certificate and Private Key after imported] to import the certificate. 

 
  You can import a certificate in PKCS#12 format. 

See "Enabling encryption settings". 

 

Enabling encryption settings 

You can enable the encryption settings after creating a certificate. This section describes how to enable the 

encryption from the web page. 

When the encryption is enabled, it will be encrypted from the communication immediately after changing the 

setting from the web page. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Security] - [SSL/TLS]. 

5  Select [Enable] for the protocol you want to apply the encryption to. 

6 Click [Submit]. 
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Exporting a certificate 

This section describes how to export a certificate from the web page. 

Depending on the SSL/TLS communication function, your PC may require to trust the machine's certificate. 

Import the exported certificate of the machine into the PC's trusted certificate store in order for the PC to trust 

the machine. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Security] - [SSL/TLS]. 

5 Select [Export Certificate] to export the certificate. 

 
  The certificate is exported in the PEM format. 

Using IPP 

Add this machine as an IPP printer in a PC. 

 

For Windows 

1 Open the "Devices and Printers", and select [Add Printer]. 

 How to open the printer folder  

2 In the [Add Printer] wizard, select [Add a Network, Wireless, or Bluetooth Printer]. 

3 Select [The printer that I want isn't listed] from the list of usable printers. 

4 Select [Select a shared printer by name]. 

5 Input "http://(IP address of this machine)/ipp" or "http://(IP address of this machine)/ipp/lp", and 

click [Next]. 

6 Click [Have Disk]. 

7 Insert the included DVD to the PC. 

If your PC does not come with a DVD drive, double-click on the driver software file downloaded from the 

website to unzip it. 

8 Input the following values in [Copy manufacturer's files from], and click [Ref]. 

For installing the PCL printer driver: "D:¥Drivers¥_PCL" 

For installing the PS printer driver: "D:¥Drivers¥_PS" 

 
 The above values are examples when the DVD drive is set to the D drive. 

 If your PC does not come with a DVD drive, specify the folder unzipped in Step 7. 

9 Select the INF file, and click [OPEN]. 

10 Click [OK]. 

11 Select a model, and click [OK]. 

12 Click [Next]. 

13 Click [Completed]. 
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14 When the installation has completed, print a test page. 

 

For macOS 

1 Insert the included DVD to the PC, and install the driver. 

 Installing software  

2 Select [System Preferences] from the Apple menu. 

3 Click [Printers & Scanners]. 

4 Click [+]. 

5 Click the [IP] tab. 

6 Select [IPP (Internet Printing Protocol)] in [Protocol]. 

7 Input the IP address of this machine in [Address]. 

8 Input "ipp" in [Cue]. 

9 Click [Add]. 

10 Click [Continue]. 

11 Check if this machine has been registered in [Printers & Scanners]. 

Communication encryption (IPSec) 

You can encrypt the communication between your PC and this machine. 

Encrypt the communication with IPSec. When IPSec is enabled, all applications are encrypted using IPSec. 

You can specify 50 hosts per IP address. Any access to this machine from an unregistered host will be 

denied. Any attempt to access an unregistered host will be invalidated. 

Set up your PC after setting up this machine in advance. 

 
  You need to prepare a pre-shared key beforehand. 

 

Setting up this machine 

To enable IPSec, it is necessary to configure the machine from the web page first. 

 
  When IPSec is enabled, any communication with the host not specified in this step will be denied. 

 IPSec communication is done when IPSec is set for this machine and the host. If IPSec is not set on the host, IPSec 

communication will not be done. 

 Be sure to make a note of the values you specify in this step. They will be required to configure IPSec settings on a 

PC. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Security] - [IPSec]. 
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5 Configure the settings following the on-screen instructions. 

 
  For the "Phase 2 Proposal" setting, [AH] or [ESP] must be enabled. 

 [AH] and [ESP] cannot be used simultaneously. When both [AH] and [ESP] are enabled, only [ESP] is used. 

6 Click [Submit]. 

The new settings will take effect after the network function of the machine has been reset. 

 
 If IPSec cannot be set up due to the inconsistency of specified parameters, the web page cannot be accessed. In this 

case, disable IPSec or initialize network settings from the operator panel of this machine. 

 

Go to "Setting up your PC". 

Setting up your PC 

It is necessary to set IPSec on your PC. For the setting method on the PC, please consult your network 

administrator. 

Using the access control function (IP filter) with the IP address 

You can use the IP Address to control the access to this machine. You can set whether to authorize setup or 

printing from the specified IP address. IP filtering is disabled by default. 

 
 Be sure to specify the correct IP address. If you specify an incorrect IP Address, you will not be able to access the 

machine using the IP protocol. 

 When IP filtering is enabled, any access to the host not specified in this setting will be denied. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Security] - [IP Filtering]. 

5 Configure the settings following the on-screen instructions. 

 
 If nothing is registered in [Administrator's IP Address setting], access to this machine may be disabled 

depending on the specified IP address range. 

 If you are using a proxy server, [Your Current Local Host/Proxy IP Address] may not match the IP address of 

the current host. 

6 Click [Submit]. 

The new settings will take effect after the network function of the machine has been reset. 

 
 IP filtering is applicable only to IPv4.  
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Using the access control function with the MAC address 

You can use the MAC Address to control the access to this machine. You can allow or deny the access from 

the specified MAC Address. 

 
 Be sure to specify the correct MAC address. If you specify an incorrect MAC address, you will not be able to access 

the machine using the network. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Security] - [MAC Address Filtering]. 

5 Configure the settings following the on-screen instructions. 

 
 If nothing is registered in [Administrator's MAC Address setting], access to this machine may be disabled 

depending on the specified MAC address range. 

 If you are using a proxy server, [Your Current Local Host/Proxy MAC Address] may not match the MAC address 

of the current host. 

6 Click [Submit]. 

The new settings will take effect after the network function of the machine has been reset. 

 
 You cannot specify the access control individually for each address. 

Notifying errors via e-mail 

Errors of consumables or maintenance parts are notified via e-mail. You can also set the timing of notification. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Mail Server Setup]. 

5 Select [Enable] in [SMTP Send]. 

6 Input the e-mail server name or the address of e-mail server in [SMTP Server]. 

7 Set the mail address allocated to this machine in [Device E-mail Address]. 

8 Set appropriate values for other setting items if necessary. 

9 Select [Network] - [Email] - [Alert Settings]. 

10 Input the e-mail address to receive notifications in [E-mail Alert Settings]. 

11 Click [Settings] for the email address you input. 

If you want to apply the notification condition to another address, click [Copy]. 
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12 When the [E-mail Alert Settings] screen is displayed, select appropriate settings in [Way of E-

mail Alerting], and click [To STEP2]. 

 
 When you select [Upon occurrence of an event], an error is notified just once. 

 When you select [Periodically], an error is notified periodically until it is cleared. 

13 Configure the settings following the on-screen instructions. 

14 Click [OK]. 

15 Click [View a summary of current configuration] to check the current settings, and click [X] to 

close the window. 

You can also check the current settings of up to two addresses in the home window. Select the address 

you want to check from the list. 

16 Click [Submit]. 

The new settings will take effect after the network function of the machine has been reset. 

 
 If no notification target error occurs, the notification e-mail will not be sent. 

Using SNMPv3 

By using the SNMP manager that is compatible with SNMPv3, the management of this machine can be 

encrypted with SNMP. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [SNMP] - [Settings]. 

5 Configure the settings following the on-screen instructions. 

6 Click [Submit]. 

The new settings will take effect after the network function of the machine has been reset. 

 
 You can use a commercially-available SNMP manager to verify and change the settings of this machine. For the MIB 

of this machine, refer to the supplied DVD, and check the MIB definition file in the [Misc] - [MIB Files] folder. 

Using IEEE802.1X (Wired LAN) 

This machine is compatible with IEEE802.1X authentication. IEEE802.1X authentication is possible after 

IEEE802.1X authentication on the web page of this machine is enabled and the authentication switch is 

connected. 

 

Setting with EAP-TLS 

This section describes how to set up EAP-TLS, one of the IEEE802.1X authentication. 
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1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [IEEE802.1X]. 

5 Select [Enable] in [IEEE802.1X]. 

6 Select [EAP-TLS] in [EAP Type]. 

7 Input the user name in [EAP User]. 

8 Select [Not use SSL/TLS Certificate for EAP authentication], and click [Import]. 

9 Input the file name of the certificate. 

Only PKCS#12 files can be imported. 

10 Input the certificate password, and click [OK]. 

11 Select [Authenticate Server], and click [Import]. 

12 Input the file name of the CA certificate, and click [OK]. 

Specify the CA certificate used for RADIUS server authentication. PEM, DER and PKCS#7 files can be 

imported. 

13 Click [Submit]. 

The new settings will take effect after the network function of the machine has been reset. 

14 When the machine is online, power off the machine. 

15 Remove the LAN cable from the machine. 

16 Go to "Connecting this machine to the authentication switch". 

 

Setting with PEAP 

This section describes how to set up PEAP, one of the IEEE802.1X authentication. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [IEEE802.1X]. 

5 Select [Enable] in [IEEE802.1X]. 

6 Select [PEAP] in [EAP Type]. 

7 Input the user name in [EAP User]. 

8 Input the password in [EAP Password]. 

9 Select [Authenticate Server], and click [Import]. 

10 Input the file name of the CA certificate, and click [OK]. 

Specify the CA certificate used for RADIUS server authentication. PEM, DER and PKCS#7 files can be 

imported. 
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11 Click [Submit]. 

The new settings will take effect after the network function of the machine has been reset. 

12 When the machine is online, power off the machine. 

13 Remove the LAN cable from the machine. 

14 Go to "Connecting this machine to the authentication switch". 

 

Connecting this machine to the authentication switch 

1 Check that this machine is powered off. 

2 Connect the LAN cable to the network interface connector of this machine. 

3 Connect the other end of the LAN cable to the authentication port of the authentication switch. 

4 Power on this machine. 

5 Set the IP address of this machine. 

Setting IEEE802.1X (Wireless LAN) 

You can set IEEE802.1X authentication with a wireless LAN. First, access the web page of this machine via a 

wired LAN to set IEEE802.1X authentication, and then set the wireless connection on the web page. 

 

Setting with EAP-TLS 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

3 Select [Admin Setup]. 

 Logging in as an administrator  

4 Select [Network] - [IEEE802.1X]. 

5 Select [Disable] in [IEEE802.1X]. 

6 Select [EAP-TLS] in [EAP Type]. 

7 Input the user name in [EAP User]. 

8 Check [Not use SSL/TLS Certificate for EAP authentication], and click [Import]. 

 
 If you select [Use SSL/TLS Certificate for EAP authentication], the certificate must be preset from the [SSL/TLS] 

menu. 

9  Select the certificate file. 

Only PKCS#12 files can be imported. 

10 Input the certificate password, and click [OK]. 

11 Select [Authenticate Server], and click [Import]. 

 
 When you select [Not Authenticate Server], go to Step 13. 
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12  Select the CA certificate file, and click [OK]. 

 
 Specify the CA certificate used for RADIUS server authentication. PEM, DER and PKCS#7 files can be 

imported. 

13 Click [Submit]. 

14 When this machine is online, go to "Connecting to a wireless LAN (WPA/WPA2-EAP) ". 

 

Setting with PEAP 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [IEEE802.1X]. 

5 Select [Disable] in [IEEE802.1X]. 

6 Select [PEAP] in [EAP Type]. 

7 Input the user name in [EAP User]. 

8 Input the password in [EAP Password]. 

9 Select [Authenticate Server], and click [Import]. 

 
 When you select [Not Authenticate Server], go to Step 11. 

10 Select the CA certificate file, and click [OK]. 

 
  Specify the CA certificate used for RADIUS server authentication. PEM, DER and PKCS#7 files can be 

imported. 

11 Click [Submit]. 

12 When this machine is online, go to "Connecting to a wireless LAN (WPA/WPA2-EAP) ". 

Connecting to a wireless LAN (WPA/WPA2-EAP) 

This machine supports the wireless LAN security method WPA/WPA2-EAP. 

Before setting WPA/WPA2-EAP as the wireless LAN security method, it is necessary to complete the wired or 

Wireless(AP Mode) network connection and set from the [IEEE802.1X] menu. 

See "Setting IEEE802.1X (Wireless LAN) ". 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [Wireless(Infrastructure)]. 
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5 Select [Enable] in [Wireless(Infrastructure)] of [Basic Settings]. 

 

 
 The factory default setting is "Disable". 

6 Select [Manually set the connection to access point ] in [Wireless Network Selection]. 

7 Select [Next]. 

8 Input the SSID name of the Wireless(AP Mode) network to connect in [SSID]. 

 

9 Select [WPA/WPA2-EAP] in [Security] of [Security Settings]. 

 

10 After all the basic settings and security settings are configured, click the [Submit] button on the 

lower left corner of the web screen to apply the settings. It may take about 1 minute to connect 

to the Wireless(AP Mode) network. If the connection fails, reset the wireless settings from the 

operator panel, or switch to wired LAN from the operator panel and reset the wireless settings 

from the web page. 

Setting the LDAP server 

 
 Consult your network administrator for the LDAP server and encryption setup. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Select [Network] - [LDAP Server Setting]. 

5 Input the FQDN or IP address of the LDAP server in [LDAP Server]. 

 
  When selecting [Digest-MD5] or [Secure Protocol] for [Method] in Step 9, input the FQDN instead of the IP 

address. An FQDN is a combination of the host name and domain name. (Example of FQDN: 

Server1.domain.local) 

6 Input the port number of the LDAP server in [Port Number]. 

7 In [Timeout], specify the timeout value to wait for the search result. 

8 Specify the BaseDN to access the LDAP server in [Search Root].  
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9 In [Method], select the required authentication method. 

[Anonymous]: Selected to access the LDAP server using anonymous authentication. 

[Simple]: Selected to access the LDAP server using simple authentication. 

[Digest-MD5]: Selected to access the LDAP server using Digest-MD5 authentication. 

[Secure Protocol]: Selected to access the LDAP server using Secure Protocol (Kerberos) authentication. 

 
 If [Anonymous] is selected, authentication will always be anonymous, even when the LDAP server is used for 

LDAP name authentication. If the LDAP server is used for LDAP name authentication, select any authentication 

method other than [Anonymous]. 

 
 If [Digest-MD5] is selected, it is required to set the DNS server. 

 If [Secure Protocol] is selected, it is required to set the SNTP server, DNS server and secure protocol server. 

10 If any option other than [Anonymous] is selected in Step 9, specify the user ID and password to 

login to the LDAP server. 

11 Select an encryption type in [Encryption]. 

[None]: No encryption will be done. 

[LDAPS]: The encryption will be done with the LDAPS method. 

[STARTTLS]: The encryption will be done with the StartTLS method. 

12 Click [Submit]. 

Setting E-mail receiving (Web page) 

Set the protocol (POP3, SMTP, etc.) for this machine to receive e-mails. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Select [Admin Setup]. 

4 Click [Network] - [Mail Server] in the left side of the screen. 

5 Set the mail server if necessary. 

6 Click [Submit]. 

Setting the power save mode (Web page) 

Set the time that will elapse before the power save mode is entered. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [Admin Setup]. 

4 Click [Management] - [Power Setup]. 

5 Select the desired switchover time from [Power Save Time], and click [Submit]. 
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Setting the sleep mode (Web page) 

Set the time that will elapse before the sleep mode is entered. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [Admin Setup]. 

4 Click [Management] - [Power Setup]. 

5 Select the desired switchover time from [Sleep Time], and click [Submit]. 

Setting "Auto Power Off" (Web page) 

Sets the Auto Power Off function. 

 

Enables the Auto Power Off function. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [Admin Setup]. 

4 Click [Management] - [Power Setup]. 

5 Select [Enable] from [Auto Power Off], and click [Submit]. 

 

Setting "Auto Power Off Time" 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [Admin Setup]. 

4 Click [Management] - [Power Setup]. 

5 Select [Auto Power Off Time] from the transition time, and click [Submit]. 

Copying the setup information of this machine to other devices 

Exporting settings of this machine 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  
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3 Click [Admin Setup]. 

4 Click [Management] - [Settings Cloning]. 

5 Click [Settings Export]. 

 

6 Select the settings to be copied. 

 

7 Click [Export]. 

8 Specify the storage location, name the file, and click [Save]. 

 
 The file may be saved without displaying the saving screen depending on the specific browser. 

 

Importing settings of this machine 

1 Open the web page of the device to which you want to copy the settings. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [Admin Setup]. 

4 Click [Management] - [Settings Cloning]. 

5 Click [Browser], and select the copying file to export. 

6 Click [Import].  
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Setting items of the web page 

View Information 

 

Item Description 

Status Displays the current status of this machine. Displays all warnings and 

errors that have occurred in this machine as "Alert Information". Further, 

you can also check the operation status of each network service, 

information list, and IP addresses set in this machine. 

Counter Displays the quantity of printouts. 

Supplies Life Displays the remaining quantity of consumables and their service life. 

Usage Report (displayed when you log in as an 

administrator of this machine) 

Displays the Printer Usage Report. 

Network You can check network configurations such as general information, 

TCP/IP configurations and maintenance information. 

System Displays the information of this machine. 

 

Paper Setup 

This function is available when you log in as an administrator of this machine. 

 

Item Description 

Tray Configuration You can set the paper size, custom paper, etc. for each tray. 

Upon using the printer driver, the setup in the printer driver will take 

priority over this setting value. 

Paper Input Options Sets paper input options, tray switching and priority. 

Duplex Last Page Sets whether to print on both sides when the last page is single-sided. 
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Admin Setup 

This function is available when you log in as an administrator of this machine. 

 

 

Network 

Item Description 

General Network Settings Sets the connection method of the network. 

Wired(LAN1) Setup Sets the standard wired LAN connection. 

You can disable the Energy Efficient Ethernet (EEE) function of the 

wired network (LAN1) by setting [Energy Efficient Ethernet] included in 

this item to [Disable]. 

Wireless(Infrastructure) Setting Sets the wireless LAN (infrastructure) connection. 

Displayed when the wireless LAN module is installed and [Extended 

Network] is set to [Wireless]. 

Wireless(AP Mode) Setting Sets the wireless LAN (AP mode) connection. 

Displayed when the wireless LAN module is installed and [Extended 

Network] is set to [Wireless]. 

NBT Sets the information about NetBIOS over TCP. 

Mail Server Sets the information about the mail server. 

Email  Receive Settings Sets the reception of mails. 

 Setting E-mail receiving (Web page) 
 

Alert Settings Sets the function to receive notifications by email when an error has 

occurred in this machine. 

 Notifying errors via e-mail  
 

SNMP Settings Sets the information about SNMP. 

Trap Sets the information about Trap of SNMP. 

IPP Settings Sets the information about IPP printing. 

Authentication Sets the information about authentication. 

Windows Rally Sets the information about Windows Rally. 

AirPrint Enables AirPrint. 

IEEE802.1X Sets the information related to IEEE802.1X/EAP. 

Secure Protocol Server Sets the information about the secure protocol server. 

LDAP Sets the information about the LDAP server. 

Cloud Settings Sets the information about the cloud connection. 

Proxy Sets the information about proxy. 

Security Protocol ON/OFF Stops network protocols and network services that you do not use. 

IP Filtering Restricts access by TCP/IP. Controls access from outside the company. 

However, this function requires knowledge about the IP address. This 

machine may be denied from access to network due to serious 

problems depending on settings. 

MAC Address Filtering Restricts access by the MAC address. Controls access from outside the 

company. However, this function requires knowledge about the MAC 

address. This machine may be denied from access to network due to 

serious problems depending on settings. 
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Item Description 

SSL/TLS Encrypts communication between this machine and your PC (client). 

IPSec Sets the encryption and tampering of communication between this 

machine and your PC (client). 

WebPage Authentication 

Method 

Sets the web page authentication method. 

Maintenance Reset/Restore Initializes or resets the network card. If it is reset, the web page will not 

be displayed even if you access from the web browser until you have 

reset. If it is initialized, the IP address will be reset to the initial state, 

and the information set manually will be lost. In that case, you will not 

be able to view the web page. 

Network Scale This setting is to operate more efficiently on the network. When using a 

hub with a spanning tree function, this function is effective when the PC 

and this machine are connected on a one-to-one basis with a crossover 

cable. 

 

Print From USB Memory Setup 

Sets printing from the USB memory. 

Item Description 

Default Settings Sets the default value for printing from the USB memory. 

Barcode Print Setup Sets the initial value for printing barcodes. 

 

Print Setup 

Item Description 

Print Menu Print Setup Sets the number of copies, etc. Upon using the printer driver, the setup 

in the printer driver will take priority over this setting value. 

Printer Adjust Sets the printer adjustment such as manual timeout and jam recovery. 

Print Position Adjust Adjusts the print position such as X Adjust, Y Adjust, Duplex X Adjust, 

and Duplex Y Adjust. 

Drum Cleaning  Sets the image drum cleaning. 

Hex Dump  Displays all received print data in hexadecimal. This mode exits when 

this machine is restarted. 

Color Menu Sets the information about color. 

System Configuration Menu  Sets various types of actions of this machine in correspondence to 

various situations such as personality and alarm release. 

Emulation PCL Setup Sets the information about PCL. 

PS Setup Sets the information about PS. 

IBM 5577 Setup Sets the information about IBM 5577. 

Private Print 

Setup 

Verify job option Specifies whether to verify the print data before printing. 

If enabled, printing is performed after verifying that the print data has 

not been changed. The integrity of print data is guaranteed, but the time 

to start printing will be longer. 

Erase job option Sets the method for erasing the print data. 

Specifies that the data cannot be overwritten after it has been erased 

and cannot be restored. 

If you overwrite, it will take longer to erase. 

Value range: No overwrite/Zero out once 

Keep job for Sets the retention period of the print data. 

After the print data is saved, if the print data is not printed after the set 

period, the print data is automatically deleted. 

Value range: 15 min/30 min/1 hour/2 hours/4 hours/8 hours/12 hours/1 

day/2 days/3 days/4 days/5 days/6 days/7 days 
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Item Description 

 Job Limitation Sets whether to save restricted print data. 

When [Private Print only] is selected, print data other than private print 

will not be accepted. 

Verify job password Selects whether to verify the job password when the access control is 

enabled. 

Job Auto Search Selects whether to perform job search at the same time as unlocking 

the panel when the access control is enabled.   

 

Management 

Sets the information about this machine. 

Item Description 

Local Interface USB Menu Sets the information about USB. 

Access Control Setup Sets the access control function. 

System Setup Sets various types of actions of this machine in correspondence to 

various situations such as unit of measurement and alarm release. 

Power Setup Sets power save, sleep and auto power off. 

Panel Setup Sets the items to be displayed on the screen. 

Buzzer Setup Adjusts the volume when an error occurs, when the printing has 

completed, when AirPrint is checked, and when the IC card is held up (if 

the IC card reader is installed). 

Flash Memory Setup Used to initialize the flash memory and format a partition. 

Job Log Setup Sets whether to save the job log. Also used to clear saved job logs. 

Job Cancel Setup Sets the actions when «CANCEL» is pressed. 

Language 

Maintenance 

Setup 

Select Language Sets the language for the screen display, the web page display and the 

report printing. 

Font Setup Sets the information about the font output mode. 

Admin Password Sets the admin password. 

Paper Feed Roller Counter Clear Clears the counter after the paper feed roller is replaced. 

Settings Save the data set in "Setting", and initialize the recalling. 

Settings Cloning Settings Import  Transmits settings of this machine which are saved and filed to the PC. 

Settings Export File and save the settings of this machine to a PC. 

Print Statistics Enables or disables the counter of maintenance parts. 

 

User Install 

Item Description 

Setup Sets the configurations checked over the network. 

Time Setup Sets the information about SNTP. 

Other Settings Sets the notification timing for the replacement of the image drum, fuser 

and belt unit. 
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Job Lists 

This function is available when you log in as an administrator of this machine. 

 

Item Description 

Job Lists Displays a list of print data sent to this machine. You can delete 

unnecessary print data. 

 

Direct Print 

 

Item Description 

Web Printing Prints with any PDF file specified. 

E-mail Printing 

(displayed when 

you log in as an 

administrator of 

this machine) 

E-mail Printing Prints when a PDF, JPEG, or TIFF file is attached to an email received 

by this machine. 

Receive Settings Sets the email reception. 

 

Links 

 

Item Description 

Links Displays the links set by the administrator in addition to those set by the 

manufacturer. 

Edit Links (displayed when you log in as an 

administrator of this machine) 

Sets the administrator's favorite URL. You can register 5 support links 

and 5 other links. Input the URL including "http: //". 
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User Management 

This function is available when you log in as an administrator of this machine. 

 

Item Description 

User List Registers/Deletes a user to use this machine. 

A maximum of 5,000 users can be registered. 

Role List Manages the role assigned to the user. 

A maximum of 100 roles can be registered. 

Group List  Manages users registered in this machine in group. 

Up to 1,000 groups can be registered. 

LDAP 

Authentication 

Settings 

LDAP Authentication 

Settings  

Sets the user information, card ID and PIN required to use LDAP 

authentication. 

Role Assignment 

Regulations 

Defines the regulations on assigning roles to users when using LDAP 

authentication. 
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User restriction (Access control) 

Access control is a function that a user authenticated by this machine can only perform permitted operations. 

Before using this machine, user authentication is required. The information required for user authentication is 

one of the following three types: user name and password, PIN (Personal Identification Number) and IC Card. 

To use the access control function, the administrator of this machine registers the user information, sets the 

authentication method, and enables access control. 

For preparations before using the access control function, please refer to "Preparations (For the administrator) ". 

 
  A card authentication kit (optional) is required to use IC card authentication. 

 If the card authentication kit is not installed, "IC Card authentication is also available." will not be displayed. 

 
 If you have been authenticated but cannot operate, check with the administrator if the operation is permitted. 

Preparations (For the administrator) 

Before using the access control function, the device administrator shall prepare the following on the web page 

of this machine. 

Register a role to set which operations are permitted or prohibited. 

 Registering a role 

There are two methods for user authentication: Local Authentication (using user information registered with 

this machine) and server authentication (using user information registered with the server). 

If you use the local authentication method for user authentication, register users and groups. 

 Registering a user 

 Registering a group 

 
  User registration can also be performed using the Configuration Tool. 

 Registering the user name and password  

If you use server authentication for user authentication, configure server authentication settings. 

 Setting authentication server 

After registering users and configuring server authentication, enable the access control function. 

 Enabling access control 

 

Registering a role 

Register a role to assign to the user. For example, create an organizational unit name or job title role, and set 

and register the allowed operations (like printing) for each role. 

A maximum of 100 roles can be registered. You can also assign multiple roles to a single user. 

You can set to permit/prohibit the following operations for a role. 

 Printing from a PC 

 Printing from a USB memory 
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By default, two types of roles are registered. 

 .AdminRole: 

The role of the device administrator. It can be assigned to general users. A user with [.AdminRole] 

assigned can act as a device administrator and perform [Administrator Login] on the web page. 

(However, the condition is that access control is enabled and it is a local user.) 

[.AdminRole] cannot be deleted or edited. 

 .DefaultRole: 

This is the role to be assigned if no role is specified when a user is registered. 

[.DefaultRole] cannot be deleted, but the access rights can be edited. 

 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [User Management]. 

4 Click [Role List]. 

 

5 Click [Add]. 

6 When the Role Information screen is displayed, input the required information. 

 Role Name: Input any role name. The same [Role Name] cannot be registered. Also, [Role Name] 

cannot be omitted. 

 Role Description: Input a description for the role. 

 Permission: Set permission/prohibition/forced prohibition of each operation in this role. Setting forced 

prohibition will prohibit operations permitted by other roles. 

 Local User List: Add or delete a local user to which this role is assigned. 

 Kerberos User List: Add a Kerberos user to whom this role applies. 
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7 Click [Submit]. 

You can copy registered roles and add new roles based on the copied configuration. 

When you click [Copy] to the right of the role name, the role information screen will be displayed, so 

change and register the required items. 

 

Registering a user 

When performing user authentication using the local confirmation method, register the user on this machine 

from the web browser. A maximum of 5,000 users can be registered. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [User Management]. 

4 Click [User List]. 

5 Set the type of user. 

 Local User: Registers user information on this machine. 

 LDAP User: A user registered in the LDAP server. 

LDAP server authentication setting is required. LDAP user cannot be registered. 

Only reference is possible. You can check the users who used this machine. 

 Kerberos User: A user registered in the Kerberos server. 

Kerberos server authentication setting is required. Kerberos user cannot be registered. Only 

reference is possible. 

You can check the list of users who used this machine. You can also assign a role to a Kerberos 

user. 

 

6 Click [Add].  
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7 When the User Information Settings screen is displayed, input the required information. 

 User Name: Input the user name. The same [User Name] can not be registered. Be sure to set it. 

 Password: Input the password. Be sure to set it. 

 Display Name: Input the display name. 

 E-mail address: Input the user's e-mail address. 

 Language Code: Input the language code. 

 PIN: Input the user's PIN. 

 Card ID: Input the user's IC card information. 

 Role: Set the user's role. [Role] can be assigned to multiple users. 

 Group: Set the group to which the user belongs. 

 

8 Click [Submit]. 

You can copy registered roles and add new users based on the copied settings. 

When you click [Copy] to the right of the user name, the user information screen will be displayed, so 

change and register the required items. 

 

Registering a group 

Users registered in this machine can be managed in a group. Up to 1,000 groups can be registered. Up to 

5,000 users can be registered in one group. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [User Management]. 

4 Click [Group List]. 

 

5 Click [+].  
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6 When the Group Information screen is displayed, input the required information. 

 Group Name: Input any group name. Be sure to set it. 

 Group Description: Input a description for the group. 

 Local User List: Set the user you want to assign to this group. 

 Kerberos User List: Set the Kerberos user you want to assign to this group. 

7 Click [Submit]. 

You can copy already registered groups and add new groups based on the copied settings. 

When you click [Copy] to the right of the group name, the group information screen will be displayed, so 

change and register the required items. 

 

Setting authentication server 

When performing user authentication using the server authentication method, set the server settings from the 

web browser. 

Here is an example of using an LDAP authentication server. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [User Management]. 

4 Click [LDAP Authentication Settings]. 

5 Click [LDAP Authentication Settings].  



 

- 233 - 

6 Create user information based on the LDAP server information. 

Input the LDAP key from which each value is obtained. 

 Display name: Set the LDAP key to obtain the display name of user information. 

 Mail address: Set the LDAP key to obtain the E-mail address of user information. 

 Language code:  Set the LDAP key to obtain the language code of user information. 

 Group:  Set to assign users to a group automatically. Set the LDAP key to obtain the assigned 

group name. When a group with a group name defined by the same text string as the acquired text 

exists in this machine, each group is assigned. When it does not exist, a group with the group name 

of acquired text string is automatically created and assigned. 

 Card ID:  Set the LDAP key to acquire a card ID to use for the IC card authentication. When not 

using IC card authentication, you do not need to input anything. 

 PIN: Set the LDAP key to to acquire the PIN to use for PIN authentication. If you do not use PIN 

authentication, you do not need to input anything. 

 User Name:  Set the LDAP key of the user name registered in the LDAP server. 

The default value for user name is the LDAP key "sAMAccountName" for a Windows server. 

Users using a Windows server do not need to change this setting. 

 Cache authentication information: Set whether authentication information is temporarily stored in this 

machine. The factory default setting is [Disable] (Do not save temporarily). When [Enable] is set, 

user authentication can be performed even when communication with the LDAP authentication 

server is not available due to a communication breakdown, etc., so this machine can be used 

continuously. 

 Validity period of cache authentication information:  Displayed when [Cache authentication 

information] is set to [Enable]. Set the validity period of the temporarily saved authentication 

information in this machine on a daily basis. The setting range is 1 to 2000 days. After the set 

number of days, authentication with temporarily stored information will not be available any more. 

 

7 Click [Submit]. 

8 Click [Role Assignment Regulations]. 

Define regulations for automatically assigning roles to LDAP users. 

 

9 Click [Add] to add new role assignment regulations. 
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10 When the role assignment screen is displayed, input the LDAP key, the LDAP value and the 

applicable role. 

When the LDAP value which is registered in the role assignment regulations of the user, and the LDAP 

value defined by the regulations are identified at the time of authentication, apply the role which is defined 

by each role assignment regulation to each user. 

When a single user matches multiple role assignment regulations, all the roles which match those 

regulations are applied to the user. 

11 Click [Submit]. 

 

Enabling access control 

After registering users and configuring the authentication server, enable access control. 

1 Open the web page of this machine. 

 Opening the web page  

2 Log in as an administrator. 

 Logging in as an administrator  

3 Click [Admin Setup]. 

4 Click [Management]. 

5 Click [Access Control Setup]. 

 

6 Select [Enable] in [Access Control]. 

 

7 Configure access control settings according to your environment. 

 Use Email print: Set to [Color], [Mono], or [Disable]. 

When [Color] is set, printing is performed according to the color settings of the received attached file. 

When [Mono] is set, the received attached file is printed either in color or monochrome. 

When [Disable] is set, the attached file received by the E-mail printing function will not be printed.  
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 Guest user use: Guest is a user assigned to those who are not successful with user authentication 

when the access control is enabled. 

This setting is used to enable or disable the use of this machine by guest. 

When [Disable] is set, you can limit the use of this machine by users who failed the user 

authentication. Specifically, you can disable printing by users who failed the user authentication and 

the operation of the operator panel. 

When [Enable] is set, you can allow users who failed the user authentication to use this machine 

within the range of guest permissions. The definition of guest permissions can be set in the guest 

permission settings. 

[Guest] is displayed as the authentication method on the login screen. 

 Set Guest Permissions:  The screen for setting the permissions for guest authentication is 

displayed. By default, guest access rights are granted for all operations. You can define guest 

permissions according to your security policy. 

 Authentication method: Enable/Disable each authentication method. 

A user can select the authentication method within the range granted by the administrator at the time 

of authentication. 

If an unnecessary authentication method is disabled in this setting, the disabled authentication 

method will not be displayed in the user options. 

 Authentication Setting: Set the authentication method for logging into this machine or printing. 

 Default authentication method: Define the focused authentication method as default when the user 

calls the authentication screen from the operator panel. 

 Register general user's IC card: You can set whether to allow local users who are not administrator 

to register their own IC cards. When enabled, any user who logged on the operator panel without 

using IC card can register their own IC cards via the IC card reader on this machine. An 

administrator can start the IC card authentication by giving the IC card to the user after he/she has 

received the IC card. 

 Card read settings:  Set to authenticate users with the FeliCa card. 

 

 If you want to discard print data that cannot be authenticated, set [Guest user use] to [Disable], or set [Set 

Guest Permissions] to prohibit the printing permission of the guest. 

8 Click [Submit]. 

 
 A card authentication kit (optional) is required to use IC card authentication. If the card authentication kit is not 

installed, "Auth By IC Card Avail" will not be displayed. 

Logging into this machine 

When access control is enabled, the home screen of this machine changes to the login screen, and user 

authentication is required. 

This section explains the login method to this machine by authenticating a user name and password. 

 
 Before logging in with an IC card, register the IC card information in one of the following ways. 

 Specifying IC card information when registering a user as administrator 

 Registering a user 

 Registering by holding the card after logging in with user name and password or PIN 

 Registering IC card information  
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1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▲ or ▼ on the operator panel to select [Local Name], and press «OK». 

3 Input your own user name, and press «OK». 

4 Input the password using the numeric keypad, and press «OK». 

5 Login is complete when "Ready To Print (logged in)" is displayed. The home screen is 

displayed. 

 
 You will be automatically logged out after a certain period of time without operating the panel. 

Printing from a PC 

If access control is enabled, when printing from a PC, input user information in the printer driver to print. 

For Windows 

In this example, Notepad is used to print from the PCL driver. 

1 Select [Print] from the [File] menu. 

2 In [Select Printer], select the required printer driver, and click [Preferences]. 

3 Select the [Extend] tab. 

4 Click [User Authentication]. 

 

5 Set [User name] and [Password] of the user as user authentication information, and 

[Authentication Type] to specify the authentication destination and authentication mode of the 

user. 

 
  [Password], [Authentication Type], and [Use User Authentication] may not be displayed in the screen 

depending on the setting of [User Authentication Options] in [Device Options] tab. 

6 Check [Use User Authentication] if it is displayed. 

 
  Uncheck [Use User Authentication] if the PIN of the job accounting client is used as user authentication 

information. 

7 Input the user name and password. 

The user name may be fixed as login name depending on the setting of [User Authentication Options] of 

the [Device Options] tab. 

Check [Use logon name as user name] to use the Windows login name as the user name. 
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8 If [Authentication Type] is displayed, select the user's authentication destination and 

authentication mode from the list. 

 Auto: Follows the method for logging into Windows. Authentication will be made by [Server LDAP] 

when you are logged into a domain or by [Device Local] when you are logged into a local PC. 

 Device Local: Authenticates by the user information in this machine. 

 Server LDAP: Authenticates by using LDAP in the user information of the server. 

 Server Kerberos: Authenticates by using Kerberos in the user information of the server. 

 
   The default authentication type can be set in [User Authentication Options] of the [Device Options] tab. 

9 Click [OK]. 

10 Specify other settings as necessary, and click [OK]. 

11 Click [Print] in the [Print] screen. 

 

Setting details of user authentication 

Set the user authentication details of the printer driver from the [Device Options] tab or [Device Settings] tab of 

printer properties. 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the icon of [PRINTRONIX LP654C *], and select [Printer properties]. 

* Driver types (e.g. PCL6/PS) 

3 For the Windows PCL printer driver, select the [Device Options] tab, and click [User 

Authentication Options]. For the Windows PS printer driver, select the [Device Settings] tab, and 

expand [Installable Options]. 

4 Set the details of user authentication. 

 Set User Authentication Options for Each User: Displays [Use User Authentication] on the user 

authentication settings screen so that you can set whether to use user authentication or not. 

 

 When [Set User Authentication Options for each user] is unchecked, user authentication will be used, and 

authentication type will follow the method for logging into Windows. Authentication will be made by [Server 

LDAP] when you are logged into a domain or by [Device Local] when you are logged into a local PC. 

 Input user authentication information when printing:Pops up user authentication settings for each 

print job. Use this option to specify an actual user for each print job in an environment where multiple 

users use the same login account on the same PC. 

This cannot be set if [Set User Authentication Options for each user] is checked. 

 Authentication Type: Sets the authentication type in user authentication settings. 

 Default Authentication Type: Specifies the default authentication type if the authentication type 

cannot be set. 

5 For the Windows PCL printer driver, click [OK]. 

6 Click [OK]. 
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For macOS 

Here is an example with Text Edit. 

1 Select [Print] from the [File] menu. 

2 Select the printer driver for this machine. 

3 Select [User Authentication] from the panel menu. 

4 Check [Use User Authentication]. 

 

 
  Uncheck [Use User Authentication] if the PIN of the job accounting client is used as user authentication 

information. 

5 Input [User name] and [Password]. 

Check [Use logon name as user name] to use the login name as the user name. 

6 If [Authentication Type] is displayed, select the user's authentication destination and 

authentication mode from the list. 

 Auto: Follows the method for logging into macOS. Authentication will be made by [Server LDAP] 

when you are logged into to a domain or by [Device Local] when you are not logged into a domain. 

 Device Local: Authenticates by the user information in this machine. 

 Server LDAP: Authenticates by using LDAP in the user information of the server. 

 Server Kerberos: Authenticates by using Kerberos in the user information of the server. 

7 Make settings required for printing. 

8 Click [Print]. 

 

When using authentication type 

1 Select [System Preferences] from the Apple menu. 

2 Click [Printers & Scanners]. 

3 Select this machine, and click [Options and Supplies]. 

4 Check the function to be used in the [Options] tab. 

5  Specify the default authentication type, and click [OK]. 

Registering IC card information 

To log into this machine using an IC card, you need to register the IC card information. You can register the IC 

card information by yourself. 

 
 A card authentication kit (optional) is required to use IC card authentication. 
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 This function is not available if you log in using any method other than local authentication. 

 This function is not available when "Register general user's IC card" is set to [Disable] by the administrator. 

 Enabling access control  

 

1 Log into this machine using the local authentication method. 

 Logging into this machine  

2 Press the scroll button ▼ on the operator panel several times to select [User Account Info], and 

press «OK». 

3 Press ▼ several times to select [Register IC card], and press «OK». 

4 Register the IC card information by following on-screen instructions. 



 

- 240 - 

Initializing the settings 

This section explains how to initialize the built-in memory and the settings of this machine. 

Initialization is done to delete the data and settings saved in this machine and restore the machine to its initial 

settings. 

When you forget the admin password, the settings cannot be initialized. 

Initializing network settings 

The network settings will return to factory defaults after initialization. 

 
 With this operation, all network settings will be initialized. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Check that [Network Setup] is selected, and press «OK». 

5 Check that [General Setup] is selected, and press «OK». 

6 Press ▲ to select [Network Factory Defaults], and press «OK». 

7 Check that [Execute] is selected, and press «OK». 

8 The display will return to the standby screen. 

Initializing the flash memory 

The flash memory is used to store form data, etc. 

Follow the procedure below to initialize it. 

 
 Once the flash memory is initialized, the following data will be deleted. 

 Data saved by [Save as shared job] or [Private Print] 

 Form data 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Press ▲ or ▼ several times to select [Others Setup], and press «OK». 
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5 Press ▲ to select [Flash Memory Setup], and press «OK». 

6 Select [Initialize] or [Format Partition], and press «OK». 

7 To initialize it, check that [Execute] is selected, and press «OK». 

To format partition, select the partition to be formatted, and press «OK». 

 
  There are two methods to initialize a memory 

 [Initialize]: Initializes the open area range (displayed in the file list) of the flash memory. 

 [Format Partition]: Initializes the user information. You can format each partition of PCL/Common/PS. 

8 When [Are you sure?] is displayed, select [Yes] and press «OK». 

To cancel the initialization, select [No] instead. 

9 When [Execute Now?] is displayed, select [Yes] and press «OK». 

This machine restarts and the memory will be initialized. 

 
 When [Execute Now?] is displayed and you select [No], the display will return to [Flash Memory Setup], but the 

initialization will not be canceled. Initialization will be done the next time the power is turned on. 

Initializing settings of this machine 

Restores settings of this machine to the factory default settings. 

 
 Initialization of settings of this machine will return the following data to the default factory settings. 

 [Menus] settings 

 [Admin Setup] settings 

 [Calibration] settings 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Press ▲ several times to select [Settings], and press «OK». 

5 Check that [Reset Settings] is selected, and press «OK». 

6 Check that [Execute] is selected, and press «OK». 

This machine restarts and the settings will be initialized. 
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Moving/Transporting this machine 

This section describes how to move or transport this machine. 

Moving this machine 

 
Doing so may cause injury. 

 

This machine weighs approx. 30 kg, so be sure to have it lifted by at least 2 personals. 

 

1 Power off this machine. 

2 Remove all cables. 

 Power cord 

 LAN cable/USB cable 

3 Remove the paper from the paper cassette. 

4 Lift this machine and move it to the destination. 

When the dedicated caster stand (optional) is installed, unlock the casters (2 places) before moving the 

machine. 

 
 When the machine is moved to an uneven surface, or when the casters do not move even after you have 

unlocked them, remove the anti-tip feet. Refer to "Shipping this machine " for the removal procedure. 

Shipping this machine 

 
Doing so may cause injury. 

 

This machine weighs approx. 30 kg, so be sure to have it lifted by at least 2 personals. 

 

 
Doing so may cause burns. 

 

Do not touch the fuser unit because it is hot. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (approx.1,500 lux or above). Do not leave it for more 

than 5 minutes even under room lighting. 

 Please use the packing box and buffer material at purchase of the product. 

 

1 Power off this machine. 

2 Remove all cables. 

 Power cord 

 LAN cable/USB cable 

3 Remove the paper from the paper cassette. 

4 Pull the front cover open lever (Blue) to open the front cover. 

5 Take out the toner cartridge. 
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6 Put the toner cartridge into a plastic bag. 

7 Close the front cover firmly with both hands. 

8 If the optional expansion tray unit is installed, use a flat-head screwdriver to remove the parts (x 

2) that fix this machine and the expansion tray unit. 

 

 
 Do not remove the parts connecting the expansion tray yet. 

 Be careful not to lose the fixing parts that were removed. 

9 Lift the machine and remove it from the expansion tray unit. 

 
 Pack the machine and the expansion tray separately for transportation. 

 

10 Attach the buffer material to this machine and put them together in the packing box. 

11 Place the toner cartridge and accessories on the buffer material, close the lid of the packing 

box, and fix it with tape. 



 

- 244 - 

12 If there are multiple expansion tray units, use a flat-head screwdriver to remove all the fixing 

parts and pack them together. 

 

13 If the caster stand is installed, use a Phillips-head screwdriver to remove the metal fixtures (x 2) 

that fix the caster stand and the expansion tray unit. 

 

14 Use a flat-head screwdriver to turn the positioning pins (x 2) in the arrow direction to remove 

them from the caster stand. 
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15 Pinch the protrusion of the anti-tip foot b through the hole on the caster stand and push it out to 

remove the anti-tip foot b. Follow the same procedure to remove the remaining anti-tip feet b. 

 

16 Remove the anti-tip foot a from the caster stand. 

 

17 Put the caster stand in the packing box. At the same time, put the metal fixtures (x 2) of the 

caster stand, positioning pins (x 2), anti-tip feet b (x 3), and anti-tip foot a that were removed in 

Steps 13 to 16 in the packing box. 

 
 Be careful not to lose the fixing parts that were removed. 
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Disposal 

To dispose of this machine, it is recommended to erase the information registered or saved in this machine. 

The following items are included in the information saved in this machine. 

 Admin Password 

 Various menu settings 

 Private print data 

 Various records 

 Data of access control and user management (local user, external user cache [LDAP, Kerberos]) 

You can erase the information by the following procedure. 

 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll button ▼ on the operator panel several times to select [Admin Setup], and 

press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Press ▼ several times to select [Others Setup], and press «OK». 

5 Press ▼ several times to select [Erase Privacy Data], and press «OK». 

6 When "Execute" is displayed, press «OK». 

7 When "Are you sure?" is displayed, select [Yes] and press «OK». 

8 When "Would you like really?" is displayed, select "Yes" and press «OK». 

Restart the machine to erase the data. 

 
 Once the action is executed, the erased data cannot be restored. To cancel the erasing, select [No] in Step 7. 
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Useful software 

 

Software list ............................................................................................ 248 

Installing software ................................................................................... 250 

Monitoring Tool (Windows)..................................................................... 252 

Network Extension ................................................................................. 258 

Color Swatch Utility ................................................................................ 260 

Color Correct Utility ................................................................................ 262 
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This section describes the software for using this machine more conveniently. 
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Software list 

This section describes the software that can be used with this machine. Please refer to each topic for how to 

use the software. 

Windows software 

 Operating environment 

Windows 10/Windows 8.1/Windows 8/Windows 7 

Windows Server 2019/Windows Server 2016/Windows Server 2012 R2/Windows Server 2012 

Windows Server 2008 R2/Windows Server 2008 

Item Description Reference 

Monitoring Tool It is a tool to monitor the firmware version of the printer, 

software version and the service life of maintenance parts. 

 Monitoring Tool 

(Windows) 
 

Network Extension You can check the settings of this machine and set options 

from the printer driver. This utility is installed automatically 

when the printer driver is installed via a network 

connection. 

 Network Extension  
 

Color Swatch Utility Prints RGB color samples. 

You can check the RGB value for printing in the desired 

color from the printed color samples. 

 Color Swatch Utility 
 

Color Correct Utility Adjusts color matching for printing from a PC. 

You can change the overall trend of the output colors by 

adjusting the output color of the palette color or by 

adjusting the hue and color of gamma values and primary 

colors. 

 Color Correct Utility 
 

PS Gamma Adjuster You can adjust the halftone density of each CMYK color 

when printing from a PC. You can adjust the image color 

density of photos, etc. 

 PS Gamma Adjuster  
 

Configuration Tool  Configures access control settings and network settings for 

this machine, and registers and deletes form data, and 

registers and manages ICC profiles in the printer. The 

registered ICC profile is used for color matching in the 

[Graphics Pro] mode of the printer driver. 

 Configuration Tool 
 

Printronix LPR utility You can check the status of this machine connected to the 

network or transfer print data to another device from your 

PC. 

 Printronix LPR Utility  
 

macOS software 

 Operating environment 

macOS 10.15 - 10.12, OS X 10.11 

Item Description Reference 

PS Gamma Adjuster You can adjust the halftone density of each CMYK color 

when printing from a PC. You can adjust the image color 

density of photos, etc. 

 PS Gamma Adjuster 
 

Color Correct Utility Adjusts color matching for printing from a PC. 

You can change the overall trend of the output colors by 

adjusting the output color of the palette color or by 

adjusting the hue and color of gamma values and primary 

colors. 

 Color Correct Utility 
 

   



 

- 249 - 

Item Description Reference 

Network Card Setup Utility Enables you to make network settings.  Network Card Setup 

Utility (macOS)  
 

Profile Assistant Registers and manages the ICC profile in the printer. The 

registered ICC profile is used for color matching in the 

[Graphics Pro] mode of the printer driver. 

Download from the website. 

Applications for mobile devices 

Item Description Reference 

Mobile Print You can print web pages or photos with an Printronix LED 

printer or LED MFP connected to a network via a wireless 

LAN from your smartphone, tablet or other mobile devices. 

(For Android/iOS)  

 Using the Mobile Print 
 

NFC Setting Tool You can restore the default settings of this machine from a 

smartphone by using the NFC function even when the 

power of this machine is off. (For Android only) 

For details, please refer to 

the "Online Manual" on the 

website. 
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Installing software 

Follow the procedure below to install the software you want to use. 

If your PC does not come with a DVD drive, or if you want to update the software, download and install it from 

the website. 

For Windows 

Install the software that you want to use with the included DVD. 

Connect this machine to a PC with a network or USB cable, and start the installation. 

 
 Check the status of this machine before installation. 

 The power is turned on. 

 For connection with a network, the machine is connected to a network with a network cable and the IP address 

and other settings of the machine have been configured. 

 

1 Insert the included DVD to the PC. 

2 When [Auto Play] is displayed, click [Launch Setup.exe]. 

 

 
 When the [User Account Control] screen is displayed, click [Yes]. 

3 Choose a language from the pull-down menu of language selection in the [Welcome] screen. 

4 Read the software license agreement, and click [Accept]. 

5 Read the environmental advice, and click [Go]. 

6 Click either [Network Connection] or [USB Connection] depending on the connection method 

between the PC and this machine. 

If [Windows Security Alert] screen is displayed, click [Allow Access]. 

7 Select the model name of this machine, and click [Go]. 
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8 Click [Individual Install]. 

 

9 Click the driver or software you want to install. 

Installation will begin. 

 
 The procedure below may vary with the selected software. 

This is an example of installing the Configuration Tool. 

10 Click [Next] to start the installation. 

 

The installation starts. 

11 When the installation is complete, click [Finish]. 

For macOS 

Drag and drop to copy it to the place you want. You can also start directly from the provided DVD. 

 

1 Insert the included DVD to the PC. 

2 Double-click on [PRINTRONIX] - [Utility] folder. 

3 Drag and drop to copy the software folder you want to install to the place you want. 

 
  Double-click on the software icon in the folder to launch it. 

For mobile devices 

Download Mobile Print from App Store or Google Play Store. 

 
 The Android version can also be downloaded from the website. 

 

The NFC Setting Tool can be downloaded from the website. 

For details, please refer to the "Online Manual" on the website. 
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Monitoring Tool (Windows) 

You can manage the firmware and software updating of the printer and the replacement period of 

maintenance parts with the Monitoring Tool. 

The Monitoring Tool is available only for Windows. 

To learn how to install the Monitoring Tool, see "Installing software ". 

 
 You can also automatically manage the firmware updating of the printer and the replacement period of maintenance 

parts. 

When using the automatic management function, use the same Windows login user when installing the Monitoring 

Tool and when using the Monitoring Tool. 

Registering the printer 

Register the printer to be monitored with the Monitoring Tool. 

 

1 Select [Start] - [Printronix] - [Monitoring Tool] to start the Monitoring Tool. 

2 Select [Register printer] from the [Settings] menu. 

 

3 Select the printer to be registered from the printer list, and click [Register]. 

 

4 Input the admin password of the printer, and click [OK]. 

 Admin password  

 

 
 If an admin password authentication error is displayed, the admin password you input may be incorrect. Input 

the correct admin password again. 
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5 Click [Close]. 

 

6 Check that the registered printer is displayed. 

 

Updating the printer software 

Monitoring Tool checks the status of this machine periodically. When software update is available for this 

machine, follow the on-screen instructions to update the software. 

 

1 When update is available for software, [Update Recommended] is displayed in the [Status] field. 

 

2 Click [Update] on the line where [Update Recommended] is displayed. 

3 Click [Agree] on the license agreement display. 

4 Follow the on-screen instructions as installation begins. 

 
 The screen may vary with the software. 

5 When the installation is complete, click [Quit]. 
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6 Check that [The latest software] is displayed in the [Status] field. 

 

7 Select [Quit] from the [File] menu. 

 

Updating the printer’s firmware 

Monitoring Tool checks the status of this machine periodically. When firmware update is available for this 

machine, follow the on-screen instructions to update the firmware. 

 

1 When firmware update is available for this machine, [Update Recommended] is displayed in the 

update field. 

 

2 Check the name of this machine, and click [Update firmware]. 

3 On the [Administrator password authentication] screen, input the admin password of this 

machine, and click [OK]. 

 Admin password  

 

4 The latest firmware is downloaded from the website, and the printer firmware is updated. 

 
 Do not turn off the printer while updating the firmware. 
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5 When [Completed] is displayed and "Success" is displayed in the [Status] field, the firmware 

update is completed. 

 
 If failed, an error message will be displayed in the [Status] field. Click [Details] on the right side of the message 

to display the error correction method. 

6 Select [Quit] from the [File] menu. 

 

Changing settings of Monitoring Tool 

1 Select [Start] - [Printronix] - [Monitoring Tool] to start the Monitoring Tool. 

2 Select [Environmental settings] from the [Settings] menu. 

 

3 Set the values in each tab, and click [Apply]. 

 [Printer Communication] tab 

 

Item Description 

Printer Search Timeout Sets the time for searching for the printer. 

Printer Communication Timeout Sets the time limit for the timeout error of connection to the printer. 

Network Search Range Specifies the range for searching for the printer. 

SNMP Community Name Sets the SNMP community name. 

Restore default Returns all settings to default values. 
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 [Server Communication] tab 

 

Item Description 

Communication timeout (s) Sets the timeout time for communication with the website. 

Communication retries (times) Sets the number of retries when an error has occurred to communication with the 

website. 

Communication retry interval (s) Sets the interval for retrying communication with the website. 

Restore default Returns all settings to default values. 

 

 [Firmware Update] tab 

 

Item Description 

Update timeout (m) Sets the timeout limit for the firmware update. 

Restore default Returns all settings to default values. 

Deleting the printer 

Delete a printer registered with the Monitoring Tool. 

 

1 Select [Start] - [Printronix] - [Monitoring Tool] to start the Monitoring Tool. 

2 Select [Delete printer] from the [Settings] menu. 
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3 Check the printer to be deleted, and click [Delete]. 

 

Troubleshooting (Monitoring Tool) 

 
 Please check the following explanation and "Frequently Asked Questions (FAQs)" on your smartphone app or the 

website. 

 If the problem persists, contact your dealer. 

 For problems arising from the application, contact the application development company. 

 

When firmware update has failed 

Cause Solution Reference 

The connection with the server has 

failed. 

Check your Internet connection environment. - 

The admin password that you input is 

incorrect. 

Check the admin password. - 

The printer is powered on. Power on the printer, enter the standby mode, and 

run the update again. 

- 

The printer is not connected. Connect the printer. - 

The printer is being used. Update the firmware after the printer has stopped. - 

An error occurred in the printer (No 

toner, paper jam, etc.). 

Update the firmware after the error has been cleared. - 

 

When driver installation or update has failed in Windows 7/Server 2008/Server 2008 R2  

Cause Solution Reference 

Microsoft update "KB4474419" is not 

applied. 

Please apply Microsoft update "KB4474419". 

For details, check the "Frequently Asked Questions 

(FAQs)" on the website. 

Website 
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Network Extension 

With Network Extension, you can check the settings of this machine and set optional configurations. 

TCP/IP must be enabled to use Network Extension. 

 
 Administrator privileges are required. 

 
 Network Extension is automatically installed when the printer driver is installed in a TCP/IP network. 

 Network Extension works in conjunction with the printer driver. Do not install Network Extension only. 

 Network Extension works only when the printer driver is connected to the Printronix LPR port or standard TCP/IP 

port. 

Displaying properties of the printer driver 

To use Network Extension, display the [Printer Properties] screen. 

 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the printer icon, and select [Printer properties]. 

Confirming settings of this machine 

You can check the settings of this machine from the [Printer Properties] screen. 

 

1 Display the [Printer Properties] screen. 

 Displaying properties of the printer driver  

2 Select the [Status] tab. 

 

3 Click [Update]. 

4 Click [OK]. 

 

Click [Web Setting] to start the web page automatically. You can change the settings of this machine on the 

web page screen. 
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 Web page (Managing this machine from a PC)  

 
 If Network Extension is used in an unsupported environment, the [Status] tab may not be displayed. 

Setting options automatically 

You can acquire the optional configurations of this machine connected to the network, and automatically set 

the printer driver. 

 

For Windows PCL printer driver 

1 Display the [Printer Properties] screen. 

 Displaying properties of the printer driver  

2 Select the [Device Options] tab. 

3 Click [Get Printer Settings]. 

4 Click [OK]. 

 

For Windows PS printer driver 

1 Display the [Printer Properties] screen. 

 Displaying properties of the printer driver  

2 Select the [Device Settings] tab. 

3 Click [Get installed options automatically], and click [Setup]. 

4 Click [OK]. 

 

 
 Setting is not possible when Network Extension is used in an unsupported environment. 

Uninstalling Network Extension 

1 Click [Start], and select [Windows System Tools] - [Control Panel] - [Programs and Features]. 

2 Select [Printronix Network Extension], and click [Uninstall]. 

3 Finish the uninstallation by following the on-screen instructions. 
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Color Swatch Utility 

You can print RGB color samples using the Color Swatch Utility. By checking the printed color sample and 

adjusting the RGB value as needed, you can print your desired colors from the application. 

 
 It is not applicable to macOS. 

 
  The Color Swatch Utility is installed automatically when the printer driver is installed. 

Printing a color sample 

1 Click [Start], and select [Printronix] - [Color Swatch Utility]. 

 

2 Click [Print]. 

3 Select the device you want to adjust from [Name]. 

4 Click [OK]. 

5 Confirm the color you want to print from the color sample, and write down the RGB value. 

Customizing the color sample 

If you cannot find the color you want to print in Step 5 of "Printing a color sample ", follow the procedure below to 

customize the color. 

 

1 Click [Switch]. 

2 Click [Detail]. 

3 Adjust the three slide bars until the color you want is displayed. 

4 Click [Close]. 

5 Click [Print]. 

6 Select this machine from [Name]. 

7 Click [OK]. 

8 Check that the color is adjusted as you wish. 

 

 
  If you are not satisfied with the result, repeat Steps 1 to 8. 
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Printing a file in your desired color 

1 Open the file to be printed. 

2 Select the text or graphic, and adjust the RGB values from the application. 

3 Print the file. 

 

 
 Read the User's Manual of the application for instructions on how to specify the color in the application. 

 To print a file to the same result with the color sample, use the same printer driver settings. 
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Color Correct Utility 

This section explains how to adjust the color using the Color Correct Utility. 

 
 Set up each printer driver. 

 To use the Color Correct Utility, you will have to login to the PC as a user with administrator privileges. 

Changing palette colors 

You can use the Color Correct Utility to specify colors of the palette selected in software like Microsoft Excel. 

 

For Windows 

 

1 Click [Start] and select [Printronix] - [Color Correct Utility]. 

2 Select [Office Palette Tuning], and click [Next]. and click [Next]. 

3 Select the device to be adjusted, and click [Next]. 

4 Select the name of the setting, and click [Print Sample]. 

 
 If the settings are initialized after the printer driver has been updated and reinstalled, start the Color Correct 

Utility to automatically reset the name of the color tuning. 

Check that the color tuning name is displayed on the [Select setting] screen. 

5 Click [Next]. 

6 Click [Print Test]. 

7 Compare the color palette on the screen with the colors of the printed color sample for 

adjustment. 

The color marked with an x cannot be adjusted. 

8 Click the color you want to adjust. 

9 Check the adjustable range of X and Y from the drop-down list. 

The adjustable value varies with the specific color. 

10 Check the printed color samples, select the most suitable color within the adjustable range, and 

then check the X and Y values. 

11 Select the values you checked in Step 10, and click [OK]. 
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12 Click [Print Test] to check whether the adjusted color is closer to the color you want, and then 

click [Next]. 

If you want to further change the color or change other colors, repeat Steps 8 to 11. 

13 Input a name for the setting, and click [Save]. 

14 Click [OK]. 

15 Click [Finish]. 

 

For macOS 

 

1 Start the Color Correct Utility. 

2 Select the device you want to adjust. 

3 Click [Next]. 

4 Click [Office Palette Tuning]. 

5 Select the name of the setting, and click [Print Sample]. 

6 Click [Next]. 

7 Click [Print Test]. 

8 Compare the color palette on the screen with the colors of the printed color sample for 

adjustment. 

The color marked with an x cannot be adjusted. 

9 Click the color you want to adjust. 

10 Check the adjustable range of X and Y from the pull-down menu. 

The adjustable value varies with the specific color. 

11 Check the printed color samples, select the most suitable color within the adjustable range, and 

then check the X and Y values. 

12 Select the values you checked in Step 11, and click [OK]. 

13 Click [Print Test] to check whether the adjusted color is closer to what you want. 

If you want to further change the color or change other colors, repeat Steps 9 to 13. 

14 Input a name and click [Save]. 

15 Select [Printers & Scanners] from [System Preferences], delete the registered adjusted device, 

and then re-register. 

Changing gamma values and hues 

The tone can be adjusted by adjusting the gamma value, and the output color can be adjusted by adjusting 

the hue. 
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For Windows 

1 Click [Start] and select [Printronix] - [Color Correct Utility]. 

2 Select [Hue & Saturation Tuning], and click [Next]. 

3 Select the device to be adjusted, and click [Next]. 

4 Select the standard mode, and click [Next]. 

 
 If the settings are initialized after the printer driver has been updated and reinstalled, start the Color Correct 

Utility to automatically reset the name of the color tuning. 

Check that the color tuning name is displayed on the [Select setting] screen. 

5 If necessary, make settings by adjusting the slide bar. 

If [Use printer's unadjusted color. ] is checked, 100 percent of each color is used for printing, and the 

slide bar of hue is fixed. 

6 Click [Print Test]. 

7 Check the printed results. 

If the desired results have not been obtained, repeat Steps 5 to 7. 

8 Click [Next]. 

9 Input a name and click [Save]. 

10 Click [OK]. 

11 Click [Finish]. 

 

For macOS 

1 Start the Color Correct Utility. 

2 Select the device you want to adjust. 

3 Click [Next]. 

4 Click [Hue & Saturation Tuning]. 

5  Select the standard mode, and click [Next]. 

6 If necessary, make settings by adjusting the slide bar. 

If [Use printer's unadjusted color. ] is checked, 100 percent of each color is used for printing, and the 

slide bar of hue is fixed. 

7 Click [Print Test]. 

8 Check the printed results. 

If the desired results have not been obtained, repeat Steps 6 to 8. 

9 Input a name and click [Save]. 

10 Select [Printers & Scanners] from [System Preferences], delete the registered adjusted device, 

and then re-register. 
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Printing with tuned color settings 

For Windows PCL printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Click [Detail] in [Setup], and select [Office Color]. 

5 Check [Color Correct Utility Settings], select settings created with the Color Correct Utility, and 

click [OK]. 

 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Select the [Color] tab, select [Office Color], and then click [Options]. 

5 Check [Color Correct Utility Settings], and then select the settings created using the Color 

Correct Utility, and click [OK]. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Office Color] in the [Color] panel. 

4 Select the settings created using the Color Correct Utility from [User Color]. 

Saving color tunning settings 

You can save the tuned color settings. 

 
 To use this function, you will have to log into the PC as a user with administrator privileges. 

 

For Windows 

1 Click [Start] and select [Printronix] - [Color Correct Utility]. 

2 Select [Import/Export Color Settings] , and click [Next]. 

3 Select the device where you want to save the settings, and click [Next]. 

4 Click [Export]. 

5 Select the settings to be exported, and click [Export]. 

6 Specify the file name and the destination folder, and click [Save]. 

7 Click [OK]. 

8 Click [Finish]. 
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For macOS 

1 Start the Color Correct Utility. 

2 Select the device where you want to save the settings. 

3 Click [Next]. 

4 Click [Import/Export Color Settings]. 

5 Click [Export]. 

6 Select the settings to be exported, and click [Export]. 

7 Specify the file name and the destination folder, and click [Save]. 

8 Click [Cancel]. 

9 Click [Finish]. 

10 Click [OK] on the confirmation screen. 

Importing color tunning settings 

For Windows 

1 Click [Start] and select [Printronix] - [Color Correct Utility]. 

2 Select [Import/Export Color Settings] , and click [Next]. 

3 Select the device into which you want to import settings, and click [Next]. 

4 Click [Import]. 

5 Select the file and click [Open]. 

6 Select the settings that you want to import, and click [Import]. 

7 Check that the settings are correctly imported, and click [Finish]. 

 

For macOS 

1 Start the Color Correct Utility. 

2 Select the device into which you want to import settings. 

3 Click [Next]. 

4 Click [Import/Export Color Settings]. 

5 Click [Import]. 

6 Select the folder into which the settings to be imported are saved, and click [Open]. 

7 Select the settings that you want to import, and click [Import]. 

8 Click [Cancel]. 

9 Confirm that the settings are correctly imported, and then exit the Color Correct Utility. 

Deleting color tuning settings 

For Windows 

1 Click [Start] and select [Printronix] - [Color Correct Utility]. 
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2 Select [Import/Export Color Settings] , and click [Next]. 

3 Select the device from which you want to delete the settings, and click [Next]. 

4 Select the settings to be deleted, and click [Delete]. 

5 Click [Yes] on the confirmation screen. 

6 Check that the settings have been deleted correctly, and click [Finish]. 

 

For macOS 

1 Start the Color Correct Utility. 

2 Select the device from which you want to delete the settings. 

3 Click [Next]. 

4 Click [Import/Export Color Settings]. 

5 Select the settings to be deleted, and click [Delete]. 

6 Click [Yes] on the confirmation screen. 

7 Check that the settings are deleted correctly, and click [Finish]. 

8 Click [OK] on the confirmation screen. 
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PS Gamma Adjuster 

You can adjust the halftone density of each CMYK color for this machine. Make adjustments if an image like a 

photo is too dark. 

 
 For Windows, the [Custom Gamma Adjustment] menu or its content may not be displayed on the [Color] tab of the 

printer driver after a name is registered in [Gamma Curve Name]. In such a case, restart your PC. 

 Using the Gamma Adjuster may slow down the printing. If you want to prioritize the speed, uncheck [Custom Gamma 

Adjustment] in the [Color] tab of the printer driver for Windows. For macOS, select [Not Specified] for [Custom 

Gamma Adjustment] in the [Quality 2] tab on the [Print Options] panel. 

 Applications that have been started before registering [Gamma Curve Name] must be restarted before printing. 

 Some applications allow you to specify dot gain correction and gamma adjustment when printing or include this 

setting in an EPS file. To use the functions provided by an application, uncheck [Custom Gamma Adjustment] in the 

[Color] tab of the printer driver for Windows. For macOS, select [Not specified] for [Custom Gamma Adjustment] in 

the [Quality 2] tab on the [Print Options] panel. 

 For Windows, the model name is displayed in the "Select Printer" list of the PS Gamma Adjuster. If multiple identical 

models exist in the "Devices and Printers", the registered [Gamma Curve Name] is valid for all identical models. 

Registering a gamma adjuster name 

For Windows PS printer driver 

1 Click [Start], and select [Printronix] - [PS Gamma Adjuster]. 

2 Select [Printronix LP654C PS] from [Select Printer]. 

3 Click [New]. 

4 Adjust the halftone. 

Adjust the halftone by editing the graph or inputing the gamma value and tone density in the text box. 

5 Input the setting name in [Gamma Curve Name], and click [OK]. 

6 Click [Add]. 

7 Click [Apply]. 

8 Click [OK]. 

9 Click [Exit] to close the PS Gamma Adjuster. 

 

For macOS 

1 Start the PS Gamma Adjuster. 

2 Click [Edit Gamma Curve]. 

3 Adjust the halftone. 

Adjust the halftone by editing the graph or inputing the gamma value and tone density in the text box. 

4 Input the setting name in [Gamma Curve Name], and click [Save]. 

5 Click [Select PPD File]. 

6 Select a PPD file, and click [Open]. 

7 Select the gamma adjuster you created, and click [Add]. 

8 Click [Save]. 

9 Select [Printers & Scanners] in [System Preferences]. 
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10 Delete the registered device to which the adjustment has been set, and then register it again. 

 

 
 Do not click the [Config] button displayed while adding the printer. 

 If a dialog box for selecting a printer option is displayed while adding a printer, click [Cancel] and then add the printer 

again. 

Printing with registered halftone 

For Windows PS printer driver 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Click [Preferences]. 

4 Check [Custom Gamma Adjustment] in the [Color] tab. 

5 Select the registered halftone adjuster name. 

6 Specify other menus as necessary, and click [OK]. 

7 Click [Print] in the [Print] screen. 

 

For macOS 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select the [Print Options] panel. 

4 Select the registered halftone adjuster name from [Custom Gamma Adjustment] of the 

[Quality2] tab. 

5 Specify other settings as necessary, and click [Print]. 
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Configuration Tool 

The Configuration Tool allows you to manage multiple machines and change their settings. 

Registering this machine 

Register this machine with the Configuration Tool when installing it for the first time. 

 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Register Device] from the [Tools] menu. 

 

3 When registrable devices are displayed, select this machine, and click [Register]. 

4 Click [Yes] on the confirmation screen. 

Starting the Configuration Tool 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

 

Checking the state of this machine 

You can check the state and information of this machine. 

 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [Device Info] tab. 

  



 

- 271 - 

 
 When this machine is connected to a network, [Device Status] is displayed. 

 To update the information, click [Update Device Information]. 

Displaying job completion on the PC 

 
 The time and time zone of this machine must be consistent with your PC. 

 

Setup 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Alert Info] from the [Plug-in] menu. 

 

3 Select [Basic settings]. 

 

4 Change the settings as necessary. 

5 Click [Update]. 

 

Device Settings 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Alert Info] from the [Plug-in] menu. 

3 Select [Setting devices]. 
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4 Click [Update device]. 

 

5 Click the device name you want to set. 

6 Change the settings as necessary, and click [OK]. 

 

Filter Settings 

You can set alert conditions to be displayed when an e-mail is received during printing. 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Alert Info] from the [Plug-in] menu. 

3 Select [Filter settings]. 

 

4 Change the settings as necessary. 

 

5 Click [OK]. 

 

 
 Up to 100 senders can be registered as e-mail senders. 
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Checking logs 

From the event log, you can check whether there are any records for this registered machine. 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Alert Info] from the [Plug-in] menu. 

3 Select [Display log]. 

4 Select [Devices displaying log]. 

 

 
 You can check the total number of recorded events in [Table of number of logs]. 

 You can check the details of recorded logs in [Log details]. 

Setting the network 

Searching for this machine on the network 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Network Setting] from the [Plug-in] menu. 

3 Select [Discover Devices]. 

4 Search results will be displayed. 

 

Specifying search conditions 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Network Setting] from the [Plug-in] menu. 

3 Select [Environment Settings]. 

4 Specify the search conditions as necessary, and click [OK]. 

 

Changing the IP address 

You can change the IP address of this machine. 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Network Setting] from the [Plug-in] menu. 

3 Select [Discover Devices]. 

4  Select this machine from the device list. 

5 Click the [Setting devices] icon. 
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6 Input the IP address. 

 

7 Click [Set]. 

8 Input the admin password, and click [OK]. 

 Admin password  

9 Click [OK] to restart the machine. 

Registering ICC profiles 

You can register and edit printer profiles in this machine. This section explains how to register ICC profiles. 

 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Storage Manager] from the [Plug-in] menu. 

3 Click the [New Project] icon. 

4 Click the [Add File to Project] icon, and change [FILE TYPE] "Color matching file(*.ICC,*.ICM)" 

in the [Open File] menu. 

5 Select the profile to be registered, and click [Open]. 

6 From [FILE TYPE], select the type of the profile you want to register. 

7 Click [Component] in the ICC profile added to the project to display the [Edit File] dialog box. 

8 Select the number you want to register. 

The numbers already used in the project cannot be selected, and they are highlighted in yellow. 

9 If necessary, input a comment in the [Comment] field. 

10 Click [OK] to apply the changes. 

11 Select this machine in the window at the bottom of the Storage Manager plug-in screen. 

12 Click the [Send project files to printer] icon. 

13 Click [OK]. 

Registering forms (form overlay) 

You can register a logo, etc., as a form file in this machine for overlay printing. This section explains how to 

register a form file. 

How to print in overlay 

 Printing overlaid text or logos (overlay printing)  
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 To use the Windows PS printer driver, administrator privileges are required. 

 To use the Windows PCL printer driver, see "Printing overlaid text or logos (overlay printing) ". 

 

Creating a form file 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the icon of this machine, and select the required printer driver from [Printer 

Properties]. 

3 Select the [Port] tab, check [FILE:] from [Printing Port], and click [Apply]. 

4 Create a form to be registered with this machine. 

5 Select [Print] from the [File] menu. 

6 Printing starts. 

7 Input a name for the file to be saved. 

Example: C:¥temp¥form.prn 

8 Select the original port from [Printing Port] on the [Port] tab, and click [OK]. 

 

Registering a form with this machine using Configuration Tool 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Storage Manager] from the [Plug-in] menu. 

3 Click the [New Project] icon. 

4 Click the [Add File to Project] icon, and select the created form file. 

The form will be added to the project. 

5 Click the form file. 

6 Select this machine in the window at the bottom of the Storage Manager plug-in screen. 

 
 When this machine is not registered with the Configuration Tool, see "Registering this machine " to register it. 

7 Click the [Send project files to printer] icon. 

8 Click [OK]. 

Checking free space of memory/hard disk 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select [Storage Manager] from the [Plug-in] menu. 

3 Click the device name from the device selection area below the Storage Manager plug-in 

screen. 

Display the storage, volume name, size, free space, location name, label, status, file name, size, 

comments, etc. by communicating with the device. 
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Registering the user name and password 

You can use the user name and password to restrict access to this machine. 

The changed settings are reflected in this machine when the [Save to device] icon is clicked. 

 

Creating a new user 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [User Setting] tab. 

4 Click [Role management]. 

5 Input the admin password, and click [OK]. 

 Admin password  

6 Click [User Name/Group]. 

7 Click the [New(User)] icon. 

8 Input the user name and password. 

Set other necessary information. 

Name:Input the display name. 

E-mail Address:Input the user's e-mail address. 

Language Code:Input the language code. 

PIN:Input the user's PIN. 

Card ID: Input the user's IC card information. 

Role:Set the user's role. 

Group:Set the group to which the user belongs 

 
  You can input the PIN as a user setting option. 

 "admin" cannot be registered as a new user name. 

9 Click [OK]. 

10 Click the [Save to Device] icon. 

 

Changing user settings 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [User Setting] tab. 

4 Click [Role management]. 

5 Input the admin password, and click [OK]. 

 Admin password  

6 Click [User Name/Group]. 

7 Select the user name to be changed. 

8 Change the settings as necessary, and click [OK]. 

9 Click the [Save to Device] icon. 
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Deleting a user 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Select this machine from [Registered Device Table]. 

3 Select the [User Setting] tab. 

4 Click [Role management]. 

5 Input the admin password, and click [OK]. 

 Admin password  

6 Click [User Name/Group]. 

7 Select the check box of the user to be deleted. 

8 Click the [Delete] icon. 

9 Click [Yes] on the confirmation screen. 

10 Click the [Save to Device] icon. 

Deleting this machine 

You can unregister this machine. 

 

1 Click [Start] and select [Printronix] - [Configuration Tool]. 

2 Right-click on this machine from [Registered Device Table]. 

3 Select [Remove device]. 

4 Click [Yes] on the confirmation screen. 

Name and function of each screen 

[Device Info] tab 

Displays the information about the device. 
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[User Setting] tab 

Sets the user, role and so on. 

 

 Item Description 

1 Role management Registers/Edits the user and role 

 

[Alert Info] plug-in 

Detects and notifies the event such as the end of printing. 

 

 Item Description 

2 Basic settings Configures basic settings such as the notification method and detection 

interval 

3 Setting devices Sets the type and presence of the event notified by each device 

4 Filter settings Sets filter conditions for pop-up notifications 

5 Display log Displays detected notification information 
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[Network Setting] plug-in 

Sets the network information. 

 

 Item Description 

6  Discover Devices Searches for network devices. 

7 Environment Settings Changes the device detection criteria and communication options. 

 

[Storage Manager] plug-in 

Registers and edits files to be downloaded to the device. 
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Icon description 

Icon Icon name Description 

 
Device Settings Changes the IP address or other settings of this machine. 

 
Create New Project Creates a new project. 

 
Add File to Project Adds files to a project. 

 
Send Project Sends a project to this machine. 

 
Save to Device Saves the settings to this machine. 

 
New (User) Creates a new user. 

 
Delete Deletes a user. 
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Printronix LPR Utility 

With the Printronix LPR Utility, you can print via a network, manage print jobs, or check the state of this 

machine. 

To use the Printronix LPR Utility, TCP/IP must be enabled. 

 
 The Printronix LPR Utility cannot be used for shared printers. Please use the standard TCP/IP port. 

Starting the Printronix LPR Utility 

1 Click [Start], and select [Printronix] - [Printronix LPR Utility]. 

Registering this machine with the Printronix LPR utility 

Add this machine to the Printronix LPR utility. 

 
 Administrator privileges are required. 

 If this machine cannot be added, exit the Printronix LPR utility, right-click on [Start] - [Printronix] - [Printronix LPR 

Utility], and select [More] - [Running As Administrator] to restart the utility. 

 
 You cannot set a device that is already registered in the Printronix LPR Utility. To change the port, select [Confirm 

Connections] from [Remote Print]. 

 

1 Start the Printronix LPR Utility. 

2 Select [Add Printer] from the [Remote Print] menu. 

When [User Account Control] screen is displayed, click [Yes]. 

3 Select [Printer Name]. 

Networked printers and printers connected to the LPR port will not be displayed. 

4 Input [IP Address]. Or, click [Discovery], select the model name to be registered from 

[Discovered Printer], and click [OK]. 

5 If necessary, input the information to identify this machine in [Comment]. 

6 Click [OK]. 

 

Checking the state of the registered machine 

1 Start the Printronix LPR utility. 

2 Select this machine. 

3 Select [Printer Status] from the [Remote Print] menu. 
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Transferring print data to the registered device 

This section explains how to transfer the specified print data to a registered device using the Printronix LPR 

utility. This section also explains how to transfer the print data to another device when a problem occurs on 

the destination device. 

 
 Print data can be transferred only to devices with the same model name as your device. 

 Before transferring print data, a device must be added. 

 

Transferring the selected print data 

1 Start the Printronix LPR utility. 

2 Select [Job Status] from the [Remote Print] menu. 

3 Select the print data to be transferred, and select [Redirect] from [Job] menu. 

4 Select the destination device, and click [OK]. 

 

Automatically transferring print data 

When this machine cannot print since it is busy, offline, out of paper, etc., you can set the print data to be 

automatically transferred to another Printronix machine. 

 
 Administrator privileges are required. 

1 Start the Printronix LPR utility. 

2 Select the machine to set. 

3 Select [Confirm Connections] from the [Remote Print] menu. 

4 Click [Detail Setup]. 

5 Check [Automatic Job Redirect Used]. 

6 To transfer the print data only when an error occurs, check [Redirect only at the time of an 

error]. 

7 Click [Add]. 

8 Input the IP address of the destination device, and click [OK]. 

9 Click [OK]. 

Printing the same document from multiple registered devices 

You can print from multiple devices with a single order. 

 
 Administrator privileges are required. 
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1 Start the Printronix LPR utility. 

2 Select the machine to set. 

3 Select [Confirm Connections] from the [Remote Print] menu. 

4 Click [Detail Setup]. 

5 Check [Print to more than one printer at a time]. 

6 Click [Options]. 

7 Click [Add]. 

8 Input the IP address of the devices to print at the same time, and click [OK]. 

9 Click [OK]. 

Opening the web page of a registered device 

You can open the web page of this machine from the Printronix LPR Utility. 

 

1 Start the Printronix LPR Utility. 

2 Select this machine. 

3 Select [Web Setting] from the [Remote Print] menu. 

 
 When the web port number is changed, the web page cannot be opened. 

For details, see "Setting the port number of the web page for the registered device ". 

Automatically following the IP address of the registered device 

You can set to maintain the connection to the original device even if the IP address of this machine is 

changed. 

 
 Administrator privileges are required. 

 
 The IP address may be changed when the IP address is dynamically allocated by DHCP, or when the network 

administrator has manually changed the IP address of this machine. 
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1 Start the Printronix LPR utility. 

2 Select [Setup] from the [Option] menu. 

3 Check [Auto Reconnect], and click [OK]. 

Setting the port number of the web page for the registered device 

1 Start the Printronix LPR utility. 

2 Select this machine. 

3 Select [Confirm Connections] from the [Remote Print] menu. 

4 Click [Detail Setup]. 

5 Input the port number of web page in [Port Numbers]. 

6 Click [OK]. 

Sending files to this machine registered with the Printronix LPR utility 

If this machine is connected to the network and registered with the Printronix LPR utility, you can download 

the print data. 

 

1 Start the Printronix LPR utility. 

2 Select the download destination device. 

3 Select [Download] from [Remote Print]. 

4 Select the file and click [Open]. 

The file is sent to this machine. 

Deleting unnecessary print data 

You can use the Printronix LPR utility to delete unnecessary print data. 

1 Start the Printronix LPR utility. 

2 Select this machine. 

3 Select [Job Status] from the [Remote Print] menu. 

4 Select the print data to be deleted. 

5 Select [Delete Job] from the [Job] menu. 

Uninstalling Printronix LPR utility 

 
 Administrator privileges are required. 

1 Make sure the Printronix LPR utility is closed. 

2 Click [Start], and select [Printronix] - [Uninstall Printronix LPR Utility]. 

When [User Account Control] screen is displayed, click [Yes]. 

3 Click [Yes] on the confirmation screen. 
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Network Card Setup Utility (macOS) 

The network setting can be done using the Network Card Setup Utility. 

TCP/IP must be enabled to use the Network Card Setup Utility. 

Setting the IP address 

1 Start the Network Card Setup Utility. 

 Installing software  

2 Select this machine from the list. 

3 Select [IP Address] from the [Actions] menu. 

4 Specify the settings as necessary, and click [Config]. 

5 Input the admin password, and click [OK]. 

 Admin password  

6 Click [OK] to enable the new settings. 

The network card of this machine will restart. 

Making web settings 

You can set the network of this machine after starting the Network Card Setup Utility. 

 

Enabling web settings 

1 Start the Network Card Setup Utility. 

 Installing software  

2 Select this machine from the list. 

3 Select [Web Page Settings] from the [Actions] menu. 

4 Check [Enable device web settings], and click [Config]. 

5 Input the admin password, and click [OK]. 

 Admin password  

6 Click [OK] in the confirmation window. 

 

Opening the web page 

1 Start the Network Card Setup Utility. 

 Installing software  

2 Select this machine from the list. 

3 Select [View Printer Web Pages] from the [Actions] menu. 

The web page will start, and the status page of this machine will be displayed. 

Exiting the Network Card Setup utility 

1 Select [Exit the Network Card Setup Utility] from the [Network Card Setup Utility] menu. 
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Printing from a mobile device 

 

Printing from a mobile device ................................................................. 287 

Showing troubleshooting tips on a mobile device .................................. 291 

Troubleshooting for the mobile device ................................................... 292 
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Printing from a mobile device 

Using the Mobile Print 

Mobile Print is an application that allows you to print photos, images, etc. stored on your smartphone, tablet or 

other mobile devices, web pages displayed on the Web browser, and photos taken with the built-in camera 

directly onto an Printronix printer or MFP from your smartphone, tablet or other mobile devices. 

Download Mobile Print from App Store or Google Play Store. 

 
 The Android version can also be downloaded from the website. 

For details on the procedure, please refer to the "Mobile Print Web Manual" on the website. 

 

Printing by connecting to an access point 

1 Connect the mobile device to the same network as this machine. 

Connect to a wireless LAN access point in the same network as this machine, or directly to this machine 

via Wireless(AP Mode). 

 Connecting via a wireless LAN  

2 Register this machine in the app and set it as the output destination. 

If it has already been registered, only the destination is set. 

3 Select the target you want to print. 

4 Tap [Print]. 

 

Printing with the NFC function 

If your mobile device supports the NFC function, you can print using the NFC function of this machine. 

To print using the NFC function, it is necessary to set the wireless LAN (AP mode) of this machine to [Enable]. 

 
 You cannot use wireless LAN (AP mode) while using wireless LAN (Infrastructure). 

 

Enabling wireless LAN (AP mode) 

1 Check that "Ready To Print" appears on the display. 

 
 If the machine is in the power save mode, press «POWER SAVE» to restore. 

2 Press the scroll buttons several times to select [Wireless(AP Mode) Setting], and press «OK». 

3 Input the admin password using the numeric keypad, and press «OK». 

 Admin password  

4 Select [Wireless(AP Mode)], and press «OK». 

5 Select [Enable], and press «OK». 

6 Press «ON LINE» to return to the standby screen. 
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Printing with this machine registered with the app 

1 Enable the NFC function of your mobile device, and enable Wi-Fi. 

2 Bring the NFC antenna of the mobile device close to the NFC mark on this machine’s operator 

panel. 

This machine is registered to the mobile device application. If it has already been registered, only the 

destination is set. 

 
 For iOS, it is necessary to display the NFC reading screen on the application in advance. 

3 Select the target you want to print. 

4 Tap [Print]. 

 

 
 As the position of the NFC antenna differs for each mobile device, please refer to the manual of your mobile device 

for further details. 

 If the printing has failed, check the Wi-Fi settings of your mobile device, and register this machine with the application 

again. 

AirPrint 

With AirPrint (Print), you can print without installing the printer driver. You can print with AirPrint (Print) from 

your iPhone, iPad and iPod touch. This section describes an overview of AirPrint and its basic settings. 

 

About AirPrint (Print) 

AirPrint (Print) is a feature that allows you to easily print from your Mac. You can print with AirPrint (Print) from 

your iPhone, iPad and iPod touch. Mobile devices and Mac can detect this machine automatically. 

With AirPrint (Print), you can easily print photos, emails, web pages, etc., displayed on the screen with 2 or 3 

taps on the screen. 

To use this feature, you should connect this machine and Mac via a wired LAN, wireless LAN or USB cable. 

For details about AirPrint, please check the Apple website. 
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Setting AirPrint (Print) 

1 Connect this machine to the same network as the mobile device. 

Connect this machine and the mobile device via a wireless LAN access point or directly with a wired LAN 

(AP mode). 

Connect this machine and access point via a wireless LAN (Infrastructure) or wired LAN. 

To connect via wireless LAN (Infrastructure), please set it in beforehand. 

 Connecting via a wireless LAN  

 

When connecting via a wired LAN, connect this machine to the access point with a LAN cable. 

 

To connect via a wireless LAN (AP mode), please set it beforehand. 

 Connecting via a wireless LAN  

 

2 When using from a Mac, connect this machine to the Mac. 

3 When printing via AirPrint (Print), set from the mobile device. 

See "Printing with AirPrint (Print)". 

 

Registering this machine on Mac 

When using AirPrint (Print) for the first time, register this machine on your Mac. 

1 Turn on the power of this machine and the PC. 

2 Connect this machine and the PC via a wireless or wired LAN. 

3 Select [System Preferences] from the Apple menu. 

4 Click [Printers & Scanners]. 

5 Click [+], and then click [Add Printer or Scanner]. 

6 Select [Printronix-LP654C-******] , and click [Add]. 
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7 Make sure that this machine is displayed in [Printer] and [LP654C-AirPrint] is displayed in 

[Type]. 

8 Close [Printers & Scanners]. 

 

Printing with AirPrint (Print) 

When using AirPrint on a Mac, register this machine on Mac in advance. 

 Registering this machine on Mac 

 

Printing from an iOS device 

1 Open the file to be printed. 

2 Tap (Operation). 

3 Tap (Print). 

The model name of the previously used printer on the same network is displayed. 

 
 When printing for the first time or when a model name other than this machine is displayed, select this machine 

in Step 4. 

4 Tap [Print] to select this machine. 

Functions supported by this machine are displayed. 

5 Set options. 

6 Tap [Print]. 

 

Printing from Mac 

1 Open the file to be printed. 

2 Select [Print] from the [File] menu. 

3 Select [Printronix-LP654C-******] from [Print]. 

4 Set options. 

5 Click [Print]. 
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Showing troubleshooting tips on a mobile device 

If an error has occurred in the machine, pressing «HELP» on the operator panel will display the error 

correction method on the display. 

At this time, if you move the mobile device*1 closer to the NFC mark on this machine when "NFC" appears on 

the upper left corner of the display, the search result of the page of a more detailed solution from "Frequently 

Asked Questions (FAQ)" on the website will be displayed on the mobile device. 

 *1 Your mobile device needs to come with the NFC function, and the NFC function must be enabled. 

Also, the Mobile Print must be installed and Internet connection is required. Communication charges may be 

incurred depending on the Internet connection method of your mobile device. 

For details, please refer to the "Mobile Print Web Manual" on the website. 
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Troubleshooting for the mobile device 

Troubleshooting for MobilePrint 

 
 This machine may take 2 to 3 minutes to join a network after power-on. Make sure that the machine is connected to 

the network before attempting to print. 

 

This machine cannot be registered in the app 

Cause Solution Reference 

Is the wireless setting of this 

machine set to the AP 

mode? 

Enable the AP mode.  Using the Mobile Print  
 

Is the NFC setting of this 

machine set to [Enable]? 

Check the status of [Admin Setup] - [Others Setup] - [NFC 

Setup] on this machine. If [Disable] is displayed, the NFC 

function is not available. Set it to [Enable]. 

- 

Is the wireless setting of the 

mobile device enabled? 

Enable the wireless setting on your mobile device. - 

 

Unable to print 

Cause Solution Reference 

Is the machine powered on? Please power this machine on. 

If the power is on, turn the power off and then on again to 

see if the problem is solved. 

 Turning the power on  

 Turning the power off  
 

When printing with the NFC 

function, are this machine 

and the mobile device set to 

communicate in the AP 

mode? 

Enable the AP mode of this machine. 

Enable Wi-Fi on the mobile device and set the connection 

destination to this machine. 

 Using the Mobile Print  
 

Is there any paper? Make sure that the out-of-paper message is not displayed.  Error message list  

 When an error 

message appears on 

the display  
 

Is there any toner? Make sure that the out-of-toner message is not displayed.  Error message list  

 When an error 

message appears on 

the display  
 

Is any error displayed? Check the error message.  Error message list  

 When an error 

message appears on 

the display  
 

Troubleshooting for AirPrint 

 
 This machine may take 2 to 3 minutes to join a network after power-on. Make sure that the machine is connected to 

the network before attempting to print. 

 For macOS or iOS, please update the software to the latest version before printing. 

When "No AirPrint Printers Found" is displayed on an iOS device 

Cause Solution Reference 

Is the machine powered on? Please power this machine on.  Turning the power on  
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Cause Solution Reference 

If the power is on, turn the power off and then on again to 

see if the problem is solved. 

 Turning the power off  
 

Is the machine connected to 

the same network as the iOS 

device?  

Check if this machine is displayed on the iOS print screen. 

If this machine is not displayed, check the IP address. 

- 

 

Unable to print 

Cause Solution Reference 

Is the machine powered on? Please power this machine on. 

If the power is on, turn the power off and then on again to 

see if the problem is solved. 

 Turning the power on  

 Turning the power off  
 

Is the machine connected to 

the same network as the iOS 

device? 

 Check if this machine is displayed on the iOS print screen. 

If this machine is not displayed, check the IP address. 

- 

Is the latest firmware 

installed? 

Make sure that the firmware of this machine and the 

macOS and iOS software are of the latest versions. 

If they are not of the latest versions, please update them to 

the latest versions from the website or Apple's website. 

- 

Is there any paper? Make sure that the out-of-paper message is not displayed.  Error message list  

 When an error 

message appears on 

the display  
 

Is there any toner? Make sure that the out-of-toner message is not displayed.  Error message list  

 When an error 

message appears on 

the display  
 

Is AirPrint set to [Enable]? Press the scroll buttons on the operator panel several times 

to check the status of [AirPrint]. If [Disable] is displayed, 

AirPrint is not available. 

- 

Is any error displayed? Check the error message.  Error message list  

 When an error 

message appears on 

the display  
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Maintenance 

 

Precautions for replacing consumables ................................................. 295 

Service life and replacement cycle of consumables .............................. 296 

Replacing the black(K) toner cartridge and the waste toner box ........... 298 

Replacing the toner cartridge (C/M/Y) .................................................... 301 

Replacing the image drum ..................................................................... 303 

Service life and replacement cycle of maintenance parts ...................... 306 

Replacing the belt unit ............................................................................ 308 

Replacing the fuser unit ......................................................................... 310 

Cleaning the main unit and the parts ..................................................... 312 

Updating software .................................................................................. 321 

Deleting software .................................................................................... 322 

Firmware update .................................................................................... 324 

This section explains how to maintain this machine for a long and comfortable use. 
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Precautions for replacing consumables 

Note the following points during the replacement. 

 

 

 
Do not throw the toner, toner cartridge or waste toner box into fire. Toner may fly off, thus causing burns. 

 
Do not store the toner cartridge and waste toner box in a place with fire. Doing so may cause a fire or burns. 

 

Do not clean up spilled toner using an electric vacuum cleaner. When spilled toner is cleaned up using an 

electric vacuum cleaner, a fire may be caused due to sparks from electrical contacts. Wipe off and remove the 

toner spilled on the floor using a wet cloth. 

 

As the fuser unit may be hot, be cautious during operation and always hold the handle to lift it. When it is hot, 

wait until it cools down before any operation. 

 

 

 

There are high-temperature parts inside the machine. Do not touch the area with the "Caution: High 

Temperature" label. Doing so may cause burns. 

 

Keep the toner cartridge and waste toner box out of the reach of children. If children swallow toner by mistake, 

immediately consult a physician. 

 

When toner is inhaled, gargle with a lot of water and move the person to a place with fresh air. Consult a 

physician as necessary. 

 
When toner gets contact with the skin of your hands etc., wash it off with soapy water. 

 

If toner gets into your eyes, immediately wash it off with a large quantity of water. Consult a physician as 

necessary. 

 
When toner is swallowed, exhale the toner. Consult a physician as necessary. 

 

When clearing a paper jam or replacing the toner cartridge and the waste toner box, take care that your hands 

and clothes are not stained with toner. When clothes are stained with toner, wash them in cold water. Heating it 

like washing in hot water may dye the toner on clothes, and the stains may not be removed easily. 

 

Do not disassemble the image drum, toner cartridge, waste toner box or belt unit. Doing so may scatter the 

toner, which may be inhaled by people or may stain clothes or hands. 

 
Store the used toner cartridge and the waste toner box in a bag so that toner does not scatter. 

 
 Use genuine Printronix consumables for optimum performance. 

 Failures caused by using non-genuine consumables may void the warranty or maintenance contract. (The use of 

non-genuine consumables will not necessarily cause failures, but please fully take notice of such usage.) 
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Service life and replacement cycle of consumables 

Toner cartridge 

Service life of the toner cartridge 

To check the remaining toner amount, select the toner of each color in [Configuration] - [Supplies Status] from 

the operator panel. 

Replacement cycle of the toner cartridge 

When the time for replacement is approaching or has arrived, the following message appears on the display. 

 
When the time for replacement is 

approaching 
→ 

When the time for replacement has 
arrived 

Displayed message 

Cyan/Magenta/Yellow/Black (K)Toner Low. 
→ 

Cyan/Magenta/Yellow/Black (K) Toner Is 

Empty. Replace With A New Toner 

Cartridge. 

Response to the 
message 

Prepare a new toner cartridge of the 

displayed color. 
→ 

Replace the toner cartridge with a new one. 

State of this machine 
Printing is possible, but the toner of the 

displayed color is low. 
→ 

The toner of the displayed color is empty. 

Printing stops. 

About 200 pages can be printed from when the time for replacement is approaching to when the time for 

replacement has arrived. (This is the reference value in the case of A4 simplex printing with a density of 5%.) 

 

 
 Printing quality will decline after the toner cartridge stays unpacked for one year or longer. Therefore, prepare a new 

toner cartridge. 

 Use genuine Printronix consumables for optimum performance. 

 Failures caused by using non-genuine consumables may void the warranty or maintenance contract. (The use of 

non-genuine consumables will not necessarily cause failures, but please fully take notice of such usage.) 

 Printing under the following conditions may damage the image drum. Replace the toner cartridge immediately. 

 Opening and closing the front cover with toner empty 

 Printing in mono without cyan (blue), magenta (red) or yellow (yellow) toner 

 Replace the toner cartridge immediately when a message indicating replacement of the toner cartridge is displayed 

and printing has stopped. 

 If you repeatedly open and close the front cover so that you can continue printing temporarily, a failure may be 

caused or the print quality may be degraded. 

In addition, after a certain period of time, printing will be disabled even if you open and close the front cover. (The 

printable period of time varies with the usage condition.) 

 Replacing the black(K) toner cartridge and the waste toner box  

 Replacing the toner cartridge (C/M/Y)  

Image drum 

Service life of the image drum 

The image drum can print approximately 50,000 sheets of A4-sized paper (for simplex printing), but the actual 

printable number of sheets may vary with the usage condition. 

The above number is based on the general usage condition (three sheets at a time). If you print a single sheet 

at a time, the life may be reduced by half. A message appears indicating preparation for replacement when 

the end of life is approaching. 
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To check the life of the image drum, select the image drum of each color in [Configuration] - [Supplies Status] 

from the operator panel. 

Replacement cycle of the image drum 

When the time for replacement is approaching or has arrived, the following message appears on the display. 

 
When the time for replacement is 

approaching 
→ 

When the time for replacement has 
arrived 

Displayed message 

Cyan/Magenta/Yellow/Black (K) Image 

Drum Near Life. 
→ 

Cyan/Magenta/Yellow/Black (K) Image 

Drum End Of Life. Replace With A New 

[Color Name] Image Drum 

Response to the 
message 

Prepare a new image drum of the displayed 

color. 
→ 

Replace the image drum with a new one. 

State of this machine 

Printing is possible, but the image drum of 

the displayed color is approaching the end of 

its service life. 

→ 
The image drum of the displayed color has 

reached the end of its service life. Printing 

stops. 

About 1,500 pages can be printed from when the time for replacement is approaching to when the time for 

replacement has arrived. 

 

 
 Printing quality will decline after the image drum stays unpacked for one year or longer. Therefore, prepare a new 

image drum. 

 Because the image drum (green part) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it uncovered 

for more than 5 minutes even under room lighting. 

 

 Use genuine Printronix consumables for optimum performance. 

 Failures caused by using non-genuine consumables may void the warranty or maintenance contract. (The use of 

non-genuine consumables will not necessarily cause failures, but please fully take notice of such usage.) 

 Replace the image drum immediately when a message indicating replacement of the image drum is displayed and 

printing has stopped. 

If you repeatedly open and close the front cover so that you can continue printing temporarily, a failure may be 

caused or the print quality may be degraded. 

In addition, after a certain period of time, printing will be disabled even if you open and close the front cover. (The 

printable period of time varies with the usage condition.) 

 If [Admin Setup] - [Panel Setup] - [Near Life Status] is set to [Disable], a message indicating the time for replacement 

will not be displayed. 

 
 You can change the timing for displaying a message indicating the time for replacement of the image drum. The 

factory default value is [1500]. 

This timing can be set from [Admin Setup] - [Others Setup] - [Near Life Setup] - [Drum Near Life Timing] on the 

operator panel. 

The setting range is from 500 to 5,000 (in increments of 500). 

 Replacing the image drum  
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Replacing the black(K) toner cartridge and the waste toner 
box 

The black(K) toner cartridge comes with a waste toner box. 

By following on-screen instructions, replace the waste toner box first and then the black(K) toner cartridge. 

 

1 Press the knob on the lower left corner on the front of the machine, and open the waste toner 

box cover toward you. 

 

2 Put your finger on the recess of the waste toner box, pull it out halfway, and pull it out by the 

top. 

 

3 Prepare a new waste toner box. 

 

4 Install the new waste toner box into this machine. 

 

5 Close the cover of the waste toner box. 
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6 Take the new black(K) toner cartridge out of its packing box. 

 

7 Shake the new toner cartridge both horizontally and vertically for several times. 

 

8 Pull the front cover open lever (blue) to open the front cover. 

 

9 Pull out the black(K) toner cartridge from the machine. 

 

10 Install the new black(K) toner cartridge into the machine. 

 

11 Close the front cover firmly with both hands. 
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12 Press «OK». 

 

13 Check that no error message appears on the display. 

 

 
 Please recycle the used toner cartridge and waste toner box. 
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Replacing the toner cartridge (C/M/Y) 

This section takes the toner cartridge (M) as an example. The toner cartridge (C/Y) can be replaced by the 

same procedure. 

 
 To replace the black toner cartridge (K), please refer to "Replacing the black(K) toner cartridge and the waste toner 

box ". 

 

1 Remove the new toner cartridge of the color to be replaced from its packing case. 

 

2 Shake the new toner cartridge both horizontally and vertically for several times. 

 

3 Pull the front cover open lever (blue) to open the front cover. 

 

4 Remove the toner cartridge of the color to be replaced from the machine. 

 

5 Insert the new toner cartridge into the machine. 
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6 Close the front cover firmly with your both hands. 

 

 

 
 Please recycle the used toner cartridge. 
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Replacing the image drum 

1 Pull the front cover open lever (blue) to open the front cover. 

 

2 Pull the L1 lever towards you until the red triangle mark on the L1 lever is aligned with the red 

triangle mark inside the machine. 

 
 If the two red triangle marks are not aligned correctly, you cannot proceed to the procedure of replacing the 

image drum. 

 

3 Pull the L2 lever and lift the output tray to the stop position. 

 
 The image drum basket cannot be pulled out unless the output tray is fully open. 

 

4 Hold the L3 handle and pull out the image drum basket until it stops. 

 
Doing so may cause burns. 

 

Do not touch the fuser unit because it is hot. 
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5 Check the image drum to be replaced by the label color. 

 

6 Remove the image drum of the color to be replaced. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 
 The image drum is not fixed in the main unit. You can just lift to remove it. 

 

7 Take the new image drum of the color to be replaced out of its box. 

8 Take out the desiccant of the new image drum. 

 

9 Install the new image drum in this machine by holding it with the color label on the right. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 

10 Hold the L3 handle and push the image drum basket all the way in. 

 
 If the image drum is not installed correctly, the image drum basket cannot be pushed all the way in. 
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 The output tray cannot be closed unless the image drum basket is pushed all the way in. 

 

11 Close the output tray, and push both sides down from top. 

 

12 Press the L1 lever all the way in. 

 
 The front cover cannot be closed unless all the image drums of the four colors are installed. 

 

13 Close the front cover firmly with both hands. 

 

 

 
 Please recycle the used image drum. 
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Service life and replacement cycle of maintenance parts 

Belt unit 

Service life of the belt unit 

The belt unit can print approximately 60,000 sheets of A4-sized paper (for simplex printing), but the actual 

printable number of sheets may vary with the usage condition. 

The above number is based on the general usage condition (three sheets at a time). 

To check the life of the belt unit, select [Functions] - [Configuration] - [Supplies Status] - [Belt] from the 

operator panel. 

Replacement cycle of the belt unit 

When the time for replacement is approaching or has arrived, the following message appears on the display. 

 
When the time for replacement is 

approaching 
→ 

When the time for replacement has 
arrived 

Displayed message 
Belt Unit Near Life. 

→ 
Belt Unit End Of Life. Replace With A New 

Belt Unit. 

Response to the 
message 

Please prepare a new belt unit. 
→ 

Replace the belt unit with a new one. 

State of this machine 
Printing is possible, but the belt unit is 

approaching the end of its service life. 
→ 

The belt unit has reached the end of its 

service life. Printing stops. 

About 1,500 pages can be printed from when the time for replacement is approaching to when the time for 

replacement has arrived. 

 

 
 A message indicating replacement of the belt unit may be displayed without displaying a message indicating that the 

time for replacement is approaching. 

In this case, please replace the belt unit. 

 Replace the belt unit immediately when a message indicating replacement of the belt unit is displayed and printing 

has stopped. 

If you repeatedly open and close the front cover so that you can continue printing temporarily, a failure may be 

caused or the print quality may be degraded. 

In addition, after a certain period of time, printing will be disabled even if you open and close the front cover. (The 

printable period of time varies with the usage condition.) 

 If [Admin Setup] - [Panel Setup] - [Near Life Status] is set to [Disable], a message indicating the time for replacement 

will not be displayed. 

 Because the image drum (green part) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it uncovered 

for more than 5 minutes even under room lighting. 

 
 You can change the timing for displaying a message indicating the time for replacement of the belt unit. The factory 

default value is [1500]. 

This timing is set from [Admin Setup] - [Others Setup] - [Near Life Setup] - [Belt Near Life Timing] on the operator 

panel. 

The setting range is from 500 to 5,000 (in increments of 500). 

 Replacing the belt unit 
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Fuser unit 

Service life of the fuser unit 

The fuser unit can print approximately 60,000 sheets of A4-sized paper (for simplex printing), but the actual 

printable number of sheets may vary with the usage condition. 

The above number is based on the general usage condition (three sheets at a time). If you print a single sheet 

at a time, the life may be reduced by half. A message appears indicating preparation for replacement when 

the end of life is approaching. 

To check the life of the fuser unit, select [Functions] - [Configuration] - [Supplies Status] - [Fuser] from the 

operator panel. 

Replacement cycle of the fuser unit 

When the time for replacement is approaching or has arrived, the following message appears on the display. 

 
When the time for replacement is 

approaching 
→ 

When the time for replacement has 
arrived 

Displayed message 
Fuser Near Life. 

→ 
Fuser Unit End Of Life. Replace With A New 

Fuser Unit 

Response to the 
message 

Prepare a new fuser. 
→ 

Replace With A New Fuser Unit. 

State of this machine 
Printing is possible, but the fuser unit is 

approaching the end of its service life. 
→ 

Printing stops. 

About 1,500 pages can be printed from when the time for replacement is approaching to when the time for 

replacement has arrived. 

 

 
 Replace the fuser unit immediately when a message indicating replacement of the fuser unit is displayed and printing 

has stopped. 

If you repeatedly open and close the front cover so that you can continue printing temporarily, a failure may be 

caused or the print quality may be degraded. 

In addition, after a certain period of time, printing will be disabled even if you open and close the front cover. (The 

printable period of time varies with the usage condition.) 

 If [Admin Setup] - [Panel Setup] - [Near Life Status] is set to [Disable], a message indicating the time for replacement 

will not be displayed. 

 
 You can change the timing for displaying a message indicating the time for replacement of the fuser unit. The factory 

default value is [1500]. 

This timing is set from [Admin Setup] - [Others Setup] - [Near Life Setup] - [Fuser Near Life Timing] on the operator 

panel. 

The setting range is from 500 to 5,000 (in increments of 500). 

 Replacing the fuser unit  
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Replacing the belt unit 

For the replacement cycle, see "Belt unit ". 

 

1 Pull the front cover open lever (blue) to open the front cover. 

 

2 Pull the L2 lever and lift the output tray to the stop position. 

 

3 Remove the belt unit by holding its blue handle. 

 
Doing so may cause burns. 

 

Do not touch the fuser unit because it is hot. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 

4 Take the new belt unit out of its box. 

 



 

- 309 - 

5 Install the belt unit in this machine by holding its blue handle. 

 

6 Close the output tray, and push both sides down firmly from top. 

 

7 Close the front cover firmly with both hands. 

 

 

 
 Please recycle the used belt unit. 
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Replacing the fuser unit 

For the replacement cycle, see "Fuser unit ". 

 

1 Lift the left and right handles of the fuser unit at the back of the output tray until a click is heard, 

and then release the lock. 

 
 The fuser unit cannot be removed unless its handle is raised vertically. 

 

2 Remove the fuser unit from this machine by holding its left and right handles. 

 
Doing so may cause burns. 

 

When the fuser unit is hot, wait until it cools down before any operation. 

 
 Do not expose this machine with the fuser unit removed to direct sunlight or strong light (About 1,500 lux or 

above). Do not leave it uncovered for more than 5 minutes even under room lighting. 

 

3 Take the new fuser unit out of its box, and lift the left and right handles up vertically until a click 

is heard. 
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4 With the warning label of the new fuser unit facing the front, hold both the left and right handles 

and install the fuser unit into this machine. 

 

5 Push down the left and right handles of the fuser unit to lock. 

 
 Make sure that the fuser unit does not float from the top of the output tray. If floating, the fuser unit will not be 

recognized so that it is not possible to start printing. 

 

 

 
 Please recycle the used fuser unit. 
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Cleaning the main unit and the parts 

Cleaning the LED head 

If there are white stripes on the output paper, the image is faded or the text is blurred, clean the LED head. 

 
 Do not use methyl alcohol or thinner. Doing so may damage the LED head. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it uncovered 

for more than 5 minutes even under room lighting. 

 

1 Power off this machine. 

2 Pull the front cover open lever (blue) to open the front cover. 

 

3 Pull the L1 lever towards you until the red triangle mark on the L1 lever is aligned with the red 

triangle mark inside the machine. 

 
 If the two red triangle marks are not aligned correctly, you cannot separate the output tray and the image drum 

basket. 

 

4 Pull the L2 lever and lift the output tray to the stop position. 
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5 Gently wipe the lens surface of the LED head (x 4) with a soft tissue paper. 

 
 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 

6 Close the output tray, and push both sides down from top. 

 

7 Press the L1 lever all the way in. 

 

8 Close the front cover firmly with both hands. 

 

Cleaning the surface of the main unit 

 
 Do not use benzene, paint thinner or alcohol as it may damage plastic parts and coating of this machine. 

 It is not necessary to lubricate the parts of this machine. Do not lubricate. 

 

1 Power off this machine.  
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2 Clean the surface of this machine with a cloth slightly moistened with water or a neutral 

detergent. 

 
 Only use water or a neutral washing agent. 

 

3 Wipe the surface of this machine with a soft dry cloth. 

Cleaning paper feed rollers (Trays 1-4) 

If paper jams occur frequently, clean the paper feed roller. Clean the separation roller of the paper cassette 

and the paper feed roller inside this machine. 

 
 If paper jams persist even after the paper feed roller is cleaned, it is recommended to replace the paper feed roller. 

The following procedure takes Tray 1 for example. You can follow the same procedure to clean paper feed 

rollers for Tray 2, Tray 3 and Tray 4. 

 

1 Pull out the paper cassette. 

 

2 Wipe the two paper feed rollers inside this machine with a cloth slightly moistened with water. 
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3 Remove the paper from the paper cassette. 

4 Wipe the separation roller of the cassette with a cloth slightly moistened with water. 

 

5 Load the paper in the paper cassette. 

6 Return the paper cassette to this machine. 

 

Cleaning the paper feed roller (MP tray) 

If paper jams occur frequently, clean the paper feed roller. 

 
 If paper jams persist even after the paper feed roller is cleaned, it is recommended to replace the paper feed roller. 

 

1 Place your fingers in the front recess and pull to open the MP tray towards you. 

 

2 Slide the manual feeder guide inward. 
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3 While lifting the MP tray gently, press the right arm inwards and remove the protrusion of the 

arm from the groove. 

 

4 Lower the MP tray, and lift up the protrusion of the arm. 

 

5 By referring to Steps 3 and 4, remove the protrusion of the left arm of the MP tray from the 

groove and lift it up. 

6 Lift up the paper placement cover until it attaches to the machine. 

 

7 Press down on the center of the MP tray, and then press and hold the white part which is visible 

through the small window at the bottom of the separation roller cover. Remove the lower paper 

feed roller (without gear) by expanding the side protrusion outward and sliding it to the left. 
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8 Press down on the center of the MP tray, place your finger over the small window on the 

separation roller cover and push it up to remove the separation roller. 

 

9 Wipe the separation roller with a cloth slightly moistened with water (while rotating it in the 

arrow direction). 

 

10 Press down on the center of the MP tray until the left trapezoidal part of the separation roller 

cover fits into the groove on the machine. 

 

11 Ensure that the separation roller is in a horizontal position, and then push both ends of the 

separation roller cover down at the same time. 

 
 Do not touch the rubber portion of the roller. 
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12 Press down on the center of the MP tray, and then press and hold the white part which is visible 

through the small window at the bottom of the separation roller cover. With the protrusion side 

on the left, install the paper feed roller (without gear) onto the lower shaft by sliding it into the 

innermost position. 

If it is hard to insert, slide to install the paper feed roller (without gear) while rotating it downward. 

 

13 Wipe the paper feed roller (without gear, with gear) with a cloth slightly moistened with water. 

 
 If it is hard to wipe the paper feed roller (without gear), wipe it while pressing down on the center of the MP tray 

and then pushing the white part which is visible through the small window at the bottom of the separation roller 

cover. 

 

14 Move the paper placement cover downward. 
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15 While pressing the right arm of the MP tray inwards, lift the MP tray lightly and hook the 

protrusion of the arm into the groove. 

 
 If you close the MP tray without hooking the protrusion of the arm to the correct position, the paper placement 

cover may be broken. Be sure to hook it in the correct position. 

 

16 Similarly, hook the protrusion of the left arm of the MP tray into the groove. 

 
 If you close the MP tray without hooking the protrusion of the arm to the correct position, the paper placement 

cover may be broken. Be sure to hook it in the correct position. 

17 Slide the manual feeder guide outward. 

 

18 Close the MP tray. 

If the MP tray does not close, check by following Steps 14 through 17. 

 

Cleaning the light-shielding film 

When streaks appear on the printing result, clean the light-shielding film of the image drum to improve the 

printing. 

 

1 Remove the black(K) image drum from this machine. 

 Replacing the image drum 

2 Make sure that the color label of the image drum is on the right side. 

3 Wipe the light-shielding film with soft tissue paper. 
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4 Install the image drum to this machine. 

 Replacing the image drum 

5 Clean the light-shielding film of other image drums as well. 

Cleaning the resist roller 

When horizontal streaks appear on the printing result, clean the resist roller to improve the printing. 

 

1 Pull the front cover open lever (blue) to open the front cover. 

 

2 Wipe the metal parts (a) and (b) of the resist roller visible on the front with soft tissue paper. 

 

 
 When cleaning the metal part (b), do not touch the rubber roller in contact with the metal part (a). 

3 Rotate the metal part downward, and repeat wiping until dirt is removed. 

4 Close the front cover firmly with your both hands. 
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Updating software 

You can update the printer driver and other software to the latest version. 

A PC connected to the Internet is required for the update. 

For Windows 

For Windows, use the Monitoring Tool. 

 Monitoring Tool (Windows)  

For macOS 

For macOS, please refer to the website. 
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Deleting software 

This section explains how to delete the printer driver from your PC. 

 
 The specific method may differ for different printer drivers and versions of Windows or macOS. 

Uninstalling the Windows printer driver 

 
 To perform this procedure, you will have to login to the PC as a user with administrator privileges. 

 Restart the PC before uninstalling the printer driver. 

 

1 Open the "Devices and Printers". 

 How to open the printer folder  

2 Right-click on the icon of the printer to be deleted, and select [Remove device]. 

3 When a confirmation message is displayed, click [Yes]. 

 
 If a message indicating that the device is being used is displayed, restart the PC and repeat Steps 1 and 2. 

4 Select one of the icons in [Printers], and click [Print server properties] in the menu bar. 

5 Select the [Drivers] tab. 

6 Click [Change Driver Settings] if displayed. 

7 Select the driver to be deleted, and click [Remove]. 

8 When a message asking whether to delete the printer driver only or the printer driver and 

package from the system, select [Remove driver and driver package], and click [OK]. 

9 When a confirmation message is displayed, click [Yes]. 

10 When the [Remove Driver Package] screen is displayed, click [Delete] - [OK]. 

 
 If deletion is rejected, restart the PC and repeat Steps 4 to 10. 

11 Click [Close] in the [Print Server Properties] screen. 

12 Restart the PC. 

Uninstalling the macOS printer driver 

 
 To perform this procedure, you will have to login to the PC as a user with administrator privileges. 

 

1 Select [System Preferences] from the Apple menu. 

2 Select [Printers & Scanners]. 

3 Select the device to be deleted, and click [-]. 

When a confirmation message is displayed, click [Delete Printer]. 

 
 If you cannot click [-], click the key mark. 

4 Close the [Printers & Scanners] screen. 
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5 Insert the provided DVD to the PC. 

6 Double-click on [Printronix] - [Drivers] - [PS] - [Uninstaller]. 

7 Confirm the model to be deleted displayed in the dialog box, and click [OK]. 

8 Follow the on-screen instructions to delete the printer driver. 

9 Once the deletion is complete, remove the included DVD from your computer. 
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Firmware update 

You can update the printer firmware (device control program) to the latest version. 

A PC connected to the Internet is required for the update. 

For Windows 

For Windows, use the Monitoring Tool. 

 Monitoring Tool (Windows)  

For macOS 

For macOS, please refer to the website. 
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When an error message appears on the display 

If a problem occurs to this machine, the ATTENTION lamp will light on or flash, and a message will appear on 

the display. 

Check the message on the display and take action based on the corresponding message. 

If [Please see HELP for details] appears at the bottom of the display, press «HELP» on the operator panel to 

show the solution. (If there is no indication, pressing «Help» will not change the indication on the display.) 

 
 If a search keyword is displayed, you can search for a solution by inputting it in [Search Keyword] of "Frequently 

Asked Questions (FAQs)" on the website or your smartphone application. 

 If a search keyword is displayed when the NFC function is enabled, the solution is displayed on this machine when 

the NFC mark on the operator panel is brought close to a device with the NFC function. Please see "Showing 

troubleshooting tips on a mobile device " for details. 

 

1 Display message 

2 ATTENTION lamp 

3 «HELP» button 

 

 

Displayed when «HELP» is pressed 

 

1 Error code 

2 Scrolls up the display 

3 Scrolls down the display 
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Error message list 

Clear the error by referring to the description of the corresponding message. 

Meanings of symbols used in the error message are as follows. 

 Color Name: One of the following: cyan (C), magenta (M), yellow (Y), black (K)  

 Tray Name: One of the following: Tray 1, Tray 2, Tray 3, Tray 4 and MP tray 

 Cover Name: Either the front cover or the top cover (Output tray) 

 Code: The error code number of 1 to 3 digits. The displayed number changes with the specific error. 

 Pages: Number of pages to print 

 Media Size: The size of paper 

 Media Type: The type of paper 

 Number: Number of all places where paper jams have occurred 

For "---", different messages are displayed depending on the state of this machine. 

When "Please see HELP for details" is displayed at the bottom of the display, if you press «HELP» on the 

operator panel, the error code and solution will be displayed. 

Message Error code Description 

Cover Name Open 

Please See HELP For Details 

310, 311 The indicated cover is open. Close the cover. 

310: Outlet tray (Top cover); 311: Front cover 

Belt Unit Is Not Installed Correctly. 

Please Reset 

Please See HELP For Details 

330 The belt unit is not properly installed. Please reinstall the belt 

unit. 

To install the belt unit, see "Replacing the belt unit ". 

Waste Toner Box Is Not Installed 

Correctly Because The Cover Is 

Open. Please Reset 

Please See HELP For Details 

331 The waste toner box is not properly installed. Please reinstall 

the waste toner box. 

To replace the waste toner box, see "Replacing the black(K) 

toner cartridge and the waste toner box ". 

Toner Cartridge Is Not Installed 

Check All Toner Cartridges Are 

Installed Correctly. Please See 

HELP For Details 

335 One of the four color toner cartridges is not properly installed. 

Please reinstall the toner cartridge that is not properly installed. 

To install the toner cartridge, see "Replacing the black(K) toner 

cartridge and the waste toner box " or "Replacing the toner 

cartridge (C/M/Y) ". 

Color Name Image Drum Is Not 

Installed Correctly. Please Reset 

Please See HELP For Details 

340, 341, 342, 343 The image drum of the displayed color is not properly installed. 

Please reinstall the image drum. 

To install the image drum, see "Replacing the image drum". 

340: Yellow; 341: Magenta; 342: Cyan; 343: Black 

Fuser Unit Is Not Installed 

Correctly. Please Reset 

Please See HELP For Details 

320 The fuser unit is not properly installed. Please reinstall the 

fuser unit. 

To install the fuser unit, see "Replacing the fuser unit ". 

If the error persists, replace the fuser unit with a new one. 

Fuser Unit Is Not Installed 

Correctly. Reset Fuser Unit 

Please See HELP For Details 

348 The fuser unit is not properly installed. Please reinstall the 

fuser unit. 

To install the fuser unit, see "Replacing the fuser unit ". 

If the error persists, replace the fuser unit with a new one. 

Color Name Image Drum End Of 

Life. Replace With A New Color 

Name Image Drum 

Please See HELP For Details 

350, 351, 352, 353 The image drum of the displayed color has reached the end of 

its service life. You can continue printing for a while by opening 

and closing the front cover, but please replace the image drum 

with a new one promptly. 

To replace the image drum, see "Replacing the image drum ". 

350: Yellow; 351: Magenta; 352: Cyan; 353: Black 

Fuser Unit End Of Life. Replace 

With A New Fuser Unit 

354 The fuser unit has reached the end of its service life. Please 

replace the fuser unit with a new one. 
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Message Error code Description 

Please See HELP For Details You can continue printing for a while by opening and closing 

the front cover. 

To replace the fuser unit, see "Replacing the fuser unit ". 

Belt Unit End Of Life. Replace With 

A New Belt Unit 

Please See HELP For Details 

355 The belt unit has reached the end of its service life. Please 

replace the belt unit with a new one. 

You can continue printing for a while by opening and closing 

the front cover. 

To replace the belt unit, see "Replacing the belt unit ". 

Belt Unit End Of Life. Replace With 

A New Belt Unit 

Please See HELP For Details 

356 The waste toner area of the belt unit is full. Please replace the 

belt unit with a new one. 

To replace the belt unit, see "Replacing the belt unit ". 

Waste Toner Full. Install New 

Waste Toner Box 

Please See HELP For Details 

357 See "Replacing the black(K) toner cartridge and the waste 

toner box ". 

Waste Toner Transfer Error. 

Please Reset Waste Toner Box 

Please See HELP For Details 

359 See "Replacing the black(K) toner cartridge and the waste 

toner box ". 

Paper Size Error. Reset Paper In 

Tray Name 

Please See HELP For Details 

400 Multiple sheets of paper are fed at a time from the displayed 

tray. Or, the paper of a size different from the paper size setting 

of the tray is fed. 

Remove the jammed paper. 

Remove the paper temporarily from the tray when multiple 

sheets of paper are fed at a time. Shuffle the paper well, 

horizontally align the edge of paper, and load the paper in the 

tray again. 

Otherwise, check the size of paper to print on and the paper 

size setting of the tray, and match the paper settings. 

Multiple Sheets Of Paper Have 

Been Fed. Reset Paper In Tray 

Name 

Please See HELP For Details 

401 Multiple sheets of paper are fed at a time from the displayed 

tray. Or, the paper of a size different from the paper size setting 

of the tray is fed. 

Remove the jammed paper. 

Remove the paper temporarily from the tray when multiple 

sheets of paper are fed at a time. Shuffle the paper well, 

horizontally align the edge of paper, and load the paper in the 

tray again. 

If overlapping paper is not fed, check the size of the paper to 

print on and the paper size setting of the tray, and match the 

paper settings. 

Printing Stopped Because The 

Rear Output Tray Is Opened 

During The Printing Job. Please 

Remove Paper 

Please See HELP For Details 

409 Open the front cover, and remove the paper left in the machine 

if any. Then, close the front cover. 

Rear Output Tray Open. Duplex 

Not Available 

Please See HELP For Details 

581 Please close the rear output tray. 

Color Name Toner Is Empty 

Replace With A New Toner 

Cartridge. Please See HELP For 

Details 

410, 411, 412 The toner of the displayed color is empty. 

You can continue using the device for a while by opening and 

closing the front cover, but the image drum may be damaged. 

Therefore, please replace the toner cartridge with a new one 

promptly. To replace the toner cartridge, see "Replacing the 

toner cartridge (C/M/Y) ". 

410: Yellow; 411: Magenta; 412: Cyan 

Black(K)Toner Is Empty 413 The black (K) toner is empty. 
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Replace With A New Toner 

Cartridge And A New Waste Toner 

Box At The Same Time. Please 

See HELP For Details 

You can continue using the device for a while by opening and 

closing the front cover, but the image drum may be 

damaged.Therefore, please replace the toner cartridge with a 

new one promptly. To replace the toner cartridge, see 

"Replacing the black(K) toner cartridge and the waste toner 

box ". 

Check That The Waste Toner Box 

Has Been Replaced, And Press 

OK 

Please See HELP For Details 

418 If you have not replaced the waste toner box, press «OK». 

If you have already replaced it, just press «OK». 

Press OK After Replacing The 

Black(K) Toner Cartridge 

 

Please See HELP For Details 

428 Replace the black(K) toner and press «OK». 

Printing Data Is Large. Memory Is 

Not Enough 

Press OK To Hide This Message. 

Please See HELP For Details 

420 The memory is insufficient. 

Print again after lowering the printing quality in the printer 

driver. 

No Cassette In Tray Name. 

Remove The Tray And Re-insert 

Please See HELP For Details 

430, 431, 432, 

433, 440, 441, 442 

The printing has stopped because the displayed paper cassette 

is not properly installed. 

Pull the paper cassette out, and insert it back. 

430, 440: Tray 1; 431, 441: Tray 2; 432, 442: Tray 3; 433: 

Tray4 

Data (Media Size, Media Type) 

Doesn't Match Paper In Tray 

Name 

Press OK To Continue Printing. 

Please See HELP For Details 

460, 461, 462, 

463, 464 

The size of paper loaded in the displayed tray does not match 

the size of paper you are trying to print on. Check the paper 

size settings of the application you are trying to print from and 

the paper size settings of the tray, and match the paper size 

settings. 

If the paper size can be loaded in portrait/landscape, please 

note the vertical/horizontal orientation. 

460: MP tray; 461: Tray 1; 462: Tray 2; 463: Tray 3; 464: Tray 

4 

No Paper In Tray Name. Set 

Media Size 

Please See HELP For Details 

490 There is no paper in the indicated tray. 

Please load paper. 

490: MP tray 

No Paper In Tray Name. 

Set Media Size. Please See HELP 

For Details 

491, 492, 493, 494 There is no paper in the indicated tray. 

Please load paper. 

491: Tray 1; 492: Tray 2; 493: Tray 3; 494: Tray 4 

Wireless Settings Are Incomplete 

Press OK To Hide This Message. 

Please See HELP For Details 

505 The wireless LAN settings are not correct. 

Please reset the wireless LAN from the beginning. For details, 

see "Connecting via a wireless LAN ". 

If the problem still persists, initialize the network settings and 

reset the wireless LAN settings. To initialize the network 

settings, see "Initializing network settings ". 

Not Connected To Wireless 

Access Point 

Press OK To Hide This Message. 

Please See HELP For Details 

506 Not connected to the wireless LAN access point. Or, the 

wireless communication may be poor. 

Check that the power of the wireless LAN access point is 

turned on. 

Check that the wireless LAN settings are correct. 

For details, see "Connecting via a wireless LAN ". 
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Message Error code Description 

   

Wireless Startup Failed 

Press OK To Hide This Message. 

Please See HELP For Details 

517 Restart this machine. 

If the problem still persists even after the reboot, power off this 

machine and check that the model name of the wireless LAN 

module is applicable to this machine. 

If the model name is incorrect, replace the wireless LAN 

module with the one suitable for this machine. 

If the model name is correct, consult your dealer. 

Receiving Data Timeout 

Press OK To Hide This Message. 

Please See HELP For Details 

519 The data could not be received within the correct time. 

When the print result is not as good as expected, extend the 

time for network timeout. The factory default setting is 90 

seconds. 

Press the scroll buttons on the operator panel several times to 

change the settings in [Menus] - [System Setup] - [Timeout 

InJob]. 

Image Drum Sensor Error. Check 

And Reset Color Name Image 

Drum 

Please See HELP For Details 

540, 541, 542, 543 A sensor error has occurred to the image drum of the indicated 

color. 

Please reinstall the image drum. To install the image drum, see 

"Replacing the image drum ". 

If the error persists, contact your dealer. 

540: Yellow; 541: Magenta; 542: Cyan; 543: Black 

Color Name Toner Cartridge Is 

Not Installed Correctly 

Reset It Correctly. Please See 

HELP For Details 

544, 545, 546, 547 The toner cartridge of the displayed color is not installed 

properly. Reinstall the toner cartridge. To install the toner 

cartridge, see "Replacing the black(K) toner cartridge and the 

waste toner box " or "Replacing the toner cartridge (C/M/Y) ". 

544: Yellow; 545: Magenta; 546: Cyan; 547: Black 

Color Name Toner Cartridge Is 

Not Installed Correctly 

Reset It Correctly. Please See 

HELP For Details 

The above message has been 

displayed multiple times. 

544 Change the settings to the following: Moisture Control: Mode 2; 

Quiet Mode: On. 

To print with low toner consumption, please restore the 

settings. (The factory default settings are as follows: Moisture 

Control: Off; Quiet Mode: Off) 

Color Name Image Drum End Of 

Life. Replace With A New Color 

Name Image Drum 

Please See HELP For Details 

560, 561, 562, 563 The image drum of the displayed color has reached the end of 

its service life. 

Please replace the image drum with a new one. 

To replace the image drum, see "Replacing the image drum ". 

560: Yellow; 561: Magenta; 562: Cyan; 563: Black 

Color Name Image Drum End Of 

Life. Replace With A New Color 

Name Image Drum 

Press OK to ignore service life and 

continue printing. Please See 

HELP For Details 

564, 565, 566, 567 The image drum of the displayed color has reached the end of 

its service life. 

Please replace the image drum with a new one. You can 

continue printing for a while by pressing «OK» on the operator 

panel, but the print quality is not guaranteed. 

To replace the image drum, see "Replacing the image drum ". 

564: Yellow; 565: Magenta; 566: Cyan; 567: Black 

Fuser Unit Is Not Installed 

Correctly. Or The Handle Of Fuser 

Is In Standing Position 

Please See HELP For Details 

582 The fuser unit is not properly installed. Or, the handle of the 

fuser unit is not locked. 

Please reinstall the fuser unit. To install the fuser unit, see 

"Replacing the fuser unit ". 

Color Name Toner Cartridge Is 

Not Installed 

610, 611, 612, 613 The toner cartridge of the displayed color is not installed. 
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Message Error code Description 

Please See HELP For Details Install the toner cartridge. To install the toner cartridge, see 

"Replacing the black(K) toner cartridge and the waste toner 

box " or "Replacing the toner cartridge (C/M/Y) ". 

610: Yellow; 611: Magenta; 612: Cyan; 613: Black 

Non Recommended Color Name 

Toner 

Please See HELP For Details 

549, 550, 551, 

552, 553, 554, 

555, 556, 557, 

614, 615, 616, 

617, 620, 621, 

622, 623 

The toner cartridge of the displayed color is not optimal for this 

machine. It is recommended to use the toner cartridge that is 

optimal for this machine. 

550, 554, 614, 620: Yellow; 

551, 555, 615, 621: Magenta; 

552, 556, 616, 622: Cyan; 

549, 553, 557, 617, 623: Black 

Paper Jam Occurred. Paper Jam 

Number Place(s). Remove The 

Paper 

Please See HELP For Details 

370, 371, 372, 

380, 381, 382, 

385, 390, 391, 

392, 393, 394, 638 

A paper jam has occurred. 

Multiple sheets of paper remain inside this machine. When the 

scroll button on the operator panel is pressed, the lamp for the 

place where paper is jammed blinks. Remove all the paper 

from where the lamp blinks. 

For how to clear paper jams, see "When paper is jammed ". 

Please Change Paper In MPTray 

Media Size 

Media Type 

Press OK To Start Printing. Please 

See HELP For Details 

660 The paper loaded in the MP tray does not match the paper you 

are trying to print on. Check the paper settings of the 

application you are trying to print from and the paper settings of 

the MP tray, and match the paper settings. 

Please Change Paper In Tray 

Name 

Confirm Media Size, Media Type 

Is Set And Then Press OK. Please 

See HELP For Details 

661, 662, 663, 664 The paper loaded in the displayed tray does not match the 

paper you are trying to print on. Check the paper settings of the 

application you are trying to print from and the paper settings of 

the tray, and match the paper settings. 

661: Tray 1; 662: Tray 2; 663: Tray 3; 664: Tray 4 

Printing Stopped Because Color 

Name Image Drum End Of Life. 

Replace With A New Color Name 

Image Drum 

Please See HELP For Details 

680, 681, 682, 683 The printing has stopped because the image drum of the 

displayed color has reached the end of its service life. 

Please replace the image drum with a new one. To replace the 

image drum, see "Replacing the image drum ". 

680: Yellow; 681: Magenta; 682: Cyan; 683: Black 

Non Recommended Belt Unit 

Please See HELP For Details 

688-01, 688-02, 

688-03, 688-04 

The belt unit is not optimal for this machine. It is recommended 

to use the belt unit that is optimal for this machine. 

Belt Unit Not Installed 

Please See HELP For Details 

689 The belt unit is not properly installed. 

Remove the belt unit and install it properly. To replace the belt 

unit, see "Replacing the belt unit ". 

Color Name Image Drum Is Not 

Installed 

Please See HELP For Details 

694, 695, 696, 697 The image drum of the displayed color is not properly installed. 

Please reinstall the image drum. To install the image drum, see 

“Replacing the image drum ". 

694: Yellow; 695: Magenta; 696: Cyan; 697: Black 

Non Recommended Fuser Unit 

Please See HELP For Details 

698-01, 698-02, 

698-03, 698-04, 

698-07 

The fuser unit is not optimal for this machine. It is 

recommended to use the fuser unit that is optimal for this 

machine. 

Fuser Unit Not Installed 

Please See HELP For Details 

699 The fuser unit is not properly installed in this machine. 

Please reinstall the fuser unit. To replace the fuser unit, see 

"Replacing the fuser unit ". 

Non Recommended Color Name 

Image Drum 

Please See HELP For Details 

684, 685, 686, 

687, 690, 691, 

692, 693, 700, 

701, 702, 703, 

704, 705, 706, 707 

The image drum of the displayed color is not optimal for this 

machine. It is recommended to use the image drum that is 

optimal for this machine. 

684, 690, 700, 704: Yellow; 

685, 691, 701, 705: Magenta; 

686, 692, 702, 706: Cyan; 

687, 693, 703, 707: Black 
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Message Error code Description 

   

Caution: Non-Genuine 

consumable detected. Check 

User's Manual "Trouble Shooting" 

to restore machine operation 

709 You can use any consumables/maintenance parts, but the print 

quality may be lowered and the optimum performance may not 

be obtained. 

If the use of non-genuine consumables/maintenance parts 

causes damage to the product or results in your product not 

functioning to its full specification, such damage or effects on 

the product are not covered by warranty. 

When you understand the above points and use non-genuine 

consumables/maintenance parts, follow the procedure below. 

 Power off the main unit. 

 Power on this machine while pressing «CANCEL» on the 

operator panel. 

 When [Ready To Print] appears, release «CANCEL». 

The above operation will be recorded inside this machine. 

Error While Initializing Settings 

Press OK To Hide This Message 

751 The initial value set with the NFC Setting Tool is not properly 

reflected in the device settings. Please check a setting value. 

Power Off and Wait for a while. 

126:Condensing Error 

Fatal 126 Condensation has occurred inside this machine. 

Turn off the power, and then turn the power back on after a 

while. 

If the same error message is displayed, contact your dealer. 

Recovered from the error nnn 

Print again if the printing result 

does not come as expected 

Press OK To Hide This Message 

- An error has occurred inside this machine, and the machine 

has restarted. Check that the print result comes as expected, 

since the machine may restart during printing. 

Print again if the printing result does not come as expected. 

Service Call 

nnn:Error 

- An error has occurred inside this machine. 

Please contact your dealer. 

Communication Error - An error has occurred in this machine. Restart this machine. 

If the error persists, contact your dealer. 

Detected An Abnormality Of 

Internal Database 

The Data Must Be Deleted 

After Pressing [OK], The Data Will 

Be Deleted, And Then Reboot 

- An error has occurred in the internal database of this machine. 

Press «OK» on the operator panel to delete the database and 

restart this machine. 

Language Change Failed. Error 

num: Code 

- Failed to change the display language on the display. 

Restart this machine, and reset the language setting. 

Firmware Update Error. Perform 

Firmware Update Again 

If The Same Error Message 

Appears, Please Contact Our 

Customer Service Center 

- Firmware update has failed. 

Please update the firmware again. For details, see "Firmware 

update ". 

PU Flash Error - An error has occurred in this machine. 

Please contact your dealer. 

Memory Is Not Enough. Please 

Reduce Resolution Or Finish The 

Function 

Press OK To Hide This Message 

- The memory is insufficient. 

Print again after lowering the printing quality in the printer 

driver. 

Manual Printing. Set Media Size In 

MPTray 

Press OK To Start Printing 

- The print mode has been specified in which paper is loaded in 

the MP tray and fed one by one. 

Load proper paper in the MP tray, and press «OK» on the 

operator panel. 
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If you are printing a multi-page document, the same massage 

appears each time after one page is printed. Press «OK» each 

time. 

   

Install New Image Drum. For 

Maximum Performance Always 

Use Printronix Original 

- The image drum of the displayed color has reached the end of 

its service life. Please replace the image drum with a new one. 

It is recommended to use the image drum that is optimal for 

this machine. 

Color Name Toner Empty. 

For Maximum Performance Always 

Use Printronix Original. 

- The toner of the displayed color is empty. 

Please replace the toner cartridge with a new one. 

It is recommended to use the toner cartridge that is optimal for 

this machine. 

--- 

Can Not Read The File 

Press OK To Hide This Message 

- Canceled because the USB memory is unplugged during 

printing from the USB memory. 

To print it again, plug the USB memory in this machine. 

--- 

Color Name Image Drum Sensor 

Error. Search Keyword: P40959 

- The image drum of the displayed color is not properly installed 

in this machine. 

Please reinstall the image drum of the displayed color. 

--- 

Color Name Image Drum Near 

Life. Search Keyword: P10076 

- The image drum is approaching its service life. 

Please prepare a new image drum. 

After the message of replacement is displayed, please replace 

it with a new one. 

--- 

Color Name Image Drum Life. 

Print Quality Not Guaranteed. 

Search Keyword: P40936 

- The image drum of the displayed color has reached the end of 

its service life. 

Print quality is not guaranteed. Please replace the image drum 

with a new one as soon as possible. To replace the image 

drum, see "Replacing the image drum ". 

--- 

Color Name Image Drum Life. 

Search Keyword: P40936 

- The image drum of the displayed color has reached the end of 

its service life. 

Please replace the image drum with a new one. To replace the 

image drum, see "Replacing the image drum ". 

--- 

Color Name Image Drum Life. 

Pages Pages Left. Search 

Keyword: P40936 

- The image drum of the displayed color has reached the end of 

its service life. 

Unable to print after the displayed number of pages. Please 

replace the image drum with a new one as soon as possible. 

To replace the image drum, see "Replacing the image drum ". 

--- 

Color Name Toner Not Installed. 

Search Keyword: P40902 

- The toner cartridge of the displayed color is not installed. 

Please install the toner cartridge. To install the toner cartridge, 

see "Replacing the black(K) toner cartridge and the waste 

toner box " or "Replacing the toner cartridge (C/M/Y) ". 

--- 

Color Name Toner Empty. Search 

Keyword: P40028 

- The toner of the displayed color is empty. 

Please replace the toner cartridge with a new one. 

--- 

Replace The black(K) Toner 

Cartridge And Waste Toner Box At 

The Same Time. Search Keyword: 

P40028 

- The black(K) toner is empty. 

Replace the black(K) toner cartridge and the waste toner box 

with new ones. 

--- 

Color Name Toner Empty. Search 

Keyword: P40028 

- The toner of the displayed color is empty. 

Please replace the toner cartridge with a new one. 

--- - The toner of the displayed color is low. Please prepare a new 

toner cartridge. 
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Color Name Toner Low. Search 

Keyword: P10081 

After the message of replacement is displayed, please replace 

it with a new one. 

--- 

Tray Name Empty 

- There is no paper in the indicated tray. 

Please load paper. 

--- 

Tray Name Cassette Missing 

- The displayed tray is not properly installed. 

Please install the tray. 

--- 

E-mail Receiving Has Been 

Cancelled 

Press OK To Hide This Message 

- The e-mail printing is canceled. 

The file attached to the e-mail is canceled under the following 

conditions. 

 The format is not PDF, JPEG or TIFF 

 No file is attached 

 The size exceeds 8 MB 

Check the file format and size of the attached file. 

--- 

IPv4 Address Is Conflicted 

Change IPv4 Address 

- The IPv4 Address conflicts with that of another machine. 

Please change the IPv4 address. 

--- 

Getting Target IP Failed. Please 

Check DHCP Settings 

- The DHCP server was not detected. 

Check that the DHCP server is connected to the same network 

of this machine. 

--- 

Error PDF 

Press OK To Hide This Message 

- Unable to print because an error has occurred to the PDF file 

you tried to print. 

Print again by using the printer driver from the application. 

--- 

PDF Cache Write Error 

Press OK To Hide This Message 

- Failed to cache the PDF file. 

Print again after increasing the free space of the flash memory. 

--- 

PDL Error Occurred 

- A PDL error has occurred. 

Press «OK» to clear the error display. 

--- 

No Communication With The 

SNTP Server 

- Failed to retrieve the time from the SNTP server. 

Press the scroll buttons on the operator panel several times to 

check that the setting of [SNTP server] is correct in [Admin 

Setup] - [Time Setup]. 

--- 

USB Hub Unsupported 

Please Detach It 

- A USB hub which is not applicable to this machine is 

connected. 

Please detach the USB hub. 

--- 

Incompatible USB Device 

Connected 

Please Detach It 

- Failed to recognize the USB device. 

Please re-connect the USB device. 

--- 

Color Toner Empty. Job Cancelled 

Press OK To Hide This Message 

- Printing of the received color data is canceled because the 

color toner is empty. 

Please replace the empty toner cartridge with a new one. 

--- 

Color Restricted. Job Rejected 

Press OK To Hide This Message 

- The print data from an user unauthorized to print in color was 

deleted. 

To print in color, contact the administrator of this machine. 

--- 

Color Restricted. Mono Printed 

Press OK To Hide This Message 

- The print data from an user unauthorized to print in color was 

printed in mono. 

To print in color, contact the administrator of this machine. 

--- 

Color Name Non Recommended 

Image Drum Detected. Search 

Keyword: P40485 

- The image drum of the displayed color is not optimal for this 

machine. 

It is recommended to use the image drum that is optimal for 

this machine. 

--- - The toner cartridge of the displayed color is not optimal for this 

machine. 
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Color Name Non Recommended 

Toner Detected. Search Keyword: 

P40947 

It is recommended to use the toner cartridge that is optimal for 

this machine. 

--- 

Non Recommended Belt 

Unit.Search Keyword: P40444 

- The belt unit is not optimal for this machine. 

It is recommended to use the belt unit that is optimal for this 

machine. 

--- 

Non Recommended Fuser 

Unit.Search Keyword: P40439 

- The fuser unit is not optimal for this machine. 

It is recommended to use the fuser unit that is optimal for this 

machine. 

--- 

Job Log Database Error 

Contact The Device Administrator 

Press OK To Hide This Message 

- A database access error has occurred to writing or reading of 

print data logs. Turn off this machine and then turn it back on. If 

the same error message is displayed again, contact your 

dealer. 

--- 

Decode Error Occurred 

Press OK To Hide This Message 

- Unable to print because an error has occurred to the image 

data. 

Please check the image data. 

--- 

Password Required To Print 

Press OK To Hide This Message 

- Printing restrictions have been imposed on the PDF file. Please 

input the password required to print. 

--- 

Invalid Password 

Press OK To Hide This Message 

- Unable to print because the password set in the PDF file does 

not match the password you input. 

Please input the correct password. 

--- 

File System Operation Failed 

<nnn> 

Press OK To Hide This Message 

- A file system error has occurred. 

Press «OK» on the operator panel to hide the message. 

--- 

Belt Unit Near Life. Search 

Keyword: P10978 

- The belt unit is approaching the end of its service life. 

Please prepare a new belt unit. 

After the message of replacement is displayed, please replace 

it with a new one. 

--- 

Change Belt Unit. Search 

Keyword: P40970 

- The belt unit has reached the end of its service life. 

Please replace the belt unit with a new one. To replace the belt 

unit, see "Replacing the belt unit ". 

--- 

Error Postscript 

- An error has occurred to Postscript data. 

Please check the print result. 

If there is a problem with the print result, print again. 

The problem may be solved if you select [Optimize for 

Portability] in the Postscript output option of the PS printer 

driver. 

--- 

Log Buffer Is Full. Job Rejected 

Press OK To Hide This Message 

- The print data was deleted because the log buffer is full. 

Please contact the printer administrator and delete the log. 

--- 

Print Restricted. Job Rejected 

Press OK To Hide This Message 

- The print data from an user unauthorized to print was deleted. 

To print, contact the administrator of this machine. 

--- 

Job Type Restricted 

Job Rejected 

Press OK To Hide This Message 

- The print data was canceled because only Private Print is 

enabled with restrictions. 

Select Private Print from Job Type in the printer driver. See 

"Printing with print data encrypted and password set (Private 

Print) ". 

--- 

Expired Saved Files Have Been 

Deleted 

Press OK To Hide This Message 

- The private print document whose retention date has passed 

was deleted. 
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--- 

NFC Unit Error. NFC Function Is 

Not Available 

 

Press OK To Hide This Message 

- An error has occurred to the NFC unit. 

NFC-specific functions are not available. 

Power off/on this machine. 

You can hide this message by selecting [Disable] for [Admin 

Setup] - [Others Setup] - [NFC Setup]. 

   

--- 

Incompatible USB Device 

Connected 

Please Detach It 

- A USB device that is not supported by this machine is 

connected. 

Please detach the USB device. 

--- 

Fuser Unit Near Life. Search 

Keyword: P10979 

- The fuser unit is approaching the end of its service life. 

Prepare a new fuser. 

After the message of replacement is displayed, please replace 

it with a new one. 

--- 

Change Fuser Unit. Search 

Keyword: P40971 

- The fuser unit has reached the end of its service life. 

Please replace the fuser unit with a new one. To replace the 

fuser unit, see "Replacing the fuser unit ". 

--- 

Waste Toner Near Full. Search 

Keyword: P10949 

- The free space of the waste toner box is low. 

Please prepare a new waste toner box. 

After the message of replacement is displayed, please replace 

it with a new one. 

--- 

Change Waste Toner Box. Search 

Keyword: P40942 

- The waste toner box is full. Please replace the waster toner 

box with a new one. 

For the method, see "Replacing the black(K) toner cartridge 

and the waste toner box ". 

--- 

Collate Fail:Too Many Pages 

Press OK To Hide This Message 

- The memory is full with the collation data. 

Reduce the number of pages of the print data. 

--- 

Invalid Print Data Received 

Press OK To Hide This Message 

- If you were printing a private job, the data was deleted because 

it was not complete. 

Please print it again. 

 

Or, the received PLD command data is not supported. 

Please check the printer driver in use. 

--- 

Duplex Print Failed 

Press OK To Hide This Message 

- Printed on one side because the paper setting is not applicable 

to duplex printing. 

To print on both sides, print again from the tray with paper 

suitable for duplex printing. For paper settings applicable to 

duplex printing, see "Applicable paper ". 

--- 

Wait Timeout Is Disabled 

- Timeout Injob is set to [Off]. 

When the USB cable is connected, you may not be able to print 

from the network. 

Please Wait 

Executing Maintenance 

Please Do Not Power Off 

- Firmware update is in progress. 

If the power is turned off halfway, this machine may not be able 

to start. 

When update is completed, the machine restarts automatically. 
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When paper is jammed 

For the error code 370 or 371 

1 Remove the jammed paper from the output exit. 

 

2 Pull the front cover open lever (blue) to open the front cover. 

 

3 Pull the L2 lever and lift the output tray until it reaches the stop position. 

 

4 Remove the paper left on the belt unit if any. 

 
Doing so may cause burns. 

 

Do not touch the fuser unit because it is hot. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 
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5 Lift the belt unit up by holding its handle. 

 

6 Remove the paper left under the belt unit if any. 

 

7 Reset the belt unit. 

 

8 Close the output tray, and push both sides down from top. 

 

9 Lift the left and right handles of the fuser unit at the back of the output tray until a click is heard, 

and then release the lock. 

 
 The fuser unit cannot be removed unless its handle is raised vertically. 
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10 Remove the fuser unit from this machine by holding its left and right handles. 

 
Doing so may cause burns. 

 

When the fuser unit is hot, wait until it cools down before any operation. 

 
 Do not expose this machine with the fuser unit removed to direct sunlight or strong light (About 1,500 lux or 

above). Do not leave it uncovered for more than 5 minutes even under room lighting. 

 

11 Remove any paper left in the machine. 

 

12 If paper is jammed in the fuser unit, with the warning label of the fuser unit facing you, slowly 

pull out the jammed paper towards you. 

 
Doing so may cause burns. 

 

When the fuser unit is hot, wait until it cools down before any operation. 

 
 Do not pull it out in the reverse direction. 
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13 With the warning label of the fuser unit facing you, hold both the left and right handles. 

 

14 Place the fuser unit in this machine, tilt its left and right handles inward, and lock the fuser unit. 

 
 Make sure that the fuser unit does not float from the top of the output tray. If floating, the fuser unit will not be 

recognized so that it is not possible to start printing. 

 

15 Close the front cover firmly with both hands. 

 

For the error code 372 

1 Remove the jammed paper from the output exit. 
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2 Pull the front cover open lever (blue) to open the front cover. 

 

3 Pull the L2 lever and lift the output tray until it reaches the stop position. 

 

4 Remove the paper left on the belt unit if any. 

 
Doing so may cause burns. 

 

Do not touch the fuser unit because it is hot. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 

5 Lift the belt unit up by holding its handle. 
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6 Remove the paper under the belt unit if any. 

 

7 Reset the belt unit. 

 

8 Close the output tray, and push both sides down from top. 

 

9 Close the front cover firmly with both hands. 

 

For the error code 380 

1 Pull the front cover open lever (blue) to open the front cover. 
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2 Pull out the jammed paper gently. 

 

3 Close the front cover firmly with both hands. 

 

For the error code 381 

1 Remove the jammed paper from the output exit. 

 

2 Pull the front cover open lever (blue) to open the front cover. 

 

3 Pull the L2 lever and lift the output tray until it reaches the stop position. 
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4 Remove the paper on the belt unit if any. 

 
Doing so may cause burns. 

 

Do not touch the fuser unit because it is hot. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 

5 Close the output tray, and push both sides down from top. 

 

6 Close the front cover firmly with both hands. 

 

For the error code 382 or 385 

1 Remove the jammed paper from the output exit. 
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2 Pull the front cover open lever (blue) to open the front cover. 

 

3 Pull the L2 lever and lift the output tray until it reaches the stop position. 

 

4 Remove the paper left on the belt unit if any. 

 
Doing so may cause burns. 

 

Do not touch the fuser unit because it is hot. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 

5 Close the output tray, and push both sides down from top. 
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6 Lift the left and right handles of the fuser unit at the back of the output tray until a click is heard, 

and then release the lock. 

 
 The fuser unit cannot be removed unless its handle is raised vertically. 

 

7 Holding both the left and right handles of the fuser unit, remove the fuser unit from this machine. 

 
Doing so may cause burns. 

 

When the fuser unit is hot, wait until it cools down before any operation. 

 
 Do not expose this machine with the fuser unit removed to direct sunlight or strong light (About 1,500 lux or 

above). Do not leave it uncovered for more than 5 minutes even under room lighting. 

 

8 Remove any paper left in the machine. 
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9 If paper is jammed in the fuser unit, with the warning label of the fuser unit facing you, slowly 

pull out the jammed paper towards you. 

 
Doing so may cause burns. 

 

When the fuser unit is hot, wait until it cools down before any operation. 

 
 Do not pull out in the reverse direction. 

 

10 With the warning label of the fuser unit facing you, hold both the left and right handles. 

 

11 Place the fuser unit in this machine, tilt its left and right handles inward, and lock the fuser unit. 

 
 Make sure that the fuser unit does not float from the top of the output tray. If floating, the fuser unit will not be 

recognized so that it is not possible to start printing. 

 

12 Close the front cover firmly with both hands. 
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For the error code 390 

1 Temporarily remove any paper loaded in the multi-purpose tray (MP tray). 

 

2 Pull the front cover open lever (blue) to open the front cover. 

 

3 Hold the edge of the jammed paper and pull it out gently. 

 

4 When the top edge is not visible, slowly pull out the paper from its rear edge. 

 

5 Close the front cover firmly with your both hands. 

 

6 If you are using a MP tray, open the MP tray and load paper with the print side up. 

 
 For how to load paper in the MP tray, see "Loading paper in the MP tray ".  
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For the error code 391, 392, 393 or 394 

This section takes the error code 391 (indicating that the paper is jammed in Tray 1) for example. For the error 

code 392, 393 or 394, remove the jammed paper by following the same procedure. 

 
 If paper jams occur frequently, clean the paper feed roller. Please see "Cleaning paper feed rollers (Trays 1-4)" for 

details. 

 

1 Pull out the paper cassette. 

 

2 Remove the jammed paper. 

 
 If no paper is jammed, feeding has failed. Reduce the number of paper loaded in the paper cassette. Also, 

make sure that the paper stopper position matches the paper size. 

 

3 Return the paper cassette to this machine. 
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4 Open and close the front cover. 

 
 Error cannot be cleared without opening and closing the front cover. 

 

For the error code 638 

First, check all the trays and remove the remaining paper. Then, remove the remaining paper inside the 

machine. 

This section explains how to remove the paper from Tray 2 as an example. 

 

1 Pull out the paper cassette. 

 

2 Remove the remaining paper. 
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3 Return the paper cassette to this machine. 

 

4 For all trays, repeat Steps 1 - 3 to remove the remaining paper. 

5 Pull the front cover open lever (blue) to open the front cover. 

 

6 Pull out the jammed paper slowly if any. 

 

7 Pull the L2 lever and lift the output tray until it reaches the stop position. 
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8 Remove the paper left on the belt unit if any. 

 
Doing so may cause burns. 

 

Do not touch the fuser unit because it is hot. 

 
 Because image drums (green parts) can easily get damaged, handle with adequate care. 

 Do not expose the image drum to direct sunlight or strong light (About 1,500 lux or above). Do not leave it 

uncovered for more than 5 minutes even under room lighting. 

 

9 Lift the belt unit up by holding its handle. 

 

10 Remove the paper left under the belt unit if any. 

 

11 Reset the belt unit. 
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12 Close the output tray, and push both sides down from top. 

 

13 Lift the left and right handles of the fuser unit at the back of the output tray until a noise is heard, 

and then release the lock. 

 
 The fuser unit cannot be removed unless its handle is raised vertically. 

 

14 Holding both the left and right handles of the fuser unit, remove the fuser unit from this machine. 

 
Doing so may cause burns. 

 

When the fuser unit is hot, wait until it cools down before any operation. 

 
 Do not expose this machine with the fuser unit removed to direct sunlight or strong light (About 1,500 lux or 

above). Do not leave it uncovered for more than 5 minutes even under room lighting. 

 

15 Remove the paper left in the machine if any.  
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16 If paper is jammed in the fuser unit, with the warning label of the fuser unit facing you, slowly 

pull out the remaining paper towards you. 

 
Doing so may cause burns. 

 

When the fuser unit is hot, wait until it cools down before any operation. 

 
 Do not pull out in the reverse direction. 

 

17 With the warning label of the fuser unit facing you, hold both the left and right handles. 

 

18 Place the fuser unit in this machine, tilt its left and right handles inward, and lock the fuser unit. 

 
 Make sure that the fuser unit does not float from the top of the output tray. If floating, the fuser unit will not be 

recognized so that it is not possible to start printing. 

 

19 Close the front cover firmly with both hands. 
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Trouble with printing 

This section describes problems with printing from a PC. 

 
 If the problem is not solved using the following explanation, contact your dealer. 

 For problems arising from the application, contact the application development company. 

I cannot print 

For Windows/macOS 

Cause Solution Reference 

This machine powered is off. Please turn the power on.  Turning the 

power on  
 

The LAN cable/USB cable is 

disconnected. 

Please check that the cable is correctly connected to this 

machine and the PC. 

 Connecting via a 

wired LAN  

 Connecting via 

USB  
 

There is a problem with the cable. Please replace the cable with a new one. - 

This machine is offline. Press «ON LINE» on the operator panel. - 

An error has occurred to this 

machine. 

Please check the error message displayed on the display. 

Or, press «HELP» on the operator panel to check and clear 

the error. 

 Error message 

list  
 

The interface settings are disabled. Please check the interface settings you are using on the 

operator panel. 

 Connecting via a 

wired LAN  

 Connecting via a 

wireless LAN  
 

The LED lamp of the power switch 

is flashing rapidly. 

This machine is broken. Please remove the power cord 

immediately and contact your dealer. 

- 

 

For Windows 

Cause Solution Reference 

This machine is not set as the 

default printer. 

Set this machine as the default printer. 

Open the "Devices and Printers", right-click on the 

[Printronix LP654C *] icon, and select [Set as Default 

Printer]. 

* represents the type of driver. (e.g. PCL6/PS) 

For Windows 10, uncheck "Let Windows manage my 

default printer". 

- 

The printout port of the printer 

driver is wrong. 

Please select the output port to which the LAN cable/USB 

cable is connected. 

- 

The printer is set offline on the PC. Open the "Devices and Printers", right-click on the 

[Printronix LP654C *] icon, and select [See what's printing]. 

When the icons are grouped, select [See what's printing] - 

[Printronix LP654C *]. 

* Represents the type of driver. (e.g. PCL6/PS) 

In the displayed screen, select the [Printer] menu, and 

uncheck [Use Printer Offline]. 

- 
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Troubleshooting for wired LAN connection 

For Windows/macOS 

Cause Solution Reference 

A crossover cable is used. Use a straight cable. - 

There is a compatibility problem 

with the hub. 

Press the scroll buttons on the operator panel several times 

to select the proper connection from [Admin Setup] - 

[Network Setup] - [Wired(LAN1) Setup] - [HUB Link 

Setting]. 

See the Instruction Manual supplied with the hub. 

- 

Wired LAN (LAN1) settings are not 

appropriate. 

Check the wired LAN (LAN1) settings.  Admin Setup  
 

Wired LAN settings are not 

appropriate. 

Either the standard wired LAN (LAN1) or wireless LAN is 

enabled for the gateway address. Select the standard wired 

LAN (LAN1) from [Admin Setup] - [Network Setup] - 

[General Setup] - [Enabling Default Gateway]. 

 Admin Setup  
 

Depending on the network device 

you are using, the connection may 

become unstable if Energy 

Efficient Ethernet (EEE) of the 

wired network (LAN1) of this 

machine is enabled. 

Check if the switching hub supports Energy Efficient 

Ethernet (EEE). 

If it supports, change [Admin Setup] - [Network Setup] - 

[Wired (LAN1) Setup] - [Energy Efficient Ethernet] to 

[Disable] from the web page of this machine and check if it 

improves. 

 Web page 

(Managing this 

machine from a 

PC)  
 

 

For Windows 

Cause Solution Reference 

The IP address is incorrect.  Make sure the IP address of this machine matches 

the one set on the PC. 

 Make sure the IP address does not overlap with that 

of other devices. 

 If [IP Address Set] is set to [Auto], the address may 

change dynamically. If the setting changes frequently, 

change [IP Address Set] of this machine to [Manual], 

and match the IP address of this machine with the one 

set on the PC. 

 Make sure the configured IP address, subnet mask 

and gateway address are all correct. 

 Make sure that the print port of the printer driver is 

correct. 

 For the Printronix LPR utility, check the IP address 

settings with the Printronix LPR utility. 

 Printing the menu 

map 

(configuration)  

 Printronix LPR 

Utility  
 

The WSD port is in use. When the print port does not function well with "WSD", 

specify the IP address or short printer name of this machine 

in the standard CP/IP port, and add the print port. 

- 

Troubleshooting for wireless LAN connection 

Unable to connect to wireless LAN 

For Windows/macOS 

Cause Solution Reference 

The wireless LAN module is not 

enabled. 

To connect to a wireless LAN, set [Extended Network] to 

[Wireless]. 

 Connecting via a 

wireless LAN  
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Cause Solution Reference 

Settings are not insufficient to 

connect. 

To connect via the wireless LAN access point or the 

wireless LAN router, set the wireless LAN (Infrastructure) 

accordingly. 

To connect a mobile device directly to this machine, set the 

wireless LAN (AP mode) accordingly. 

 Connecting via 

an access point 

(Infrastructure)  

 Connecting 

directly with this 

machine (AP 

mode)  
 

Network connection settings are 

incorrect. 

 Wireless LAN (Infrastructure) and Wireless LAN (AP 

mode) cannot be enabled at the same time. 

 To connect via a wireless LAN (Infrastructure), set 

[Wireless(AP Mode)] to [Disable] and 

[Wireless(Infrastructure)] to [Enable]. 

 To connect via a wireless LAN (AP mode), set 

[Wireless(Infrastructure)] to [Disable] and 

[Wireless(AP mode)] to [Enable]. 

 Connecting via a 

wireless LAN  
 

The settings of wireless LAN 

(Infrastructure) are incorrect. 

If you are connected via a wireless LAN (Infrastructure), 

check the infrastructure settings. 

 Connecting via 

an access point 

(Infrastructure)  
 

The settings of wireless LAN (AP 

mode) are incorrect. 

If you are connected via a wireless LAN (AP Mode), check 

the AP mode settings. 

 Connecting 

directly with this 

machine (AP 

mode) 
 

A timeout occurs during 

connection. 

Connect by specifying the wireless LAN access point you 

want to use from the wireless LAN access points detected 

by this machine. 

 Connecting by 

selecting a 

wireless LAN 

access point from 

the operator 

panel 
 

 

For Windows 

Cause Solution Reference 

The IP address is incorrect.  Make sure the IP address of this machine matches 

the one set on the PC. 

 Make sure the IP address does not overlap with that 

of other devices. 

 If [IP Address Set] is set to [Auto], the address may 

change dynamically. If the setting changes frequently, 

change [IP Address Set] of this machine to [Manual], 

and match the IP address of this machine with the one 

set on the PC. 

 Make sure the configured IP address, subnet mask 

and gateway address are all correct. 

 For the Printronix LPR Utility, check the IP address 

settings with the Printronix LPR Utility. 

 Printing the menu 

map 

(configuration)  

 Printronix LPR 

Utility  
 

The WSD port is in use. When the print port does not function well with "WSD", 

specify the IP address or short printer name of this machine 

in the standard CP/IP port, and add the print port. 

- 
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Unable to connect to wireless LAN (Infrastructure) 

First, print out the Network Information, and then check the following explanation while having a look at items 

numbered ① to ⑥ in the following figure in Wireless (Infrastructure) Information. 

Network Information can be printed from [Print Information] - [Network]. 

 

 

Unable to connect to the access point (State of ④ is not set to "Connected") 

Cause Solution Reference 

[Wireless] is not selected in the 

[Extended Network] settings. 

Select [Admin Setup] - [Network Setup] - [General Setup] - 

[Extended Network] - [Wireless]. 

 Connecting via 

an access point 

(Infrastructure) 
 

The wireless LAN access point 

does not function properly. 

Check that the power of the wireless LAN access point is 

turned on and it functions properly. 

- 

[Wireless (Infrastructure)] is set to 

[Disable].* Above ① 

Set [Wireless(Infrastructure)] to [Enable]. 

*Wireless LAN (Infrastructure) and Wireless LAN (AP 

mode) cannot be enabled at the same time. 

 Connecting via 

an access point 

(Infrastructure)  
 

[SSID] is incorrect. Or it is blank.* 

Above ② 

Check the SSID of the wireless LAN access point you want 

to connect is correct, and connect with the correct SSID. 

If it is blank, the settings for the wireless LAN connection of 

this machine are insufficient. Set [Wireless(Infrastructure) 

Setting]. 

 Connecting via 

an access point 

(Infrastructure)  
 

The encryption key is incorrect. Check the encryption key of the wireless LAN access point 

you want to connect is correct, and set the correct 

encryption key. 

When a same number is lined up in the encryption key, be 

sure to press «OK» after inputting each number. 

Example: To input 1233, 

press «1» → «2» → «3» → «OK» → «3». 

It is incorrect to press «1» → «2» → «3» → «3». In that 

case, «1»«2»«d» is input, which is not the correct 

encryption key. 

 Connecting via 

an access point 

(Infrastructure)  
 

The setting of [Security] does not 

match the security of the wireless 

LAN access point.* Above ③ 

Check the security (encryption method) of the wireless LAN 

access point that you want to connect, and set it to keep 

consistent. 

 Connecting via 

an access point 

(Infrastructure)  
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Communication is not stable 

Cause Solution Reference 

The RSSI value is too small.* 

Above ⑥ 

The signal strength is insufficient. 

Put this machine in an unobstructed view position near the 

wireless LAN access point. (The recommended distance is 

30 m or less.) 

Do not place an electric appliance (especially microwave 

oven or digital cordless telephone) that emits weak 

electronic waves near this machine. 

It may be difficult to connect if there is a metal, aluminum 

sash or reinforced concrete wall between this machine and 

the wireless LAN access point. 

- 

The current frequency band is 

congested.* Above ⑤ 

[Band] displays the current frequency band to which this 

machine is connected. 

This machine is compatible with the 2.4 Ghz/5.0 GHz band. 

If the wireless LAN access point is compatible with the 2.4 

GHz/5.0 GHz band, try changing the connecting frequency 

band of the machine (or changing the SSID settings). 

 Connecting via 

an access point 

(Infrastructure)  
 

 

Able to connect to the access point but unable to communicate 

Cause Solution Reference 

The IP address is in the same 

segment as the one on the wired 

side. 

Since the communication may be unstable if the wired LAN 

and wireless LAN are connected to the same subnet, 

please connect to a different subnet. 

- 

The setting of the enabled default 

gateway is wired LAN instead of 

wireless LAN. 

To communicate with a terminal outside the segment via a 

wireless LAN, press the scroll buttons on the operator 

panel to select [Admin Setup] - [Network Setup] - [General 

Setup] - [Enabling Default Gateway] and set it to 

[Wireless(Infrastructure)]. 

In that case, the wired LAN cannot communicate with 

terminals outside the segment. 

*You can check from [General Information] - [Enabling 

Default Gateway] in Network Information. 

 Connecting via 

an access point 

(Infrastructure)  
 

 

Unable to connect to a wireless LAN (AP mode) 

First, print out the Network Information, and then check the following explanation while having a look at items 

numbered ① to ④ in the following figure in Wireless (AP Mode) Information. 

Network Information can be printed from [Print Information] - [Network]. 

 

 

Terminals cannot connect 

Cause Solution Reference 

[Wireless] is not selected in the 

[Extended Network] settings. 

Select [Admin Setup] - [Network Setup] - [General Setup] - 

[Extended Network] - [Wireless]. 

 Connecting 

directly with this 

machine (AP 

mode)  
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Cause Solution Reference 

[Wireless (AP Mode)] is set to 

[Disable]. 

*Above ① 

Set [Wireless(AP Mode) Setting] - [Wireless(AP Mode)] to 

[Enable]. 

*Wireless LAN (Infrastructure) and Wireless LAN (AP 

mode) cannot be enabled at the same time. 

 Connecting 

directly with this 

machine (AP 

mode)  
 

[SSID] is not consistent with the 

SSID selected by the wireless 

terminal. 

*Above ② 

Check that the SSID of this machine matches the SSID 

selected by the wireless terminal you want to connect. 

 Connecting 

directly with this 

machine (AP 

mode)  
 

The setting of [Security] is not 

consistent with that of the wireless 

terminal. 

*Above ③ 

Check that the security of this machine matches the 

security set for the wireless terminal you want to connect. 

 Connecting 

directly with this 

machine (AP 

mode) 
 

The encryption key is not 

consistent with that of the wireless 

terminal. 

Check that the encryption key of this machine matches the 

encryption key set for the wireless terminal you want to 

connect. 

You can check from [Wireless(AP Mode) Setting] - [Manual 

Setup]. 

 Connecting 

directly with this 

machine (AP 

mode)  
 

[Number Of Connected] is set to 

4.* Above ④ 

A maximum of 4 terminals can be connected wirelessly (AP 

mode) to this machine. Terminals exceeding the maximum 

number cannot be connected. Disconnect other terminals 

and try to connect again. 

 Connecting 

directly with this 

machine (AP 

mode)  
 

Troubleshooting for USB connection 

USB does not connect 

For Windows/macOS 

Cause Solution Reference 

The cable does not meet the 

specifications. 

Please use a USB 2.0 cable. 

The connector type on the machine side is type B. 

- 

A USB hub is used. Connect this machine directly to the PC.  Connecting via 

USB  
 

The printer driver is not installed 

correctly. 

Please re-install the printer driver.  Installing 

software on a PC  
 

 

For Windows 

Cause Solution Reference 

A switch, buffer, extension cable, 

or USB hub is used. 

Connect this machine directly to the PC.  Connecting via 

USB 
 

There are other printer drivers that 

operate via USB connections. 

Remove other printer drivers from the PC. - 
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Troubleshooting for printing results 

This section describes troubles with printing results. 

Click the corresponding symptom to see the solution. 

 
 Please check the following explanation and "Frequently Asked Questions (FAQs)" on your smartphone app or the 

website. 

 If the problem persists, contact your dealer. 

 

List of troubles with printing results 

 

Paper feed direction 

White streaks appear in the vertical direction 

 

Printing is faint in the vertical direction 

 

Printing is light 

 

White dots or lines appear 

 

Condensation occurs on printed paper 
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Streaks appear in the vertical direction 

 

Dots and horizontal streaks appear in the paper feeding direction 

periodically 

 

White area is lightly stained 

 

 

Edges of text are blurred 

 

When envelopes or coated paper is printed, the whole area is thinly 

stained 

 

Toner comes off when rubbed 

 

Uneven Gloss 

 

Point stains appear 
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Stains are printed 

 

The entire paper is printed in black 

 

Nothing is printed 

 

White streaks occur 

 

The peripheral area is dirty 

 

The color of images does not come as expected 

 

Paper feed direction 

An afterimage printed on the front edge of the paper is printed 
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White streaks appear in the vertical direction 

 

Cause Solution Reference 

The LED head is dirty. Wipe the LED head with soft tissue paper.  Cleaning the LED 

head 
 

The toner is low. "Toner Low. " or "Toner Empty. Replace with a new toner 

cartridge." is displayed, replace the toner cartridge. 

 Replacing the 

black(K) toner 

cartridge and the 

waste toner box 

 Replacing the 

toner cartridge 

(C/M/Y) 
 

The window film of the image drum 

is dirty. 

Wipe the window film with soft tissue paper.  Cleaning the 

light-shielding film 
 

The image drum has not been 

installed correctly. 

Please install the image drum correctly.  Replacing the 

image drum 
 

A foreign object is stuck in the 

image drum. 

Please replace the image drum.  Replacing the 

image drum 
 

Printing is faint in the vertical direction 

 

Cause Solution Reference 

The LED head is dirty. Wipe the LED head with soft tissue paper.  Cleaning the LED 

head  
 

The toner is low. "Toner Low." or "Toner Is Empty. Replace With A New 

Toner Cartridge." is displayed, replace the toner cartridge. 

 Replacing the 

black(K) toner 

cartridge and the 

waste toner box  

 Replacing the 

toner cartridge 

(C/M/Y)  
 

The paper is not supported. Use recommended paper.  Applicable paper  
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Printing is light 

 

Cause Solution Reference 

The toner is low. "Toner Low." or "Toner Empty. Replace with a new toner 

cartridge." is displayed, replace the toner cartridge. 

 Replacing the 

black(K) toner 

cartridge and the 

waste toner box  

 Replacing the 

toner cartridge 

(C/M/Y)  
 

The density is not adjusted. Press the scroll buttons on the operator panel several times 

to select [Calibration] and run density adjustment. 

 Adjusting the 

density manually  
 

The paper is moist. Use the paper stored at appropriate temperature and 

humidity. 

 Storing paper  
 

The paper is not supported. Use recommended paper.  Applicable paper  
 

The paper is not supported. 

The media weight is set 

incorrectly. 

Press the scroll buttons on the operator panel several times 

to select the paper tray you are using from [Menus] - [Tray 

Configuration], and set an appropriate value for [Media 

Weight]. Or, change [Media Weight] to a thicker value than 

the present value. 

 Setting paper 

information on 

the operator 

panel  
 

Recycled paper is used. Press the scroll buttons on the operator panel several times 

to select the paper tray you are using from [Menus] - [Tray 

Configuration], and set a thicker value for [Media Weight]. 

 Setting paper 

information on 

the operator 

panel  
 

It is used under an environment 

where combustion is emitted. 

Do not install this machine under an environment where 

combustion is emitted. If this machine is used under an 

environment where combustion is emitted indoors such as 

near an electric or gas stove, the image drum may be 

degraded. 

 Installation 

environment  
 

White dots or lines appear 

 

Cause Solution Reference 

Dry the paper as it is moist. Use the paper stored at appropriate temperature and 

humidity. 

 Storing paper  
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Condensation occurs on printed paper 

 

Cause Solution Reference 

The paper is moist. Use the paper stored at appropriate temperature and 

humidity. 

 Storing paper 
 

This machine is used in a place 

with high humidity or sudden 

changes in temperature and 

humidity. 

Use this machine in an environment with an appropriate 

temperature and humidity. 

 Installation 

environment  
 

The edge of the paper is wet. Press the scroll buttons on the operator panel several times 

to select [Menus] - [Print Adjust] - [Moisture Control], and 

change the setting. This setting may delay the completion 

of printing the first page. 

- 

Streaks appear in the vertical direction 

 

Cause Solution Reference 

The toner is low. "Toner Low." or "Toner Empty. Replace with a new toner 

cartridge." is displayed, replace the toner cartridge. 

 Replacing the 

black(K) toner 

cartridge and the 

waste toner box  

 Replacing the 

toner cartridge 

(C/M/Y)  
 

The image drum is scratched. Please replace the image drum.  Replacing the 

image drum  
 

Paper guide is misaligned. Check the position of the paper guide in the paper tray.  Loading paper  
 

Dots and horizontal streaks appear in the paper feeding direction 

periodically 
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Cause Solution Reference 

If dots or streaks of a specific color 

appear at intervals of about 75 

mm, the green tube of the image 

drum is scratched or dirty. 

Please replace the image drum.  Replacing the 

image drum 
 

If dots or streaks of various colors 

appear at intervals of about 94 

mm, the fuser unit is scratched or 

dirty. 

Replace the fuser unit.  Replacing the 

fuser unit  
 

If the intervals are about 38 mm, 

parts inside the belt unit are 

broken. 

Replace the belt unit.  Replacing the 

belt unit  
 

If the intervals are about 34 mm or 

43 mm, parts in the image drum 

are damaged. 

Please replace the image drum.  Replacing the 

image drum  
 

If the intervals are about 30 mm, 

there are foreign objects in the 

image drum. 

Open and close the front cover and print again. 

If the problem persists, replace the image drum. 

 Replacing the 

image drum  
 

If the intervals are about 31 mm, 

the resist roller is dirty. 

Open the front cover and wipe the resist roller with soft 

tissue paper. 

 Cleaning the 

resist roller  
 

The image drum has been 

exposed to light. 

Install the image drum back to the printer, and leave the 

printer idle for a few hours. If the problem persists, replace 

the image drum. 

 Replacing the 

image drum  
 

Dirt has deposited on the paper 

transfer path. 

Test print a few pages.  Printing the menu 

map 

(configuration)  
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White area is lightly stained 

 

Cause Solution Reference 

Static electricity occurs to the 

paper. 

Use the paper stored at appropriate temperature and 

humidity. 

 Storing paper  
 

Thick paper is used. Use thinner paper.  Loading paper  
 

The toner is low. "Toner Low." or "Toner Empty. Replace with a new toner 

cartridge."is displayed, replace the toner cartridge. 

 Replacing the 

black(K) toner 

cartridge and the 

waste toner box  

 Replacing the 

toner cartridge 

(C/M/Y)  
 

Edges of text are blurred 

 

Cause Solution Reference 

The LED head is dirty. Gently wipe the LED head with soft tissue paper.  Cleaning the LED 

head  
 

The paper is not supported. Use recommended paper.  Applicable paper  
 

The paper is moist. Use the paper stored at appropriate temperature and 

humidity. 

 Storing paper  
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When envelopes or coated paper is printed, the whole area is thinly 

stained 

 

Cause Solution Reference 

When envelopes or coated paper 

is printed, toner may adhere 

(cover) to the whole area. 

This is not a malfunction. 

Do not use coated paper as much as possible. 

 Applicable paper  

 Inapplicable 

paper  
 

Toner comes off when rubbed 

 

Cause Solution Reference 

The media weight is set 

incorrectly. 

Press the scroll buttons on the operator panel several times 

to select the paper tray you are using from [Menus] - [Tray 

Configuration], and set an appropriate value for [Media 

Weight]. Or, change [Media Weight] to a thicker value than 

the present value. 

 Setting paper 

information on 

the operator 

panel  
 

Recycled paper is used. Press the scroll buttons on the operator panel several times 

to select the paper tray you are using from [Menus] - [Tray 

Configuration], and set a thicker value for [Media Weight]. 

 Setting paper 

information on 

the operator 

panel  
 

Uneven Gloss 

 

Cause Solution Reference 

The media weight is set 

incorrectly. 

Press the scroll buttons on the operator panel several times 

to select the paper tray you are using from [Menus] - [Tray 

Configuration], and set an appropriate value for [Media 

Weight]. Or, change [Media Weight] to a thicker value than 

the present value. 

 Setting paper 

information on 

the operator 

panel  
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Point stains appear 

 

Cause Solution Reference 

The paper is not supported. Use recommended paper. 

If the paper has a lot of paper dust, load the paper after 

shuffling it well. 

 Applicable paper  
 

If the intervals are approx. 75 mm, 

the green tube of the image drum 

is scratched or dirty. 

If the image drum is scratched, replace it with a new one.  Replacing the 

image drum  
 

Stains are printed 

 

Cause Solution Reference 

The paper is moist. Use the paper stored at appropriate temperature and 

humidity. 

 Storing paper  
 

The paper is not supported. Use recommended paper.  Applicable paper  
 

The entire paper is printed in black 

 

Cause Solution Reference 

The machine may have broken 

down. 

Please contact your dealer. - 
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Nothing is printed 

 

Cause Solution Reference 

Multiple pages were fed at a time. Load the paper again after shuffling it well. 

Clean the paper feed roller. 

 Loading paper  

 Cleaning paper 

feed rollers 

(Trays 1-4)  

 Cleaning the 

paper feed roller 

(MP tray)  
 

The machine may have broken 

down. 

Print the menu map and check if the device itself can print. 

If the menu map cannot be printed correctly, contact your 

dealer. 

 Printing the menu 

map 

(configuration)  
 

White streaks occur 

 

Cause Solution Reference 

The paper is moist. Use the paper stored at appropriate temperature and 

humidity. 

 Storing paper  
 

The paper is not supported. Use recommended paper  Applicable paper  
 

The peripheral area is dirty 

 

Cause Solution Reference 

The size is not reduced by scale 

according to the paper size. 

Reduce the size by scale according to the paper size.   Enlarging/Reduci

ng to fit the 

specified media 

size  
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The color of images does not come as expected 

 

Cause Solution Reference 

The toner is low. When "Toner Low." or "Toner Empty. Replace with a new 

toner cartridge." is displayed, replace the toner cartridge. 

 Replacing the 

black(K) toner 

cartridge and the 

waste toner box  
 

The setting of [Black Finish] is not 

suitable for the application. 

In [Black Finish] of the printer driver, select [Composite 

Black (CMYK)] or [True Black (K)]. 

 Screens and 

functions of the 

printer driver  
 

Color tuning has been changed. Perform color matching in the printer driver.  Color matching in 

the printer driver  

 Simulating print 

results  
 

Color balance is not adjusted. Press the scroll buttons on the operator panel several times 

to select [Calibration], adjust density, or adjust the color 

balance. 

 Adjusting the 

density manually  

 Adjusting the 

color balance 

(density)  
 

Color misregistration is not 

corrected. 

Open and close the front cover. Or, press the scroll buttons 

on the operator panel several times to select [Calibration] - 

[Adjust Registration]. 

 Adjusting 

registration 

manually  
 

An afterimage printed on the front edge of the paper is printed 

 

Cause Solution Reference 

If an afterimage is printed under 

about 94 mm, the media weight 

may not be set correctly. 

Press the scroll buttons on the operator panel several times 

to select the paper tray you are using from [Menus] - [Tray 

Configuration], and set an appropriate value for [Media 

Weight]. Or, change [Media Weight] to a thinner value than 

the present value. 

 Setting paper 

information on 

the operator 

panel  
 

If an afterimage is printed at an 

interval of about 94 mm, the fuser 

unit may be scratched or dirty. 

Replace the fuser unit.  Replacing the 

fuser unit  
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Software troubleshooting 

 Monitoring Tool 

 → Troubleshooting (Monitoring Tool)  
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Troubleshooting for this machine and paper 

Troubleshooting for the machine 

 
 Please check the following explanation and "Frequently Asked Questions (FAQs)" on the website or your 

smartphone application. 

 If the problem persists, contact your dealer. 

Symptom Cause Solution Reference 

Nothing is displayed 

even after the power is 

turned on. 

The power cord is 

disconnected. 

Firmly insert the power cord. - 

There is a power 

failure. 

Check the power transmission status to the 

outlet. 

- 

It does not work. The power cord is not 

inserted firmly. 

Firmly insert the power cord. - 

The power is not 

turned on. 

Please turn the power on.  Turning the 

power on 
 

The power was turned 

off by the Auto Power 

Off function. 

Please turn the power on. Or, disable the auto 

power off function. 

 Turning off the 

power 

automatically 

(Auto Power Off)  
 

This machine is 

frozen. 

Press and hold the power switch for more than 

5 seconds to force a shutdown. 

- 

The LED lamp of the 

power switch is 

flashing rapidly at 

intervals of approx. 0.3 

seconds. 

 

This machine is 

broken. 

Please remove the power cord immediately 

and contact your dealer. 

 

- 

The output tray does 

not close. 

The belt unit is not 

inserted properly. 

Install the belt unit again.  Replacing the 

belt unit  
 

The image drum 

basket is not inserted 

to the end. 

Insert the image drum basket to the end.  Replacing the 

image drum  
 

The front cover does 

not close. (The L1 

lever dose not move.) 

The image drum is not 

installed. 

Insert the image drum by pulling the L2 lever 

and opening the output tray. 

 Replacing the 

image drum 
 

The error is not 

cleared even after the 

toner or drum is 

replaced. 

The replaced 

consumables are not 

correct. 

Check the name and color of the consumables 

that must be replaced by the error message on 

the display. Replace the corresponding 

consumables. 

 Error message 

list  

 Replacing the 

black(K) toner 

cartridge and the 

waste toner box  

 Replacing the 

toner cartridge 

(C/M/Y)  
 

The toner cartridge is 

not installed properly. 

Check that the toner cartridge is installed 

firmly. 

    

Printing process does 

not start. 

An error is displayed. Check the error code and follow the on-screen 

instructions. 

 Error message 

list  
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Symptom Cause Solution Reference 

The LAN/USB cable is 

not plugged in. 

Firmly insert the LAN/USB cable.  Connecting via a 

wired LAN  
 

There is a problem 

with the LAN/USB 

cable. 

Use another LAN/USB cable. - 

The LAN cable does 

not meet the 

specifications. 

Please use the cable of Ethernet 10BASE-

T/100BASE-TX/1000Base specifications. 

- 

The USB cable does 

not meet the 

specifications. 

Please use the USB cable enclosed with this 

machine. 

- 

There may be a 

problem with the print 

function. 

Press the scroll buttons on the operator panel 

to select [Print Information] - [Configuration], 

and print the configurations to check the 

printing performance. 

 Printing the menu 

map 

(configuration) 
 

The communication 

protocol is disabled. 

Press the scroll buttons on the operator panel 

to select [Admin Setup] - [Network Setup] and 

enable the communication protocol in use. 

- 

The printer driver is 

not selected. 

Open the "Devices and Printers". Right-click on 

the icon of this machine, and select "Set as 

Default Printer". 

 How to open the 

printer folder 
 

The output port of 

printer driver is 

incorrect. 

Specify the output port to connect the 

LAN/USB cable. 

- 

Nothing is displayed. This machine is in the 

sleep mode. 

Check that «POWER SAVE» is blinking, and 

press «POWER SAVE» to start this machine. 

- 

The print data is not 

sent. 

The LAN/USB cable is 

broken. 

Connect with a new cable. - 

The PC has timed out. Increase the length of timeout in port settings 

of the PC. 

- 

An abnormal sound is 

heard. 

This machine is tilted. Install it on a stable and flat surface. - 

Paper dust or foreign 

objects are left inside 

this machine. 

Check the inside of this machine and remove 

the object if any. 

- 

The output tray is 

open. 

Close the output tray. - 

A resonant sound is 

heard. 

While the temperature 

inside this machine is 

rising, printing is done 

on narrow or thick 

paper. 

This is not a fault with this machine. Use it as it 

is. 

- 

Printing does not start 

immediately. 

This machine is 

warming up for 

recovering from the 

power save mode or 

sleep mode. 

Extend the time that will elapse before the 

power save mode or sleep mode is entered by 

the following procedure. 

Press the scroll buttons on the operator panel 

to select [Power Save Time] or [Sleep Time] 

from [Menus] - [System Adjust]. 

 Setting the power 

save function  
 

    

Printing stops in 

between. 

The temperature is 

adjusted because the 

Please wait. - 
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Symptom Cause Solution Reference 

temperature inside this 

machine has risen due 

to long-time 

continuous printing. 

The printing will automatically start again once 

the temperature of this machine returns 

appropriate. 

The memory is 

insufficient. 

The memory of this 

machine is insufficient 

as the print data is too 

big. 

Print again after reducing the resolution in the 

printer driver. 

- 

All pages are not 

printed. 

The WSD port is used. Change the print destination port to the 

standard TCP/IP port. 

- 

Printing, printer search 

or setup is not 

available in the sleep 

mode. 

The NBT/WINS 

protocol is suppressed 

in the sleep mode. 

Press the scroll buttons on the operator panel 

to select [Specific] from [Admin Setup] - [USB 

Setup] - [Connected Host]. 

- 

Periodic email alerts 

are not notified in the 

sleep mode. 

Periodic email alerts 

notification is 

suppressed in the 

sleep mode. 

Press the scroll buttons on the operator panel 

to select [Specific] from [Admin Setup] - [USB 

Setup] - [Connected Host]. 

- 

The time and date 

settings of this 

machine may be 

shifted if acquired from 

the server. 

The time update 

function with the SNTP 

server is suppressed 

in the sleep mode. 

Press the scroll buttons on the operator panel 

to select [Specific] from [Admin Setup] - [USB 

Setup] - [Connected Host]. 

- 

Printing is slow. Printing is also 

performed on the PC 

side. 

Use a PC with a fast processing speed. - 

In [Print Options] tab 

of the printer driver, 

[Extra Fine (Multi-

Tone)] or [Fine 

(1200x1200dpi)] is 

selected. 

Select [Normal (600x600dpi)] in the 

[Preferences] or [Print Options] tab of the 

printer driver. 

- 

The print data is 

complicated. 

Select simple print data. - 

Narrow paper (less 

than 182 mm) is used. 

Press the scroll buttons on the operator panel 

to select [Menus] - [Print Adjust] - [Narrow 

Paper Speed], and change the setting. 

- 

When moisture control 

is set to [Mode1] or 

[Mode2], it may take 

more time to print and 

output the first page. 

Press the scroll buttons on the operator panel 

to select [Off] in [Menus] - [Print Adjust] - 

[Moisture Control]. 

- 

Display of the printer 

driver is abnormal. 

The printer driver may 

not work correctly. 

Delete and reinstall the printer driver.  Deleting software 

 Installing 

software 
 

    

The power turns off 

automatically. 

If this machine has not 

been used for a 

certain period of time 

Press the scroll buttons on the operator panel 

to select [Admin Setup] - [Power Setup] - [Auto 

Power Off] - [Disable]. 

 Turning off the 

power 
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Symptom Cause Solution Reference 

(whose factory default 

setting is 4 hours), the 

power will turn off 

automatically. This 

function is called Auto 

Power Off. 

automatically 

(Auto Power Off) 
 

The web page does 

not open. 

[Web] is set to 

[Disable] in the menu 

of this machine. 

Press the scroll buttons on the operator panel 

to select [Enable] in [Admin Setup] - [Network 

Setup] - [General Setup] - [Web]. 

- 

The IP address is 

incorrect. 

Check the IP address of this machine and 

correct it if needed. 

 Printing the menu 

map 

(configuration) 
 

The LAN cable is 

disconnected. 

Check connection of the LAN cable.  Connecting the 

LAN cable 
 

"Yellow Toner 

Cartridge Is Not 

Installed 

Correctly/Reset It 

Correctly. (Error Code: 

544)" is repeatedly 

displayed. 

Toner consumption is 

high, and it is being 

used in a condition 

where the supply from 

the toner cartridge is 

insufficient. 

Change the settings to the following: Moisture 

Control: Mode 2; Quiet Mode: On. 

To print with low toner consumption, please 

restore the settings. (The factory default 

settings are as follows: Moisture Control: Off; 

Quiet Mode: Off) 

 Menu list 
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Troubleshooting for the paper 

 
 Please check the following explanation and "Frequently Asked Questions (FAQs)" on the website or your 

smartphone application. 

 If the problem persists, contact your dealer. 

Symptom Cause Solution Reference 

 Paper jams occur 

frequently. 

 Multiple sheets of 

paper are pulled 

in 

simultaneously. 

 The paper is 

pulled in an 

inclined direction. 

This machine is tilted. Install it on a stable and flat surface. - 

The paper is either too 

thin or too thick. 

The paper is either too thin or too thick. Use 

the paper applicable to this machine. 

 Applicable paper 
 

The paper is moist or 

charged with static 

electricity. 

Use the paper stored at appropriate 

temperature and humidity. 

 Storing paper 
 

The paper is wrinkled, 

folded or curled. 

Use the paper applicable to this machine. 

Straighten the paper if it is curled. 

 Applicable paper 
 

The paper has had its 

reverse side printed. 

Already printed paper cannot be printed again 

from Tray 1/2/3/4. 

Print from the MP tray. 

- 

The paper is not 

aligned yet. 

Shuffle the paper well, and load the paper with 

the top, bottom, left and right aligned. 

 Loading paper 
 

Load only one sheet of 

paper. 

Load multiple sheets of paper. - 

Additional paper is 

loaded in the tray 

while the existing 

paper is kept as it is. 

Remove the existing paper in the tray, and load 

the paper again together with the new one with 

the top, bottom, left and right aligned. 

 Loading paper 
 

The paper is not 

loaded straight. 

Align the paper with the paper guide and paper 

stopper of Tray 1/2/3/4. 

Align the paper with the manual feeder guide of 

the MP tray. 

 Loading paper 
 

The envelope is 

loaded in a wrong 

orientation. 

Load the envelope again correctly.  Loading paper 
 

Envelopes are sticked 

together. 

Shuffle the envelopes well, or stack them one 

by one. 

- 

Load paper with a 

paper weight of 221-

256 g/m2, envelope or 

labels in Tray 1/2/3/4. 

Load paper with a paper weight of 221-256 

g/m2, envelope or labels in the MP tray. 

 Paper applicable 

to each tray 
 

The rear output tray is 

not closed properly. 

Firmly close the rear output tray.  Setting the output 

bin  
 

Paper jams occur 

frequently. 

The paper feed roller 

is dirty with paper 

dust. 

Clean the paper feed roller.  Cleaning paper 

feed rollers 

(Trays 1-4) 

 Cleaning the 

paper feed roller 

(MP tray) 
 

Paper cannot be fed. [Paper Source] in the 

printer driver is 

selected incorrectly. 

Check the paper tray, and select the correct 

tray from [Paper Source] in the printer driver. 

- 

Manual feeding is 

specified in the printer 

driver. 

Disable [Feed paper individually] in the printer 

driver. 

 Printing one 

sheet at a time 

manually 
 

Paper cannot be fed 

from Tray 2/3/4 

Tray 2/3/4 is not set up 

in the printer driver. 

Set up Tray 2/3/4 in the printer driver.  Setting the printer 

driver 
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Symptom Cause Solution Reference 

The machine is not 

restored even after the 

jammed paper is 

removed. 

- Open and close the front cover. - 

The paper gets curled. 

The paper is waved. 

The paper is wrinkled. 

The paper is moist or 

charged with static 

electricity. 

Use the paper stored at appropriate 

temperature and humidity. 

 Storing paper 
 

Thin paper is used. Press the scroll buttons on the operator panel 

to select [Menus] - [Tray Configuration] - [(Tray 

Name) Config] - [Media Weight]. Then, change 

the current setting to a thinner value. 

 Setting paper 

information on 

the operator 

panel 
 

The paper gets curled. 

The paper is waved. 

Thin paper is used. Press the scroll buttons on the operator panel 

to select [Menus] - [Print Adjust] - [High Humid 

Mode], and change the setting. 

- 

The paper twines 

around the inside of 

the fuser. 

The media weight is 

set incorrectly. 

Press the scroll buttons on the operator panel 

to set an appropriate value in [Menus] - [Tray 

Configuration] - [(Tray Name) Config] - [Media 

Weight]. 

Or, change [Media Weight] to a thicker value 

than the present one. 

 Setting paper 

information on 

the operator 

panel 
 

Thin paper is used. Use thicker paper. - 

There is near-solid 

filling at the top edge 

of the paper. 

Try leaving a margin at the top edge of the 

paper. 

With duplex printing, try leaving a margin at the 

rear edge of the paper. 

- 

The paper winds 

around the belt unit. 

Thin or soft paper is 

used. 

Use thicker paper. 

For A5 size, change the orientation of the 

paper. 

- 

Corners of the paper 

are folded (the edge is 

folded). 

The paper is curled. 

The paper is waved. 

Use the paper stored at appropriate 

temperature and humidity. 

 Storing paper 
 

The envelope is 

wrinkled. 

The paper is moist. Use the paper stored at appropriate 

temperature and humidity. 

 Storing paper 
 

This machine is being 

used in high 

temperature and 

humidity. 

Press the scroll buttons on the operator panel 

to select a mode (Mode1, Mode2 or Off) from 

[Menus] - [Print Adjust] - [High Humid Mode]. 

 Menu list 
 

If the problem persists Load the envelope with the flap facing the main 

unit. Next, from Print Setup, set the orientation 

to 180° reversion. 

 Screens and 

functions of the 

printer driver 
 

Misalignment occurs 

when paper is output 

from the expansion 

tray. 

Misalignment occurs 

with each tray. 

Press the scroll buttons on the operator panel 

to select the tray to adjust in [Menus] - [Print 

Adjust] - [Print Position Adjust], and correct the 

value of [X Adjust] (Landscape) or [Y Adjust] 

(Portrait). 

 Correcting the 

print position of 

the tray  
 

The edge of the paper 

is wet. 

Wet paper is used. Press the scroll buttons on the operator panel 

to select [Menus] - [Print Adjust] - [Moisture 

Control], and change the setting. 

- 

    

The paper is 

automatically fed from 

another paper tray 

Tray Switch is set to 

Auto. 

Change the Auto Tray Switch setting in the 

printer driver. 

 Screens and 

functions of the 

printer driver 
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when the paper tray 

runs out of paper 

during printing. 

For the Windows PCL printer driver, uncheck 

[Setup] - [Paper Feed Options] - [Paper feed 

options] - [Auto Tray Change]. 

For the Windows PS printer driver, uncheck 

[Layout] - [Advanced] - [Printer Features] - 

[Tray Switch] - [Off]. 

For macOS, go to [Paper Feed] - [All Pages 

From] to select the tray to be used. 

When a power failure occurs 

If a power failure occurs while the power is on, the power will not turn on automatically even after the power 

failure is recovered.  

If you want the power to turn on automatically after the power failure is recovered, select [Always On] or [Last 

State] in [Boot Menu] - [After AC power supply fails]. 

 Boot Menu  

 
 The machine may not work properly if an uninterruptible. power supply (UPS) or inverter is used. Do not use any 

uninterruptible. power supply or inverter. 

 

With the factory default settings, when a power failure occurs, this machine acts as follows. 

State of this machine Action 

Receiving Reception is interrupted halfway. 

Printing a report Report printing is interrupted halfway. 

Standby Printing cannot be started. 
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Specifications 

Model Model Number 

LP654C  N36800A 

 

General specifications 

Item LP654C 

CPU ARM processor (667 MHz) 

Memory Built-in DDR3 32bit 1GB 

Weight (with consumables) Approx. 28 kg 

Dimensions (WxDxH) 395 × 430 × 290 mm 

Power N36800A: 110V - 127V AC +/-10% 

N36800B: 220V - 240V AC +/-10% 

Power 

consumption (of 

the main unit 

only) 

Operating 840 W 

Standby 20 W (Average) 

Peak 1,150 W 

Power save 

mode 

Less than 14 W 

Sleep mode N36800A: Less than 0.8W*1 

N36800B: Less than 1.1W*1 

Power off N36800A: Approx. 0.1 W or less 

N36800B: Approx. 0.15 W or less 

Operating 

environment 

conditions 

Operating Temperature: 10°C - 32°C; Humidity: 20% - 80% RH 

Pause Temperature: 0°C - 43°C; Humidity: 10% - 90% RH 

Interface USB 2.0, Ethernet 10BASE-T/100BASE-TX/1000BASE-T, USB 2.0 Host, 

IEEE802.11 a/b/g/n Wireless LAN 

Display screen 2.9-inch monochrome graphic panel, 320 x 128 dots 

Compatible OS Windows 10/Windows 8.1/Windows 8/Windows 7 

Windows Server 2019/Windows Server 2016/Windows Server 2012 R2/Windows 

Server 2012/Windows Server 2008 R2/Windows Server 2008 

macOS X 10.11 - 10.15 

Service life*2 5 years or 600,000 sheets 

Storage environment Temperature: -10°C - 43°C 

Relative humidity: 10% - 90% 

 *1: The default setting. It may vary with the specific settings. 

 *2: The service life of this machine depends on the specific usage. 

Printing specifications 

Item LP654C 

Print method The method of dry electrophotographic recording using LED (light-emitting diode) as 

exposure light source 

Page description language PCL6 (XL3.0), PCL5c, IBM5577 (H02), PostScript3, PDF (v2.0) 

Resident PCL: European 91 fonts, Japanese 4 fonts 

PS: European 80 fonts, Japanese 2 fonts 

Resolution 600 x 600 dpi, 1200 x 1200 dpi 

Print colors Yellow, Magenta, Cyan, Black 

Printing speed (A4, Portrait) Color/Mono 

Simplex printing: 35 ppm 

Duplex printing: 18 ppm 
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Item LP654C 

First page 

output time 

Color Approx. 6.5 sec (A4) 

Mono Approx. 6.5 sec (A4) 

Media Size Tray 1 A4, A5, A6, B5, B6, Letter, Legal 13/13.5/14, Executive, Statement, 8.5-inch SQ, 

Folio, 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm), 5 x 7 inches, custom 

sizes 

Expansion tray 

unit (Optional) 

A4, A5, A6, B5, B6, Letter, Legal 13/13.5/14, Executive, Statement, 8.5-inch SQ, 

Folio, 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm), 5 x 7 inches, custom 

sizes 

MP Tray A4, A5, A6, B5, B6, B6 Half, B7, B8, Letter, Legal 13/13.5/14, Executive, Statement, 

8.5-inch SQ, Folio, Index Card (3 x 5 inches), 4 x 6 inches, 5 x 7 inches, Long scale 

(max: 1321 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm), C5, DL, 

Com-9, Com-10, Monarch, custom sizes 

Duplex printing A4, A5, A6, B5, B6, Letter, Legal 13/13.5/14, Executive, Statement, 8.5-inch SQ, 

Folio, 16K (197 x 273 mm, 195 x 270 mm, 184 x 260 mm), 5 x 7 inches, custom 

sizes 

Custom size ・Tray 1 

 100 - 216 mm (W),148 - 356 mm (L) 

・Expansion tray unit 

 105 - 216 mm (W),148 - 356 mm (L) 

・MP tray 

 55 - 216 mm (W), 91 - 1321 mm (L) 

・Duplex 

 105 - 216 mm (W), 148 - 356 mm (L) 

Paper quality Plain (60 g/m2- 256 g/m2), Envelope, Label 

Paper feeding method Auto paper feeding from Tray 1, the MP tray and the expansion tray unit (Optional) 

Manual feeding from the MP tray 

Feeding capacity ・Tray 1 

 250 sheets (80 g/m2), with the total weight of 25 mm or less 

・MP tray 

 100 sheets (80 g/m2), with the total weight of 10 mm or less; 10 envelopes (GSM 

paper weight: 85 g/m2) 

・Expansion tray unit 

 Plain: 530 sheets (80 g/m2), with the total weight of 53 mm or less 

Paper output method Output tray, rear output tray 

Output capacity ・Output tray 

 Plain: 150 sheets (80 g/m2) 

・Rear output tray 

 Plain: 100 sheets (80 g/m2) 

Assured printing range 6.35 mm or more from the edge of the paper (except for special paper like 

envelopes) 

Printing accuracy*1 Writing position accuracy: ±2 mm (±3 mm for the bottom tray when 3 expansion 

trays are installed); paper slant: ±1 mm/100 mm 

Image stretch: ±1 mm/100 mm (80 g/m2) 

Warm-up time ・Power-on 

 Approx. 20 sec or less (At room temperature 25ºC and rated voltage) 

・When Power Save enabled 

 Approx. 11 sec or less (At room temperature 25ºC and rated voltage) 

 Approx. 13 sec or less only for Taiwan-oriented models (At room temperature of 

25°C and rated voltage) 
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Item LP654C 

  

Print quality assurance conditions ・Operating range 

 Temperature: 10°C; Humidity: 20% - 80% RH 

 Temperature: 32°C; Humidity: 20% - 60% RH 

 Humidity: 30% RH; Temperature: 10°C - 32°C 

 Humidity: 80% RH; Temperature: 10°C - 27°C 

・Full color printing quality assurance range 

 Temperature: 17°C - 27°C; Humidity: 50% - 70% RH 

Consumables Toner cartridge, image drum 

Maintenance parts Belt unit, fuser unit 

 *1:Standard-sized paper 

Specifications of the expansion tray unit 

Item Expansion tray unit 

Weight Approx. 6.0 kg 

Dimensions 395 mm (W) x 450 mm (D) x 139 mm (H) 

Network specifications 

Item LP654C 

Interface Ethernet 10BASE-T/100BASE-TX/1000BASE-T, IEEE 802.11a/b/g/n Wireless LAN 

Protocol TCP/IPv4, TCP/IPv6, NetBIOS over TCP, LPR, Port9100, IPP, FTP, HTTP, 

TELNET, SMTP, POP3, SNMPv1/v3, DHCP, DHCPv6, DNS, DDNS, WINS, 

Bonjour, SNTP, LLTD, Web Services for Devices (WSD), SSL/TLS, IPSec, LDAPv3, 

Kerberos, IEEE802.1X, AirPrint, HTTPS, SMTPS, POP3S, IPPS, FTPS, LDAPS 

Wireless LAN specifications 

Item LP654C 

Wireless LAN standard IEEE802.11a/b/g/n compliant (2.4 GHz/5 GHz) 

Security Disabled, WEP, WPA-PSK, WPA2-PSK, WPA-EAP, and WPA2-EAP 

Regulatory wireless LAN statements 

  FCC Statement 

  IC Statement 

  Europe-CE Declaration of conformity. 

FCC statement 

FCC WARNING 

Changes or modifications not expressly approved by the party responsible for compliance could void the 

user's authority to operate the equipment. 

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 

harmful interference in a residential installation. This equipment generates, uses and can radiate radio 

frequency energy and, if not installed and used in accordance with the instructions, may cause harmful 
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interference to radio communications. However, there is no guarantee that interference will not occur in 

a particular installation. If this equipment does cause harmful interference to radio or television reception, 

which can be determined by turning the equipment off and on, the user is encouraged to try to correct the 

interference by one or more of the following measures:  
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- Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. 

IC statement 

This device complies with Part 15 of FCC Rules and Industry Canada licence-exempt RSS standard(s). 

Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this 

device must accept any interference, including interference that may cause undesired operation of this device. 

Le présent appareil est conforme aux la partie 15 des règles de la FCC et CNR d'Ubdustrie Canada 

applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux conditions 

suivantes : (1) I'appareil ne doit pas produire de brouillage, et (2) I'utilisateur de I'appareil doit accepter tout 

brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement. 

This Class [B] digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe [B] est conforme à la norme NMB-003 du Canada. 

Caution (FCC/IC): 

5.15-5.25 GHz band is restricted to indoor operations only. 

La bande 5150-5250 MHz est restreints à une utilisation à l'intérieur. 

This equipment complies with FCC/IC radiation exposure limits set forth for an uncontrolled environment and 

meets the FCC radio frequency (RF) Exposure Guidelines and RSS-102 of the IC radio frequency (RF) 

Exposure rules. This equipment should be installed and operated keeping the radiator at least 20 cm or more 

away from person's body. 

Cet équipement est conforme aux limites d'exposition aux rayonnements énoncées pour un environnement 

non contrôlé et respecte les règles les radioélectriques (RF) de la FCC lignes directrices d'exposition et 

d'exposition aux fréquences radioélectriques (RF) CNR-102 de l'IC. Cet équipement doit être installé et utilisé 

en gardant une distance de 20 cm ou plus entre le dispositif rayonnant et le corps. 

Europe - CE Declaration of Conformity 

 

This equipment complies with the essential requirements of the European Union directive 2014/53/EU. 

The telecommunications functionality of this product may be used in the following EU and EFTA countries: 

Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland, France, Germany, Greece, 

Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania, Luxembourg, Malta, Netherlands, Norway, 

Poland, Portugal, Romania, Slovak Republic, Slovenia, Spain, Sweden, Switzerland, Turkey and United 

Kingdom. 
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Dimensions 

Plan view 

 

Side view 
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With options installed 
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Using the FAQ guide of this machine 

If an error occurs in this machine, you can search for a solution by accessing the "Frequently Asked 

Questions (FAQs)" on the website from the mobile device application or the FAQ on your PC. 

You can also easily find a solution by inputting the keyword in "Search Keyword" displayed on this machine. 

 

How to display "Search Keyword" 

If an error occurs in this machine (when «ATTENTION» on the operator panel blinks or lights on) and [Please 

See HELP For Details] appears on the display, press «HELP» on the operator panel to display "Search 

Keyword". 

 

 

From your mobile device 

1 Install the Mobile Print application. 

 

2 Tap to launch the application, and tap [FAQ]. 

3 Select your machine from the product selection screen. 

4 Input the keyword in "Search Keyword" displayed on this machine to search for a solution. 

 
 You can also narrow the search by category or by inputting other keywords. 
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5 If "NFC" appears on this machine's display, bring the mobile device where the Mobile Print app 

is running close to the NFC mark on the operator panel, and "FAQ" will start and display the 

result of the search for the solution page. 

 

 
 If you are using iOS, tap [NFC] to display [Ready to Scan] and then move the mobile device close to this 

machine. 

 

 This function is available to the NFC-compatible device with Mobile Print installed. 

 Enable the NFC function on your mobile device. 

 Check that the NFC setting of this machine is enabled. The factory default setting is [Enable]. 

 

From your PC 

For Windows 

1 Install the FAQ. 

If you install the software using [Recommended Install] or [Batch Install], the FAQ will be installed. 

Else you can install it using [Individual Install]. 

You can also install it from the website. 

 
 Refer to "Installing software on a PC " for the installation method. 

2 Open the FAQ icon located on the desktop. 

3 Select your machine from the product selection screen.  
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4 Input the keyword in "Search Keyword" displayed on this machine to search for a solution. 

 
 You can also narrow the search by category or by inputting other keywords. 

 

 

For macOS 

1 Install the FAQ. 

Copy the FAQ from the enclosed DVD to your desktop. 

You can also install it from the website. 

2 Open the FAQ icon located on the desktop. 

3 Select your machine from the product selection screen. 

4 Input the keyword in "Search Keyword" displayed on this machine to search for a solution. 

 
 You can also narrow the search by category or by inputting other keywords. 
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Contact us 

 

Printronix, LLC.  

7700 Irvine Center Drive, Suite 700  

Irvine, CA 92618, USA 

Tel: 1-800-665-6210 

http:/www.printronix.com 
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Menu tree 
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